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CHAPTER1

Introduction to Mixxx

Mixxx enables you to perform live DJ mixes with your digital music collection. It helps you rock the party with DJ
controllers, vinyl turntables, or even just your keyboard. It is developed by an international team of volunteers who want
to bring the joy of DJing to everyone. The project is non-profit, open-source and community driven. Together, we aim
to build the best DJ software ever created. We hope you will join us!

1.1 How Mixxx Works

Mixxx is different from typical music player applications because it plays multiple audio files at the same time and has
many features to manipulate the playback of the audio files. This lets you creatively mix different tracks together on the
fly.
You can use Mixxx to preview the next track in headphones before the audience hears it, also known as headphone cueing.
This helps you choose a track that is appropriate for the present moment and that will mix well into the currently playing
track(s). To use headphone cueing, you need at least 2 separate audio outputs, typically provided by a USB audio interface
(also known as a “sound card”, although most of them are not shaped like cards anymore).
The shortcut for headphone cueing in Deck1 is T while for Deck 2 the shortcut is Y.
Mixxx can be used in two different ways for headphone cueing:
Internal Mixing

Mixxx plays multiple audio files on the computer at the same time, mixes them together, and sends the mixed
signal to one audio interface output. A separate signal is sent to another audio interface output for headphone
cueing. Often a DJ controller is used with internal mixing to provide easier control over Mixxx than a mouse
and keyboard.

External Mixing
In this kind of setup, Mixxx plays multiple audio files on the computer at the same time and sends each track
to a separate audio interface output. The audio interface's outputs are plugged into an external hardware
mixer. The hardware mixer performs the actual mixing of the audio signals. On the hardware mixer, there
are separate outputs for the mixed signal to play to the audience and for the DJ to use headphone cueing.

1
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Figure1: Using Mixxx together with a DJ controller for internal mixing. The DJ controller has an integrated audio
interface that provides two separate stereo outputs.

External mixing is typically used with turntables and special vinyl records to manipulate digital music files as
if the music was on the vinyl records.

1.1. How Mixxx Works 2
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Figure2: Using Mixxx together with a USB audio interface, external mixer, and timecode vinyl for external mixing

1.1. How Mixxx Works 3



CHAPTER2

Getting Started

2.1 Installing Mixxx

After downloading Mixxx from our Website, you need to install it on your computer.
Windows Double-click the Mixxx installation file and go through the installation wizard.
macOS Double-click the Mixxx .dmg file and drag the Mixxx icon to your Applications folder.
GNU/Linux No steps are necessary after you follow the instructions on the download page.

2.2 Upgrading Mixxx

You may safely install Mixxx on top of any previous version. You don't need to uninstall the old version.
Your settings and library will not be removed or reset, but they may be upgraded when you launch the new version of
Mixxx. Note that we do not guarantee that new configurations will work on older versions of Mixxx, therefore you may
want to make a backup of your existing settings just in case.

Windows
Mixxx settings are in %LOCALAPPDATA%\Mixxx, which is usually something like c:\
Users\<username>\AppData\Local\Mixxx. If you have trouble finding this
folder, see these instructions.

macOS Mixxx settings are in /Users/<username>/Library/Containers/org.
mixxx.mixxx/Data/Library/Application Support/Mixxx

GNU/Linux Mixxx settings are in /home/<username>/.mixxx
Copy this directory to a backup drive or somewhere else on your system to make a backup of your settings.
Lihat juga:
For detailed descriptions of the settings files, go to The Mixxx Settings Directory.

4
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2.3 Opening Mixxx

Once you've installed Mixxx, start by opening Mixxx and importing your music to the Mixxx library.
Windows Double-click the Mixxx icon on the Desktop. Alternatively, browse your Windows start menu and click the

Mixxx icon, or perform a search for Mixxx.exe.
macOS Double-click the Mixxx icon in the Applications folder. Alternatively, drag the Mixxx icon to the dock

and double-click it there or search for mixxx in Spotlight.
GNU/Linux Click the Mixxx icon in the applications menu or launcher of your desktop environment or perform a

search for mixxx. Alternatively type mixxx into the terminal, then hit Return. If your audio interface is
not accessible from Mixxx because it is used by other applications via PulseAudio, you may close and restart
Mixxx using pasuspender mixxx. See Launching Mixxx from the Command Line for an overview of Mixxx's
command line options.

2.4 Importing your audio files

Figure1: Mixxx running on Windows 10 - Choose music library directory dialog

The first time you run Mixxx, you are asked to select a directory where your music is stored. By default, the dialog points
to a location where music files are typically held, but you can select any location on your computer.
Click Select Folder and Mixxx will scan your music library. Depending on the size of your library this could take some
time. All the supported music files Mixxx detects will be listed in the Tracks - View and edit your whole collection.
If you want to refresh your library (for example because you added or moved files), you can do this with Library ‣ Rescan
Library in the menu. If you want to rescan at every launch, select Preferences ‣ Library ‣ Rescan on startup.

Peringatan: On Windows 7 and 8 the import dialog points to your Windows “Music“ Library, a special-purpose
virtual folder. You can not use these virtual folders. Select a regular folder instead, usually “My Music“, like pictured
above.

2.3. Opening Mixxx 5
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2.5 Analyze your library

Mixxx automatically analyzes tracks the first time you load them in a deck. This allows you to run beatgrid, key,

and ReplayGain detection on tracks in advance. It also prepares the waveform overviews, detects file corruption, and
calculates the BPM values.
Lihat juga:
For more information, go to Beat Detection.

2.5.1 Why you should analyze your audio files

If the tracks have never been played with Mixxx before, the library columns BPM, Duration and Key will be empty or
unreliable (because the values are just read from the file's tags if present and might be wrong). Pre-generating beatgrids
gives you the chance to double-check the beat markers to make sure they are correct. Errors in beatgrids can cause
difficulty when syncing tracks. Furthermore, track analysis takes considerable CPU power and might cause skips in the
audio --- things you surely don't need while performing.

2.5.2 How to analyze your audio files

Once you have imported your music library, press OK on the Preferences window.
• Go to the Analyze view on the left side panel of the library.
• To analyze a few specific tracks, hold down the Ctrl button, and select the tracks that you want to analyze or you
can shift-select a range of tracks. Once they've been highlighted, click the Analyze button on the top right of
the library section.

• To analyze the newly added tracks, toggle the New label and then click Analyze.
• To analyze the entire library, toggle the All label and then click Analyze.
• The New and All toggle buttons are located at the top left of the analysis pane - just above the Preview and Cover
Art column titles of the library.

While analyzing, the progress in percentage and total queue length are shown.

2.6 Configuring sound input and output

Before you can start using Mixxx, you need to configure Mixxx to use your sound hardware in Preferences ‣ Sound
Hardware. You do not need to configure all inputs and outputs.
TheDJHardware chapter explains different types ofDJ hardware and how to set them upwith the input and output options.
For Mixxx to perform the best it can on your system, configure the other Sound Hardware preferences in addition to the
inputs and outputs.

2.5. Analyze your library 6
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Figure2: Mixxx Sound Hardware Preferences

2.6.1 Output Options

Internal mixing:
Use these outputs if you are not using an external hardware mixer. If you are using a controller with a built-in audio
interface, use these outputs.

• Master: all decks, samplers, microphones, and auxiliary inputs mixed together. This output is sent to the speakers
for the audience.

• Headphones: all decks, samplers, microphones, and auxiliary inputs assigned to pre-fader listening
• Booth: same as Master output, but has a separate gain control

External mixing:
• Decks 1-4: the individual unmixed decks to send to an external mixer
• Bus Left/Center/Right: all decks, samplers, and auxiliary inputs assigned to each side of Mixxx's crossfader

2.6.2 Input Options

Internal mixing:
Use these inputs if you are not using an external hardware mixer. If you are using a controller with a built-in audio
interface, use these inputs.

• Microphone 1-4: live microphone or musical instrument inputs
• Auxiliary 1-4: other sound sources

External mixing:
• Record/Broadcast: When this is configured, Mixxx will record and broadcast from this audio interface input instead
of the internal master mix. If you have a microphone plugged into the mixer, do not configure the Microphone 1-4
inputs.

Either internal or external mixing:

2.6. Configuring sound input and output 7
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• Vinyl Control 1-4: timecode input from turntables or CDJs for manipulating decks 1-4
Lihat juga:
Using Microphones

2.6. Configuring sound input and output 8



CHAPTER3

The Mixxx User Interface

Welcome to the Mixxx interface. This is where the magic happens. You are going to want to get very familiar with this
interface because it is the main way to use Mixxx. In this chapter, we present the default interface of Mixxx and describe
its elements, knobs and faders.

Figure1: The Mixxx interface - Latenight skin

This is the LateNight skin, PaleMoon color theme. It is the default skin supplied with Mixxx 2.3. There are a variety of

9
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other skins included with Mixxx. You should explore them all to figure out which one you prefer. This section will focus
on LateNight only, though all Mixxx skins provide most of the controls described here.

3.1 Skin Settings

On top, and on the right side of the user interface are the section expansion buttons and options.

Figure2: The GUI section quick toggles buttons in the top tool bar

If you click on either WAVEFORMS, 4 DECKS, MIXER, EFFECTS, SAMPLERS or MICS & AUX then you will enable
control sections for interacting with:

• Waveform Displays

• Decks

• Mixer

• Effects

• Samplers

• Microphones & Auxiliary Inputs

You can also use the specific Application shortcuts.
Click the SETTINGS button or gear icon (depending on the skin) to open the skin settings menu. This provides common
basic controls as well as some skin-specific options.

3.2 Decks

The deck section comes in three sizes: Full, Compact andMini. You can switch between any of the three sizes by clicking
on the Settings button or the gear icon. Under the Decks section, click on "hide mixer to select". This will automatically
select the Compact deck (underlined and bolded). If you wish to change to a different deck size, you can choose FULL
or Mini.

The FULL deck (which is similar in all skins) will show the Vinyl Control Mode and Cueing controls and
Key controls at the top of the deck section and then the Hotcue Controls, Intro/Outro Markers, Loop
Controls at the bottom.
The Compact deck has a reduced set of controls for when you don't need all of them on screen, for example
when they're also accessible from your controller. Reverse is removed from the Playback/Cue Controls, and
the Hotcue Controls, Intro/Outro Markers, Loop Controls and rate adjust buttons are not shown.
The mini deck is of a much smaller size and shows only the waveform and the Track Information Display.
You can also use minimal decks with the maximized library.

Petunjuk: Hiding the mixer will by default switch to the compact decks.
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Figure3: The Skin Settings menu on the right
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Figure4: A deck with a track loaded

The deck section allows you to control everything relating to a virtual turntable deck. We are going to break this down
into sections.

3.2.1 Track Information Display

Figure5: The track information section of the deck

Track Title The title of the track that was loaded into a deck is displayed on top. This is the same as the title listed under
the Title column heading in theMixxx library. This information is initially loaded from the track's metadata. If the
metadata is missing, the title and artist are guessed from the filename.

Track Artist The artist of the track is listed below. It is the same as listed under the Artist column heading in theMixxx
library.

Time Elapsed/Remaining/Both By default it displays the total elapsed time in the track up to the millisecond. Clicking
on the display switches to the Time Remaining view, which indicates how much time is left before the track reaches
the end. Clicking the display again, both the elapsed and remaining time are shown simultaneously in the format
elapsed time / remaining time. You can change the default in Preferences ‣ Decks ‣ Deck options.

BPM (Tempo) The number at the top right is the effective BPM of the track. This is the detected BPM of the track,
adjusted for the playback rate of the track. For example, if the track is normally 100 BPM, and it is playing at
+5%, then the effective BPM will read 105 BPM.

Petunjuk: You can use a keyboard shortcut and tap with the beat to set the BPM to the speed you are tapping,
go to Using a Keyboard for more information.

Key

Figure6: The Key options.
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The key displays the current musical key of the loaded track after pitch shifting. The key is displayed below the BPM
(Tempo). This is the same as the key that is shown under the Key column heading in the Mixxx library. Clicking the key
will expand it to reveal more options:

• Pitch Control: This changes the track pitch independent of the tempo. Left-clicking the - button decreases the
pitch by one semitone. Right-clicking it decreases the pitch by 10 cents. Left-clicking the + button increases the
pitch by one semitone. Right-clicking it increases the pitch by 10 cents.

• Sync and Reset Key: Left-clicking theMATCH button sets the key to a pitch that allows harmonic transition from
the other track. It requires a detected key on both involved decks. Right-clicking it resets the key to the original
track key.

Cover Art The cover art of the track loaded into the deck is displayed on the left side of the track. This is the same as
the cover art that is shown under the Cover Art column heading in theMixxx library. In Deere skin you can choose
to enable or disable the cover art by clicking the gear icon in the upper right corner, then toggling the Decks ‣ Cover
Art option. Clicking on the cover art will expand it into a full blown image. The cover art is also shown in the Vinyl
Widget next to the parallel waveforms.

3.2.2 Waveform Displays

The waveform section of a deck allows you to visualize the audio changes that occur throughout the track, you can basically
“see” your music.
By default the waveform displays are aligned parallel to each other in order to make beatmatching easier, as it is possible
to beatmatch visually by aligning the beats that appear in each waveform.

Figure7: Parallel waveforms in the default Mixxx skin (LateNight, PaleMoon theme)

Depending on the skin, Mixxx displays either parallel waveforms (default) or separate waveforms. LateNight and Tango
skins only have resizable parallel waveforms while Shade skin provides only separate waveforms. In Deere skin you can
select your preferred appearance by clicking the gear icon in the upper right corner, then toggling the Skin Settings ‣
Parallel Waveforms option.

Peringatan: If you have a slower computer and notice performance issues with Mixxx, try lowering the frame rate
or changing the waveform type in Preferences ‣ Waveforms.

Waveform summary The big waveform summary shows the waveform envelope of the track near the current playback
position and is updated in real time. The mouse can be used on the waveform to pause, scratch, spin-back or
throw the tracks. Right-clicking on the waveforms allows you to drag with the mouse to make temporary pitch
adjustments.
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Petunjuk: You can select from different types of displays for the waveform, which differ primarily in the level of
detail shown in the waveform, in Preferences ‣ Waveforms ‣ Waveform type.

Waveform overview The smaller, zoomed-out version of the waveform shows the various markers within the track as
well as the waveform envelope of the entire track. This is useful because they allow DJs to see breakdowns far in
advance. As visual aid, the part of the track that has already been played is darkened.
Clicking somewhere on the waveform allows you to jump to an arbitrary position in the track. Like with the
Waveform summary, you can select from different types of displays for the overview in Preferences ‣ Waveforms ‣
Overview type.

Vinyl Widget The line on the vinyl widget rotates if the track moves. It is similar to the position marker found on
scratch records. Use the mouse on the vinyl widget to pause, scratch, spin-back or throw tracks - just like a real
record. When performing Loop rolls or right-clicking on the vinyl during playback, a “ghost” marker hints where
the playback will continue. The Vinyl Widget is hidden by default and can be enabled in the Deck Options Button
Grid.
If vinyl control is enabled, it can optionally display the time-coded vinyl signal quality. Activate the option in
Preferences ‣ Vinyl Control ‣ Show Signal Quality in Skin.

Waveform Zoom Using the mouse-wheel everywhere in the waveform summary will zoom the waveform in or out. You
can choose whether to synchronize the zoom level between the decks in Preferences ‣ Waveforms.

Waveform Marker While mixing, various additional markers can appear on the waveforms:
• Position marker: The static vertical line in the center of the waveform summary indicates the playback point of
the deck. The waveform overview includes a vertical line to show the current position within the track.

• Beat marker: The regular white lines on the waveform summary indicate the locations of beats in the audio, also
called the beatgrid.

• Cue marker: Indicates the position of the cue point.
• Hotcue marker: Indicate the position and number of a hotcue point if set.
• Loop-in/Out marker: Indicate the beginning and the end of a loop.
• Loop overlay: Is drawn between the Loop-in/Out markers and changes color depending on whether a loop is
activated or not.

• Track ending notification: If the waveform overview flashes red, only 30 seconds are left before the track reaches
the end.

3.2.3 Deck Options Button Grid

Figure8: The Options Button Grid of the deck

The six buttons at the bottom right below the waveform allow you to configure the deck. Starting from the top row (left
to right) and the bottom row (left to right), the buttons are as follows:
Slip Mode Toggle When active, the playback continues muted in the background during a loop, reverse, scratch, etc.

Once disabled, the audible playback will resume where the track would have been.
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Quantize Mode Toggle If enabled, all cues, hotcues, loops, and beatloops will be automatically quantized so that they
begin on a beat.

Beat-grid Adjust Button Clicking this button adjusts the track beat-grid so that the current position is marked as a beat.
This is useful if Mixxx was able to accurately detect the track's BPM but failed to align the beat markers on the
beats. For more information, go to the chapter Beat Detection.

Eject Track Button Clicking this button ejects the track from the deck. Alternatively you can use a keyboard shortcut,
go to the chapter Using a Keyboard for more information.

Repeat Mode Toggle If enabled, the repeat mode will jump back to the beginning and continue playing when the track
finishes.

Keylock Toggle Key lock locks the track's pitch so that adjustments to its tempo via the rate slider do not affect its pitch.
This is useful if you would like to speed up or slow down a track and avoid the “chipmunk” effect that speeding up
vocals has.

3.2.4 Playback/Cue Controls

Figure9: The playback and cueing controls of the deck

Play/Pause Button Clicking the Play/Pause button starts and pauses the playback.
Lihat juga:
The actual behavior of the Play/Pause button depends on the selected Cue mode.

Cue Button If the button is pressed while the track is playing, the play position jumps to the Cue point on the track and
the track is paused. Once the track is paused at the Cue point, you can preview it by holding the Cue Button. If
you have not moved the Cue point yet, the default point is at the track's beginning.
Lihat juga:
The actual behavior of the Cue button depends on the selected Cue mode.

Reverse button Press and hold this button to temporarily play the track backwards during regular playback. Right-click
and hold for 'Censor' mode. This reverses the track while the playback continues muted in the background. On
release playback is resumed where the track would have been if it had not been reversed.

Setting Cue points

Every track has a Cue point, by default on its beginning. Unlike with Hotcues, you can't delete, but only move Cue points.
The Cue point is moved according to the selected Cue mode, as explained below.
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Auto Cue

Mixxx automatically seeks to the saved Cue point on track load. If none exists, seeks to the beginning of the track.
Uncheck Preferences ‣ Interface ‣ Auto Cue ‣ Jump to main cue point on track load to always seek to the beginning of the
track.

Using Cue Modes

Mixxx supports various Cue modes that adapt to fit other devices in your setup or your personal preferences. The actual
behavior of the Play, Pause, and Cue buttons depends on the selected Cue mode. To change the Cue mode, go to
Preferences ‣ Decks ‣ Cue mode.
Mixxx mode (default)

• While paused at Cue point (Cue button lit):
– Hold down the Cue button to play the track from the Cue point, as long as the button is pressed. After releasing
the Cue button, the track jumps back to the Cue point and pauses again.

– Press Play/Pause before releasing the Cue button to continue playback normally.
• While paused not at Cue point (Cue button flashing):

– Tap the Cue button to store the current position as new Cue point.
• While playing:

– Tap the Cue button to jump to the Cue point and pause playback.
Mixxx mode (no blinking)

• Same as the default Mixxx mode, but without blinking indicators.
Pioneer mode

• Same as Mixxx mode, but the buttons are more flashy matching a Pioneer CDJ player.
– The Play/Pause button flashes once per second when a track is paused.
– The Cue button flashes twice a second when the next push will move the Cue point.

Denon mode
• While paused at Cue point (Cue button lit) - same as Mixxx mode:

– Hold down the Cue button to play the track from the Cue point, as long as the button is pressed. After releasing
the Cue button, the track jumps back to the Cue point and pauses again.

– Press Play/Pause before releasing the Cue button to continue playback normally.
• While paused not at Cue point (Play button flashing):

– Tap the Cue button to move the track back to Cue point.
– Tap the Play/Pause button to move the Cue point to the current position and start playback.

• While playing - same as Mixxx mode:
– Tap the Cue button to jump to the Cue point and pause playback.

Numark mode
• Same as Denon mode, but without a flashing Play/Pause button.
• This mode is useful if you want to implement a custom skin with 3-button decks, featuring a Cue button, a dedicated
Pause button, and a Play/Stutter button.
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CUP (Cue + Play) mode
• Press the Cue button to jump to the Cue point and pause, continuing playback only when either the Cue button is
released or Play/Pause is pressed.

• If the Cue button is pressed while paused, the Cue point is first moved to the current position.

Petunjuk: Use the Hotcue Controls to place more reference points on a track.

Lihat juga:
You can also use keyboard shortcuts for Cueing. Go to Using a Keyboard for more information.

3.2.5 Intro/Outro Markers

Figure10: The Intro/Outro End and Start Markers

You can use the Intro/Outro Markers with Auto DJ to mix in and out of points but unlike hotcues, they do not mark only
one point. The intro and outro are sections and each section is defined by two points. See Auto DJ - Automate your mix.
Intro Start/End Markers The analyzer places the intro start point at the first sound of a track and you can decide where

to place the intro end point. Left-clicking on the marker when it is set jumps to the marker. When it is not set,
clicking sets the marker to the current play position. Right-clicking on the marker when it is set clears the marker.

Outro Start/End Markers The analyzer places the outro end point at the last sound of a track and you can decide where
to place the outro start point. Left-clicking on the marker when it is set jumps to the marker. When it is not set,
clicking sets the marker to the current play position. Right-clicking on the marker when it is set clears the marker.

Catatan: If quantization is enabled, left-clicking on any of the markers snaps to the nearest beat.

3.2.6 Transport Controls

Figure11: The transport controls of the deck

Beatjump/ Loop Move Size You can type, use the arrow keys or scroll vertically in the input box to select the number
of beats to jump or move, with the Beatjump Forward/ Backward buttons.

Beatjump Backward button Clicking this while the loop is inactive will make the track jump backward by the set
number of beats (left click) or by one beat (right click). Clicking this while the loop is active will move the loop
backward by the set number of beats (left click) or by one beat (right click).
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Beatjump Forward button Clicking this while the loop is inactive will make the track jump forward by the set number
of beats (left click) or by one beat (right click). Clicking this while the loop is active will move the loop forward
by the set number of beats (left click) or by one beat (right click).

3.2.7 Vinyl Control Mode and Cueing controls

Figure12: The Vinyl Control Mode and Cueing controls of a deck

The control above the waveforms relate to the vinyl control feature in Mixxx and is hidden in the default Mixxx user
interface. Click the gear icon in the upper right corner, then toggle Skin Settings ‣ Vinyl Control Options, or use the specific
Application shortcuts to show or hide the section.
Lihat juga:
For more information on how to use Vinyl control in your setup, go to the chapter Vinyl Control.
Vinyl button
This button enables vinyl control. When enabled in Mixxx, the track on the Mixxx deck is controlled by the external vinyl
control.
Pass button
This button enables passthrough. When enabled, audio from an external vinyl can be played on the Mixxx deck.
Abs/Rel/Const button

• Absolute mode: The track position equals needle position and speed.
• Relative mode: The track speed equals needle speed regardless of needle position.
• Constant mode: The track speed equals last known-steady speed regardless of needle input.

Cue/Hot button
This button determines how cue points are treated in vinyl control relative mode:

• Off: Cue points are ignored.
• Cue: If the needle is dropped after the cue point, the track will seek to that cue point.
• Hot: The track will seek to the nearest previous hotcue point.

3.2.8 Sync and Rate Controls

Figure13: Rate
controls

The rate controls allow you to change the rate at which tracks are played. This is very useful for
beatmatching two tracks together in a mix. You can control rate changes also from your computer's
keyboard, see the chapter Using a Keyboard for more information.
SYNC button

• Left-Click: Changes the rate of the track so that the BPM and phase of the track
matches the other deck.

• Right-Click: Only changes the rate of the track to match the other deck but does not
adjust the phase.
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Decks and samplers now pick which sync target to sync to on the fly. Decks can't sync to
samplers and samplers can only sync to decks. The sync target for samplers is:

• The first deck (in numerical order) that is playing a track with a detected beatgrid, and
has a rate different than zero.

• The first deck (in numerical order) that has a track loaded with a detected beatgrid, no
matter if it is playing or stopped.

So basically, if you sync a sampler and both deck 1 and deck 2 are playing a track with a
beatgrid then deck 1 will win since numerically it is first. The sync targets for decks are
chosen with the new master sync feature, see Master Sync for more information.

Pitch/Rate slider The slider allows you to change the speed of the song, by default up to 10% from
the tracks original tempos. The speed will increase as you move the slider up, opposite to the behavior found on
DJ turntables and CDJ. Right-clicking on the slider will reset the tempo to its original value.

Pitch Rate Display The percent that the track's rate is sped up or slowed down is noted here. Is the
Pitch/Rate slider positioned at the center, the pitch rate display is at +0.0%, which indicates
no change.

Temporary Pitch/Rate buttons (Nudge) Pushing the diagonal arrow buttons is like nudging the
metal edge of a turntable, or the outer edge of a CD player. It will give the track a push or
pull forwards or backwards. If the buttons are released the previous tempo is restored. The
buttons can act as either a fixed pitch bend or a ramping pitch bend.

Pitch/Rate buttons Clicking the - button will set the pitch/rate lower while the+ button will set the
pitch/rate higher. This is like moving the pitch slider up or down by a fixed amount. Unlike
using the temporary pitch/rate buttons, the change is permanent so these button s don't need
to be held down.

Lihat juga:
To customize the amount by which the buttons alter the pitch of the track, the slider range as well as the direction, go to
Preferences ‣ Interface ‣ Adjustment buttons ‣ Permanent / Temporary.

Petunjuk: If the tempo of a track changes, you'll notice that the tone changes based on the pitch used (e.g. playing at
faster pitch gives a chipmunk sound). You can enable the Keylock feature to maintain a constant tone.

3.2.9 Loop Controls

Figure14: The beatloop and looping controls of the deck

In this section of the Mixxx interface you can control (beat-)loops and set the loop points of a track. You can also shift
loops using the beatjump / loop move controls shown at the right side of the looping controls.
Beatloop size The input box allows you to set the size of the loop in beats to set with the Beatloop button. Changing this

resizes the loop if the loop already matches the size. If a loop is set, a loop overlay will be drawn on the waveforms.
Beatloop Left-clicking the Beatloop button starts a loop over the set number of beats. If quantize is enabled, it snaps to

the nearest beat. This works for manually placed loops as well as automatic loops set by the beatlooping buttons.
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Depending on the current status of the loop, the loop overlay on the waveforms changes color. Right-clicking the
Beatloop button temporarily enables a rolling loop over the set number of beats. Playback will resume where the
track would have been if it had not entered the loop.

Double loop Clicking on the arrow pointing up will double the current loop's length up to 64 bars. The length of the
loop overlay in the waveform will increase accordingly.

Halve loop Clicking on the arrow pointing down will halve the current loop's length down to 1/32 bars. The length of
the loop overlay in the waveform will decrease accordingly.

Loop-In This button allows you to manually set the start point of a loop. A loop-in marker is placed on the waveform
indicating the position. If clicked when a loop was already set, it moves the start point of a loop to a new position.

Loop-Out This button allows you to manually set the end point of a loop. A loop-out marker is placed on the waveform
indicating the position. If clicked when a loop was already set, it moves the end point of a loop to a new position.

Reloop Left-clicking this button toggles the current loop on or off. If the loop is ahead of the current position, looping
will start when the loop is reached. This works only if the Loop-in and Loop-Out marker are set. Right-clicking
this button enables the loop, jumps to Loop-in marker and stops playback.

Petunjuk: If you are playing inside a loop and want to move the end point beyond its current position in the track, click
on the Beatloop button first and when the play position reaches the desired position, click on the Loop-Out button.

Lihat juga:
If the Quantizemode is enabled, the loops will automatically snap to the nearest beat. This is disabled by default, click on
the Quantize Mode Toggle to enable it.

3.2.10 Hotcue Controls

Figure15: The hotcue controls of the deck

To jump in between different parts of a track, you can use these numbered buttons. You can also use keyboard shortcuts,
go to Using a Keyboard for more information.

Setting Hotcues

Clicking on a numbered button will set a hotcue at the current play position on the track. A marker with the corresponding
number will appear in the waveform and the button will light up to indicate that the hotcue is set.
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Playing Hotcues

• While playing: Tap a hotcue button to cause the track to instantly jump to the location of the hotcue and continue
playing. If you are playing inside a loop and tap a hotcue whose position is outside of the loop, then the track still
instantly jumps to the hotcue but the loop will be deactivated.

• While stopped: Tap a hotcue button to cause the track to instantly jump to the location of the hotcue and start
playing as long as the button is pressed. Press the Play keyboard shortcut while the hotcue button is pressed to
continue playback, then release the hotcue button.

Highlighting Hotcues

It's possible to add labels or colors to your hotcues to make them easier to distinguish and make it possible to get their
"meaning" at first glance.
Labels and colors can be assigned from the Hotcue context menu, which can be opened by right-clicking either the hotcue
button or the hotcue marker in the waveform overview.

Petunjuk: Mixxx allows customizing the color palette and bulk replacing hotcue colors.

Deleting Hotcues

To delete a hotcue, right-click on the hotcue button or the waveformmarker in the overview waveform to open the context
menu, then click the trash icon.

Catatan: Mixxx supports up to 36 hotcues per deck. By default, only some of them are visible in the user interface.
You can customize your keyboard or controller mappings to use all of them.

Lihat juga:
Just as with the loops (see above), if the quantizemode is enabled, the hotcues will automatically snap to the nearest beat.
This is disabled by default, click on the Quantize Mode Toggle to enable it.

3.3 Mixer

The mixer section of the Mixxx user interface allows you to control how the different decks and samplers are mixed
together.

3.3.1 Channel Faders and Level Meters

Level meters The left meter shows the volume level for the left deck, while the right meter shows the volume level for
the right deck. The double meter at the center shows the current volume of the main output's left and right channel
separately. These should stay at the top of the green region, with the loudest parts of the music (transients) briefly
going into the yellow region. They should never be in the red region. Refer to Setting your levels properly (gain
staging) for more details.

Line faders The two large faders on either side of the level meters are the deck volume faders, also known as Channel-
or Line-faders. Adjusting these controls the volume of each deck.
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Figure16: The mixer section

Petunjuk: Some DJ's prefer to use the line faders over the crossfader for fading between tracks. Try it, you may
like it.

3.3.2 Equalizers and Gain Knobs

Gain Knob The gain knob (orange) above the volume fader allows you to adjust the gain applied to the deck. Use this
to compensate for the differences in recording levels between tracks. In general, you should adjust this knob so that
the track's level meter stays around the top of the green region with the loudest parts of the track (the transients)
briefly going into the yellow region. Do NOT turn the Gain Knob up so much that the level meter is in the
red region. At this point the track is clipping, which sounds bad and could damage equipment.

Catatan: By default, Mixxx automatically applies an additional ReplayGain so tracks have approximately equal
loudness at unity gain. Your tracks must be analyzed to take advantage of this feature. When an unanalyzed track
is loaded, Mixxx calculates its ReplayGain value, but will not apply a newly calculated ReplayGain value to a track
after it has already started playing (to avoid a sudden change in the gain of a playing track).

Lihat juga:
For an explanation of why you should set your gains this way, see Setting your levels properly (gain staging).

EQ Knobs
The low, mid, and high EQ knobs allow you to change the filters of the audio. This allows you to
selectively reduce or boost certain frequency ranges of the audio.
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Figure17: EQ Controls
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Peringatan: Be careful not to raise the EQs so much that the signal clips, indicated by a level meter being in
the red region. See Setting your levels properly (gain staging) for a more detailed explanation.

Kill Switches The small boxes next to each EQ knob are called kills. Hold these buttons to fully remove that frequency
range. Short click on the buttons for latching. When in Latch mode, click again to restore the frequency range. If
the Kill switches do not work as expected, check the high/low shelf EQ settings in the preferences.

Quick Effect Super knob This knob lets you control the Meta knob of the deck's Quick Effect. 'Filter' is the default.
Right-click this knob to center it. This is equivalent to 'no audible effect' for the built-in filter effects only (Filter,
Moog Ladder 4 Filter). The button next to the knob toggles the effect. It provides the same latching capabilities
like the EQ Kill switches.

Lihat juga:
You can customize the EQ settings in Preferences ‣ Equalizer.

3.3.3 PFL/Headphone Button

Figure18: The headphone buttons of both decks in the mixer

The headphone button is also known as the pre-fader listen or PFL button and allows you to use headphone cueing. That
is, it allows you to hear the track you will play next in your headphones before your audience hears it. This helps you plan
when to start the next track and manipulate it to make it blend better with the currently playing track (for example, by
synchronizing the beats, setting a loop, or using EQs). Pressing the PFL button plays the track on the headphone output
at full volume regardless of the position of the crossfader or the deck’s line fader. To play a track in your headphones but
not have the audience hear it, press the PFL button and move the crossfader all the way to the opposite side of the deck
or turn the deck’s volume fader all the way down.

Catatan: Headphone cueing is only available if you have configured a Headphone Output in Preferences ‣ Sound Hard-
ware.

Catatan: If you use an external hardware mixer, plug your headphones into that rather than your sound card. Use the
headphone buttons on the mixer rather than the buttons in Mixxx.
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3.3.4 Crossfader

Figure19: The crossfader section of the mixer

The crossfader determines the actual volume of each deck when moving the slider from left to right. If both decks are
playing and the crossfader is in its default center position, then you will hear both decks. Right-clicking on the crossfader
will reset the slider to its default position.
To move the crossfader left or right, you can use the keyboard shortcut G and H. To apply small crossfade left and small
crossfade right, the shortcuts are Shift + G and Shift + H respectively.
You can reverse the configuration of the crossfader, so that the right deck is on the left end of the crossfader and vice versa.
This is also known as Hamster Style. To adjust the crossfader to your style of mixing, go to Preferences ‣ Crossfader.
The crossfader orientation determines to which side of the crossfader the deck is assigned. It can be set to the left or right
side, or to the center where it is unaffected by the crossfader knob.

Petunjuk: Using the AutoDJ feature in Mixxx, you can automate the crossfade between the decks.

3.3.5 Headphone and Main Mix Controls

Figure20: The headphone and main mix knobs

Headphone Mix knob Allows you to control howmuch of the Main output you hear in theHeadphones output. It works
like a crossfader between the stereo Main and stereo PFL signal. If the knob is set to the left, you only hear the
PFL signal, which is the usual position for prelistening tracks.
This can be used to practice DJing with only one stereo output and a set of either speakers or headphones.
Additionally, this can be used to mix in headphones when you cannot hear the speakers connected to the main
output and there are no booth monitor speakers. Some DJs prefer to use this knob to mix in headphones all the
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time, but many find it to be a difficult way to play. If there is only one set of speakers and no booth monitors, you
can avoid the need to mix in headphones by setting up the speakers behind you so both you and your audience can
hear them.

Catatan: Don't forget to activate the PFL button on the deck you want to listen to in your headphones.

Head knob (Headphone gain)
This knob controls the gain applied to the headphone output signal that Mixxx sends to your sound card.
Generally, this knob should not be adjusted. To adjust the volume in your headphones, adjust your sound
card's gain on the headphone output. Most external sound cards have a gain knob specifically for the
headphone jack. If you use an onboard sound card for your headphones, adjust the gain control in your
OS mixer program. If your sound card only has one gain knob that controls both the Main output and
the headphone output, then adjust the Head knob in Mixxx to control the volume of your headphones
without affecting your Main output.

Catatan: Not all controls may be present in all skins anymore. However, these controls can be mapped to
keyboards and MIDI controllers. See Mixxx Controls for detailed information.

Headphone Split Cue button If activated, two mono signals are sent to the headphone output instead of one stereo
signal. The main signal plays in the right channel, while the cueing signal plays in the left channel. You can still
adjust the Head Mix knob to control the mix of the Main and cue signals in the left channel.

Balance Knob This knob allows you to adjust the balance (left/right orientation) of the Main output.
Main Knob The Main Gain Knob controls the gain applied to the Main output signal that Mixxx sends to your sound

card, Internet broadcasting servers, and recorded mixes. Generally, this knob should not be adjusted. To change
the output volume, a gain control should be adjusted as close to the speakers as possible for the best signal-to-noise
ratio throughout your signal chain. Ideally, the volume would only be adjusted by adjusting the gain on the power
amplifier. On active speakers, including computer speakers, studio monitors, and PA systems that do not require a
separate amplifier, this means adjusting the gain on the speakers (which may be labeled "Volume").
As a DJ, you may not have access to the power amplifier. In that case, adjust the volume by adjusting the gain on
the equipment closest to the power amplifier that you have access to. Typically, this is a DJ mixer. If you are not
going through a mixer, adjust the gain of your sound card. If your sound card does not have any controls on it (for
example, for sound cards built into computers), adjust the sound card settings with your OS mixer program. The
Main Gain Knob in Mixxx should be a last resort for adjusting volume.

Peringatan: In no case should any part of the signal chain be clipping, indicated by a level meter going
into its red region or an LED labeled "clipping" turning on.

Lihat juga:
For an explanation of why you should set your gains this way, see Setting your levels properly (gain staging).
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3.4 Samplers

Figure21: Sample decks

Figure22: Sample decks expanded

Samplers are miniature decks. They allow you to play short samples and jingles but also additional tracks in your mix.
They come with a small overview waveform and a limited number of controls. All controls work just like on the regular
decks, see Decks.
The Sampler section can be hidden in the Mixxx user interface. Click the SAMPLERS button at the top of the user
interface, or use the specific Application shortcuts to show or hide the section.

3.4.1 Waveform Display

Waveform overview The waveform shows the various markers within the track as well as the waveform envelope of the
entire track. Clicking somewhere on the waveform allows you to jump to an arbitrary position in the track.

Waveform Marker While mixing, some additional markers can appear on the waveforms:
• Position marker: A vertical line indicates the playback point of the sample deck.
• Hotcue marker: Indicate the position and number of a hotcue point if set.

3.4.2 Track Information Display

Track Artist/Title The artist and title of the track that was loaded into a sampler deck is displayed here.
BPM (Tempo) The number at the top right is the effective BPM of the track. Tap the BPM to set the BPM to the speed

you are tapping.

3.4.3 Sample Deck Options Button Grid

The buttons grid next to the waveform overview allow you to configure the sampler deck. Starting from the top row (left
to right) and the bottom row (left to right), the buttons are as follows:
Repeat Mode Toggle If enabled, the repeat mode will jump back to the beginning and continue playing when the track

finishes.
Eject Track Button Clicking this button ejects the track from the deck.
Keylock Toggle Keylock locks the track's pitch so that adjustments to its tempo via the rate slider do not affect its pitch.
Crossfader Orientation Toggle The crossfader orientation determines to which side of the crossfader the sampler is

assigned. It can be set to the left or right side, or to the center where it is unaffected by the crossfader knob.
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3.4.4 Sample Deck Controls

Play/Pause button Clicking the button always starts playback from the cue point. If playback is already enabled the play
position will jump back to the cue point. Right-clicking on the button will stop playback and seek the play position
to the beginning of the sample.

Sync Button Syncs the Sampler deck to a regular deck, as described in Sync and Rate Controls.
• Left-Click: Changes the rate of the track so that the BPM and phase of the track matches the sync target.
• Right-Click: Only changes the rate of the track to match the sync target but does not adjust the phase.

Hotcue Controls To jump in between different parts of a sample, you can use these numbered hotcue buttons.
PFL/Headphone Button If active, the pre-fader listen or PFL button allows you to listen to the track in your headphones.
Gain Knob Allows you to adjust the gain applied to the track.
Level Meter Shows the level of the signal and can be adjusted with the Gain knob.
Pitch/Rate slider The slider allows you to change the speed of the sample. Right-clicking on the slider will reset the

tempo to its original value.

3.5 Effects

Figure23: Collapsed effect unit

Figure24: Expanded effect unit

Mixxx comes with some built in sound effects that can be chained together in effect units. Effect units can be freely
assigned to different decks as well as other inputs. The buttons for routing decks to effect units are in the Decks.
Lihat juga:
The Efek chapter has a more detailed explanation of the effects system.
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3.6 Microphones & Auxiliary Inputs

Figure25: The Microphone section

The microphone section is hidden in the default Mixxx user interface. Click the MICS & AUX button at the top of your
user interface, or use the specific Application shortcuts to show or hide the section.
Lihat juga:
The Using Microphones chapter has detailed instructions for setting up microphones with various hardware.

3.6.1 Microphone Controls

Talk Button Hold this button and talk to mix the microphone input into the Mixxx Main output. Short click on the
button for latching. This is handy for talking for an extended period, for example when streaming a radio show.
When in Latch mode, click again to mute the microphone input.

Mix Orientation Toggle This control determines the microphone input's mix orientation. Either to the left side of
crossfader, to the right side or to the center (default). Clicking cycles through all the options.

Microphone Volume Meter This displays the microphone volume input signal strength.
Microphone Gain Knob Use this knob to adjust the gain of the microphone output. Try to keep the volume at a rea-

sonable level to avoid signal clipping.

3.7 Preview Deck

Figure26: The Preview Deck with a track loaded

The Preview Deck is a special deck that allows you to pre-listen to tracks in the headphones before using them in your
mix. Pre-listening to a track does not change its Played state as well as the play counter and is not logged in the History.
Press CTRL + 4 (Windows/Linux) or CMD + 4 (Mac) to display the Preview Deck.
The features in detail:

• Track Artist/Title: The artist and title of the track is displayed here. This is the same as that listed under the Track
and Title column heading in the Mixxx library. This information is initially loaded from the track's metadata.

• Eject Track button: Clicking this button ejects the track from the deck.
• Play/Pause button: Clicking the button starts and pauses the playback. Right-clicking on the button will stop
playback and seek the play position to the beginning of the tracks.
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• Waveform overview: Shows the variousmarkers (Cues, Hotcues) within the track as well as the waveform envelope
of the entire track. Clicking somewhere on the waveform allows you to jump to an arbitrary position in the track.

• Gain slider: Move the slider to adjust the gain of the track.
• Volume Meter: Shows the current volume of the track. If it's too loud and distorted, a peak indicator flashes red.

Lihat juga:
For more information, go to the chapter Previewing Tracks.
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CHAPTER4

The Mixxx Library

4.1 Overview of the Library features

Figure1: The Mixxx Library

The library manages all of your music files. This is where you can find the tracks you want to play and load them into a
deck or sampler; see Loading Tracks. Mixxx imports your music library automatically when it is run for the first time,
see Changing music directories for more information.
The sidebar on the left contains different collections of music. The track list view on the right displays the tracks in those
collections.
Sidebar:

• Search: Search for tracks in your Mixxx library.
• Tracks: View and edit your whole collection.
• Auto DJ: Automatically load and crossfade tracks for unattended mixing.
• Playlists: Arrange tracks in a set order.
• Crates: Organize tracks in (unordered) collections.
• Computer: Navigate, view, and load tracks from folders on your hard disk and connected devices.
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• Recordings: Record your mix and view previous recordings.
• History: Browse lists of tracks played in past mixing sessions.
• Analyze: Generate Mixxx-specific data for tracks before a gig.
• External Libraries: Access your existing iTunes, Traktor, Rhythmbox, and Banshee libraries.

Track List:
• Sort: Display and sort track collections by different criteria.
• Load: Drag tracks you want to play to the waveform display.
• Edit: Rate tracks and edit track properties.

4.2 Tracks - View and edit your whole collection

A sortable list of all the tracks in your music library.

Customizing the view Move columns by clicking a column header and dragging it to another position. Right-click on
a column header to show or hide individual columns. Adjust the column width to fit the contents of the rows by
double-clicking on the separator between two column headers.

Sorting Tracks Tracks are automatically sorted by the active column. Click on the active column header to reverse the
sort order. Click on another column header to change the active column.

• Multi-Column sorting
You can sort multiple columns by clicking up to three column headers you wish to sort your tracks by. This
makes searching for tracks in a large list more efficient. Clicking twice on a column header will reverse the
sort order.
Example:
1. Click on the BPM column header -> list is sorted by BPM
2. Click on the Year column header -> list is sorted by year. If year is equal, it is still sorted by the last

criteria, e.g. BPM.
3. Click on the Genre column header -> list is sorted by genre. If genre is equal, it is still sorted by year. If

genre and year is equal, then it is sorted by BPM.
• Random sorting
Click on the Preview column header to randomly sort tracks.

• Sort keys by circle of fifths
Click on the Key column header. The order starts with C at the top, then its relative minor (a), then adds 1
sharp (G), then G's relative minor (e), and so adding sharps/removing flats around the circle of fifths. For
Lancelot notation, it starts with G#m at the top, which is 1A in that notation, and proceeds alphanumerically
(minor keys appear before their relative major keys in this case).

Rating tracks Make sure the Rating column is not hidden. Rate tracks by hovering over the rating field and clicking the
stars.

Track Inline editing Mixxx reads metadata from the tracks to fill the columns of the library. Double-click on a field,
edit the data, and hit Enter when you are done. Go to the chapter edit metadata for detailed information.

Loading tracks To load a track into a deck, you can either drag it to the waveform display, use the context menu or use
keyboard shortcuts. Go to the chapter Loading Tracks for detailed information.
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Importing tracks Mixxx imports your music library automatically when it is run for the first time. Go to the chapter
Changing music directories for detailed information.

Previewing Tracks To pre-listen to tracks in your headphones without loading them to a regular deck, click the
icon in the Preview column. Go to the chapter Previewing Tracks for detailed information.

Cover/Album Art Mixxx can display cover art it finds for a track in the library. It will search for available cover art in
the following places in order and will use the first one it finds:
1. The first image saved in the track's ID3v2/Vorbis tags
2. An image file in the track folder (if there is only one image file there.)
3. %track-file-base%.jpg in the track directory for %track-file-base%.mp3
4. %album%.jpg
5. cover.jpg
6. front.jpg
7. album.jpg
8. folder.jpg

Mixxx supports the following image types: jpg, jpeg, png, gif, bmp
Rescan Library If you want to manually refresh your library without exiting (for example because you added or moved

files) you can do this with Library ‣ Rescan Library in the menu at the top of the application window. You can
prompt an automatic rescan when Mixxx is started under Preferences ‣ Library ‣ Rescan on startup.
Rescanning the library will add new files to the library and mark tracks as missing if the corresponding file has been
deleted. It tries to detect and relocate missing tracks if files have been renamed or moved into another directory.
Automatically refreshing the metadata of tracks when files have been modified by an external application is not
supported, yet. In this case you need to select the affected tracks and (re-)import their metadata from file tags.

4.2.1 Track list context menu

Right-clicking on selected tracks in the track list reveals the context menu:
• Add to Auto DJ
Adds the content of the selection to either the bottom or top of the Auto DJ playlist for automatic mixing. The
replace option deletes the Auto DJ queue first, and then fills it with the selected tracks.

• Load to
Loads a selected file to one of the available Decks, Samplers or to the Preview Deck. Alternatively simply drag it to
theWaveform Displays. The number of available decks and samplers might differ, depending on the selected skin.
Note that you can't load multiple files at once.

• Add to Playlist
Add selected tracks to an existing playlist, or drag the selection to a playlist crate in the sidebar. Choose Create
new playlist to put them into a new playlist.

• Crates
The checkbox shows in which existing crates the selection is in. Changing the crates selection does not collapse the
menu, which allows much easier categorization of tracks without going through the menu from scratch. Choose
Create new Crate to put them into a new crate.
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• Select Color
Assign a color to all selected tracks to indicate mood, energy etc. Select the black button at the top left to remove
the color.

• Metadata
– Import from File Tags: If the track's metadata changes, (e.g. if you used iTunes to edit it,) this option lets
you save the new values for the selected tracks to the Mixxx library. See edit metadata.

– Import from MusicBrainz: Look up metadata online by searching theMusicBrainz database and apply the
search results to your tracks. See edit metadata.

– Export to File Tags: Saves metadata to files. Mixxx may wait to modify files until they are not loaded to
any decks or samplers. If you do not see changed metadata in other programs immediately, eject the track
from all decks and samplers or shutdown Mixxx.

– Cover Art
∗ Choose New Cover: Select an image from the file browser as the cover.
∗ Clear Cover: Delete any cover information saved for this track.
∗ Reload from track/folder: Reload the cover from the tracks' ID3v2 tags or a picture in the track folder
if the tags do not supply any.

• Clear
– BPM and Beatgrid: Removes the BPM and beatgrid data from the selected tracks in the Mixxx library.
After doing this, we recommend analyzing the tracks again.

– Play Count: Marks selected tracks as not played in the current session and sets their play counter to zero.
The icon in the Played column changes.

– Hotcues: Clears all saved hotcues and hotcue labels.
– ReplayGain: Clears all saved ReplayGain values.
– Waveform: Clears the saved waveform data from the selected tracks. This is useful if a file is overwritten by
another file of the same name, or was edited externally (e.g. in a waveform editor). To clear the waveform
cache for all tracks in the library, select Preferences ‣ Waveforms ‣ Clear cached Waveforms .

– All: Clears all of the data above from the Mixxx library database at once.
• Change BPM

– Allows to change the BPM to 50%, 66%, 75%, 133,33%, 150%, or 200% of the BPM set by Mixxx when
analyzing the tracks. If many of the detected BPM values are incorrect, you may try other settings in the
Analyzer Settings and re-run the analysis.

– Lock/Unlock BPM: Locks/Unlocks the BPM of selected tracks so you can't edit them in the track properties.
The icon next to the track's BPM in the library row is a toggle. Clicking it will set the status to "locked",
and the icon changes to .

• Hide from Library
Temporarily hides selected tracks from the track list. Hidden tracks are listed in the Hidden Tracks menu item
which is explained below.

• Open in File Browser
Brings up the selected files in your file manager.

• Properties
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Similar to inline editing explained above, the properties dialog allows you to view and edit metadata such as title,
artist, album, and view the full file name and path. Note that you can not edit multiple files at once.

Catatan: Most of the context menu items are available in file lists of other views like Auto DJ, Playlists, and Crates as
well.

4.2.2 Missing Tracks

The Missing Tracks view is accessible by expanding the Library tree item in the sidebar. Any tracks that were previously
loaded into your library but were later not found on your drive will appear here. Mixxx does not automatically delete
records of missing tracks so that extra metadata Mixxx might have (such as hot cues and beat grids) will not be lost in
case the file is replaced.
The features in detail:

• Select All button: Selects all tracks in the current view.
• Purge button: Purges the selected tracks from the Mixxx library, but does not remove them from your computer.
This will delete all metadataMixxx has for a track.

4.2.3 Hidden Tracks

The Hidden Tracks view is accessible by expanding the Library tree item in the sidebar. Any tracks that were previously
loaded into your library but were later set to be hidden from the library will appear here. Use the Hide from Library
context menu item in the tracks view to temporarily hide selected tracks.
The features in detail:

• Select All button: Selects all tracks in the current view.
• Purge Button: Purges the selected tracks from the Mixxx library, but does not remove them from your computer.
This will delete all metadataMixxx has for a track.

• Unhide Button: Removes the selected tracks from theHidden Tracks view and makes them available in the regular
track lists again. The tracks will re-appear in every playlist or crate they were in before being hidden.

Lihat juga:
To learn how to permanently remove tracks from theMixxx library using theHidden Tracks view, see permanently remove
tracks.

4.3 Loading Tracks

Tracks can be loaded into a deck in several ways:
• Right-click the library track table: Right-clicking on a track in the table will present the options Load in Deck 1
and Load in Deck 2, among others. Making either selection will load a track into a deck.

• By Using a Keyboard to load the selected track in the library track table. Use keyboard ↑ and ↓ arrow button to
select a track, Shift + ← to load into Deck 1 and Shift + → to load into Deck 2.

• Drag-and-drop from library track table: Dragging-and-dropping a track from the track table onto a waveform
display will load the track into that deck.
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• Drag-and-drop from deck to deck: Once you've loaded a track to deck, sampler, or preview deck, click on the
track title, track artist or cover art and drag it to another deck or sampler. Note that you can also drop tracks onto
Playlists and Crates in the sidebar, as well as into track tables of active Playlists or Crates.

• Drag-and-drop from external file browser: Dragging-and-dropping a track from an external file browser directly
onto a waveform display in Mixxx will load that track. This function also works with some other applications. For
example, on macOS, dragging-and-dropping a track from iTunes onto one of Mixxx's waveform displays will load
it into that deck.

4.4 Finding Tracks (Search)

The search function filters the currently displayed list (e.g. a playlist, a crate, or even the whole library) for tracks that
match your search query.

• Activate the search input field by clicking in it or pressing CTRL + F (Windows/Linux) or CMD + F (Mac).
• Type your search term(s). Mixxx filters the tracks as you type and shows only those matching the search term(s).
Search terms can include an artist's name, a song title, BPM, etc.

• To clear the search string hit ESC or click the clear button right next to the input field.
• Hit TAB to cycle between the search and the list of results in the library. Use the ↑ and ↓ keys to scroll in the list
of results.

Catatan: If the search input field has focus, the Mixxx keyboard shortcuts are disabled, see Using a Keyboard.

4.4.1 Using search operators

Search operators allow you to formmore complex search queries. They allow you to limit certain search terms to particular
properties of your tracks.
Mixxx supports the following filters:

• Text filtering: album_artist, album, artist, comment, composer, crate, genre, grouping, location, title
Examples

artist: “com truise”
album:Danger
genre: Trance
title: foo
composer: foo
comment: foo
genre:hip-hop -genre:gangsta

Catatan: It doesn't matter if you have space between the colon and the argument or not. Quotes must be used for
multi-word text arguments.

• Numeric filtering: bitrate, bpm, played, rating, track, year
Examples
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bpm:140
bpm: >140
year: <2010
bpm: >=140
rating: <=4
bpm: 140-150
played: >10

Catatan: You can put a space after the colon but currently there must be no space between the operator and the
number.

• Special filtering: key, duration, added, dateadded, datetime_added, date_added
– Supports fuzzy matching of key searches. The following example lists tracks with harmonically compatible
keys to C# minor.

~key:c#m

You can combine operators but there's no way to do an “OR” search right now. The following example lists
all tracks by “Danger” over 3 minutes long that are rated 4 or 5.

artist:Danger duration:>3m rating:>=4

– Negative search filters. Use the - prefix as negation operator. The following example would find “hip-hop“
from any year but 1990.

genre:hip-hop -year:1990

– Search for empty fields. The following example lists all tracks without a genre. It works for all text fields,
including crates.

genre:""

Examples

duration:2m10
duration:<2:10
duration:>1m35s
duration:>62

Catatan: You can put a space after the colon but currently there must be no space between the operator and the
number.
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4.5 Previewing Tracks

To pre-listen to a track, activate the Preview column in a library view. Clicking the icon in the library's Preview
column loads the selected track into a special Preview Deck that will only output sound in the headphones channel. Click
the icon to stop the playback.
Alternatively, select a track from the track list of the Mixxx library, drag the track to the waveform view of the Preview
Deck and click the Play button next to the waveform.
To display the Preview Deck, press CTRL + 4 (Windows/Linux) or CMD + 4 (Mac).

Petunjuk: Click on the Preview column header to randomly sort tracks.

4.6 Edit metadata of audio files

Mixxx reads relevant metadata from the tracks and displays them in the library columns. You are free to edit most
metadata, and Mixxx offers a number of different ways to do so. Note that some information can not be edited, such as
bitrate, size, length, type, filename, and location.

Catatan: Mixxx does not support editing the metadata of many tracks at a time (bulk editing).

Peringatan: Mixxx won't touch your audio files by default. Changes to a track's metadata will be saved to the Mixxx
library, but not to the track itself.
If you wish to write modified track metadata from the library into file tags, check the box in Preferences ‣ Library ‣
Track Metadata Synchronisation.

4.6.1 Manual Edit

Track Inline editing: To enable inline editing in the library go to Preferences ‣ Library ‣ Miscellaneous and check the
box "Edit metadata after clicking selected track".
Select any track in the library and click on the field you want to edit. If the field is editable, it will become an
editable text box. Enter a value and hit Enter when you are done.

Figure2: Mixxx library - Inline editing

Properties editor: To open the editor right-click on a single track in the library or any track label in decks or samplers,
then select Properties in the track menu. You can also double-click any track label in the decks or samplers to open
the editor directly.
Add or change values in the editable fields, and save your changes as explained below.

• OK: Accept the changes and close the editor.
• Apply: Accept the changes and leave the editor open.
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Figure3: Mixxx library - Properties editor
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• Cancel: Discard the changes and close the editor.
• Previous/Next: Load the previous or next track in the current library view.
• Import Metadata from File: Prompts Mixxx to re-read the metadata of the selected track (such as when
you have modified it externally with another application.)

• Import Metadata from MusicBrainz: Look up metadata on-line by searching the MusicBrainz database.
See below.

4.6.2 Using the MusicBrainz online database

MusicBrainz is an open-source music encyclopedia that collects music metadata and makes it available to the public.

Figure4: Mixxx library - MusicBrainz Wizard

The MusicBrainz wizard in Mixxx allows searching the MusicBrainz database and applying the results to your tracks.
Click on a single track in the library and select Get Metadata from MusicBrainz. Mixxx fetches track data from the
MusicBrainz database and displays the search results.
Select the best match from the search results by clicking on it in the list.

• Apply: Apply the selected MusicBrainz metadata to the track.
• Close: Close the wizard.
• Previous/Next: Load the previous or next track in the current library view and perform a MusicBrainz lookup on
it as well.

Fetching track metadata from MusicBrainz can fail:
• if Mixxx is unable to find the specified track in the MusicBrainz database,
• if Mixxx cannot reach the MusicBrainz servers (if they are down),
• or if you are not connected to the Internet.

Petunjuk: The MusicBrainz service has been designed for identifying full audio files. If a track is less than 2 minutes
long, identifying the file will likely fail. Identifying a layered mix-track or mash-up may produce false positives in the
result list.
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4.6.3 Using third-party software

If you have edited file metadata in third-party software you need to re-import the modified metadata into Mixxx manually
by selecting the affected tracks, open the context menu, and then choose Metadata ‣ Import From File Tags.

Petunjuk: Rescanning the library with Library ‣ Rescan Library in the menu on top of the application window will only
detect newly added or removed tracks but no modifications of existing tracks. This is a known limitation.

Popular software to edit metadata of audio files include:
• Mp3tag (Windows)
• Kid3 (Mac, Windows, Linux)
• Picard (Mac, Windows, Linux)

4.7 Auto DJ - Automate your mix

The Auto DJ queue is a special playlist that contains extra controls for automatic mixing. This is useful when taking

a break from live mixing or for using Mixxx as media player.
The Auto DJ features in detail:

• Shuffle button: Randomizes the order of tracks in the Auto DJ playlist.
• Add Random button: Adds a random track from track sources (crates) to the Auto DJ queue. If no track sources
are configured, the track is added from the library instead.

• Skip track button: Skips the next track in the Auto DJ playlist.
• Fade now button: Triggers the transition to the next track.
• Transition time spin-box: Determines the duration of the transition. A negative value will add a pause between
tracks.

• Selection Info label: Displays the duration and number of selected tracks. Press Ctrl + A to get the total duration
of the AutoDJ queue.

• Enable Auto DJ button: Toggles the Auto DJ mode on or off.
The Skip track, Add Random and Fade now buttons are only accessible if the Auto DJ mode is enabled. The Search field
in the upper left corner is disabled in Auto DJ. By default, Auto DJ removes tracks after playing them but if you want
it to play the same tracks over and over again, you can activate the Auto DJ Requeue option in Preferences ‣ Auto DJ ‣
Re-queue tracks after playback.
Auto DJ Crates
It is possible to add random tracks to the bottom of the Auto DJ playlist. The tracks are chosen from a set of crates that
you have set as a source for Auto DJ, or from the standard library. Mixxx will normally try to select tracks that haven't
yet been played. You can set a minimum number of tracks that are always available for selection no matter when they
were last played in Preferences ‣ Auto DJ ‣ Minimum available tracks in Track Source.
Lihat juga:
For more information, go to the chapter Auto DJ.
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4.8 Playlists - Arranging tracks in a set order

Playlists are ordered lists of tracks that allow you to plan your DJ sets. Some DJs construct playlists before they

perform live; others prefer to build them on-the-fly.
Playlists are not directly loadable into decks as Mixxx is primarily intended for live, attended performance use. However,
you can right-click a playlist to queue it to Auto DJ, so in a sense you can "play" it.

• Create a playlist: Right-click on the Playlists sidebar item and select Create New Playlist. Name the playlist and
click OK. The total number of tracks and total duration are displayed next to the name.

• Import playlists: Right-click on the Playlists sidebar item and select Import Playlist. Select one or more playlists
and click OK. Mixxx creates an import of these existing external playlists as new Mixxx playlists.

• Add Tracks: Add tracks to a previously created playlist by dragging-and-dropping a selection of tracks from the
library or playlists onto the name of a playlist in the sidebar. Alternatively, use the right-click context menu in the
library's track list.

Petunjuk: If you have a track selected in the library, all of the visible playlist and crates that it is in are shown in
bold.

Right-click on an existing playlist name to access the different features in the context menu:
• Add to Auto DJ: Adds the content of the playlist to the Auto DJ queue for automatic mixing.
• Rename: To rename a playlist, just enter a new playlist name and click OK.
• Duplicate: Sometimes you want to build a playlist based on an existing one. Select the playlist you would like to
duplicate, choose Duplicate Playlist, name the new playlist and click OK.

• Remove: Removes an unlocked playlist. Tracks that were in the playlist remain in the library for later use.

• Lock: This icon indicates a locked playlist. If a playlist is locked, you cannot add tracks, rename or delete

the playlist. Choose Unlock from the context menu to unlock the playlist.
• Analyze entire playlist: Forces the analysis of the tracks in the playlist in the Analyze view.
• Import playlist: Import tracks from external playlists in various file formats to the selected playlist. For more
information, go to Using libraries from other software.

• Export playlist: Export a playlist to various file formats such as m3u, m3u8, pls, txt, or csv. This allows you
to use the data in other applications.

• Export Track files: This copies all of the tracks in a playlist into a folder such as an external USB stick. Only files
are copied, not Mixxx-specific metadata like waveforms or cover art that is not embedded in the file.
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4.9 Crates - Organizing tracks into collections

Crates are unordered collections of tracks, just like DJ cases holding your favorite records.

• Create a crate: Right-click on the Crates sidebar item and select Create New Crate. Name the crate and click OK.
The total number of tracks and total duration are displayed next to the name.

• Import crates: Right-click on the Crates sidebar item and select Import Crate. Select one or more playlists and
click OK. Mixxx creates an import of these existing external playlists as new Mixxx crates.

• Add Tracks: Add tracks to a previously created crate by dragging-and-dropping a selection of tracks from the
library or playlists onto the name of a crate in the sidebar. Alternatively use the context menu in the library's track
list.

Right-click on an existing crate's name to access the different features in the context menu:
• Rename: To rename a crate, enter the new crate name and click OK.
• Duplicate: Just like playlists you can duplicate an existing crate. Select the crate you would like to duplicate,
choose Duplicate Crate, name the new crate and click OK.

• Remove: Removes an unlocked crate. Tracks in the crate are still available in the library for later use.

• Lock: This icon indicates a locked crate. If a crate is locked, you cannot add tracks, rename or delete the

crate. Choose Unlock from the context menu to unlock the crate.
• Auto DJ Track Source: Use this crate as a source for random tracks in Auto DJ, see Auto DJ crates .
• Analyze entire crate: Forces the analysis of the crate in the Analyze view.
• Import crate: Import tracks from external playlists in various file formats to the selected crate.
• Export crate: Export a crate to various file formats, such as m3u, m3u8, pls, txt, or csv. This allows you to
use the data in other applications.

• Export Track files: This copies all of the tracks in a crate into a folder such as an external USB stick. Only files
are copied, not Mixxx-specific metadata like waveforms or cover art that is not embedded in the file.

4.9.1 Crates vs. Playlists

Crates are unordered collections of tracks. Unlike playlists, they cannot contain duplicate entries and do not support
arranging tracks within them.
Often DJs group tracks by genre, keep lists of favorite tracks, and/or prepare lists of tracks they want to play at a particular
party. In these cases they rarely care about the order since they will choose it at the party based on the dance floor and
mood. They certainly don't want duplicates in these lists. Crates serve these purposes. You can think of them like labels
in GMail or Web 2.0 tags for your music.
If however you want to plan out a specific set and practice the transitions, you will want an ordered list of tracks. Playlists
serve this purpose.
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4.10 Computer - Loading tracks from anywhere on your computer

This mode works like a file manager and allows you to load tracks from anywhere on your computer and connected

devices, that are not necessarily already in your Mixxx library.
Click the Computer sidebar item to navigate the computer and find your music. Depending on your operating system, your
music will usually be found in the “My Music” or “Music” folder. Drag the files you want to import to the Tracks

icon or directly to theWaveform Displays.

Catatan: Currently you can only drag files (not folders) to the Mixxx library.

Right-click on a folder and choose Add to Library to add the folder as an additional music directory. Mixxx will watch
this directory and its subdirectories for new tracks.
Lihat juga:
For more information, go to Changing music directories.

4.10.1 Quick Links - Bookmark your favorite folders

Using the Quick Links sub-menu you can bookmark folders for direct access. Click the Browse sidebar item and navigate
to the folder you would like to bookmark. Right-click and choose Add to Quick Links. The folder is now pinned below
the Quick Links. To un-pin that folder, right-click and choose Remove from Quick Links.

4.11 Recordings

In this section of the library you can start and stop recording your session as well as view previous recordings and

the dates they were made.
Lihat juga:
For more information, go to Recording Your Mix.

4.12 History - Keep track of your sessions

The history section automatically keeps a list of tracks you play in your DJ sets. This is handy for remembering

what worked in your DJ sets, posting set-lists, or reporting your plays to licensing organizations. Every time you start
Mixxx, a new history section is created. If you don't play any tracks during the session, it will be discarded.

This icon indicates the current session.

Click on the History icon in the sidebar to switch to the History view, then right-click on a session's name/date to access
the different features:

• Add to Auto DJ: Adds the content of the session to the Auto DJ queue for automatic mixing.
• Rename: Rename a session. The default is the calendar date (YYYY-MM-DD).
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• Remove: Remove a previous (unlocked) session. (You cannot remove the current session.)

• Lock: Protect a previous session against accidental merge or deletion. An icon indicates a locked session.

• Create new history playlist: Split off the current history session and add a new session without having to restart
Mixxx. The current history must contain at least one track for this option to be available.

• Join with previous: Append the selected history session to the end of the previous one.
• Export playlist: Export a session in various file formats. This allows you to use the data in other applications.

4.13 Analyze - Prepare your tracks

This section allows you to analyze your tracks in advance of loading them into a deck. Analyzing tracks requires consid-
erable CPU power and may cause skips in the audio while performing, so it helps to have your tracks analyzed before you
play. See Analyze your library for details.

4.14 Using libraries from other software

Supported libraries:

• iTunes (Windows, macOS)

• Traktor (Windows, macOS)

• Rhythmbox (GNU/Linux)

• Banshee (Windows, macOS, GNU/Linux)

• Serato (Windows, macOS)

• Rekordbox (Windows, macOS)

The external library views allow you to use music libraries you have created in these third-party applications. You can
access music as well as playlists. If available, Mixxx automatically loads the external libraries from their default locations
on your hard drive.

Catatan: Playing a track from an external library will add it to your Mixxx library.

Lihat juga:
External libraries can be disabled under Preferences ‣ Library.
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4.14.1 Using the iTunes/Traktor/Rhythmbox/Bashee/Rekordbox library

Right-click on the iTunes icon in the Library tree and select Choose Library to load the iTunes Music Library.
xml from a different location. Select Use Default Library to reset.

• Right-click on a iTunes/Traktor/Rhythmbox/Banshee playlist and choose Import Playlist to import it into a new
Mixxx playlist.

• If you have an iTunes configuration file (*.xml) from a Windows or Mac partition mounted in Linux, you can
load it and use your iTunes tracks and playlists as well.

4.14.2 Using the Rekordbox library

To read Rekordbox databases for CDJ/XDJ players on USB or SD devices, the database has to be exported to a USB
or SD device with a FAT or HFS file system using the Rekordbox Export mode. Databases that have been moved to an
external device via Preferences > Advanced > Database management in Rekordbox are not supported.

1. Plug your USB or SD drive in while Mixxx is running.
2. Click on the Rekordbox item in the library sidebar to scan for Rekordbox prepared USB drives. If no Rekordbox

devices show up, you can click on Check for attached Rekordbox devices (refresh).
3. Click on the desired removable device. All your folders and playlists will be revealed for you to play from.

How Rekordbox hotcues, memory cues, and loops are imported

The following data is read:
• Folders
• Playlists
• Beatgrids
• Hot cues
• Memory cues
• Loops

Mixxx currently has one main cue point, one loop, and thirty eight hotcues. As such:
• All Rekordbox hotcues are mapped to Mixxx hotcues as expected, the first chronological Rekordbox memory cue
is mapped to the Mixxx main cue.

• The first chronological Rekordbox loop is also mapped to the Mixxx loop.
• All loops (including the first loop), and all subsequent Rekordbox memory cues are appended as Mixxx hotcues
following the previously imported Rekordbox hotcues.

• The hotcue andmemory cue colors you assigned in Rekordbox are also imported, assisting in distinguishing between
them.

Although additional imported Rekordbox loops only appear in Mixxx 2.3 as hotcues, their loop information is stored in
the Mixxx library and will become usable in Mixxx 2.4.
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4.14.3 Using the Serato library

Mixxx supports reading your Serato library and crates both from your local hard drive as well as portable USB drives.
Smart crates are currently not supported.
Serato stores information such as hot cues, track color and beatgrid in the file tags. Regardless of whether a track is loaded
into deck from the library or directly from the file browser, Mixxx will import that information automatically if present.
Saved loops are imported as well, but since Mixxx is lacking support for multiple saved loops, only the first loop is usable
in Mixxx. All other saved loops can be used like regular hotcues for now.
Waveforms, Gain values and "Flips" are not imported from Serato.

Catatan: Due to differences in the metadata format, importing Serato information from Ogg Vorbis files is currently
not supported.

To import Serato libraries from external USB drives:
1. Copy music library from Serato into external USB drive
2. Plug in USB drive while Mixxx is running
3. Click on Serato in the library. All USB drives containing a Serato library will be detected automatically.
4. For each removable device, the library and all crates from Serato will accessible.

If you have already added a track containing Serato Metadata to your Mixxx library in a Mixxx version that didn't support
reading that data, you can reimport it from the file's tags via the track context menu.

Peringatan: This action will clear your existing cuepoints in Mixxx if the file contains Serato Metadata

To reimport metadata from files:
• Right click on the track to show the context menu
• Select Metadata ‣ Import From File Tags.

Petunjuk: Decoders may slightly detect different track start and end times for files from different sources, this could
possibly be because of the presence of countless encoders and decoders for MP3 and M4A/AAC. This problem may
cause your cues to be shifted up by a few milliseconds. Mixxx might not always be able to mitigate this problem, but it's
possible to shift all cues for a track at once as a workaround.

4.15 Removing tracks from the library

Removing tracks from the Mixxx library will not physically delete them from your drive. However it does delete extra
metadata Mixxx might have (such as hotcues and the beatgrids), and removes links to playlists or crates.

1. Click the Library item in the sidebar.
2. Find and select the tracks you want to remove, perform a right-click on them and select Hide from Library from

the context menu.
3. Expand the Library item in the sidebar and click on the Hidden tracks sub-item. All tracks that were set to be

hidden from the library will appear here.
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4. Select the tracks you want to remove, or use the Select All button.
5. To confirm you want to permanently remove these tracks from the library, click Purge.

Petunjuk: If you want to hide or purge only tracks from a specific folder you may use the location: search operator,
or sort the table by "Location".

Petunjuk: If you later decide to add some of the deleted tracks back, import them to the Mixxx library again, see
Changing music directories.

4.16 Compatible file formats

Mixxx supports a variety of audio file formats:

Lossless Lossy
FLAC (flac) MP3 (mp3)
Wave (wav) Ogg Vorbis (ogg)
Aiff (aiff, aif) AAC (aac, m4a, mp4)

Opus (opus)

Lossless formats preserve every detail of the original recording and are recommended for the best sound quality. The
FLAC format compresses the files to take less space on your computer without sacrificing audio quality. WAV and AIFF
files are uncompressed and take up much more space.
Lossy formats take up less storage space on your computer than lossless formats at the expense of reducing sound quality.
Assuming an average track length of about 4 minutes, a 1 TB hard drive or solid state drive can store about 42000 FLAC
files or about 115000 MP3 files at 320 kbps.
There is no benefit to converting lossy file to lossless formats. The detail lost when making the lossy file cannot be
recovered.
AAC (M4A) is supported on Windows Vista and macOS 10.8 onwards. The Platform Update Supplement is required
for Windows Vista.
On Linux, AAC playback is disabled by default due to licensing restrictions. To enable the playback of AAC files, build
Mixxx from source with m4a/AAC files support.

Peringatan: DRM protected files, such as m4p files purchased in the iTunes Store in 2009 or earlier, are not
supported.

Peringatan: ALAC files use the same container MP4 container format and file extensions (m4a, mp4) as AAC files,
but Mixxx cannot play ALAC files. It is recommended to convert ALAC files to FLAC for use in Mixxx. This will
not reduce the sound quality of the files.
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4.17 Music from audio CDs

Mixxx can not play music directly from audio CDs. Use a CD ripping program to copy the audio from the CD to files on
your computer. It is recommended to save the ripped files in the FLAC format. Many different programs are available to
rip CDs, but not every program is capable of saving them to FLAC.

4.17. Music from audio CDs 49



CHAPTER5

DJ Hardware

Although Mixxx can be used with just a laptop or desktop computer, fully taking advantage of Mixxx's features requires
specialized DJ hardware. Depending on your budget and application area, your setup and requirements may vary. This
chapter provides general background information about various types of DJ hardware.
To make DJing with Mixxx a fun experience, at least the following pieces are needed:

• speakers to play the music to the audience,
• an audio interface with 4 mono/2 stereo output channels (or 2 mono output channels + a DJ splitter cable),
• headphones for prelistening tracks while another track is playing on the speakers, and
• audio cables and adapters to connect the equipment to your computer.

Additionally, you might consider getting the following equiment:
• a controller,
• turntables, an audio interface with phono inputs and timecode vinyl,
• a laptop/controller stand,
• a surge protector to protect the equipment from voltage spikes,
• cases for laptop, controller and headphones, and
• custom fader and knob caps to customize your gear.

Lihat juga:
Instructions how to useDJControllers that work out-of-the-boxwithMixxx can be found in theHardwareManuals section
of this manual. The Mixxx DJ Hardware Guide on the Mixxx Wiki also lists additional devices, including information
about their prices, features, and compatibility with Mixxx.
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5.1 Controllers

DJ controllers are devices with knobs, faders, buttons, and jog wheels to control DJ software such as Mixxx. Controllers
allow quick access to different controls while providing tactile and visual feedback indicating the state of each control,
such as the position of a knob or whether a switch is on or off. This allows you to focus on manipulating the music without
needing to look at your computer screen all the time. Controllers also allow using two hands to manipulate two different
controls at the same time, which is required for many mixing techniques.
DJ controllers typically do not do any actual audio processing. Instead, they send signals (typically MIDI or HID over a
USB cable) to the computer to instruct DJ software how to manipulate the audio. Many DJ controllers include an audio
interface with 2 separate stereo outputs built into the device. This allows the DJ to transport and setup only one piece of
hardware in addition to a laptop. Some devices can be used as both a controller and hardware mixer.
Mixxx can work with any MIDI or HID controller as long as there is a mapping file to tell Mixxx how to understand the
controller's signals. Mixxx comes bundled with a number of MIDI and HID mappings, which are listed in the Hardware
Manuals section. For controllers that Mixxx does not yet support, you can search the forum to see if anyone has started
a mapping. You can also start one yourself using the information in the Controller Mapping Documentation on the wiki.
Lihat juga:
Using MIDI/HID Controllers describes how to configure Mixxx to use controllers.

5.2 Audio Interfaces

An audio interface (also known as a "sound card", although few of them are shaped like cards anymore) is a device that
allows a computer to send output to and receive input from audio equipment. Whether using internal or external mixing,
it is recommended to use a single audio interface with at least 4 independent output channels (2 separate stereo pairs).
The headphone jack on most laptops is not a second audio output. Rather, plugging headphones into the jack simply
redirects the laptop's single stereo output from its speakers to your headphones. A splitter cable can be used to separate
the stereo output of a headphone jack into two separate mono outputs for headphone cueing, but it is recommended to
use a sound card with at least four mono outputs (for two stereo pairs). Such sound cards tend to be higher quality than
those built into laptops and allow your mix to be enjoyed in stereo by your audience.
Unlike some proprietary DJ systems, Mixxx can use any audio interface and anyMIDI or HID controller that your OS has
drivers to use. If your controller has an integrated audio interface, you may choose to use a different audio interface for
higher quality audio. Mixxx can also use multiple audio interfaces simultaneously.

5.2.1 Audio Interface Considerations

This section provides background information to help you choose an audio interface to use with Mixxx.

Bit Depth and Sample Rate

Most music is published with a bit depth of 16 bits at a sample rate of 44.1 kHz because this is all that is needed to store
all the detail of music in digital form.
Bit depth determines the possible dynamic range of the signal. 16 bits is more than enough for playing back music. While
24 bits is helpful for recording, it is useless for playback.
Half the sample rate determines the maximum frequency that can be represented by the signal. Humans generally can't
hear frequencies above 20 kHz, so a sampling rate of 44.1 kHz, representing a maximum frequency of 22.05 kHz, is fine
for playback. Higher sample rates like 88.2 kHz and 96 kHz can be helpful to reduce aliasing distortion when recording,
but have no benefit for playback and make your computer work harder.
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For a more thorough and technical explanation of why 16 bits at 44.1 kHz is all that is needed for playback, read 24/192
Music Downloads Are Very Silly Indeed.

Specifications

When considering specifications, higher dynamic range, higher signal-to-noise ratio (SNR), higher maximum output level,
lower THD+N (Total Harmonic Distortion + Noise; look for a more negative dB value or smaller percentage), and lower
crosstalk (more negative dB value) are better. Cheap audio interfaces tend to not have these specifications published.

Connector and Cable Types

If you are unfamiliar with professional audio equipment, read Digital DJ Tips' Essential Guide to Audio Cables for DJs
to understand the different kinds of connectors on audio interfaces. It is better to use an audio interface with balanced
outputs, especially if you will run long cables directly into an amplifier or active speakers without going through a hardware
mixer. Balanced signals reject interference and are less susceptible to ground loop hum issues (which can be a problem
when plugging unbalanced gear into separate power sources).
However, most venues have DJs plug into hardware DJ mixers, which typically only have RCA inputs (RCA cables cannot
be balanced). Most home/computer speakers and amplifiers have RCA and/or 1/8" TRS stereo inputs. Most live sound
mixers have balanced 1/4" TRS mono inputs. If you need to interconnect balanced and unbalanced gear, refer to this
guide from Presonus (deleted, via archive.org) and this guide from Rane (deleted, via archive.org).

Number of Channels

Audio interfaces sometimes have multiple connectors for a single channel, resulting in more connectors than channels.
So, not every connector can send or receive and independent signal. For example, some audio interfaces made for DJing
have 4 output channels with 4 mono output connectors and 1 stereo headphone connector. This does not mean that the
audio interface can send out 6 different signals at the same time; rather, the signal on 2 of the mono outputs and the stereo
headphone output would be the same. Also, many controllers have separate master and booth outputs with independent
volume controls, but they both play the same signal.

Vinyl Control and Phono Preamplifiers

Turntables output low voltage (phono level) signals that need to be amplified to line level before most audio equipment
can work with them. So, if you want to use Vinyl Control, sometimes referred to as a Digital Vinyl System (DVS), it
is best to have phono preamplifiers (one for each deck) somewhere between your turntable and sound card to boost the
turntable's phono level signal to line level. Mixxx can amplify phono level signals in software, but it is better to do it in
hardware. The phono preamp can be in the turntable, in the audio interface, or a stand alone device. Most audio interfaces
do not have phono preamps; these are generally found on audio interfaces specifically made for controlling DJ software
with timecode vinyl. Mixers with audio interfaces have phono preamps on their deck inputs, but not necessarily on every
deck input. Many higher-end all-in-one controllers also include audio interfaces with phono preamps.
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Driver Support

Unlike some proprietary DJ programs, Mixxx works with any audio interface that is compatible with your operating
system — including for timecode vinyl (DVS) use.
USB Audio Class compliant audio interfaces should work out of the box on all operating systems supported by Mixxx.
This is the case for the integrated audio interfaces in most DJ controllers. Sound cards that aren't USB Audio Class
compliant need a driver for each OS.

Catatan: On Windows, you should install the manufacturer's drivers even for USB class compliant audio interfaces to
be able to use the recommended ASIO sound API.

Petunjuk: If you are considering buying a controller or audio interface, the easiest way to tell if it is USB class compliant
before you buy it is to search for macOS drivers for the device on the manufacturer's website. If it is advertised as
compatible with macOS or iOS but there are no drivers to download for macOS, the device is USB class compliant.

5.3 Mixers

Mixers are devices that combine audio signals. DJ mixers are different from live and studio mixers because they have
multiple stereo channels with phono preamplifiers for connecting Turntables. It is conventional to use a DJ mixer with
Vinyl Control, but vinyl control can be used without a hardware mixer.
Using Mixxx with a DJ mixer requires an audio interface with at least 4 mono outputs (2 stereo pairs) to send Mixxx's
decks to the mixer's stereo channels. Some DJ mixers have a USB audio interface built into them. This lets Mixxx send
unmixed audio files directly to the mixer without needing a separate stand-alone audio interface.
Often DJs who use DJ software with internal mixing send their master output to a hardware mixer. This can be helpful
to send the mixed signal to both a main speaker output for the audience and booth speakers for the DJ with separate gain
controls for each output. It also facilitates smooth transitions between DJs.
However, using an external mixer with internal mixing is not necessary and reduces the sound quality. Each piece of
equipment an audio signal passes through reduces the sound quality, so avoiding unnecessary equipment in the signal
path can provide better sound quality. Many DJ controllers provide separate master and booth outputs with independent
volume controls. Alternatively, a sound card with at least 6 output channels can be used with Mixxx's Booth output.
Many people confuse "analog mixers" and "hardware mixers", but these are not the same. Many hardware mixers process
audio digitally with specialized signal processors as opposed to a general purpose CPU like those in laptop and desktop
computers.
Lihat juga:
Recording And Broadcasting With An External Hardware Mixer
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5.4 Turntables

Turntables are mechanical devices that play music recordings cut into vinyl phonograph records. Before software like
Mixxx was available, the art of DJing originated with turntables and DJ mixers. Special vinyl records can be used with
turntables to control the playback of digital files in Mixxx as if the digital file was pressed onto the vinyl record.
Lihat juga:
Vinyl Control

5.5 CDJs

CDJs are devices that play digital audio files and have controls from manipulating the playback of the audio. Originally
CDJs played audio CDs, but new devices typically use USB storage drives or SD cards. Some CDJs can be plugged into
a computer with a USB cable to function as a controller for Mixxx.

5.6 Microphones

Microphones convert changes in sound pressure in air to changes in voltage (an analog audio signal). Mixxx can work
with any microphone that can be plugged into your audio interface.
Lihat juga:
Using Microphones

5.7 Headphones

Being able to listen to what you will play next in headphones before your audience hears on the main speakers or your
broadcast stream is an essential part of DJing. DJ headphones are generally better quality than typical consumer head-
phones. Importantly, they are designed to have good isolation, meaning they block outside sound. This allows the DJ to
focus on the sound in the headphones better without having to turn up the volume to drown out sound from the moni-
tors, PA system, and chatter. Also, DJ headphones have hinges or flexible headbands that allow the DJ to take off one
headphone cup to hear the monitor or PA output better in one ear and compare it to the headphone output in the other
ear.
When shopping for headphones, consider how well they isolate sound and their durability. The most frequent places that
headphones break are the cable attachment point and the headband. Look for headphones with detachable cables, metal
headbands, and other individually replaceable parts. Avoid Bluetooth headphones because these may be unreliable and
will always reduce sound quality. Active noise canceling headphones also tend to have worse sound quality than other
headphones of a comparable price. DJ headphones with a closed design block out a lot of sound simply by being closed.
Whether to get on-ear or over-ear headphones is a matter of personal preference. Everyone's head is different, so head-
phones that are comfortable for a friend or a reviewer may not be comfortable for you.
In-ear monitors (IEMs) isolate sound better than headphones but are more expensive. They usually cost more than double
the price of good DJ headphones with comparable quality. They may be a sound investment for musicians who play often
in very loud environments to preserve their hearing.
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5.8 Splitter Cables

DJ splitter cables are the cheapest way to get two separate sound outputs from your computer. These plug into the onboard
audio interface built into computer motherboards and split the stereo signal into two separate mono signals. However,
onboard audio interfaces are not good quality, and you lose the stereo effect of hearing different sounds arranged in space.
Devices marketed as "headphone splitter" instead of DJ splitters duplicate one stereo signal in two jacks. These cannot
be used for headphone cueing. Also, generic stereo-to-mono splitter cables or adapters typically have two mono jack
outputs. Plugging headphones or stereo speakers into a generic stereo-to-mono splitter will only play sound on one side
of the headphones or speakers.
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CHAPTER6

Example Setups

This chapter presents some example hardware setups with instructions for how to configure Mixxx to work with them.
Lihat juga:

• DJ Hardware: background information about different types of equipment.
• Configuring sound input and output: details about each available input and output option.
• Using Microphones: details for configuring Mixxx to work with microphones.
• DJ Hardware Guide lists specific devices with information about their prices, features, and compatibility with
Mixxx.

6.1 Computer Only

The built-in audio interface on most computers comes with a single stereo line-out and a microphone input. This can be
set up with Mixxx in two ways:

6.1.1 Practicing Mixing / Broadcasting

This setup can be used with a single audio output for speakers or headphones to practice DJing without investing in any
equipment other than a computer and a set of speakers or headphones. With this configuration, use the Pre/Main Knob
to switch back and forth between the Master mix and PFL signal. This setup cannot be used to play for a live audience
because the Master mix is not sent to an audio interface output. However, it can be used by radio DJs who only need to
send the Master mix to a broadcast audience.

1. Open Preferences ‣ Sound Hardware
2. Select the Output tab
3. From the Headphones drop-down menu, select your built-in audio interface, then Channels 1-2. Although this is

labeled Headphones, you can also plug speakers into the output jack of your computer.
4. Depending on your audio interface, you can specify a microphone
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a. Use your built-in microphone or connect a microphone to your computer
b. Check that your microphone is detected by your OS
c. Open the Input tab
d. From the Microphone drop-down menu, select the input your microphone is connected to

5. Click Apply to save the changes.

6.1.2 Playing for an Audience

This setup allows for playing to an audience without headphone cueing.

Figure1: Using Mixxx with your built-in sound card

1. Open Preferences ‣ Sound Hardware
2. Select the Output tab
3. From the Master drop-down menu, select your built-in audio interface, then Channels 1-2
4. Depending on your audio interface, you can specify a microphone

a. Use your built-in microphone or connect a microphone to your computer
b. Check that your microphone is detected by your OS
c. Open the Input tab
d. From the Microphone drop-down menu, select the input your microphone is connected to

5. Click Apply to save the changes.
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6.2 Laptop and Splitter Cable

The cheapest way to DJ and cue with headphones uses a stereo-to-mono DJ splitter cable (also known as a “Y cable”)
plugged into the headphone jack of a laptop or other computer. This cable divides the stereo output from a single jack
into two separate mono signals.
This setup allows you to start DJing without having to invest in expensive equipment. However, because the signals are
in mono, you and your audience will not be able to enjoy music producers' positioning of sound in space (although many
club PA systems are wired in mono anyway). Furthermore, audio interfaces built into computers are usually low quality
and often pick up interference from other components of the computer.
Using a built-in audio interface and a stereo-to-mono splitter

1. Open Preferences ‣ Sound Hardware
2. Select the Output tab
3. Check that your headphones are plugged into the side of the cable with a headphones symbol and that the speakers

are plugged into the side of the cable with a speaker symbol.
4. From the Master drop-down menu, select your built-in audio interface, then Channel 1
5. From the Headphones drop-down menu, select your built-in audio interface, then Channel 2
6. Click Apply to save the changes.

Peringatan: Most splitter cables, particularly those marketed as headphone splitter cables, output the same stereo
signal to two headphone jacks and will not work for this DJ setup. Also, if you use a generic stereo-to-mono splitter
adapter, you may only be able to hear out of one side of your speakers and headphones. DJ splitter cables allow you
to hear the same mono signal on both sides of your headphones and speakers.

6.3 Laptop and External USB Audio Interface

Figure2: Using Mixxx together with an external audio interface

Using two audio interfaces (built-in + external)
1. Open Preferences ‣ Sound Hardware
2. Select the Output tab
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3. From the Master drop-down menu, select the external audio interface, then Channels 1-2
4. From the Headphones drop-down menu, select the built-in audio interface, then Channels 1-2

Using an external multi-channel audio interface
1. Open Preferences ‣ Sound Hardware
2. Select the Output tab
3. From the Master drop-down menu, select the external audio interface, then Channels 1-2
4. From the Headphones drop-down menu, select the external audio interface, then Channels 3-4
5. Click Apply to save the changes.

6.4 Laptop and MIDI or HID Controller

Lihat juga:
The Controllers section of the DJ Hardware chapter has background information about controllers.

6.4.1 Controllers with an integrated audio interface

Many DJ controllers include an integrated multi-channel audio interface. A setup with this kind of controller may look
like the diagram below:

Figure3: Using Mixxx together with a DJ controller and integrated audio interface

Using a controller with an integrated multi-channel audio interface
1. Open Preferences ‣ Sound Hardware
2. Select the Output tab
3. From the Master drop-down menu, select your controller's audio interface, then Channels 1-2
4. From the Headphones drop-down menu, select your controller's audio interface, then Channels 3-4
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5. Click Apply to save the changes.

6.4.2 Controllers without an integrated audio interface

Controllers without an integrated audio interface can be used together with a USB audio interface as depicted in the
diagram below:

Figure4: Using Mixxx together with a DJ controller and external audio interface

Using a controller without an integrated audio interface
1. Open Preferences ‣ Sound Hardware
2. Select the Output tab
3. From the Master drop-down menu, select the external audio interface, then Channels 1-2
4. From the Headphones drop-down menu, select the built-in audio interface, then Channels 1-2
5. Click Apply to save the changes.

6.5 Laptop, External Hardware Mixer and Vinyl Control

This setup allows DJs to use the techniques of DJing with vinyl record turntables combined with the portability and
flexibility of a laptop computer. Instead of carrying crates of records or CDs, DJs can carry their entire music collection
on their laptop. In addition to a laptop and headphones, this setup requires an audio interface with at least two pairs of
stereo inputs and outputs as well as a pair of timecode records.
Lihat juga:
Go to the chapter Vinyl Control for detailed information.
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Figure5: Using Mixxx together with turntables and external mixer
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CHAPTER7

Controlling Mixxx

Mixxx can be controlled with a keyboard, a mouse, MIDI/HID controllers, time-code records/CDs, or a combination of
these. The choice usually depends on your budget or style of DJing.

7.1 Using a Mouse and Touchpad

Use your mouse to interact with the controls in the Mixxx User Interface on your computer screen. You can perform
actions by pointing and clicking with your mouse.

• Single Left Click: Performing a left mouse click on buttons triggers the default action for that control. Moreover
if you click on a value in the track list of the Mixxx library, you can change the value. For example the year of a
track.

• Single Right Click: On most buttons, performing a right click triggers a different action than a left click. You can
return any knob or fader to its default value by right-clicking that control.

• Mouse Drag: Click on a knob or fader, hold the left mouse button and move your cursor to change the value of
the control. Use mouse drag to drop tracks from the file list to the decks, crates, playlists, etc.

• Mouse Wheel: Just like Mouse Drag, you can change knob and fader values by placing the cursor over the control
and moving the mouse wheel.

Petunjuk: If you hover with the mouse over a control (e.g. the crossfader) in the Mixxx user interface, the tooltip lists
the left- and right-click action respectively.

Petunjuk: On a Macbook or a computer with a touchpad that lacks mouse buttons, a two-finger click gesture is often
treated as a right click.

Lihat juga:
Using theMouse drag/wheel on the waveforms you can adjust zoom and playback rate of the tracks. Formore information,
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go toWaveform Displays.

7.2 Using a Keyboard
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Figure1: Mixxx Keyboard shortcuts (for en-us keyboard layout)
Download the image

Controlling Mixxx with a keyboard is handy. Unlike mouse control, the keyboard allows you to manage things simulta-
neously. For example, you can start playing a track on deck 1 whilst stopping deck 2 at the same time.
The default mapping for English keyboards is depicted in the figure above. It is divided into a left-hand side for deck 1
and right-hand side for deck 2. Please note that you can also access the functions through Mixxx's interface.
For some user groups, like those using controllers or vinyl control, it might be useful to enable/disable the keyboard
mappings at runtime. You can do so by clicking Options ‣ Enable Keyboard Shortcuts.

Petunjuk: If you hover with the mouse over a control (e.g. the crossfader) in the Mixxx user interface, the tooltip lists
the keyboard shortcuts of the control among a description of the control.

Lihat juga:
For a list of default shortcuts, go to Keyboard mapping table.

7.2.1 Customizing the keyboard mapping

Mixxx allows you to customize the keyboard control. For more information, go to:
• Making a Custom Keyboard Mapping
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7.3 Using MIDI/HID Controllers

Mixxx supports MIDI and HID controllers which are external hardware devices used to control audio applications. Many
DJs prefer the hands-on feel of a controller with Mixxx because it can feel similar to using a real mixer and turntables or
CDJ.

7.3.1 Loading a controller mapping

Figure2: Mixxx Preferences - Loading a controller mapping

Without loading the correct mapping, your controller does not work with Mixxx.
1. Connect your controller(s) to your computer
2. Start Mixxx
3. Go to Preferences ‣ Controllers
4. Select your device from the list of available devices on the left, and the right pane will change
5. Select the mapping for your controller from the Load Mapping drop-down menu
6. Make sure that the Enabled checkbox is ticked
7. Click Apply and Mixxx can now be controlled by your controller(s).
8. Repeat step 4-7 for any of the controllers you want to use

Petunjuk: If you do not find a connected device in the list, make sure to install any necessary drivers for that device.
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7.3.2 Supported controllers

Mixxx can use any MIDI/HID controller that is recognized by your OS (some may require drivers), as long as there is a
MIDI/HID mapping file to tell Mixxx how to understand it. Mixxx comes bundled with a number of mappings for various
devices. There are two levels of controller mappings:

• Mixxx Certified Mappings: These mappings are verified by the Mixxx Development Team.
• Community SupportedMappings: These mappings are provided and have been verified as working by theMixxx
community, but the Mixxx Development Team is unable to verify their quality because we don't have the devices
ourselves. They might have bugs or rough edges.

If you run into issues with any of these mappings, please file a bug report on our Bug Tracker or tell us about it on
our mailing list, forums, or IRC channel. Device support varies for each supported OS, so make sure to consult the
documentation of the device.

Petunjuk: Additional mappings are available in the Controller mapping forum.

Lihat juga:
Before purchasing a controller to use with Mixxx, consult our Hardware Compatibility wiki page. It contains the most
up-to-date information about which controllers work with Mixxx and the details of each.

7.3.3 Installing a mapping from the forum

To use a controller mapping that did not come bundled with Mixxx, place the controller mapping in your User Mappings
folder. This is the folder called "controllers" inside your User Preferences folder. To open your User Mappings folder, go
to Preferences ‣ Controllers and click the Open User Mapping Folder button. Alternatively, navigate to the folder in your
OS file browser:

• GNU/Linux: /home/<username>/.mixxx/controllers
• macOS: /Users/<username>/Library/Containers/org.mixxx.mixxx/Data/Library/
Application Support/Mixxx/controllers

• Windows Vista and newer: C:\Users\<username>\AppData\Mixxx\controllers
• Windows XP: C:\Documents and Settings\<username>\AppData\controllers

On Windows, the AppData folder is hidden, so if you have not already, you will need to set Windows Explorer to show
hidden files and folders (how to do this varies with each version of Windows).
If the mapping was posted as a .zip file, first extract the .zip file by right clicking on it in your file browser and
selecting the option for extracting an archive or compressed folder. Copy the .xml file into your User Mapping folder.
If there is a .js file, also copy that to your User Mapping folder. Restart Mixxx and load the mapping.

7.3.4 Map your own controller

There is no mapping available for your controller or you want to change an existing mapping? You canmap your controller
by using the Controller Wizard or take full control with the MIDI Scripting support in Mixxx.
Lihat juga:
Go to Adding support for your MIDI/HID Controller for detailed information.
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7.4 Using Timecode Vinyl Records and CDs

Vinyl control allows a user to manipulate the playback of a track in Mixxx using a turntable or CDJ as an interface. In
effect, it simulates the sound and feel of having your digital music collection on vinyl. Many DJs prefer the tactile feel of
vinyl, and vinyl control allows that feel to be preserved while retaining the benefits of using digital audio.
Lihat juga:
Go to Vinyl Control for detailed information.
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CHAPTER8

Vinyl Control

Vinyl control allows a user to manipulate the playback of a track in Mixxx using a real turntable as a controller. In effect,
it simulates the sound and feel of having your digital music collection on vinyl. Many DJs prefer the tactile feel of vinyl,
and vinyl control allows that feel to be preserved while retaining the benefits of using digital audio.

8.1 How does it work?

Vinyl control uses special timecode records or CD's which are placed on real turntables or CDJ. The audio output of the
turntables is plugged into a audio interface connected to a computer on which Mixxx is running. When a record is played
on one of the attached turntables, Mixxx reads the timecode from the record and uses the information to manipulate
whatever track is loaded.

8.2 What do I need to use it?

It is possible to use Mixxx's vinyl control with a variety of setups. Unlike some proprietary DJ software, Mixxx can use
several types of timecode media and any audio interface that your operating system has drivers to use. Optionally, any
MIDI/HID controller can be used together with timecode control. The basic setups for timecode control are:
Setup 1: Vinyl DJ

2-4 timecode vinyls, 2-4 turntables with phono pre-amplifiers (or line-level output), and 2-4 stereo sound
inputs.
Your audio interface inputs must match the turntable outputs. Turntables output very quiet phono-level
outputs that must be amplified for Mixxx to use. You should either find a audio interface that has phono
pre-amplifiers built in (one for each deck), use standalone phono pre-amplifiers, or use turntables with built
in phono pre-amplifiers.
You can try skipping the phono pre-amps if you use the software pre-amp in Mixxx on the Vinyl Control
preferences pane. This may not work for everyone. Line-level signals are preferred and recommended.
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For turntables a typical setup is depicted in the figure below. First, connect the RCA cables from the turntables
to the inputs on your audio interface. Second, connect the outputs of your audio interface to the inputs on
your mixer.

Figure1: Using Mixxx together with turntables and external mixer

Catatan: Many modern turntables have a Line/Phono select switch. If yours does, make sure it matches the input or
switch setting on your sound card.

Setup 2: CDJ
2-4 timecode CDs, 2-4 CD decks, and 2-4 stereo sound inputs.
Setting up CDJs for use with timecode CDs is similar to setting up turntables. The figure below outlines a
typical configuration. First, connect the RCA cables of the CDJs to inputs of your audio interface. Second,
connect the inputs of your mixer to the outputs of your audio interface. Make sure the input mode of your
audio interface is set to Line.

Sound inputs
• It is recommended to use a DJ audio interface that has multiple stereo line inputs on it.
• Alternatively you can use multiple audio interfaces, each with a single stereo line in, but this is strongly discouraged.

Mixxx supports vinyl control input through a single audio interface with at least 4-channels of input (two stereo line-in
jacks), or through multiple separate audio interfaces which each have 2-channels of input (a single stereo line-in jack).
Vinyl control requires the use of stereo line-in jacks - Mono or microphone inputs will not work.
It is strongly recommended to use a audio interface that comes with native low latency drivers such as ASIO (Windows)
or CoreAudio (Mac). Linux users depend on the quality of the corresponding open source driver.

Catatan: For best scratch performance with vinyl control, we recommend using a system capable of latencies of 10ms.
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Figure2: Using Mixxx together with CDJs and external mixer

With higher latencies the scratch sound will start to become distorted.

Catatan: An external hardware mixer is not required for using timecode control. You can use aMIDI or HID controller
to mix in software instead.

8.2.1 Supported Timecode media

You can use any of the timecode media supported by Mixxx:

Type Responsiveness
Serato CV02/2.5 Vinyl Very high
Serato Control CD 1.0 Very high
Traktor Scratch MK1 Vinyl Very high
Traktor Scratch MK2 Vinyl Not supported
MixVibes DVS V2 Vinyl Very high

At the present time, Serato records are recommended if you are looking to buy vinyl. If you want to use CDs, you can
download a free copy for personal use from Serato.

8.2. What do I need to use it? 69

https://serato.com/controlcd/downloads


Mixxx User Manual, Rilis 2.3.0

8.3 Configuring Input and Output devices

Figure3: Mixxx preferences - Setting up Input and Output devices for Vinyl Control

Mixxx can be controlled by up to 4 decks with either timecoded vinyl or timecoded CDs.
1. Open Preferences ‣ Sound Hardware
2. Select the Input tab
3. From the Vinyl Control 1 - Vinyl Control 4 drop-down menus, select the audio interface(s) which your decks are

plugged into.
4. In the channel selection drop-down menu, select the channel pairs corresponding to the plug on your audio interface

that your deck(s) are plugged into, typically Channels 1-2 and Channels 3-4 etc.
5. Click Apply to save the changes.
6. Select the Output tab
7. Specify Deck 1 - Deck 4 to route Mixxx's output directly to the external mixer
8. Click Apply to save the changes.

8.4 Configuring Vinyl Control

You can configure vinyl control in Preferences ‣ Vinyl Control.

8.3. Configuring Input and Output devices 70



Mixxx User Manual, Rilis 2.3.0

Figure4: Mixxx preferences - Setting up vinyl control

8.4.1 Turntable Input Signal Boost

Many turntables provide unamplified “phono level” output which must be boosted to a “line level” signal. Normally, a
mixer or audio interface provides this amplification, but if you're plugging a turntable's phono output directly into a audio
interface that doesn't support phono input, Mixxx can do the amplification. The Turntable Input Signal Boost slider allows
you to adjust the level of preamplification applied to your decks' signal. However, it is always preferable to use a proper
phono preamplifier if you have one.

8.4.2 Vinyl Configuration

• Vinyl Type: Several types of timecoded media can be used to control Mixxx. Configure the drop-down menus to
match what type of timecoded media you are using on your decks.

• Deck Vinyl Tempo: Change this if you prefer to scratch with your turntable or CDJ set at 45 RPM, default is 33
RPM.

• Lead-in Time: Allows you to set a dead-zone at the start of your vinyl or CD, where the time code will be ignored.
This is useful in situations where the time code begins very close to the edge of a vinyl which can make back-cueing
over the first beat in a track tricky to do without your turntable's needle falling off the vinyl. Setting a lead-in time
of 20 seconds or more helps alleviate this by giving you more room on the vinyl to cue with. It's also useful when
you've worn the grooves at the edge of a control record to the point that it no longer works reliably: you simply set
the lead-in so that the start of the tracks begin in good groove area. You can keep doing this until you run out of
groove area, thereby decreasing your record replacement frequency.

• Show Signal Quality in Skins: If enabled, a circular representation of the incoming timecode signal is displayed
in real-time on the Vinyl Widget in the Mixxx Interface.

Petunjuk: Although not recommended, you can use different kinds of timecode media per deck.
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8.4.3 Control Mode

Mixxx has three control modes regardless of which control records you use.
• Absolute Mode: Provides Mixxx with both pitch and position information from the timecode, and allows you to
seek by needle dropping on your vinyl or seeking on your CDJ.

• RelativeMode: Takes the position to be relative to your deck's starting point, and only controls the pitch in Mixxx.
It is not possible to seek using your deck in relative mode, with one exception. If you drop the needle in the Lead-in
Time area (see Vinyl Configuration), Mixxx will seek back to the beginning of the track. Once a track is playing in
Relative Mode, Mixxx will not allow you to select Absolute mode. Otherwise, the track would suddenly jump to a
new position. Make sure the record is stopped and then you're free to select Absolute mode.

• Constant Mode: This special mode is usually only activated when Mixxx needs to keep playing a track even if
the vinyl control signal isn't present. Constant mode is automatically enabled when the needle reaches the end of a
vinyl control record.

8.4.4 Cueing Modes

Mixxx has two optional cueing modes for vinyl control which only apply to Relative Mode. These modes are useful for
quickly seeking to specific positions in a track without touching the laptop. Turntablists often need to find a break or a
vocal sample, and cueing modes make these easy to find.

• Cue: In this mode, when you drop the needle on the record after the Cue point, Mixxx will seek to that cue point.
• Hot Cue: When the needle is dropped Mixxx will seek to the nearest hotcue point, working backwards. So if you
have a hotcue at the one-minute mark, and another at the two-minute mark, you can drop the needle anywhere
between one and two minutes and Mixxx will seek to the one-minute hotcue.

Petunjuk: You can change the Control and Cueing Modes directly in the Mixxx user interface while mixing, go to Vinyl
Control Mode and Cueing controls. Alternatively, use the Application shortcuts.

8.4.5 Signal Quality

A successful vinyl control setup hinges on good signal quality. Many factors can affect signal quality, but the most
important one is ensuring the volume level of your timecode signal is moderate. A signal that is too loud or too quiet will
cause adverse performance, often characterized by a loss of position data causing absolute mode to behave like relative
mode.
Mixxx represents the quality of the timecode signal as a circular graphic coming from the vinyl control audio itself. The
graphs correspond to your active input devices Deck 1 - Deck 4 .
If your vinyl signal is working, you should see a round, green circle drawn with two lines. This vinyl “doughnut” should
be as circular as possible, and the lines should be clear with a minimum amount of fuzz.

Petunjuk: You can display the signal quality in the Mixxx user interface while mixing, see Configuring Input and Output
devices .
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8.5 Enabling Vinyl Control

For each deck, select Options ‣ Vinyl Control ‣ Enable Vinyl Control, or use the Application shortcuts.

8.5.1 Vinyl Control Status Display

Figure5: The vinyl control status, and signal quality display of the deck

A rectangle provides visual feedback with regards to vinyl control status of a deck.
• Off: Vinyl control disabled on the deck.
• Green: Vinyl control is enabled on the deck.
• Yellow: The needle has reached End-Of-Record.

8.6 Single Deck Control

If you only have one turntable, you can still use Mixxx to play your sets. In the Preferences ‣ Sound Hardware ‣ Input tab,
use the same audio input for both Vinyl Control decks.
When mixing, you'll have one track playing automatically while the other is controlled by the turntable. Start by enabling
vinyl control on the first deck, and start mixing. When you're ready to cue up the next record, just disable vinyl control
on the first deck and enable it on the second deck. Playback will continue on the first deck without interruption. Cue up
the second track and mix it in. When you're ready to cue the first deck again, just toggle the second deck off and the first
deck on again.
Use the Application shortcuts to swap focus from one deck to the other. Alternatively, select Vinyl ‣ Single Deck mode in
the Controller Wizard, to assign the control to a key on your controller.
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8.7 End-Of-Record Mode

Sometimes the track you are playing is longer than the timecode area on your record. If the needle reaches the end of
the vinyl timecode, Mixxx will enter a special End-Of-Record Mode. When this happens, the vinyl indicator (usually a
green rectangle) will blink yellow as a warning. At the same time, Mixxx will automatically enable Constant Mode and
will ignore the turntable's pitch. At this point the track will simply continue playing until the end. When you load a new
track, End-Of-Record Mode will be automatically disabled and Constant Mode turned off.
When you're in End-Of-Record Mode and you want to still use the turntable for pitch control, simply lift the needle and
place it anywhere in the main timecode area. It's OK, the track won't stop playing. As soon as Mixxx detects that the
needle has settled, it will automatically switch to Relative Mode.

8.8 Control Track

Some vinyl control records have a special portion of grooves near the center of the record for selecting and loading tracks
in the user interface. You can see these grooves because there is a gap between the main timecode area and the inner
circle. Some control records have not been tested with Mixxx, and their control areas are not supported. Serato CV02
Vinyl and Traktor Vinyl MK1 are known to work. Serato CV02 CDs are known not to work.
Just drop the needle in the control area and let the record play forward or backward. The highlighted row in the library
should move up or down. Simply lift the needle and drop it anywhere in the main timecode area to load the track.

8.9 Troubleshooting

Configuration
To complete your setup you must configure Mixxx properly. Make sure you have:

• specified Deck 1 - Deck 4 in Preferences ‣ Sound Hardware to route Mixxx's output directly to the external mixer
• specified Vinyl Control 1 - Vinyl Control 4 under Preferences ‣ Sound Hardware ‣ Input
• selected the correct control type under Preferences ‣ Vinyl Control ‣ Vinyl type in the preferences. See the list of
Supported Timecode media

• enabled vinyl control via the menu under Options ‣ Vinyl Control ‣ Enable Vinyl Control.
Signal Quality
The graph is displayed in Preferences ‣ Vinyl Control, see Signal Quality.
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Signal Meaning Troubleshooting

Vinyl control input channels not correctly set up.
Vinyl control will not work.

Open Preferences/ Sound Hardware and set up the
devices you want to use, see Configuring Input and
Output devices

Vinyl control input channels set up correctly.
Waiting for timecode input signal.

Start your turntable or CDJ with the selected time-
code vinyl or CD.

Nearly perfect green doughnut about half the
width of the graph. Rotating radar sweeps in the
direction your record on the turntable is spinning.

Everything is OK, nothing to do. Go spin some
beats.

Incorrect choice of vinyl control source. Dough-
nut looks good but has a solid red color.

Select the correct vinyl type in the preferences. E.g.
maybe you selected side B of the Serato Vinyl but
your record is on side A.

Input signal is bad. As the vinyl signal gets worse,
you'll see the color of the doughnut change from
green over orange to red.

Check the wiring / grounding on your turntable /
CDJ. You timecode record / CD might be worn out
or the needle on your turntable is dirty.

Wrong direction. The green doughnut looks good
but the radar sweeps in the opposite direction of
the record on your turntable / CDJ.

You probably have a wiring problem. Try reversing
the left and right inputs on your turntable. You may
also have to rewire the headshell.

Input signal is no timecode signal. Mixxx receives
a normal audio signal while it expects a timecode
signal.

Start your turntable or CDJ with the selected time-
code vinyl or CD. You may want to check if the in-
puts devices are set up correctly in the preferences.

Left or right channel is missing. Mixxx receives
only a mono signal but needs a stereo timecode
signal to operate.

Check the wiring on your turntable / CDJ and also
the headshell and needle on your turntable.

Timecode signal too loud. Mixxx receives a signal
which has too much amplification.

Lower the amplification, either on your external
mixer, audio interface, or with the Turntable Input
Signal Boost.

Timecode signal too quiet. Mixxx receives a signal
which has not enough amplification.

Boost the amplification, either on your external
Mixer, audio interface, or with the Turntable Input
Signal Boost.
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CHAPTER9

Using Microphones

Mixxx can work with any microphone that can be plugged into your audio interface. There are three ways to use micro-
phones with Mixxx, each with their own pros and cons:

• Software Monitoring: Cheapest and simplest to set up, but you cannot hear yourself without a disorienting delay,
referred to as "latency".

• Direct Monitoring: Recommended for most users. This is the cheapest to set up with good sound quality and without
the latency of software monitoring.

• Hardware Mixers: Most expensive option to set up with high sound quality. This does not have the latency of
software monitoring.

Peringatan: USB microphones are not recommended. These devices have their own audio interface built in and can
only be used with software monitoring. Some USB microphones have headphone jacks for direct monitoring, but the
music from Mixxx cannot be heard in this headphone jack. Also, they can be difficult to configure at the same time
as a different audio interface for music output.

Lihat juga:
The Mixxx DJ Hardware Guide lists specific audio interfaces with information about their prices, features, and suitability
for use with microphones.

9.1 Software Monitoring

Software monitoring can be used with the built-in microphone on a laptop or with a headset plugged into the built-in
audio interface on a computer. However, there is a delay between the time you make sound into the microphone and hear
it in the Master output. Due to the nature of digital audio, it takes time for input from the audio interface to be available
for Mixxx to process, time for Mixxx to process the audio, and more time to send the audio back out the audio interface.
This time is referred to as "latency".
Mixxx can be configured to run at low latencies by choosing a smaller Audio Buffer, but there is no way to completely
eliminate latency. Although latency is measured in milliseconds, even a few milliseconds of latency can be disorienting

76

https://github.com/mixxxdj/mixxx/wiki/Hardware-Compatibility


Mixxx User Manual, Rilis 2.3.0

and distracting to hear, whether you are using the microphone for spoken announcements, vocals, or playing a musical
instrument.
To use software monitoring:

1. Open Preferences ‣ Sound Hardware.
2. Select the Input tab.
3. For Microphone 1, select the audio interface that your microphone is plugged into.
4. Click the Apply button.
5. Click the OK button.
6. Click the Mics button in the main Mixxx window to show the microphone controls.
7. Click the Talk button when you are using the microphone.

Petunjuk: If you would prefer to not hear the microphone input, you can set the Microphone Monitor Mode option
to Direct monitor (recording and broadcasting only). This will still mix the microphone input with your recorded and
broadcasted mixes, but it will not mix the microphone with the Master output. Don't forget to press the Talk button when
using the microphone if you use this option.

9.2 Direct Monitoring

An audio interface with direct monitoring and a Loopback Input is the recommended way to use microphones with Mixxx
for most users. Except for audio interfaces built into computers, most audio interfaces with microphone inputs support
direct monitoring. However, not all audio interfaces that support direct monitoring also have a loopback input.
Direct monitoring routes the audio from the audio interface's inputs directly its outputs. This avoids the latency of sending
it into the computer and back out with Software Monitoring. At the same time, the audio interface sends the input into
the computer so Mixxx can record and broadcast it.

9.2.1 Loopback Input

Some audio interfaces that support Direct Monitoring have a loopback input feature. They add Mixxx's output to the
microphone signal before sending it to the computer. This makes it easier to set up Mixxx with direct monitoring than
configuring Latency Compensation.
To configure Mixxx with a loopback input:

1. Open Preferences ‣ Sound Hardware.
2. Click the Input tab.
3. Select the audio interface for the Record/Broadcast input. Do not configure anything for theMicrophone 1-4 inputs.
4. Click the Apply button.
5. Click the OK button.
6. Activate direct monitoring and loopback on your audio interface.
7. Adjust the microphone volume with the input gain knob on your audio interface.

The microphone controls in Mixxx will not affect your microphones because they are mixed by the audio interface and
not sent directly to Mixxx.
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9.2.2 Latency Compensation

When using Direct Monitoring, you will hear the microphone mixed with the music from Mixxx without any noticeable
latency. However, it still takes time for Mixxx to receive the microphone signal and process it. Without compensating for
this latency or using a Loopback Input, the microphone inputs will be out of time relative to the music in your recorded
and broadcasted mixes.
Mixxx can compensate for this timing misalignment, but it is complicated to set up. If you do not want to record your
microphone into your mix or broadcast, you can activate direct monitoring on your audio interface without configuring
latency compensation.

Measuring Round Trip Latency

To configure Mixxx to compensate for input latency while using direct monitoring, first you must measure the round trip
latency of your setup. The round trip latency is different from the size of the Audio Buffer configured in Mixxx. It is the
amount of time it takes for audio to make a complete trip from your audio interface's input, through your computer, and
back out the audio interface.
Mixxx cannot calculate the round trip latency because it depends on details of your audio interface's hardware, your
operating system, your audio interface's driver, and other factors in your computer's hardware. The round trip latency can
only be found by measuring it. To do this, use a physical cable to connect the audio interface's output to its input. Then,
use a third party program to measure the round trip latency. These programs are recommended on each OS:

• GNU/Linux: jack_iodelay
• Windows: RTL Utility
• macOS: Audacity

You must use the same sample rate and audio buffer size in the measurement program as you do in Mixxx for the
measurement to be accurate. If you decide to change the sample rate or buffer size you use with Mixxx, you will need to
remeasure your round trip latency to have your microphone inputs aligned in your recorded and broadcasted mixes.

Peringatan: Make sure direct monitoring is not activated on your audio interface while you are measuring the round
trip latency or you will not get an accurate measurement.

Configuring Latency Compensation

1. Before opening Mixxx, measure the round trip latency.
2. Open Mixxx.
3. Open Preferences ‣ Sound Hardware.
4. Click the Input tab.
5. Select the audio interface input(s) for theMicrophone 1-4 inputs. Select a single mono channel for eachMicrophone

input unless you are using stereo microphones.
6. For the Microphone Monitor Mode option, select Direct monitor (recording and broadcasting only).
7. Enter the measured round trip latency in milliseconds for the Microphone Latency Compensation option.
8. Click the Apply button.
9. Click the OK button.
10. Activate direct monitoring on your audio interface.
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11. Click the Mics button in the main Mixxx window to show the microphone controls.
12. Click the Talk button when you are using the microphone.
13. Adjust the microphone volume with the input gain knob on your audio interface. Do not adjust the microphone gain

in Mixxx. If you do, the relative volume of the mics and music will be different in your recorded and broadcasted
mixes compared to what you hear out of your audio interface.

Mixxx will not record or broadcast your microphone if the Talk button is not active. However, you will still hear the
microphone in your main output because the microphone is mixed by your audio interface, not Mixxx. You may leave
the Talk button on to ensure you do not forget it, but this will record and broadcast background noise when you are not
actively using the microphone. If your microphone has an on/off switch on it, you may leave the Talk button enabled in
Mixxx and use the switch on the microphone to avoid adding background noise to your mix. Alternatively, you can adjust
the input gain on your audio interface throughout your mix.

9.2.3 Activating Direct Monitoring And Loopback On The Audio Interface

General tips for activating direct monitoring and loopback are described below. However, every audio interface is dif-
ferent, so refer to the audio interface manual from the manufacturer for more details.
On stand-alone audio interfaces, there is often a knob on the device that controls direct monitoring. This knob crossfades
the audio interface's output between the signal from the computer and the directly monitored inputs. If your audio
interface has a knob like this, set the knob to the center. Alternatively, some audio interfaces have a switch to toggle
direct monitoring instead of a knob.
To hear mono microphone inputs on both sides of the stereo output with direct monitoring, you typically need to toggle
a switch on the device.
If the audio interface supports Loopback Input, that may be activated by a switch on the device.
Audio interfaces with lots of inputs and outputs often have a control panel program provided by the manufacturer that is
installed automatically with the driver. This may be used instead of knobs and switches on the hardware to control direct
monitoring, loopback, stereo/mono switches, and other audio interface features. On GNU/Linux, you might be able to
access these controls with alsamixer.
Refer to the section below for details about DJ Controllers With Microphone Inputs.

9.3 Hardware Mixers

Mixxx can be used with a microphone plugged into an external hardware mixer. This does not have the problem with
latency that happens with Software Monitoring. However, it is generally recommended to use an audio interface that
supports Direct Monitoring and a Loopback Input instead of an external mixer. If you are using Vinyl Control and a
microphone, you may need an external mixer.
Mixxx can send each deck to separate stereo channels on an external mixer by using the Deck 1-4 outputs. This requires
an audio interface with at least 4 output channels (2 stereo pairs). Audio interfaces built into computers only have one
stereo output and they do not have high sound quality. Thus, another audio interface is recommended. Audio interfaces
with at least 4 output channels typically have microphone inputs and support Direct Monitoring, so there is no need for
the external mixer.
However, audio interfaces with phono preamplifiers for Vinyl Control do not have microphone inputs. If you want to use
vinyl control with a microphone, it is recommended to plug the microphone into a DJ mixer.

Peringatan: Some mixers that are not designed for DJing have a built-in USB audio interface. However, the audio
interfaces in these mixers typically send only 2 channels (one stereo pair) to the mixer, so they are not recommended.
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9.3.1 Recording And Broadcasting With An External Hardware Mixer

To record or broadcast with an external hardware mixer, the output of the mixer needs to be connected to the input of
an audio interface. Most DJ mixers have an extra output for this which may be labeled "record", "session", "auxiliary",
or "booth". Some audio interfaces for vinyl control have enough input channels to receive the output of the mixer and
timecode from two turntables. If yours does not, you may use the input of the audio interface built into your computer,
but these do not have high sound quality.
Alternatively, some DJ mixers have a built-in USB audio interface. These have inputs with phono preamplifiers for vinyl
control and usually can send the record output back to the computer without a separate audio interface. Many (but not all)
of these mixers are digital mixers, so they can send signals back and forth to Mixxx without converting them to analog.
This results in higher sound quality for your recorded and broadcasted mixes compared to using a separate audio interface
with an external mixer.
To configure Mixxx for using a hardware mixer for recording and/or broadcasting:

1. Open Preferences ‣ Sound Hardware.
2. In the Output tab, select the audio interface for the Deck 1-2 outputs (and Deck 3-4 outputs if your audio interface

and mixer support 4 decks).
3. Click the Input tab.
4. For the Record/Broadcast input, select the audio interface connected to the mixer's output. For mixers with a

built-in USB audio interface, refer to the mixer manufacturer's manual to find which channels of the mixer's audio
interface send the record output.

5. If you are using vinyl control, select the audio interface connected to the turntables for the Vinyl Control 1-4 inputs.
6. Click the Apply button.
7. Click the OK button.

Do not configure anything for the Microphone 1-4 inputs when using an external mixer. The microphone controls in
Mixxx will not affect your microphones because the microphone is mixed by the external mixer.
DJ mixers typically do not supply phantom power required for condenser microphones. Stand-alone audio interfaces
typically do supply phantom power.

9.4 DJ Controllers With Microphone Inputs

DJ controllers with microphone inputs typically mix the microphone input with the master output without sending it to
the computer. This does not have the problem with latency that happens with Software Monitoring. However, many cheap
DJ controllers do not digitize the signal to make it available to the computer. Refer to the controller's page on the Mixxx
wiki or the manual from the controller manufacturer for details about your particular controller.
If the controller does not digitize the microphone input, you cannot use Mixxx's microphone input to record or broadcast
with the microphone using Mixxx'sMicrophone 1-4 inputs. It is still possible to record and broadcast the microphone by
connecting the booth output of the controller to an audio interface input and configuring this forMixxx'sRecord/Broadcast
input. If the controller does not have a booth output, a Y splitter cable can be used on each side of the stereo main output
to connect the main output to both the speakers and to another audio interface's input.
DJ controllers typically do not supply phantom power required for condenser microphones. Stand-alone audio interfaces
typically do supply phantom power.
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9.5 Microphone Ducking

Microphone ducking is a technique to improve the audibility of speech by reducing the volume of background music
while a voice signal is recorded by the microphone and allows listeners to hear the voice more clearly and consistently.
While usingMixxx with a microphone, you might want the music to automatically fade into the background each time you
speak, or you might prefer lowering the volume of the music to a specific level. Microphone ducking helps you achieve
this. The music will 'duck' out of the way of the microphone audio.

Figure1: The microphone ducking controls

The Strength knob adjusts the microphone talkover ducking strength and its behaviour depends on any of the Microphone
talkover modes described below. Clicking on the Auto button will switch it to any of three modes:

• Off: When you speak through the microphone, the music volume does not reduce.
• Auto: When you speak through the microphone, the music volume will be reduced when Mixxx detects your voice.
You can adjust the amount by which the volume is automatically reduced with the Strength knob.

• Manual:In this mode, the music will play at the volume set by the Strength knob whenever the microphone Talk
button is active, regardless of the volume coming through the microphone input. When you speak through your
microphone, set the volume to which the music should reduce by turning the Strength knob to a level that suits you.
When you disable Talk mode, the music will return to the regular volume

Petunjuk: To set the Ducking volume correctly, you can use manual mode to adjust the knob to your taste and then set
to auto when happy.
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CHAPTER10

Live Broadcasting - Start your own Internet radio

Live Broadcasting in Mixxx allow you to stream your mix over the Internet to listeners around the world.
Lihat juga:
TheUsing Microphones chapter has detailed instructions for including input frommicrophones in your broadcasted mixes.

10.1 Streaming Servers

Remote streaming server Mixxx allows you to feed your audio stream directly to Shoutcast and Icecast streaming
servers. Depending on the number of listeners, streaming audio requires a significant amount of bandwidth.
Streaming servers provide the required bandwidth and broadcast the stream to your listeners. A popular free
streaming service is Caster.fm. A review of several free and paid stream hosts is available at broadcastingworld.net.

StreamingServer

Listener1
Internet

Listener2Internet

Listener3

Internet
Router InternetMixxx Lan

Figure1: Mixxx as client-side streaming source broadcasting to an remote streaming server

Local streaming server For experienced users, it may be interesting to set up your own local streaming server. This
turns your personal computer into a radio station and listeners connect directly to your server. Mixxx as a streaming
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source does not need to run on the same computer as your streaming server. However, professional stations often
run the streaming source on the same computer as the streaming server for stability and reliability reasons. Keep
in mind that if want to stream audio to a significant number of listeners, you'll need enough bandwidth. Read the
Shoutcast documentation or Icecast documentation for server setup instructions.

Router

Listener1
Internet

Listener2Internet

Listener3

Internet
StreamingServer LanMixxx

Figure2: Mixxx as client-side streaming source broadcasting to an local streaming server

10.2 Configuring Mixxx

Start by supplying Mixxx with all information needed to establish a connection to the streaming server:
• Open Preferences ‣ Live Broadcasting.
• Insert the settings following the descriptions in the Mixxx preferences - Setting up live broadcasting
• Click OK
• Go to Options ‣ Enable Live Broadcasting or use the Application shortcuts to start broadcasting.

10.2.1 Server Connection

• Type: Select the type of streaming server you want to connect with. Shoutcast 1, Icecast 1, and Icecast 2 servers
are supported.
Mixxx works with Shoutcast 2 using the Shoutcast 1 protocol if you provide a stream name in Preferences ‣ Live
Broadcasting ‣ Stream Settings. If you don't provide a stream name, Shoutcast 2 rejects the connection (where
Shoutcast 1 would accept this case).

• Host: You can enter the host as either a host name or an IP address.
• Login: As provided by your streaming server provider. Without this, you will not connect successfully to the server.
The default login for Icecast is source while the default login for Shoutcast is admin.

• Mount: A mount point is a unique name identifying a particular stream. For Shoutcast it is not necessary to specify
a mount point. The setting must not be blank if you are using Icecast. Try the default /mount or /live. If you
haven't been given a specific mount point you can usually make one up. It always begins with a / (slash) followed
by a text without any special characters in it.

• Port: As provided by your streaming server provider. Most servers use the default port 8000.
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Figure3: Mixxx preferences - Setting up live broadcasting

• Password: As provided by your streaming server provider, unless you run your own radio server. It is required to
establish the connection to the server and to start the broadcast.

Peringatan: Do not enter a URL as the host! http://example.com:8000 does not work. Use example.
com in the Host field and 8000 in the Port field instead.

10.2.2 Stream Settings

• Public stream: If enabled, this option adds your radio station to the Shoutcast/Icecast directory.
• Enable UTF-8 metadata: If enabled, this option fixes broken accented and foreign language symbols inmetadata,
assuming the streaming provider has configured the server to support UTF-8 metadata.

• Dynamically update Ogg Vorbis metadata: Due to flaws in some streaming clients, updating Ogg Vorbis meta-
data dynamically can cause listener glitches and disconnections. Check this box to update the metadata anyway.
Some players that listeners can use have bugs that can cause audio glitches or disconnections when the Ogg Vorbis
metadata is updated dynamically. If this is not a problem, you can enable this checkbox.

• Stream name: So, what's the name of your show?
• Website: The website you would like your listeners to visit.
• Description: Enter your DJ name and a short tagline.
• Genre: List the main genres you play. This attracts search hits on stream directories. Genre must not be blank.
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10.2.3 Encoding

• Bitrate: Selecting a bitrate of 128 or 160 kbps is common and provides sufficient quality to your listeners. Higher
bitrates will use a larger chunk in your Internet connection bandwidth to stream and for your listeners to receive
the stream.

• Format: Mixxx supports streaming to Icecast servers either in MP3 or Ogg Vorbis format, streaming to Shoutcast
servers is supported in MP3 format.

10.2.4 Metadata

Shoutcast metadata format

This allows to set custom metadata formats for the Shoutcast title field. Previously only artist - title
was allowed. For example if you were broadcasting as part of a station, you could add the station's name or
the presenter's name in the title: MyStation | $artist - $title. Or if you were doing a live mix
with several artists, you could have: Live mix by MyName - currently playing: $artist.
Or even if you wanted a very unusual format: Hey, I like $artist, here is $title by
$artist.
The changes do not affect the case for the combination of OGG/Icecast2.

Custom metadata

By default, Mixxx broadcasts artist and title information of the files that you play to your listeners. You can
disable this feature and use your own custom metadata.

• Enable custom metadata: Toggles custom metadata on and off.
• Artist: Insert your custom artist metadata here, your DJ name for example.
• Title: Insert your custom title metadata here.

10.2.5 Icecast vs. Shoutcast

Both essentially serve the same purpose. An Icecast server can stream eitherMP3 or Ogg Vorbis. However, although Ogg
is more efficient and effective (you get higher-fidelity sound than MP3 at lower data rates) not all players can play Ogg
streams. As a result MP3 is probably a safe choice unless you know your listeners can hear an Ogg stream successfully.

10.2.6 Broadcast directories

Generally your streaming server host adds your radio station to the Shoutcast/Icecast directory, if you enable the Public
Stream option in Preferences ‣ Live Broadcasting ‣ Stream Settings.

• Shoutcast radio directory: www.shoutcast.com
• Icecast radio directory: dir.xiph.org

Often streaming hosts will run their own directories. Check your host's FAQ to find out. If you want to promote your
streaming radio station even more, register at services like streamfinder.com. An overview of different internet radio
directories is available at shoutcheap.com
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10.3 Troubleshooting

• If you have trouble connecting to your streaming server, check the configuration in the Mixxx preferences - Setting
up live broadcasting.

• You may have selected the Ogg Vorbis format that is unsupported by Shoutcast servers.
• You may need to check your firewall settings. Both Icecast and Shoutcast use two ports. If you are streaming on a
port (for example, port 8000) then you need to open up the next port (port 8001) as well.

• You may need to configure port forwarding if you are behind a router or your router will block requests to your
streaming port (for example, port 8000)
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CHAPTER11

Efek

Mixxx has a powerful sound effects system. Understanding how it works can open you up to a wide variety of mixing
techniques.

11.1 Effect Units

Mixxx has 4 effect units. By default, only 2 of them are shown. The other 2 effect units can be shown by toggling the
setting in the skin settings menu.

Figure1: An effect unit

Each effect unit can load up to 3 effects in a chain. These effects are processed one after the other in series. You will hear
different sounds depending on the order of effects within the chain. Each effect in the chain has its own button to toggle
it on and off.
Effect units can process sound from:

• decks
• microphones
• auxiliary inputs
• the master mix
• the PFL (headphone) mix
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• left/middle/right crossfader buses
The buttons to route effect units to decks, microphones, and auxiliary inputs are located in the deck, microphone, and
auxiliary sections of the skin. The buttons for routing other inputs to effect units are in different locations depending on
the skin.

Figure2: The effect unit buttons located in the deck.

If a channel is assigned to multiple effect units, those effect units are chained together. This allows you to chain more
than 3 effects at a time.
To route deck 1 to effect unit 1, click the FX1 button on deck 1 to turn it on. To route deck 2 to effect unit 2, click the
FX2 button on deck 2, and so on. It's also possible to route a single deck to multiple effect units, or multiple decks to a
single effect unit.
The mix knob adjusts the mix between the dry signal (input to the unit) and the wet signal (output of the last effect in the
unit). It changes the level of all 3 effects in the unit together. Refer to the Effect Unit Mix Modes section below for details.
Effects are processed after the deck faders and crossfader. This allows effects like Echo and Reverb to continue outputting
sound after their input has been cut off by lowering the fader. Unlike other DJ software and hardware, effects can also
be heard in headphones even though they are processed after the faders for the master output. Refer to the Effects In
Headphones section below for details.
Note that equalizer and filter effects create a phase shift. If the mix knob is anywhere in the middle between dry and
wet and any of these effects are enabled in the unit, there will be comb filtering which is probably not desired. For more
background information, read Equalizers and Phase Shift.

11.2 Effect Parameters & Metaknobs

Every effect within an Effect Unit has its own set of parameters. By default, these are hidden. Instead, there is a single
knob called a "metaknob" for each effect which is linked to the different parameters. The metaknob allows you to easily
control the effects in a unit without having to manipulate every parameter individually.
If you want more detailed control of effects, press the expansion button on the effect unit to reveal the effect parameters:
You can customize how the metaknob is linked to the parameters by clicking the buttons below the parameter knobs. The
button under the parameter name controls the metaknob link mode:

• Inactive: parameter not linked
• Active: parameter moves with metaknob
• Left side active: parameter moves with left half of metaknob turn
• Right side active: parameter moves with right half of metaknob turn
• Left and right side active: parameter moves across range with half of metaknob turn and back with the other half

The button below the metaknob link button inverts the parameter's relationship to the metaknob.
For information about specific effects and their parameters, hover your mouse over them to show the tooltip. If you do
not see tooltips, check that you have them enabled for the skin in Preferences ‣ Interface.
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Figure3: An effect unit with parameters showing

Effects (except for Reverb) that have a length of time as a parameter are synchronized to the tempo of decks.

11.3 Effect Unit Mix Modes

The effect unit mix knob controls the level of all 3 effects in the unit together. It can be toggled between two different
modes with the mix mode button adjacent to it.

Figure4: An effect unit in Dry/Wet mode

In the default Dry/Wet mode, the mix knob crossfades between the dry signal (input to the first effect in the unit) and the
wet signal (output of the last effect in the unit). When the knob is fully left, no sound will be heard from the effect unit.
When the knob is fully right, only the output of the effect unit will be heard without any of the dry input signal.

Figure5: An effect unit in Dry+Wet mode

In Dry+Wet mode, the dry signal is always at full volume. The mix knob controls how much of the wet signal is added
to the dry signal. A useful example for Dry+Wet mode is loading a filter or equalizer effect before the Echo effect.
With this setup, the filter or equalizer can remove bass frequencies from the echoed signal without removing them from
the unechoed signal. If the effect unit is switched to Dry/Wet mode with the same effects in the same order, the bass
frequencies will be taken out of the echoed signal, but they will also be removed from the unechoed signal.
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11.4 Effects In Headphones

To preview how a track will sound with effects before you mix in the track, simply assign the deck to an effect unit and
enable the headphone button for the deck. Note that this will increase CPU compared to assigning an effect unit to a
deck without the headphone button enabled. This is because effects are processed in parallel for the headphone output
(prefader) and master output (postfader).
Effects can also be previewed in headphones on decks that are playing to the audience, but this requires a few more steps:

1. Disable the effect unit for the deck
2. Enable the headphone button for the deck
3. Enable the headphone button for the effect unit
4. Enable effects and adjust their metaknobs and parameters for how you want the effects to sound.
5. When you are ready to mix in the effect, turn the mix knob fully left (dry)
6. Enable the effect unit for the deck
7. Turn the mix knob right so the effects are heard in the master output
8. Disable the headphone button for the effect unit so you do not forget to turn it off later

11.5 Controller Effects Mapping

This section describes how to use the standard Mixxx mapping for effects sections on controllers with the typical layout
of 4 knobs (or 3 knobs + 1 encoder) and 4 buttons for effects. It allows you to switch between controlling all 3 effects of
a chain or controlling each parameter of one effect.
By default, 3 knobs are used for controlling effect metaknobs and the buttons under them toggle each effect on/off. To
temporarily toggle an effect on/off, press and hold an effect enable button. The 4th knob is used for the mix (dry/wet)
knob of the whole chain. On controllers designed for Serato, the Beats encoder is used as the mix knob.
The button next to the mix knob is used for focusing effects. On controllers designed for Serato, this button is labeled
Tap. While holding this button pressed, the enable buttons for each effect switch to choosing which effect is focused.
When an effect is focused:

• the knobs switch to controlling the first 3 parameters of that effect instead of the metaknobs of each effect in the
chain;

• the buttons switch to controlling the first 3 button parameters of the effect; and
The LED of the focus button indicates whether any effect is focused. When its LED is on, you can hold the button down
to see which effect is focused without having to look at the computer screen. To unfocus the effect, you can short press the
focus button. The focused effect is remembered, so when you short press the focus button again, the previously focused
effect will be refocused (it is not remembered when you shut down Mixxx though).
Alternatively, if you want to keep all the parameters showing on screen, you can press and hold the focus button, then
press the button of the focused effect to unfocus it. Showing all the parameters without having an effect focused is helpful
for experimenting with different ways of linking parameters to the metaknob.
When the focus button is pressed with shift, it toggles the Effect Unit between controlling different Effect Units in Mixxx.
Typically this is used to toggle between Effect Units 1 & 3 or 2 & 4, like deck toggle buttons.
To load different effects, hold shift and turn the knob for an effect.
To load chain presets 1-4, press the buttons with shift (new in Mixxx 2.4).
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CHAPTER12

DJing With Mixxx

Mixxx was designed to be easy to learn for both novice and experienced DJs.
This part of the manual provides you with directions for using Mixxx's features to create your own mixes.

12.1 Setting Your Levels Properly (Gain Staging)

Setting your levels properly, also known as gain staging, is essential for getting the best sound quality out of the
equipment you are using. At every link in your signal chain, from Mixxx's channel gains to the power amplifier, the
level should be well above the noise floor, but lower than the maximum level before the signal clips. The level meters
should mostly be around the top of their green region. The level meter pictured to the left shows where Mixxx's level
meters should average at the loudest parts of tracks. The average level should not be in the yellow region. Use the
yellow region to leave headroom, or available level above the average before the signal clips. The loudest parts of the
music (the transients) should briefly go into the yellow region.

Figure1: A waveform at a good level. Note that the example waveforms in this section were made by adjusting the visual
gain of the waveform display in Mixxx to illustrate the concepts. Adjusting the visual gain of the waveform display does
not change the level of the audio.

If a level meter is in its red region, the signal is clipping and the gain should be turned down. Some equipment
doesn't have a level meter and only has an LED that turns on when the signal clips. Clipping means that the peaks

of the waveform are flattened because the equipment has reached the maximum level that it can amplify the signal to.
This distorts sound in an unpleasant way and can damage equipment by driving it with more power than it is designed to
handle. Increasing the gain past the point where clipping begins (further into the red on a meter) will distort the signal
more. If you want to make the sound louder when every part of the signal chain is at its maximum without clipping, use
more speakers or use speakers that are more sensitive and convert electrical energy into acoustic energy more efficiently.
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Figure2: A clipping waveform

On the other hand, the signal should not be too low. This is because every audio device generates a little noise at a
level referred to as its noise floor. Additionally, analog signals pick up noise as they travel along wires. The signal
measured by the meter on the left is relatively close to the noise floor. When a device is turned up, the noise floor
does not go up; only the signal does. However, every time the signal is amplified by the gain of another piece of
equipment, both the noise and the signal from previous devices in the signal chain are amplified. For example, if your
sound card is turned down and you turn the gain up on your mixer to compensate, the signal-to-noise ratio (SNR)
of the sound card output will be low and the mixer's gain will amplify the signal and the noise from the sound card,
plus the noise picked up along the wire. The end result will have more noise than if the output of the sound card was
turned up before the signal reached the mixer and the mixer's gain did not have to be turned up.

Figure3: A waveform that is too close to the noise floor

Catatan: To adjust the output volume of a sound system while maintaining a high signal-to-noise ratio, the gain should be adjusted
as close to the speakers as possible. Refer to the Gain Knob section for details.

12.2 Beatmatching and Mixing

Beatmatching is the process of adjusting the playback rate of a track so that it matches the tempo of another track.
Beatmatching also involves adjusting the phase of the beats in a track so that they are aligned with the beats in the other
track. Matching the tempo and aligning the beats are the two things a DJ must do to beatmatch.
Mixxx can match the tempo and align the beats for you but this requires an accurately detected BPM value and a correct
beat grid for both tracks. To enable this feature, tap the SYNC button. To beatmatch manually, the tempo of the two tracks
must be synchronized by adjusting the playback rate sliders. You can adjust the phase of the beats by right-clicking and
dragging on either waveform display to temporarily speed up or slow down one of the tracks until the beats are aligned.
The temporary pitch bend buttons can also be used to momentarily adjust the playback rate, allowing you to “shuffle” the
beats in a track forwards or backwards, so they can be aligned with another track. See the chapter Sync and Rate Controls.
Two tracks are beatmatched once their tempos are matched and their beats are aligned. A “perfect” beatmatch is nearly
impossible - there will always be a tiny difference in the playback rates. A keen DJ will keep his or her ears open and
listen for the beats drifting out of alignment. This has a distinct “double bass kick” sound which is often preceded by the
kick weakening in intensity as the two kicks drift out of phase. When this happens, the beats can be realigned by simply
tapping one of the temporary pitch bend buttons a few times in the appropriate direction.
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12.3 Master Sync

Master Sync is an intelligent assistant that allows you to leave the beatmatching to Mixxx so you can focus on track
selection, effects manipulation, looping, 4 deck mixing, and other advanced DJing techniques.
To activate Master Sync on a deck, push and hold (or click and hold) the SYNC button. You'll know Master Sync is on
because the sync button will remain lit. Changing the rate of any deck that has Sync lit will change the rates of all other
decks that also have the Sync button lit. There is no need to set specific decks to be a master or followers. You can play,
stop, eject, load, and queue any track with master sync and it won't interrupt the playback of the other decks. However,
changing the rate of a stopped deck will change the rate of playing decks.
Master Sync will also notice if one of your tracks is double the BPM of another track and match them correctly. So if
you want to mix a 140 BPM drum & bass track with a 70 bpm dubstep track, Master Sync will make sure they are lined
up properly.

Petunjuk: Usually, Master Sync will only make sure the rate sliders are set correctly. If you also want to make sure
your beats are perfectly in sync, turn on the QUANTIZE button. When activated, Quantize will ensure that the beats are
perfectly lined up as well.

12.4 Harmonic Mixing

Harmonic mixing is a technique to mix songs with matching melodies and harmonies. To learn more about harmonic
mixing you might want to check out the mixshare archive.
Mixxx has two features to help you with harmonic mixing. The first is a key lock. When it is active changing the speed of
a track won't affect the key. To enable key lock, click the key lock button in the Deck Options Button Grid. The second is
that Mixxx can automatically detect the key of a track and will display it in the library and the decks. The notation which
is used to display a key can be changed in Key Detection Preferences.

12.5 Recording Your Mix

With the integrated recording feature you can record your mix as an audio file and listen to it later, distribute it as a
Podcast or burn it to CD.
By default, Mixxx records the Master output. Alternatively, Mixxx can record the output of an external mixer if you have
an audio interface configured for the Record/Broadcast input in Preferences ‣ Sound Hardware. Refer to Recording And
Broadcasting With An External Hardware Mixer for details.
Mixxx can record your mix in various audio formats and quality settings. You can split your recordings, generate cue
files, choose a custom recording directory and even set your own metadata. By default, Mixxx saves your recordings as
losslessWAV files to a Mixxx/Recordings sub-folder in the Mixxx music directory. Before you start recording, we
recommend that you adjust the settings in Preferences ‣ Recording.
If you click on the Recordings icon in the sidebar of the Mixxx library, the track table to the right displays the content of
your recordings directory. New recordings are automatically saved to this directory as well as CUE files if you choose to
create them in the preferences.

Petunjuk: Recording your mixes and listening to them later to critique yourself is a great tool for improving your DJing
skills. Sending your mixes to other DJs for feedback can also be helpful.
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Figure4: Mixxx library - Recordings view

12.5.1 Record your mix to disk

Click on the recording icon on top of the application window to start, and stop the recording session. The duration of the
running recording is displayed next to the icon.

Catatan: The recording widget might not be available in some skins.

Alternatively:
• Click on the Recordings icon in the sidebar to switch to the Recordings view
• Click the Start Recording button or click Options ‣ Record Mix in the menu on top of the Mixxx application window.
• The display above the track table shows how much data has already been recorded, as well as the duration of the
recording.

• Perform your mix
• Click the Stop Recording button to stop the recording when the mix has finished.

Petunjuk: You can instantly play your recording as a track in Mixxx. Simply drag-and-drop the track to a deck.

12.6 Intro and Outro Cues

Intro/Outro cues are used to mix in and out of tracks and they can also be used with Auto DJ to mix in and out at those
points. Unlike hotcues, they do not mark only one point. The into and outro are sections and each section is defined by
two points.
Mixxx detects where the first and last sounds are when analyzing a track making it easy to stop playing silent parts at the
beginning and at the end of the track. The analyzer places the intro start point at the first sound and the outro end point
at the last sound. The first and last sounds are determined by the first time the signal rises above -60 dBFS and the last
time it goes below -60 dBFS.
You can decide where to place the intro end and the outro start points. Marking the whole intro and outro allows Mixxx
to calculate how long each section is and show it on the overview waveform. This information can help you know when to
press play on the next track. Auto DJ can also use this information to line up tracks and determine how long to crossfade.
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Figure5: Intro start and outro end cues placed at the first and last sound of a track respectively by the analyzer

Figure6: Intro end and outro start markers placed on the track alongside the intro start and the outro end markers to make
sections
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12.6.1 Mixing With Intro & Outro Cues

You can line up the ends of the intro and outro so the energy of the new song picks up right as the old track ends.

Figure7: Intro and outro end markers aligned showing on the waveform

If the intro and outro are short enough to fit on the waveform at the same time, you can simply watch the waveforms
and press play when the markers align. Otherwise, you can watch the time remaining on the deck and hover your mouse
cursor over the outro end line on the overview waveform. Mixxx will show you how much time is left until that point.
When that time equals the length of the intro, press play to precisely line up the end of the intro. If you have changed the
tempo of the track, the time remaining scales to show the real time remaining at the adjusted tempo.

Alternatively, you can line up the start of the intro & outro. In this case, watch the scrolling waveform when the outro
start point is coming up on the old track. Then, press play on the new track when the old track reaches the outro start.

Catatan: There are no rules on which method should be used. The method you decide to use is an artistic
judgement based on the musical content of each track, what the vibe of the crowd is at that moment, and
what you want to do with the mix.

If you do not have the intro end and outro start points marked when loading a track, you can find and mark these in
headphones before you mix in the track. Then seek back to the intro start to get the track ready. If you don't have time to
find the outro end point before mixing in the track, you can use the deck cloning feature to drag and drop to a new deck,
then seek ahead on the new deck and listen in headphones to mark the outro start point. If you don't have time to do that
either, you can right click on the overview waveform where you think the outro starts. Then look for how far that is from
the end of the track to compare it to the length of the intro of the next track.

Figure8: Here the outro is approximately 30 seconds long. However, the analyzer placed the outro end point before the
end of the track, so the outro is actually a little bit shorter than 30 seconds. Without marking the outro start point, you
would have to do some math in your head to find exactly how long the outro is.
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12.7 Auto DJ

Figure9: Mixxx library - Auto DJ view

Auto DJ allows you to automatically load tracks from the Auto DJ playlist when the current track is nearly finished, and
crossfade into it. See Auto DJ - Automate your mix.
Auto DJ does not take into account the volume of each track, nor the frequency content, nor the rhythms, so it's not
intended to be a replacement for a human DJ. However, it is good enough to give a human DJ a break without a major
disruption to the mix.

12.7.1 Loading tracks into Auto DJ

To play tracks automatically, they must first be loaded into the Auto DJ playlist. The Auto DJ playlist is empty by default.

Figure10: Mixxx library - Adding a playlist to Auto DJ

There are several ways to load tracks into the Auto DJ playlist:
• Select single or multiple tracks from the library, a regular playlist or crate and drag them to the Auto DJ icon on
the left.
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• Select a regular playlist or crate, right-click with the mouse and select Add to Auto DJ from the mouse menu. This
adds all tracks to Auto DJ.

• While in the Auto DJ view of the library, drag tracks from external file managers to the Auto DJ icon in the sidebar
or to the Auto DJ track table on the right.

12.7.2 Automatically adding tracks from crates

Instead of inserting the contents of the crates directly into the Auto DJ playlist, Auto DJ crates are associated crates that
become a source of random track selections.

• Add a crate to the Auto DJ track sources: Expand the Auto DJ item in the sidebar, and right-click on the Crates
sub-item. Select one of the existing crates from the list. This makes the content of the crate available for random
selection into the Auto DJ queue for automatic mixing. The name of the crate is now listed as sub-item below.
If you do not have any crates available for selection in the list, go and create a crate first and add some tracks, see
Crates - Organizing tracks into collections.

• Manually add tracks from track sources to Auto DJ: Click the Auto DJ item in the sidebar and switch to the
Auto DJ view of the library. Click the Add random button to add one track at the time from Auto DJ track sources
to the bottom of the Auto DJ playlist.

Catatan: If you did not set any crates as an Auto DJ track source, clicking the Add Random button will add a
randomly selected track from the whole library instead.

• Automatically add tracks from track sources to Auto DJ: Mixxx can randomly add tracks to the Auto DJ
playlist from track sources as soon as a specified minimum number of tracks remain. Select Preferences ‣ Auto DJ
‣ Enable random track addition to queue ‣ On. SetMinimum allowed tracks before addition to change the minimum
number of tracks after which random tracks may be added.

Catatan: If you did not set any crates as an Auto DJ track source, tracks are selected from the whole library
instead.

• Remove a crate from the Auto DJ track sources: Expand the Auto DJ item in the sidebar, and right-click on
one of the crates listed below the Crates sub-item. Select Remove Crate as Track Source to remove the crate from
the Auto DJ track sources.

12.7.3 Playing tracks in Auto DJ

Now that you have loaded tracks into the Auto DJ playlist, you can activate Auto DJ as follows:
• Click on the Auto DJ icon in the sidebar to switch to the Auto DJ view of the library.
• Click the Enable Auto DJ button.
• The first tracks from your list are loaded into the decks and the playback starts.
• Mixxx will continue to automatically mix until the Auto DJ playlist is empty.
• Click the Disable Auto DJ button to stop the automatic mixing

Petunjuk: You can add a track to the end of the Auto DJ playlist once it is played instead of removing it. Set Preferences
‣ Auto DJ ‣ Re-queue tracks after playback ‣ On.
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12.7.4 Auto DJ Mix Modes

Auto DJ has several modes it can use to mix tracks:
• Full Intro + Outro
• Fade At Outro Start
• Full Track
• Skip Silence

The Full Intro + Outro and Fade At Outro Start modes both use the intro and outro cues but the Full Track and Skip
Silence cues do not.

Full Intro + Outro and Fade At Outro Start

The Full Intro + Outro and Fade At Outro start Auto DJ modes use the intro & outro cues to determine how long to
crossfade and how to align the tracks in time. In both modes, Auto DJ compares the duration of the outro of the old track
and the intro of the new track. Auto DJ picks the time of the shorter section as the crossfade time.
In both modes, if the outro is shorter than the intro, Auto DJ will align the start of the outro with the start of the intro.

Figure11: Intro and outro start markers aligned by Auto DJ

The two modes work differently when the outro is longer than the intro.
Full Intro + Outro Mode The full length of both the intro and the outro are always played. When the outro is longer

than the intro, Auto DJ aligns the end of the intro and outro by starting the next track during the outro of the
previous track. This mode is the most likely to sound good with the widest variety of tracks. Therefore, it is the
default mode.

Figure12: Intro and outro start cues aligned by Auto DJ in Full Intro + Outro mode

Fade At Outro Start Auto DJ always aligns the start of the intro and outro. When the outro is longer than the intro,
Auto DJ cuts off the end of the outro. This can be helpful if you want to prevent the energy of the mix from
declining during a long outro. However, the transition may sound abrupt if the intro is short.
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Figure13: Intro and outro start cues aligned by Auto DJ in Fade At Outro mode

Full Track and Skip Silence

The Full Track and Skip Silence Auto DJ modes do not use the intro and outro cues. They crossfade tracks over a number
of seconds that you specify in the box next to the mode selection menu. The Full Track mode plays the entire length of
every file. The Skip Silence mode works the same way but automatically cuts out silence at the beginning and ends of
tracks (defined as when the signal first goes above or below -60 dBFS).

Petunjuk: If you still want to use Auto DJ like a normal music player application, use one of these modes with a
transition time of 0 seconds.
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CHAPTER13

Preferences

Mixxx has many options to customize in Options ‣ Preferences.

13.1 Sound Hardware

Figure1: Mixxx Sound Hardware Preferences

To achieve the best performance with Mixxx it is essential to configure your audio buffer, sample rate, and audio API.
These three factors largely determine Mixxx's responsiveness and reliability. The optimal settings will vary based on your
computer and hardware quality.
For information about the different input and output options, refer toConfiguring sound input and output. TheDJHardware
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chapter explains different types of DJ hardware and how to set them up with the input and output options. If you are
using a microphone, refer to the Using Microphones chapter.

13.1.1 Audio Buffer

The audio buffer is the amount of audio in milliseconds that Mixxx processes at a time. This is a major factor that
determines the latency between changing controls in Mixxx such as moving the crossfader or pressing the play button
and hearing the audio change. For example, with an audio buffer of 23 ms, it will take approximately 23 milliseconds
for Mixxx to stop the audio after you toggle the play button. The actual latency will be longer depending on a variety of
factors.
The audio buffer setting determines how quickly your operating system expects Mixxx to react. A smaller audio buffer
means Mixxx will be more responsive, but requires a faster CPU and quality audio interface. Setting your audio buffer too
small may be too much for your computer and audio interface to handle. In this situation, Mixxx playback will be choppy
and very clearly distorted as your system will not be able to keep up with how frequently Mixxx is trying to process audio.
It is recommended to set your audio buffer as small as your system can handle reliably without glitches. Experiment with
different audio buffer sizes to find what works for your system.
An audio buffer between 23-64 ms is acceptable if you are using Mixxx with a keyboard/mouse or a controller. An audio
buffer below 10 ms is recommended when vinyl control is used because Mixxx will feel unresponsive otherwise.
The Adjusting Audio Latency page on the Mixxx Wiki has tips for different operating systems that may help you use a
smaller audio buffer reliably.

Peringatan: Your system may glitch only occasionally if you have your audio buffer set a little too low. This will
happen at unpredictable times and you may not notice if you are only doing brief tests of each audio buffer size. When
you think you have found a good buffer size for your system, play withMixxx for at least a half hour before performing
to ensure no glitches happen.

13.1.2 Sample Rate

The sample rate setting in Mixxx controls how many samples (chunks of audio) per second are produced by Mixxx. This
determines the maximum frequency in Mixxx's signal, which is half the sample rate. Humans can only hear up to 20
kHz, so there is generally no need to use more than a 44.1 kHz (44100 Hz) sample rate for playback. Most music is
published with a 44100 Hz sample rate, and playing music in a different sample rate than the audio file slightly reduces
sound quality.

Peringatan: A sample rate of 96 kHz gives your computer less than half the time to as to do the same processing.
Increasing the sample rate will increase CPU usage and likely raise the minimum audio buffer size you can use reliably.

13.1.3 Sound API

The Sound API that Mixxx uses is the method by which Mixxx talks to your operating system in order to deliver audio to
your audio interface. Your choice of Sound API can drastically affect Mixxx's performance on your computer. Therefore
it is important to take care to choose the best Sound API available to you.
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Windows

The following Sound APIs are available on Windows:
• ASIO: Good
• WDM-KS: Good
• WASAPI: Acceptable
• DirectSound: Poor
• MME: Poor

It is best to use the ASIO Sound API that bypassses the sound processing of the Windows kernel. Using ASIO requires
a driver for your audio interface from the manufacturer. Check the manufacturer's website to see if a driver download is
available. Soundcards designed for musicians almost always have an ASIO driver available, but audio interfaces built into
computers and very cheap audio interfaces typically do not have an ASIO driver. If there is no ASIO driver available for
your audio interface, use the WDM-KS API. There is generally no advantage to using ASIO4ALL, a wrapper around the
WDM-KS API.

GNU/Linux

The following Sound APIs are available on GNU/Linux:
• ALSA: Good
• JACK: Good
• OSS: Acceptable

ALSA is the simplest sound API to configure. Using ALSA will prevent any other programs from using the audio
interface(s) that Mixxx is using.
JACK allows you to route audio between JACK-compatible applications in flexible ways and output sound from multiple
programs at the same time. However, JACK can be complicated to set up. Unless you will be connecting Mixxx to other
JACK-compatible applications, JACK offers no advantages over ALSA. To use JACK, start the JACK daemon before
running Mixxx. Otherwise JACK will not appear as a Sound API in the preferences.
Most modern GNU/Linux distributions use PulseAudio by default. When launched from a GUI menu entry or icon,
Mixxx suspends PulseAudio while it is running so that Mixxx can use ALSA directly. Like JACK, PulseAudio allows
multiple programs to access one audio interface, but PulseAudio and JACK have opposite design goals. PulseAudio is
designed to make ordinary computer usage such as watching videos online and listening to music easy whereas JACK
is designed for demanding low latency audio programs like Mixxx. It can be difficult to setup JACK and PulseAudio to
work well together. So, unless you already use JACK, it is easiest to let Mixxx suspend PulseAudio and use ALSA.
If the PulseAudio plugin for alsalibs is installed on GNU/Linux, you can choose the virtual device pulse. This allows
Mixxx to share the default system audio interface with other media players. This only works if you start Mixxx without
pasuspender, which you can do by running mixxx from a console rather than clicking the launcher icon in a menu or on
your desktop. Since the sound stream is routed from ALSA to Pulse and back to ALSA, this adds an additional latency
of ~2 x the selected audio buffer size.
OSS is an Sound API that predates ALSA. Few modern audio interfaces have OSS drivers.
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macOS

CoreAudio is the only Sound API on macOS.

13.1.4 Other Sound Hardware options

• Multi-Soundcard Synchronization: Mixxx is able to use two or more audio interface at a time, each with its own
clock. When multiple audio interfaces are in use, the Mixxx engine is driven by the Master audio interface. Here
you can select the synchronization used for the other audio interfaces to avoid buffer overflows or underflows.

• Keylock/Pitch-Bending Engine: This allows you to select the engine used for independent tempo and pitch
changes (e.g. key lock). Use Soundtouch on lower power machines (such as netbooks) or if you experience buffer
underflows while using key lock.

• Master Mix: You may disable the master mix to reduce Mixxx's CPU usage if you do not use the Master output,
recording or live broadcasting.

• Master Output Mode: In Mono mode, the left and right channel are combined into a mono signal which is passed
to both channels of your master audio interface. This is useful for setups where the audience cannot hear your mix
in stereo because of speaker placement or playing in a space with lots of reverberation.

• Buffer Underflow Count: Underflows (data is not available when needed) indicate that some of the subsystems in
Mixxx can't keep up with real-time deadlines imposed by the current audio buffer size. This is useful to tune the
latency settings. If the counter increases, then increase your audio buffer size, decrease the sample rate setting or
change the sound API setting if available.

13.2 Pustaka

13.2.1 Changing music directories

You can manually add, relink, and remove Mixxx music directories in Preferences ‣ Library.
Add a new music directory Mixxx handles multiple music library folders. Click Add to browse to a directory where

your music is stored. Mixxx will watch this directory and its subdirectories for new tracks.
If you add a directory that is already in your library, or you are currently rescanning your library, the operation is
canceled.
Directories can also be added from the Computer sidebar item inside the library.

Relink a existing music directory If an existing music directory is moved or renamed, Mixxx doesn't know where to
find the audio files in it. The tracks will still show in library but they can't be loaded on decks and the tracks will
become missing after the library is rescanned.
To relink the music directory, go to Preferences ‣ Library, click Relink to select the music directory in its new
location. This will re-establish the links to the audio files in the Mixxx library.
Click Library ‣ Rescan Library, this will update the tracks and cause them to show up again in the library, check
the location column in the library and you should see that it now points to the new music directory.
The playlists, crates, history and all track data like cue points, rating, comments etc. are preserved after relinking
the library, the tracks are also not re-analyzed as the cached analysis is reused. You can confirm this by checking
the Key and BPM columns to see if there is a key and BPM for every track.

Catatan: It is recommended to take a backup of your Mixxx configuration files before moving or renaming music
directories used in Mixxx. The location of Mixxx configuration files vary based on the operating system:
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• Windows: %USERPROFILE%\Local Settings\Application Data\Mixxx\

• macOS: Library/Application Support/Mixxx

• Linux: The configuration files are found in the .mixxx folder in your home directory.

Remove a music directory Click Remove, and Mixxx will no longer watch a directory and its subdirectories for new
tracks, and asks what would you like to do with the tracks from these directories.

• Select Hide Tracks to hide all tracks from this directory and subdirectories.
• Select Delete Track Metadata to delete all metadata for these tracks from Mixxx permanently
• Select Leave Tracks Unchanged to leave the tracks unchanged in your library.

Hiding tracks saves their metadata in case you re-add them in the future.
Metadata means all track details (artist, title, playcount, etc.) as well as beatgrids, hotcues, and loops. This choice
only affects the Mixxx library. No files on disk will be changed or deleted.

Petunjuk: When changing music directories, you might want to run a library rescan afterwards. Select Library ‣ Rescan
Library in the menu.

13.3 Colors

13.3.1 Selecting Palettes and Default Colors

Track/Hotcue Palette It is possible to assign colors to tracks and hotcues to highlight them. Mixxx offers a selection of
different palettes that you can choose colors from.
You can also make your own palette by clicking the Edit button next to the palette name. This will open a the palette
editor.

Default Hotcue Color It is possible to either select a single color from the current hotcue palette that will be assigned to
all newly created hotcue colors, or select the By hotcue number option. The latter will automatically assign a color
from the palette to new hotcues based on the hotcue number.

13.3.2 Editing Palettes

The palette editor allows you add, modify, reorder and remove colors in a color palette and save it under a new name.
You can also delete custom palettes.
To modify a color, double-click it to open the color picker window.
When editing the hotcue palette, the palette editor also allows assigning a specific default color to a hotcue number. This
setting is honored when Hotcue default color is set to By hotcue number.
That makes it possible to assign just a few distinct colors to your hotcues automatically, but still have more colors available
in the palette in case you want to override the color manually.
For example, if you have a color palette consisting of 4 colors, and you configure the palette to assign the first color to
hotcue 1 and the third color to hotcue 2, then hotcue 1 will use the first color and hotcue 2 will be assigned the third color.
The colors will repeat when setting a hotcue with a number greater than those used in the palette. In the example above,
hotcue 3 will use the first color and hotcue 4 the second color, and so on.
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You can also assign the same color to more than one hotcue. For example by separating the hotcue numbers with a comma
(“2, 4, 7”), expressing a range of numbers (“1 - 3”) or any combination of that (“6, 1 - 3, 7”).
If no color in the palette has a hotcue number assigned to it, new hotcues will use the color at the same index from the
palette (i.e. hotcue 1 will be assigned the first color in the palette, hotcue 2 uses the second color in the palette, etc.).

13.3.3 Replacing Hotcue Colors

Sometimes it's necessary to bulk replace colors of existing hotcues in your library. Instead of changing the color of every
single hotcue manually, you can Replace to open the cue color replace dialog.
In addition to selecting the new color, you may set conditions that determine which hotcues the new color will be assigned
to. If you tick both checkboxes, the new color will only applied if both conditions match.

13.4 Beat Detection

Mixxx uses an ultra-precise BPM and beat detector. Manual adjustments are redundant in many cases because Mixxx
knows where the beats are.
BPM and beat detection is a complex operation. Depending on your computer and the track's bitrate and duration this
may take some time. By default Mixxx analyzes the complete track. To accelerate beat detection on slower computers, a
“Fast Analysis” option is available. If enabled, the BPM is computed by analyzing the first minute of the track. In most
cases this does not affect the beat detection negatively because most of today's dance music is written in a 4/4 signature
with a fixed tempo.

Figure2: Mixxx preferences - BPM settings

The table below summarizes the beat detection settings:
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Option Deskripsi
Enable Fast Analysis If enabled, BPM will be detected by only using the first minute of audio.
Assume constant tempo If enabled, Mixxx assumes that the distances between the beats are constant. If

disabled, the raw beat grid obtained by the analyzer is presented. The latter is ap-
propriate for tracks with variable tempo.

Enable Offset Correction Prevents beat markers from being placed incorrectly.
Re-analyze beats when set-
tings change or beat detection
data is outdated

If enabled, Mixxx over-writes old beat grids from prior versions. Moreover, it will
re-analyze the BPM if your beat detection preferences change or BPM data from 3rd
party programs are present.

13.4.1 Correcting Beat Grids

There may be situations where BPM and beat detection do not result in a proper beat grid.
Typically, the detected BPM is correct but the analyzer has failed to detect the location of the first beat. Consequently,
the beat markers are shifted, i.e. the beat markers are a fixed distance from the true beat. To adjust the beat grid, cue the
track before a real beat and click the Beat-grid Adjust button in the Deck Options Button Grid.
If the detected BPM is not accurate, the corresponding beat grid will also be inaccurate. A deviation of 0.02 BPM units
from the correct BPM will cause beatgrid alignment issues on long tracks (e.g. a club mix). If this happens, your beatgrid
may look aligned for the few minutes but you will notice a slight drift as the song goes on. Finding the correct BPM is
easy in many cases - just follow the note below.

Catatan: If the detected BPM value is not sufficiently accurate but very close to an integer value, try to set the BPM
value manually to the integer.

13.5 Key Detection

Mixxx comes with a high precision musical key detector to help you make smooth mixes by ensuring that your tracks are
musically compatible.

13.5.1 Analyzer Settings

Key detection is a complex operation. Depending on your computer and the track's bitrate and duration this may take
some time. By default Mixxx analyzes the complete track. To accelerate key detection on slower computers, a “Fast
Analysis” option is available. If enabled, the key is computed by analyzing the first minute of the track.
The table below summarizes the Key detection settings:

Option Deskripsi
Enable Fast Analysis If enabled, the key will be detected by using only the first minute of audio.
Re-analyze key when settings change
or Key detection data is outdated

If enabled, Mixxx will re-analyse tracks if you select a different key detection
plugin or the key was generated by a program other than Mixxx.

Key Notation Change the way keys are displayed in the library.
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Figure3: Mixxx preferences - Key settings

13.6 Equalizer

Preferences ‣ Equalizer allows you to setup the equalizers.
• Equalizer Rack: The Equalizer Rack is a special effect rack that is connected to the deck's equalizer and filter
controls.
In this section you can select the equalizers and quick effects that are used with the decks.

• Equalizer Plugin: Here you can select the effect that is used as the mixing EQ in each deck. By default only
built-in equalizers are displayed. Unchecking Only allow EQ knobs to control EQ specific effects allows you to select
any other effect.

• Quick Effect: Here you can select the effect that is controlled by the dedicated filter knob in each deck. By default
only built-in filter effects are selected for all decks, but that can be changed as above.

• High/Low Shelf EQ: This slider sets the crossover frequencies of the mixing EQ. It controls which frequency
range is affected by the low, mid, and high channel EQ knobs. By default the low knob controls the bass and sub
bass range up to 246 Hz. The mid knob controls the mid range up to 2.5 kHz. The remaining treble range is
controlled by the high knob.

• Master EQ: This section allows you to setup an EQ that affects the master output.

13.6.1 Mixing Equalizers

Mixxx offers three types of mixing equalizers with a full kill option. These equalizers are "isolators", adapted from analog
crossover networks. Each EQ is combination of a high shelf filter, a band pass filter, and a low shelf filter. Each EQ type
has a unique sound, so try them out to find out which one you prefer.
The Bessel EQs with Lipshitz and Vanderkooy Mix (LV-Mix) do not alter the sound or take any processing time when
their knobs are in the center position. They activate once you adjust an EQ knob.
The Linkwitz-Riley EQ on the other hand always applies a minimum, natural sounding phase shift to the sound. Their
processing time does not change when you adjust the EQ knobs.
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Figure4: Equalizer Preferences

The following table compares some technical parameters:

Jenis cut roll-off phase shift bit perfect CPU usage
Bessel4 LV-Mix soft -24 db/Oct linear yes low
Bessel8 LV-Mix medium -48 db/Oct linear yes medium
Linkwitz-Riley sharp -48 db/Oct minimum no high

• cut: the frequency response (curve form) at the cross over frequency.
• roll-off: The steepness of the EQ bands.
• linear phase: No phase distortion, all frequencies are processed with the same group delay.
• minimum phase: A natural phase distortion, the group delay changes by the frequency.
• bit perfect: Whether the EQ leaves the original samples untouched when the EQ is at unity.
• CPU usage: Processing time needed to calculate the EQ output.
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Advanced Topics

14.1 Adding support for your MIDI/HID Controller

With several dozens of DJ controllers supported out-of-the-box, Mixxx gives you comprehensive hardware control for
your DJ mixes, see Using MIDI/HID Controllers.
Support for additional devices can be added toMixxx by creating a newmapping file. This file tellsMixxx how to translate,
or map, MIDI/HID messages from a controller into commands that Mixxx understands.
You can download and share custom controller mappings in the Mixxx User customizations forums.
For a list of controls that can be used in a controller mapping, see Mixxx Controls.

14.1.1 Controller Wizard

By far, the easiest way to create a new MIDI mapping is by using the Controller Wizard.
1. Connect your controller(s) to your computer
2. Start Mixxx
3. Go to Preferences ‣ Controllers
4. Select your device from the list of available devices on the left, and the right pane will change
5. Activate the Enabled checkbox
6. Click on Learning Wizard to open the selection dialog
7. Click any control in the Mixxx GUI
8. Alternatively, click the Choose Control button and choose one from the selection list
9. Push Learn and then move a control or push a button on your controller to map it. You can also move a control

without pushing the Learn button if you are learning many controls.
10. If you are learning a button, just push it once. If you are learning a knob or a slider, try to move it throughout its

range.
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Figure1: Mixxx Controller Wizard - Mapping a control

11. After Mixxx detects the control, you may click Learn Another or you can click on another button in the Mixxx GUI
to learn another control.

12. When you are finished mapping controls, click Done
There are also some advanced options in the Midi Wizard you may need to use:

• Soft Takeover: Use this option for knobs or sliders to avoid sudden jumps in when the knob in the GUI doesn't
match the physical knob. If you select this option, you won't be able to perform super-fast motions as easily.
(Recommended off)

• Invert: Use this option for controls that you want to work backwards from how they were detected.
• Switch Mode: Use this option on controllers that have controls that act like switches and emit one value on the first
press, and a different value on the next press. (Think an actual hardware toggle switch, or a button that lights up on
the first press and turns off on the second press).

• Jog Wheel / Select Knob: Use this for knobs that don't have a beginning or an end, but spin continuously.
The Controller wizard saves the new mapping to the following file paths:

• Linux: /home/<username>/.mixxx/controllers
• macOS: /Users/<username>/Library/Containers/org.mixxx.mixxx/Data/Library/
Application Support/Mixxx/controllers

• Windows: %LOCALAPPDATA%\Mixxx\controllers
You can then modify the XML file it creates (or any of the ones that ship with Mixxx) if you'd like
to fine-tune it or add more mappings. For more information, go to https://github.com/mixxxdj/mixxx/wiki/
MIDI-Controller-Mapping-File-Format.
The Controller Wizard works only for MIDI devices. Currently you can't map modifier (shift) keys and platter rotations.
Use MIDI Scripting instead.
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14.1.2 MIDI Scripting

In order to support the advanced features of many MIDI/HID controllers, Mixxx offers what we call MIDI Scripting.
It enables MIDI controls to be mapped to QtScript (aka Javascript/EMCAScript) functions stored in function library files,
freeingMixxx from a one-to-oneMIDI mapping ideology. These user-created functions can then do anything desired with
the MIDI event such as have a single controller button simultaneously affect two or more Mixxx properties (“controls”),
adjust incoming control values to work better with Mixxx (scratching), display a complex LED sequence, or even send
messages to text displays on the controller.
For more information, go to https://github.com/mixxxdj/mixxx/wiki/Midi-Scripting and https://github.com/mixxxdj/
mixxx/wiki/hid_mapping_format.

14.2 Making a Custom Keyboard Mapping

The default keyboard mappings are defined in a text file which can be found at the following location:
• Linux: /usr/local/share/mixxx/keyboard/en_US.kbd.cfg
• macOS: /Applications/Mixxx.app/Contents/Resources/keyboard/en_US.kbd.cfg
• Windows: <Mixxx installation directory>\keyboard\en_US.kbd.cfg

Depending on your system's language settings, Mixxx might use a different file as default, e.g. de_DE.kbd.cfg for
German or es_ES.kbd.cfg for Spanish.
It is not recommended that you modify the system-wide keyboard mapping file because all your changes may be lost if
you uninstall or upgrade Mixxx. Instead, copy the default mapping file to the following location:

• Linux: ~/.mixxx/Custom.kbd.cfg
• macOS: ~/Library/Containers/org.mixxx.mixxx/Data/Library/Application
Support/Mixxx/Custom.kbd.cfg

• Windows: %LOCALAPPDATA%\Mixxx\Custom.kbd.cfg
Then edit this file and save the changes. On the next startup, Mixxx will check if Custom.kbd.cfg is present and
load that file instead of the default mapping file. This has the advantage that you can always revert back to the default
mapping by deleting Custom.kbd.cfg.
For a list of controls that can be used in a keyboard mapping, see Mixxx Controls.
You can download and share custom keyboard mappings in the Mixxx User customizations forums.

14.3 Additional Effects via external Mixer Mode

Mixxx comes with a set of native effects. Additionally, using the external mixer mode you can route each deck directly to
3rd party effect hosts.
The following examples are only intended to encourage experimentation, they are not definitive guidance.
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14.3.1 Effects via AU Lab on macOS

Figure2: The Au Lab routing for external effects on macOS

OnmacOS there is a simple and free way to giveMixxx access to the collection of AU/VST/MAS plugins that are installed
on your system.

• Install the free SoundflowerBed, a system extension for inter-application audio routing.
• Install the free digital audio mixing application AU Lab.

Petunjuk: macOS 10.15 (Catalina) introduces additional restrictions on running non-Apple software. Make sure to
grant permission in System Preferences --> Security & Privacy --> Microphone --> AU Lab.

Alternatively, try Blackhole, a modern virtual audio driver that allows applications to pass audio to other applications with
zero additional latency, and Hosting AU, a free micro-sized DAW that hosts Audio Unit instruments and effect plugins.
In Mixxx

• Go to Preferences ‣ Sound Hardware‣ Output
• Select for Deck 1 the Soundflower 16 device with Channel 1-2
• Select for Deck 2 the Soundflower 16 device with Channel 3-4
• Click the Apply button

In AU Lab
• Click on the + button to create a new configuration
• Add 2 stereo input tracks in the Audio Input Tab
• Add 2 stereo output tracks in the Audio Output Tab
• Click OK
• Change the audio input device to Soundflower 16
• Change the audio output device for example to Built-in Output
• Click Create document
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• In the Output 1 channel, select an effect from the drop-down menu, for example Apple ‣ AUCompressor
The effect should now react if you play a track in Mixxx.

14.3.2 Effects via JACK Rack on GNU/Linux

Figure3: The Jack routing for external effects on GNU/Linux

Use Jack to route each deck directly through JACK Rack effect racks, or for more control you can use Ardour (or another
DAW) using sends for effects. This gives Mixxx access to the extensive collection of LADSPA plugins.
Make sure the correct multichannel audio interface has been selected in Jack (Jack settings visible bottom left). Note that
Mixxx possibly labels its Jack ports as Portaudio.

14.4 Deleting Your Library

The library file is stored in the following places depending on your operating system:
Windows The Mixxx library is stored in the %USERPROFILE%\Local Settings\Application Data\

Mixxx\ folder. To delete your library on Windows, delete the mixxxdb.sqlite file in this folder.
macOS The Mixxx library is stored in the Library/Application Support/Mixxx folder in your home di-

rectory. To delete your library on macOS type the following command into a terminal:

rm ~/Library/Application\ Support/Mixxx/mixxxdb.sqlite

GNU/Linux The Mixxx library is stored in the .mixxx folder in your home directory. To delete your library on
GNU/Linux type the following command into a terminal:
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rm ~/.mixxx/mixxxdb.sqlite

Peringatan: Deleting your library will lose all of your metadata. This includes saved hotcues, loops, comments,
ratings, and other library related metadata. Only delete your library if you are fine with losing these.
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CHAPTER15

Contributing to the Project

Mixxx is a community-driven project involving many DJs worldwide. Without the contributions from these DJs, Mixxx
would not exist, and we're constantly looking for more contributors.
We want to make it as easy as possible for people to get involved in Mixxx development. First off, to be clear you don't
have to be a programmer to contribute.

15.1 As a non-developer

• Donate to Mixxx using Paypal to help support and enhance development.
• Make skins
• Make MIDI mappings for your controller
• Report bugs
• Update our Wiki to make sure the information on it is up to date.
• Translate Mixxx using Transifex
• Answer questions on the Troubleshooting Forum and the Launchpad Answers page
• Help promote Mixxx: If you've got a blog, write an article about Mixxx. Blog about our new releases when they
come out. Any exposure on the web and in print helps our project grow, and is much appreciated.

• Send us some photos of you using Mixxx at a gig!
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15.2 As a software developer

• You don't have to know C++. There are developers who got into Mixxx development while learning C++ along the
way.

• Join our mailing list: mixxx-devel
• Join our Zulip chat.
• Tell us your ideas! Email us, talk on Zulip, file wishlist bugs, or post on the forums.
• Register an account on our development platform Github and fork our code. See Using Git for Mixxx Development
• Join the Mixxx Development Team on Launchpad.
• Get familiar with the code. Pick a bug off of the Easy Bug List
• Get help fixing the bug on Zulip, talk to us about the best way to do it.

Contributing to Mixxx in 3 Easy Steps:
1. Pick a bug off of the Easy Bug List
2. Talk to us on Zulip for help on how to fix it.
3. Fix it! Done! Your name will now be on the Mixxx contributor list.
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CHAPTER16

Appendix

16.1 Keyboard mapping table

Shortcuts let you work more efficiently. This table lists the default keyboard shortcuts for accessing Mixxx with an English
keyboard layout. Depending on your language settings the defaults may be different.

Mixer
Crossfade Left G
Crossfade Right H
Small Crossfade Left Shift + G
Small Crossfade Right Shift + H
Microphone Talkover `

Deck 1 Deck 2
Activate/Disable Effects Unit 5 0
Headphone Cue (Pre-fader listen) T Y
Bass Kill B N
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Playback Deck 1 Deck 2
Load selected track to deck Shift + ← Shift + →
Unload track from deck Alt + Shift + ← Alt + Shift + →
Playback D L
Seek Backwards A J
Reverse Playback Shift + A Shift + J
Seek Forwards S K
Tempo Adjust Down F1 F5
Tempo Adjust Up F2 F6
Small Tempo Adjust Down Shift + F1 Shift + F5
Small Tempo Adjust Up Shift + F2 Shift + F6
Temporary Tempo Adjust Down F3 F7
Temporary Tempo Adjust Up F4 F8
Small Temporary Tempo Adjust Down Shift + F3 Shift + F7
Small Temporary Tempo Adjust Up Shift + F4 Shift + F8
Tempo (BPM) Sync 1 6
BPM Tap Tempo Adjust Shift + ! Shift + ⌃

Cue and Loop Deck 1 Deck 2
Set Cuepoint Shift + D Shift + L
Cue F ;
Cue Go-to-and-stop Shift + F Shift + :
Activate 4 Beat Loop Q U
Halve Beat Loop Size W I
Double Beat Loop Size E O
Set Loop In Point 2 7
Set Loop Out Point (Activates Loop) 3 8
Toggle Loop On/Off 4 9
Set Hot cue 1 Z M
Set Hot cue 2 X ,
Set Hot cue 3 C .
Set Hot cue 4 V /
Clear Hot cue 1 Shift + Z Shift + M
Clear Hot cue 2 Shift + X Shift + <
Clear Hot cue 3 Shift + C Shift + >
Clear Hot cue 4 Shift + V Shift + ?

Vinyl Control Deck 1 Deck 2
Passthrough Ctrl + J Ctrl + K
Vinylcontrol Mode Ctrl + Shift + Y Ctrl + Shift + U
Vinylcontrol Cueing Ctrl + Alt + Y Ctrl + Alt + U
Single Deck Toggle / Swap Decks Ctrl + T
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Library
Maximize the library view Space
Load selected track to deck Shift + ← (Deck 1) Shift + → (Deck 2)
Select all files in current list Ctrl + A
Select group of files in current list Click first item, hold Shift key, click last item
Focus search bar Ctrl + F
Clear search input Ctrl + Back
Exit search and leave focus ESC

Preview Deck
Load Selected Track And Play Alt + Return
Start/Stop Return
Seek Backwards Alt + ←
Seek Forwards Alt + →

Auto DJ
Shuffle Auto DJ playlist Shift + F9
Skip next track in Auto DJ Shift + F10
Fade to next track in Auto DJ Shift + F11
Toggle Auto DJ on/Off Shift + F12

Lihat juga:
Mixxx allows you to customize the keyboard shortcuts. For more information, and to download a keyboard mapping
image, go to Using a Keyboard.

16.2 Application shortcuts

Use these shortcuts to access features available in the menu on top of the application window.

Function Key
File menu
Load Track to Deck 1 Ctrl + O
Load Track to Deck 2 Ctrl + Shift + O
Library menu
Add new Playlist Ctrl + N
Add new Crate Ctrl + Shift + N
View menu
Show Skin Settings Menu Ctrl + 1
Show Microphone Section Ctrl + 2
Show Vinyl Control Section Ctrl + 3
Show Preview Deck Ctrl + 4
Show Cover Art Ctrl + 6
Maximize Library Space
Full Screen (Windows & Linux) F11
Full Screen (macOS) Shift + Command + F
Options menu

berlanjut ke halaman berikutnya
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Table 1 – lanjutan dari halaman sebelumnya
Function Key
Enable Vinyl Control 1 Ctrl + T
Enable Vinyl Control 2 Ctrl + Y
Enable Vinyl Control 3 Ctrl + U
Enable Vinyl Control 4 Ctrl + I
Enable Live Broadcasting Ctrl + L
Record Mix Ctrl + R
Enable Keyboard Shortcuts Ctrl + `
Open Preferences (Windows & Linux) Ctrl + P
Open Preferences (macOS) Ctrl + ,
Exit Mixxx Ctrl + Q
Developer menu
Reload skin Ctrl + Shift + R
Developer Tools Ctrl + Shift + T
Stats: Base Bucket Ctrl + Shift + B
Stats: Experiment Bucket Ctrl + Shift + E
Debugger Enabled Ctrl + Shift + D

Petunjuk: The Ctrl key onWindows&Linux is equivalent to theCommand key onmacOS. TheAlt key onWindows
& Linux is equivalent to the Option key on macOS. Application shortcuts are not customizable.

Catatan: The Developer menu is available if Mixxx is started using the Launching Mixxx from the Command Line.

16.3 Launching Mixxx from the Command Line

To launch Mixxx using the command line:
Windows Locate the folder where Mixxx is installed and copy the file path. You can also obtain the file path by right

clicking on the Mixxx icon and then choosing 'Properties'. Copy the path and paste it in terminal and add \mixxx
at the end - everything should be inside quotes. Press Enter. The entire command will look like this

"C:\Program Files\Mixxx\mixxx"

macOS Similarly, for macOS, the command will be

/Applications/Mixxx.app/Contents/MacOS/mixxx

GNU/ Linux If Mixxx is in your system's search path ($PATH), you can just type

mixxx
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16.3.1 Command line options

Mixxx is designed to be as user-friendly as possible. As such, its command line options are only useful for development
or debugging, as they make these tasks easier. Command line options are case-sensitive.
To launch Mixxx with any of these command line options, simply append the option to the base command for your
operating system. For example, to launch Mixxx in developer mode on Windows, type this in terminal

"C:\Program Files\Mixxx\mixxx" --developer

In addition to these options, it is possible to specify one or more music file(s) on the command line. These will be loaded at
start-up. Each file you specify will be loaded into the next virtual deck. For a list of supported file types, go to Compatible
file formats.

--resourcePath PATH Top-level directory where Mixxx will look for its resource files such as MIDI
mappings, overriding the default installation location.

--pluginPath PATH Top-level directory where Mixxx will look for sound source plugins in addition to
default locations.

--settingsPath PATH Top-level directory where Mixxx will look for user settings files such as the library
database and preferences configuration file.

--controllerDebug Log all controller data Mixxx sends and receives as well as scripts it loads.
--developer Enable developermode. Includes extra logs, stats on performance and theDeveloper

tools menu as well as tooltips and logs useful for skin developers.
--safeMode Disable OpenGL widgets (scrolling waveforms, spinnies) to work around GPU

driver bugs. If Mixxx is crashing on startup, try using this.
• Automatically loads empty waveforms
• Disables spinning vinyl widgets
• Disables synchronization polling
• Doesn't open controllers by default

--locale LOCALE Use a custom locale for loading translations (e.g fr)
-f, --fullScreen Start Mixxx in full-screen mode.
--logLevel LEVEL Set the verbosity of command line logging.

Value Meaning
critical Critical/Fatal only
warning Above + Warnings
info Above + Informational messages
debug Above + Debug/Developer messages
trace Above + Profiling messages

--logFlushLevel LEVEL Set the logging level at which the log buffer is flushed to mixxx.log. LEVEL
is one of the values defined at --logLevel above.

--debugAssertBreak Breaks (SIGINT) Mixxx if a DEBUG_ASSERT evaluates to false.
A debugger can then be used to continue. This disables the
MIXXX_DEBUG_ASSERTIONS_FATAL flag which can otherwise lead to a
time consuming full rebuild.

-h, --help Display this help message and exit
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16.4 Developer tools

To start Mixxx in Developer mode from a custom resource directory with MIDI and HID logging enabled, type the
following line into the terminal and hit return:

./mixxx --controllerDebug --developer --resourcePath res

16.4.1 Experiment modes for rapid development and testing

• Adds a static Experiment class with a tri-state mode flag that indicates whether the experiment mode is OFF, BASE,
or EXPERIMENT.

• Adds Developer ‣ Stats:Experiment Bucket and Developer ‣ Stats:Base Bucket. Each one toggles between OFF and
BASE/EXPERIMENT so you can choose exactly what time spans you would like to collect in your base and
experiment buckets.

• Updates StatsManager to segment collected stats into a base and experiment bucket. This allows you to quickly
measure the difference a code change has on relevant counters / timers within the same execution of Mixxx.

This is useful for quickly enabling and disabling a code change without a re-compile/re-run cycle to get an anecdotal sense
of how it "feels" as well as a quantified sense of how it differs in terms of stats Mixxx collects.
All stats collected via the usual Counter/Timer/ScopedTimer/etc. tools are segmented into a BASE STATS and EXPER-
IMENT STATS section printed to the log on exit.

16.5 Mixxx Controls

Nearly every knob, button, or fader you see in Mixxx's interface is controllable via Mixxx's "control" system. The control
system allows skins, MIDI controllers, HID controllers and keyboards to control Mixxx via a single interface.
A control is identified by a "group" (which is used for grouping associated controls) and a "key" (the name of the individual
control).
For example, the volume fader for Deck 1 is identified by the group [Channel1] and key volume. Similarly, the
volume fader for Sampler 1 is identified by the group [Sampler1] and key volume.
The group is used to collect all the controls that affect one component of Mixxx into one collection. Some groups have a
high overlap of controls in common (e.g. samplers, decks, and the preview deck all share the same control keys).
In addition to controlling Mixxx, the control system can be used to inspect Mixxx's state. For example, the sample rate
of the track loaded in Deck 1 can be accessed via the [Channel1],track_samplerate control. You can read
the [Channel3],play control to determine whether Deck 3 is playing.
The default value range is 0.0 to 1.0, unless otherwise noted. Binary means that it is either 'ON' (non-zero) or 'OFF'
(zero).

Petunjuk: Discovering Controls used in Skins
You can view the control connected to any part of a skin by running Mixxx with the --developer command line
option and hovering your mouse cursor over part of the skin. If no tooltip appears, enable tooltips for the Library and
Skin in Options ‣ Preferences ‣ Interface.

Petunjuk: Changing any control from the GUI in Developer Mode
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When running Mixxx in Developer Mode (with the --developer command line option), you can view and manually
set the state of any control in Mixxx by going to Developer ‣ Developer Tools.

Lihat juga:
See controlindex for a full list.

16.5.1 ControlPotMeter controls

The following extensions add some features to ControlPotMeter controls (volume, crossfader, ...). Use in conjunc-
tion with [ChannelN], [SamplerN], [Master], ... groups.

Control Suffix Description, example
_up Increases the value, e.g. [ChannelN],rate_perm_up sets the speed one step higher (4 %

default)
_down Decreases the value, sets the speed one step lower (4 % default)
_up_small Increases the value by smaller step, sets the speed one small step higher (1 % default)
_down_small Decreases the value by smaller step, sets the speed one small step lower (1 % default)
_set_one Sets the value to 1.0, sets the channel volume to full
_set_minus_oneSets the value to -1.0, sets the channel volume to zero
_set_default Input: sets the control to its default, return to default waveform zoom level
_set_default Output: set to 1.0 if the control is at its default, light up the pitch fader center indicator
_set_zero Sets the value to 0.0, put the crossfader in the middle again
_toggle Sets the value to 0.0 if the value was > 0.0, and to 1.0 if the value was 0.0, will cut off/on a track

while you're playing
_mi-
nus_toggle

Sets the value to -1.0 if the value was > -1.0, and to 1.0 if the value was -1.0, can tilt the crossfader
from left to right

These controls can be used in JavaScript files like this:

// This won't work:
engine.setValue(group, "pitch_up_small", 1.0);

// Use this instead:
script.triggerControl(group, "pitch_up_small", 50);

To use *_toggle the respective shortcut for scripts is:

script.toggleControl(group, "keylock_toggle", 100);

16.5.2 The [Master] group

The [Master] group generally corresponds to controls that affect the mixing engine. This will bear some similarity to
what you will find on a DJ mixer (e.g. crossfader controls, headphone cueing controls, etc.).
[Master]audio_latency_usage

Reflects fraction of latency, given by the audio buffer size, spend for audio processing inside Mixxx. At value near
25 % there is a high risk of buffer underflows
This is a ControlPotMeter control.

Range 0 .. 25 %
Feedback latency meter
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Baru pada versi 2.0.0.
[Master]audio_latency_overload

Indicates a buffer under or over-flow. Resets after 500 ms
This is a ControlPotMeter control.

Range binary
Feedback Overload indicator

Baru pada versi 2.0.0.
[Master]audio_latency_overload_count

Counts buffer over and under-flows. Max one per 500 ms
Range 0 .. n
Feedback Counter in hardware preferences

Baru pada versi 2.0.0.
[Master]balance

Adjusts the left/right channel balance on the Master output.
This is a ControlPotMeter control.

Range -1.0..1.0
Feedback Center Balance knob

[Master]booth_enabled
Indicates whether a Booth output is configured in the Sound Hardware Preferences.

Range binary
Feedback Booth gain knob shown or hidden

Baru pada versi 2.1.0.
[Master]booth_gain

Adjusts the gain of the Booth output.
This is a ControlPotMeter control.

Range 0.0...1.0...5.0
Feedback Booth gain knob

Baru pada versi 2.1.0.
[Master]crossfader

Adjusts the crossfader between players/decks (-1.0 is all the way left).
This is a ControlPotMeter control.

Range -1.0..1.0
Feedback Crossfader slider

[Master]crossfader_down
Moves the crossfader left by 1/10th.

Range binary
Feedback Crossfader slider

[Master]crossfader_down_small
Moves the crossfader left by 1/100th.
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Range binary
Feedback Crossfader slider

Baru pada versi 1.10.0.
[Master]crossfader_up

Moves the crossfader right by 1/10th.
Range binary
Feedback Crossfader slider

[Master]crossfader_up_small
Moves the crossfader right by 1/100th.

Range binary
Feedback Crossfader slider

Baru pada versi 1.10.0.
[Master]duckStrength

Microphone ducking strength
This is a ControlPotMeter control.

Range 0.0..1.0
Feedback Strength knob

Baru pada versi 2.0.0.
[Master]enabled

Indicator that the master mix is processed.
Range binary
Feedback None

Baru pada versi 2.0.0.
[Master]gain

Adjusts the gain for the master output as well as recording and broadcasting signal.
This is a ControlPotMeter control.

Range 0.0..1.0..5.0
Feedback Master volume knob

Baru pada versi 2.0.0.
[Master]headEnabled

Indicator that the headphone mix is processed.
Range binary
Feedback None

Baru pada versi 2.0.0.
[Master]headGain

Adjusts the headphone output gain.
This is a ControlPotMeter control.

Range 0.0..1.0..5.0
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Feedback Headphone volume knob
Baru pada versi 2.0.0.

[Master]headMix
Adjusts the cue/main mix in the headphone output.
This is a ControlPotMeter control.

Range default
Feedback Pre/Main knob

[Master]headSplit
Splits headphone stereo cueing into right (master mono) and left (PFL mono).

Range binary
Feedback Split Cue button

Baru pada versi 2.0.0.
[Master]latency

Latency setting (sound buffer size) in milliseconds (default 64).
Range >=0 (absolute value)
Feedback Latency slider in the prefs

[Master]maximize_library
Toggle maximized view of library.

Range binary
Feedback Toggle maximized view of library

Baru pada versi 2.0.0.
[Master]num_decks

The number of decks currently enabled.
Range integer
Feedback None

Baru pada versi 1.9.0.
[Master]num_effectsavailable

The number of available effects that can be selected in an effect slot.
Range integer, read-only
Feedback None

Baru pada versi 2.1.0.
[Master]num_samplers

The number of samplers currently enabled.
Range integer
Feedback None

Baru pada versi 1.9.0.
[Master]num_preview_decks

The number of preview decks currently enabled.
Range integer
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Feedback None
Baru pada versi 1.11.0.

[Master]PeakIndicator
Indicates when the signal is clipping (too loud for the hardware and is being distorted) (composite).
This is a ControlPotMeter control.

Range binary
Feedback Clip light (mono)

[Master]PeakIndicatorL
Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the left channel.
This is a ControlPotMeter control.

Range binary
Feedback Clip light (left)

[Master]PeakIndicatorR
Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the right channel.
This is a ControlPotMeter control.

Range binary
Feedback Clip light (right)

[Master]samplerate
The current output sample rate (default: 44100 Hz).

Range absolute value (in Hz)
Feedback None

[Master]talkoverDucking
Toggle microphone ducking mode (OFF, AUTO, MANUAL)

Range FIXME
Feedback Ducking mode button

Baru pada versi 2.0.0.
[Master]VuMeter

Outputs the current instantaneous master volume (composite).
This is a ControlPotMeter control.

Range default
Feedback Master meter (mono)

[Master]VuMeterL
Outputs the current instantaneous master volume for the left channel.
This is a ControlPotMeter control.

Range default
Feedback Master meter L

[Master]VuMeterR
Outputs the current instantaneous master volume for the right channel.
This is a ControlPotMeter control.
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Range default
Feedback Master meter R

[Master]headVolume
Adjust headphone volume.

Range 0.0..1.0..5.0
Feedback Headphone Gain knob

Ditinggalkan sejak versi 2.0.0: Use [Master],headGain instead.
[Master]volume

Adjust master volume.
Range 0.0..1.0..5.0
Feedback Master Gain knob

Ditinggalkan sejak versi 2.0.0: Use [Master],gain instead.

16.5.3 Decks, Preview Decks and Samplers

Each deck in Mixxx corresponds to a [ChannelN] group. Whenever you see [ChannelN], think "Deck N". N can
range from 1 to the number of active decks in Mixxx.
Preview decks and Sample decks ("samplers") inMixxx are identical to regular decks, they simply have a different purpose
(previewing tracks or playing samples, respectively). Any control listed above for [ChannelN]will work for a samplers
and preview decks, just replace [ChannelN] with [PreviewDeckN] or [SamplerN].
Lihat juga:
There are some additional global controls for samplers.
[ChannelN]back
[PreviewDeckN]back
[SamplerN]back

Fast rewind (REW)
Range binary
Feedback << button

[ChannelN]beat_active
[PreviewDeckN]beat_active
[SamplerN]beat_active

Indicates whether the player is currently positioned within 50 milliseconds of a beat or not. This can be used to
make controller LEDs blink on every beat.

Range binary
Feedback None

Baru pada versi 1.10.0.
[ChannelN]beat_closest
[PreviewDeckN]beat_closest
[SamplerN]beat_closest

Its value is set to the sample position of the closest beat of the active beat and is used for updating the beat LEDs.
:range: -1, 0.0, real-valued :feedback: None

[ChannelN]beat_distance
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[PreviewDeckN]beat_distance
[SamplerN]beat_distance

Outputs the relative position of the play marker in the section between the the previous and next beat marker.
:range: 0.0 - 1.0, real-valued :feedback: None

[ChannelN]beatjump
[PreviewDeckN]beatjump
[SamplerN]beatjump

Jump forward by beatjump_size (positive) or backward by beatjump_size (negative). If a loop is active,
the loop is moved by beatjump_size.

Range real number, -1, 0, 1
Feedback Player jumps forward or backward by X beats.

Baru pada versi 2.0.0.
[ChannelN]beatjump_size
[PreviewDeckN]beatjump_size
[SamplerN]beatjump_size

Set the number of beats to jump with beatjump_forward/beatjump_backward.
Range positive real number
Feedback Beatjump size spinbox

Baru pada versi 2.1.0.
[ChannelN]beatjump_forward
[PreviewDeckN]beatjump_forward
[SamplerN]beatjump_forward

Jump forward by beatjump_size. If a loop is active, the loop is moved forward by X beats.
Range binary
Feedback Player jumps forward by beatjump_size.

Baru pada versi 2.1.0.
[ChannelN]beatjump_backward
[PreviewDeckN]beatjump_backward
[SamplerN]beatjump_backward

Jump backward by beatjump_size. If a loop is active, the loop is moved backward by X beats.
Range binary
Feedback Player jumps backward by beatjump_size.

Baru pada versi 2.1.0.
[ChannelN]beatjump_X_forward
[PreviewDeckN]beatjump_X_forward
[SamplerN]beatjump_X_forward

Jump forward by X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64. If a
loop is active, the loop is moved forward by X betas.

Range binary
Feedback Player jumps forward by X beats.

Baru pada versi 2.0.0.
[ChannelN]beatjump_X_backward
[PreviewDeckN]beatjump_X_backward
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[SamplerN]beatjump_X_backward
Jump backward by X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64. If a
loop is active, the loop is moved backward by X beats.

Range binary
Feedback Player jumps backward by X beats.

Baru pada versi 2.0.0.
[ChannelN]beatloop_activate
[PreviewDeckN]beatloop_activate
[SamplerN]beatloop_activate

Set a loop that is beatloop_size beats long and enables the loop
Range binary
Feedback A loop is shown over beatloop_size beats

Baru pada versi 2.1.0.
[ChannelN]beatloop_X_activate
[PreviewDeckN]beatloop_X_activate
[SamplerN]beatloop_X_activate

Activates a loop over X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64
Range binary
Feedback A loop is shown over X beats.

Baru pada versi 1.10.0.
[ChannelN]beatloop_size
[PreviewDeckN]beatloop_size
[SamplerN]beatloop_size

Set the length of the loop in beats that will get set with beatloop_activate and beat-
looproll_activate. Changing this will resize an existing loop if the length of the loop matches beat-
loop_size.

Range positive real number
Feedback Beatloop size spinbox and possibly loop section on waveform

Baru pada versi 2.1.0.
[ChannelN]beatloop_X_toggle
[PreviewDeckN]beatloop_X_toggle
[SamplerN]beatloop_X_toggle

Toggles a loop over X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64
Range binary
Feedback A loop is shown over X beats.

Baru pada versi 1.10.0.
[ChannelN]beatloop_X_enabled
[PreviewDeckN]beatloop_X_enabled
[SamplerN]beatloop_X_enabled

1 if beatloop X is enabled, 0 if not.
Range binary
Feedback Beatloop X button in skin is lit.
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Baru pada versi 1.10.0.
[ChannelN]beatlooproll_activate
[PreviewDeckN]beatlooproll_activate
[SamplerN]beatlooproll_activate

Activates a rolling loop over beatloop_size beats. Once disabled, playback will resume where the track would
have been if it had not entered the loop.

Range binary
Feedback A loop overlay is shown over beatloop_size beats on waveform.

Baru pada versi 2.1.0.
[ChannelN]beatlooproll_X_activate
[PreviewDeckN]beatlooproll_X_activate
[SamplerN]beatlooproll_X_activate

Activates a rolling loop over X beats. Once disabled, playback will resume where the track would have been if it
had not entered the loop. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64

Range binary
Feedback Beatloop X button in skin is lit. A loop overlay is shown over X beats on waveform.

Baru pada versi 1.11.0.
[ChannelN]beats_adjust_faster
[PreviewDeckN]beats_adjust_faster
[SamplerN]beats_adjust_faster

Adjust the average BPM up by +0.01
Range binary
Feedback The beatgrid lines move closer to each other.

Baru pada versi 2.0.0.
[ChannelN]beats_adjust_slower
[PreviewDeckN]beats_adjust_slower
[SamplerN]beats_adjust_slower

Adjust the average BPM down by -0.01.
Range binary
Feedback The beatgrid lines move further apart from each other.

Baru pada versi 2.0.0.
[ChannelN]beats_translate_curpos
[PreviewDeckN]beats_translate_curpos
[SamplerN]beats_translate_curpos

Adjust beatgrid so closest beat is aligned with the current playposition.
Range binary
Feedback The beatgrid moves to align with current playposition.

Baru pada versi 1.10.0.
[ChannelN]beats_translate_match_alignment
[PreviewDeckN]beats_translate_match_alignment
[SamplerN]beats_translate_match_alignment

Adjust beatgrid to match another playing deck.
Range binary
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Feedback Instead of syncing the beatgrid to the current playposition, sync the beatgrid so the nearest
beat lines up with the other track's nearest beat.

Baru pada versi 2.0.0.
[ChannelN]beats_translate_earlier
[PreviewDeckN]beats_translate_earlier
[SamplerN]beats_translate_earlier

Move beatgrid to an earlier position.
Range binary
Feedback The beatgrid moves left by a small amount.

Baru pada versi 2.0.0.
[ChannelN]beats_translate_later
[PreviewDeckN]beats_translate_later
[SamplerN]beats_translate_later

Move beatgrid to a later position.
Range binary
Feedback The beatgrid moves right by a small amount.

Baru pada versi 2.0.0.
[ChannelN]beatsync
[PreviewDeckN]beatsync
[SamplerN]beatsync

Syncs the tempo and phase (depending on quantize) to that of the other track (if BPM is detected on both).
range binary
feedback The Sync button flashes and the tempo slider snaps to the appropriate value.

Berubah pada versi 1.10.0.
[ChannelN]beatsync_phase
[PreviewDeckN]beatsync_phase
[SamplerN]beatsync_phase

Syncs the phase to that of the other track (if BPM is detected on both).
Range binary
Feedback The Sync button flashes and the tempo slider snap to the appropriate value.

Baru pada versi 1.10.0.
[ChannelN]beatsync_tempo
[PreviewDeckN]beatsync_tempo
[SamplerN]beatsync_tempo

Syncs the tempo to that of the other track (if BPM is detected on both).
Range binary
Feedback The Sync button flashes and the tempo slider snaps to the appropriate value.

Baru pada versi 1.10.0.
[ChannelN]bpm
[PreviewDeckN]bpm
[SamplerN]bpm

Reflects the perceived (rate-adjusted) BPM of the loaded file.
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This is a ControlPotMeter control.
Range real-valued
Feedback BPM value display

Berubah pada versi 1.10.0.
[ChannelN]bpm_tap
[PreviewDeckN]bpm_tap
[SamplerN]bpm_tap

When tapped repeatedly, adjusts the BPM of the track on the deck (not the tempo slider!) to match the taps.

Catatan: If you want to change the rate of the deck use script.bpm.tapButton(deck) in your controller mapping
instead.

Range binary
Feedback BPM value display (playback speed doesn't change)

Baru pada versi 1.9.2.
[ChannelN]CloneFromDeck
[PreviewDeckN]CloneFromDeck
[SamplerN]CloneFromDeck

Clone the given deck number, copying the play state, position, rate, and key. If 0 or a negative number is given,
Mixxx will attempt to select the first playing deck as the source for the clone.

Range integer between 1 and [Master],num_decks (inclusive)
Feedback The channel will start playing at the rate and position of the source deck.

Baru pada versi 2.3.0.
[ChannelN]CloneFromSampler
[PreviewDeckN]CloneFromSampler
[SamplerN]CloneFromSampler

Clone the given sampler number, copying the play state, position, rate, and key.
Range integer between 1 and [Master],num_samplers (inclusive)
Feedback The channel will start playing at the rate and position of the source deck.

Baru pada versi 2.3.0.
[ChannelN]cue_cdj
[PreviewDeckN]cue_cdj
[SamplerN]cue_cdj

Represents a Cue button that is always in CDJ mode.
Range binary
Feedback None

Baru pada versi 1.10.0.
[ChannelN]cue_clear
[PreviewDeckN]cue_clear
[SamplerN]cue_clear

Deletes the already set cue point and sets [ChannelN],cue_point to -1.
Range binary
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Feedback None
[ChannelN]cue_goto
[PreviewDeckN]cue_goto
[SamplerN]cue_goto

If the cue point is set, recalls the cue point.
Range binary
Feedback Player may change position

[ChannelN]cue_default
[PreviewDeckN]cue_default
[SamplerN]cue_default

In CDJ mode, when playing, returns to the cue point and pauses. If stopped, sets a cue point at the current location.
If stopped and at a cue point, plays from that point until released (set to 0.)

Range binary
Feedback Cue button

[ChannelN]cue_gotoandplay
[PreviewDeckN]cue_gotoandplay
[SamplerN]cue_gotoandplay

If the cue point is set, seeks the player to it and starts playback.
Range binary
Feedback Player may change position and start playing.

Baru pada versi 1.11.0.
[ChannelN]cue_gotoandstop
[PreviewDeckN]cue_gotoandstop
[SamplerN]cue_gotoandstop

If the cue point is set, seeks the player to it and stops.
Range binary
Feedback Player may change position.

Baru pada versi 1.11.0.
[ChannelN]cue_indicator
[PreviewDeckN]cue_indicator
[SamplerN]cue_indicator

Indicates the blinking pattern of the CUE button (i.e. 1.0 if the button is illuminated, 0.0 otherwise), depending on
the chosen cue mode.

Range binary
Feedback Cue button

Baru pada versi 2.0.0.
[ChannelN]cue_mode
[PreviewDeckN]cue_mode
[SamplerN]cue_mode

Represents the currently chosen cue mode.
Range
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Value compatible hardware
0.0 Mixxx mode (default)
1.0 Pioneer mode
2.0 Denon mode
3.0 Numark mode
4.0 Mixxx mode (no blinking)
5.0 CUP (Cue + Play) mode

Feedback None
[ChannelN]cue_play
[PreviewDeckN]cue_play
[SamplerN]cue_play

Go to cue point and play after release (CUP button behavior). If stopped, sets a cue point at the current location.
Range binary
Feedback None

Baru pada versi 2.1.0.
[ChannelN]cue_point
[PreviewDeckN]cue_point
[SamplerN]cue_point

The current position of the cue point in samples.
Range absolute value
Feedback Cue point marker

[ChannelN]cue_preview
[PreviewDeckN]cue_preview
[SamplerN]cue_preview

Plays from the current cue point.
Range binary
Feedback Cue button lights and waveform moves

[ChannelN]cue_set
[PreviewDeckN]cue_set
[SamplerN]cue_set

Sets a cue point at the current location.
Range binary
Feedback Cue mark appears on the waveform

[ChannelN]cue_simple
[PreviewDeckN]cue_simple
[SamplerN]cue_simple

If the player is not playing, set the cue point at the current location otherwise seek to the cue point.
Range binary
Feedback Cue button

[ChannelN]duration
[PreviewDeckN]duration
[SamplerN]duration

Outputs the length of the current song in seconds
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Range absolute value
Feedback None

[ChannelN]eject
[PreviewDeckN]eject
[SamplerN]eject

Eject currently loaded track
Range binary
Feedback Eject button is lit. Be sure to set back to 0 with scripts so the button does not stay lit.

Baru pada versi 1.9.0.
[ChannelN]end
[PreviewDeckN]end
[SamplerN]end

Jump to end of track
Range binary
Feedback Track jumps to end

[ChannelN]end_of_track
[PreviewDeckN]end_of_track
[SamplerN]end_of_track

Switches to 1 if the play position is within the end range defined in Preferences ‣ Waveforms ‣ End of track warning.
Range binary, read-only
Feedback Waveform and Overview widgets show a flashing border

[ChannelN]file_bpm
[PreviewDeckN]file_bpm
[SamplerN]file_bpm

The detected BPM of the loaded track.
Range positive value, read-only
Feedback None

[ChannelN]file_key
[PreviewDeckN]file_key
[SamplerN]file_key

The detected key of the loaded track.
Range ?, read-only
Feedback None

Baru pada versi 2.0.0.
[ChannelN]fwd
[PreviewDeckN]fwd
[SamplerN]fwd

Fast forward (FF)
Range binary
Feedback > button

[ChannelN]hotcue_X_activate
[PreviewDeckN]hotcue_X_activate
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[SamplerN]hotcue_X_activate
If hotcue X is not set, this sets a hotcue at the current play position and saves it to hotcue slot X.
If hotcue X is set, the player seeks to hotcue X's position. Setting the control to 1 when the track is currently not
playing (i.e. play is set to 0) will start hotcue previewing. After resetting the control to 0, playback will usually be
stopped and the player will seek to the hotcue position. If play is set to 1 while previewing is active, the playback
will continue and no seek occurs.

Range binary
Feedback Player may change position. Hotcue X marker may change on waveform.

Baru pada versi 1.8.0.
[ChannelN]hotcue_X_clear
[PreviewDeckN]hotcue_X_clear
[SamplerN]hotcue_X_clear

If hotcue X is set, clears its hotcue status.
Range binary
Feedback Hotcue X marker changes on waveform.

Baru pada versi 1.8.0.
[ChannelN]hotcue_X_color
[PreviewDeckN]hotcue_X_color
[SamplerN]hotcue_X_color

Color of hotcue X or -1 if the hotcue is not set.
Range 3-Byte RGB color code (or -1)
Feedback Color of Hotcue X button and waveform marker changes.

Baru pada versi 2.3.0.
[ChannelN]hotcue_X_enabled
[PreviewDeckN]hotcue_X_enabled
[SamplerN]hotcue_X_enabled

Indicates if hotcue slot X is set. The value is 1 if the hotcue is set (position is not -1), 0 otherwise.
Range binary, read-only

Baru pada versi 1.8.0.
[ChannelN]hotcue_X_goto
[PreviewDeckN]hotcue_X_goto
[SamplerN]hotcue_X_goto

If hotcue X is set, seeks the player to hotcue X's position.
Range binary
Feedback Player may change position.

Baru pada versi 1.8.0.
[ChannelN]hotcue_X_gotoandplay
[PreviewDeckN]hotcue_X_gotoandplay
[SamplerN]hotcue_X_gotoandplay

If hotcue X is set, seeks the player to hotcue X's position and starts playback.
Range binary
Feedback Player may change position.
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Baru pada versi 1.11.0.
[ChannelN]hotcue_X_gotoandstop
[PreviewDeckN]hotcue_X_gotoandstop
[SamplerN]hotcue_X_gotoandstop

If hotcue X is set, seeks the player to hotcue X's position and stops.
Range binary
Feedback Player may change position.

Baru pada versi 1.8.0.
[ChannelN]hotcue_X_position
[PreviewDeckN]hotcue_X_position
[SamplerN]hotcue_X_position

The position of hotcue X in samples, -1 if not set.
Range positive integer
Feedback Hotcue X marker changes on waveform.

Baru pada versi 1.8.0.
[ChannelN]hotcue_X_set
[PreviewDeckN]hotcue_X_set
[SamplerN]hotcue_X_set

Set hotcue X to the current play position. If hotcue X was previously set, clears its hotcue status.
Range binary
Feedback Hotcue X marker changes on waveform.

Baru pada versi 1.8.0.
[ChannelN]hotcue_focus
[PreviewDeckN]hotcue_focus
[SamplerN]hotcue_focus

Contains the number of the most recently used hotcue (or -1 if no hotcue was used).
Range positive integer (or -1)
Feedback None

Baru pada versi 2.3.0.
[ChannelN]hotcue_focus_color_prev
[PreviewDeckN]hotcue_focus_color_prev
[SamplerN]hotcue_focus_color_prev

If there is a focused hotcue, sets its color to the previous color in the palette.
Range binary
Feedback Color of focused hotcue button and waveform marker changes.

Baru pada versi 2.3.0.
[ChannelN]hotcue_focus_color_next
[PreviewDeckN]hotcue_focus_color_next
[SamplerN]hotcue_focus_color_next

If there is a focused hotcue, sets its color to the next color in the palette.
Range binary
Feedback Color of focused hotcue button and waveform marker changes.
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Baru pada versi 2.3.0.
[ChannelN]intro_end_activate
[PreviewDeckN]intro_end_activate
[SamplerN]intro_end_activate

If the intro end cue is set, seeks the player to the intro end position. If the intro end is not set, sets the intro end to
the current play position.

Range binary
Feedback Player may change position. Intro end marker may change on waveform.

Baru pada versi 2.3.0.
[ChannelN]intro_end_clear
[PreviewDeckN]intro_end_clear
[SamplerN]intro_end_clear

If the intro end cue is set, clears its status.
Range binary
Feedback Intro end marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]intro_end_enabled
[PreviewDeckN]intro_end_enabled
[SamplerN]intro_end_enabled

1 if intro end cue is set, (position is not -1), 0 otherwise.
Range binary, read-only
Feedback Intro end button lights up.

Baru pada versi 2.3.0.
[ChannelN]intro_end_position
[PreviewDeckN]intro_end_position
[SamplerN]intro_end_position

The position of the intro end in samples, -1 if not set.
Range positive integer
Feedback Intro end marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]intro_end_set
[PreviewDeckN]intro_end_set
[SamplerN]intro_end_set

Set intro end to the current play position. If intro end was previously set, it is moved to the new position.
Range binary
Feedback Intro end marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]intro_start_activate
[PreviewDeckN]intro_start_activate
[SamplerN]intro_start_activate

If the intro start cue is set, seeks the player to the intro start position. If the intro start is not set, sets the intro start
to the current play position.

Range binary
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Feedback Player may change position. Intro start marker may change on waveform.
Baru pada versi 2.3.0.

[ChannelN]intro_start_clear
[PreviewDeckN]intro_start_clear
[SamplerN]intro_start_clear

If the intro start cue is set, clears its status.
Range binary
Feedback Intro start marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]intro_start_enabled
[PreviewDeckN]intro_start_enabled
[SamplerN]intro_start_enabled

1 if intro start cue is set, (position is not -1), 0 otherwise.
Range binary, read-only
Feedback Intro start button lights up.

Baru pada versi 2.3.0.
[ChannelN]intro_start_position
[PreviewDeckN]intro_start_position
[SamplerN]intro_start_position

The position of the intro start in samples, -1 if not set.
Range positive integer
Feedback Intro start marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]intro_start_set
[PreviewDeckN]intro_start_set
[SamplerN]intro_start_set

Set intro start to the current play position. If intro start was previously set, it is moved to the new position.
Range binary
Feedback Intro start marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]key
[PreviewDeckN]key
[SamplerN]key

Current key of the track
Range
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Value OpenKey Lancelot Traditional
1 1d 8b C
2 8d 3b D♭
3 3d 10b D
4 10d 5b E♭
5 5d 12b E
6 12d 7b F
7 7d 2b F♯/G♭
8 2d 9b G
9 9d 4b A♭
10 4d 11b A
11 11d 6b B♭
12 6d 1b B
13 10m 5a Cm
14 5m 12a C♯m
15 12m 7a Dm
16 7m 2a D♯m/E♭m
17 2m 9a Em
18 9m 4a Fm
19 4m 11a F♯m
20 11m 6a Gm
21 6m 1a G♯m
22 1m 8a Am
23 8m 3a B♭m
24 3m 10a Bm

Baru pada versi 2.0.0.
[ChannelN]keylock
[PreviewDeckN]keylock
[SamplerN]keylock

Enable key-lock for the specified deck (rate changes only affect tempo, not key)
Range binary
Feedback key-lock button activates

Baru pada versi 1.9.0.
[ChannelN]LoadSelectedTrack
[PreviewDeckN]LoadSelectedTrack
[SamplerN]LoadSelectedTrack

Loads the currently highlighted track into the deck
Range binary
Feedback Track name & waveform change

[ChannelN]LoadSelectedTrackAndPlay
[PreviewDeckN]LoadSelectedTrackAndPlay
[SamplerN]LoadSelectedTrackAndPlay

Loads the currently highlighted track into the deck and starts playing
Range binary
Feedback Track name & waveform change & Play/pause button

Baru pada versi 1.11.0.
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[ChannelN]local_bpm
[PreviewDeckN]local_bpm
[SamplerN]local_bpm

Reflects the average bpm around the current play position of the loaded file.
Range positive value
Feedback None

[ChannelN]loop_double
[PreviewDeckN]loop_double
[SamplerN]loop_double

Doubles beatloop_size. If beatloop_size equals the size of the loop, the loop is resized.
Range binary
Feedback Beatloop size spinbox changes

Baru pada versi 1.10.0.
Berubah pada versi 2.1.0.

[ChannelN]loop_enabled
[PreviewDeckN]loop_enabled
[SamplerN]loop_enabled

Indicates whether or not a loop is enabled.
Range binary, read-only
Feedback Loop in waveform is active.

Baru pada versi 1.8.0.
[ChannelN]loop_end_position
[PreviewDeckN]loop_end_position
[SamplerN]loop_end_position

The player loop-out position in samples, -1 if not set.
Range positive integer
Feedback Loop-out marker shows on waveform.

Baru pada versi 1.8.0.
[ChannelN]loop_halve
[PreviewDeckN]loop_halve
[SamplerN]loop_halve

Halves beatloop_size. If beatloop_size equals the size of the loop, the loop is resized.
Range binary
Feedback Beatloop size spinbox changes

Baru pada versi 1.10.0.
Berubah pada versi 2.1.0.

[ChannelN]loop_in
[PreviewDeckN]loop_in
[SamplerN]loop_in

If loop is disabled, sets the player loop in position to the current play position. If loop is enabled, press and hold to
move loop in position to the current play position. If quantize is enabled, beatloop_size will be updated to
reflect the new loop size.

Range binary
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Feedback Loop-in marker changes on waveform.
Baru pada versi 1.8.0.
Berubah pada versi 2.1.0.

[ChannelN]loop_in_goto
[PreviewDeckN]loop_in_goto
[SamplerN]loop_in_goto

Seek to the loop in point.
Range binary
Feedback Waveform position jumps

Baru pada versi 2.1.0.
[ChannelN]loop_out
[PreviewDeckN]loop_out
[SamplerN]loop_out

If loop is disabled, sets the player loop out position to the current play position. If loop is enabled, press and hold
to move loop out position to the current play position. If quantize is enabled, beatloop_size will be updated
to reflect the new loop size.

Range binary
Feedback Loop-out marker changes on waveform.

Baru pada versi 1.8.0.
Berubah pada versi 2.1.0.

[ChannelN]loop_out_goto
[PreviewDeckN]loop_out_goto
[SamplerN]loop_out_goto

Seek to the loop out point.
Range binary
Feedback Waveform position jumps

Baru pada versi 2.1.0.
[ChannelN]loop_move
[PreviewDeckN]loop_move
[SamplerN]loop_move

Move loop forward by X beats (positive) or backward by X beats (negative).
Range real number
Feedback Loop moves forward or backward by X beats.

Baru pada versi 2.0.0.
[ChannelN]loop_move_X_forward
[PreviewDeckN]loop_move_X_forward
[SamplerN]loop_move_X_forward

Moves the loop in and out points forward by X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5,
1, 2, 4, 8, 16, 32, 64

Range binary
Feedback Loop moves forward by X beats.

Baru pada versi 2.0.0.
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[ChannelN]loop_move_X_backward
[PreviewDeckN]loop_move_X_backward
[SamplerN]loop_move_X_backward

Loop moves by X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64
Range binary
Feedback Loop moves backward by X beats.

Baru pada versi 2.0.0.
[ChannelN]loop_scale
[PreviewDeckN]loop_scale
[SamplerN]loop_scale

Scale the loop length by the value scale is set to by moving the end marker. beatloop_size is not updated to
reflect the change.

Range 0.0 - infinity
Feedback Loop length is scaled by given amount on waveform.

Baru pada versi 1.10.0.
[ChannelN]loop_start_position
[PreviewDeckN]loop_start_position
[SamplerN]loop_start_position

The player loop-in position in samples, -1 if not set.
Range positive integer
Feedback Loop-in marker changes on waveform.

Baru pada versi 1.8.0.
[ChannelN]orientation
[PreviewDeckN]orientation
[SamplerN]orientation

Set channel orientation for the crossfader.
Range

Value Meaning
0 Left side of crossfader
1 Center (not affected by crossfader)
2 Right side of crossfader

Feedback None
Baru pada versi 1.9.0.

[ChannelN]orientation_center
[PreviewDeckN]orientation_center
[SamplerN]orientation_center
[AuxiliaryN]orientation_center

Assign channel to the center of the crossfader.
[ChannelN]orientation_left
[PreviewDeckN]orientation_left
[SamplerN]orientation_left
[AuxiliaryN]orientation_left

Assign channel to the left side of the crossfader.
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[ChannelN]orientation_right
[PreviewDeckN]orientation_right
[SamplerN]orientation_right
[AuxiliaryN]orientation_right

Assign channel to the right side of the crossfader.
[ChannelN]outro_end_activate
[PreviewDeckN]outro_end_activate
[SamplerN]outro_end_activate

If the outro end cue is set, seeks the player to the outro end position. If the outro end is not set, sets the outro end
to the current play position.

Range binary
Feedback Player may change position. Outro end marker may change on waveform.

Baru pada versi 2.3.0.
[ChannelN]outro_end_clear
[PreviewDeckN]outro_end_clear
[SamplerN]outro_end_clear

If the outro end cue is set, clears its status.
Range binary
Feedback Outro end marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]outro_end_enabled
[PreviewDeckN]outro_end_enabled
[SamplerN]outro_end_enabled

1 if outro end cue is set, (position is not -1), 0 otherwise.
Range binary, read-only
Feedback Outro end button lights up.

Baru pada versi 2.3.0.
[ChannelN]outro_end_position
[PreviewDeckN]outro_end_position
[SamplerN]outro_end_position

The position of the outro end in samples, -1 if not set.
Range positive integer
Feedback Outro end marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]outro_end_set
[PreviewDeckN]outro_end_set
[SamplerN]outro_end_set

Set outro end to the current play position. If outro end was previously set, it is moved to the new position.
Range binary
Feedback Outro end marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]outro_start_activate
[PreviewDeckN]outro_start_activate
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[SamplerN]outro_start_activate
If the outro start cue is set, seeks the player to the outro start position. If the outro start is not set, sets the outro
start to the current play position.

Range binary
Feedback Player may change position. Outro start marker may change on waveform.

Baru pada versi 2.3.0.
[ChannelN]outro_start_clear
[PreviewDeckN]outro_start_clear
[SamplerN]outro_start_clear

If the outro start cue is set, clears its status.
Range binary
Feedback Outro start marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]outro_start_enabled
[PreviewDeckN]outro_start_enabled
[SamplerN]outro_start_enabled

1 if outro start cue is set, (position is not -1), 0 otherwise.
Range binary, read-only
Feedback Outro start button lights up.

Baru pada versi 2.3.0.
[ChannelN]outro_start_position
[PreviewDeckN]outro_start_position
[SamplerN]outro_start_position

The position of the outro start in samples, -1 if not set.
Range positive integer
Feedback Outro start marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]outro_start_set
[PreviewDeckN]outro_start_set
[SamplerN]outro_start_set

Set outro start to the current play position. If outro start was previously set, it is moved to the new position.
Range binary
Feedback Outro start marker changes on waveform.

Baru pada versi 2.3.0.
[ChannelN]passthrough
[PreviewDeckN]passthrough
[SamplerN]passthrough

Connects the vinyl control input for vinyl control on that deck to the channel output. Allows to mix external media
into DJ sets.

Range binary
Feedback Passthrough label in the waveform overview and passthrough button

Baru pada versi 2.0.0.
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[ChannelN]PeakIndicator
[PreviewDeckN]PeakIndicator
[SamplerN]PeakIndicator

Indicates when the signal is clipping (too loud for the hardware and is being distorted)
This is a ControlPotMeter control.

Range binary
Feedback Clip light

[ChannelN]PeakIndicatorL
[PreviewDeckN]PeakIndicatorL
[SamplerN]PeakIndicatorL

Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the left channel
This is a ControlPotMeter control.

Range binary
Feedback Clip light (left)

Baru pada versi 2.0.0.
[ChannelN]PeakIndicatorR
[PreviewDeckN]PeakIndicatorR
[SamplerN]PeakIndicatorR

Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the right channel
This is a ControlPotMeter control.

Range binary
Feedback Clip light (right)

Baru pada versi 2.0.0.
[ChannelN]pfl
[PreviewDeckN]pfl
[SamplerN]pfl

Toggles headphone cueing (PFL).
Range binary
Feedback Headphone button

[ChannelN]pitch
[PreviewDeckN]pitch
[SamplerN]pitch

The total adjustment to the track's pitch, including changes from the rate slider if keylock is off as well as
pitch_adjust.

Catatan: Do not map this to knobs or sliders on controllers; map pitch_adjust instead.

This is a ControlPotMeter control.
Range -6.0..6.0
Feedback Key display

Baru pada versi 2.0.0.
[ChannelN]pitch_up
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[PreviewDeckN]pitch_up
[SamplerN]pitch_up

Changes the track pitch up one half step, independent of the tempo.
Range binary
Feedback Key display

Baru pada versi 2.0.0.
[ChannelN]pitch_down
[PreviewDeckN]pitch_down
[SamplerN]pitch_down

Changes the track pitch down one half step, independent of the tempo.
Range binary
Feedback Key display

Baru pada versi 2.0.0.
[ChannelN]pitch_adjust
[PreviewDeckN]pitch_adjust
[SamplerN]pitch_adjust

Adjust the pitch in addition to the tempo slider pitch.
This is a ControlPotMeter control.

Range -3.0..3.0
Feedback Key display

Baru pada versi 2.0.0.
[ChannelN]play
[PreviewDeckN]play
[SamplerN]play

Toggles playing or pausing the track.
The value is set to 1 when the track is playing or when previewing from cue points and when the play command is
adopted and track will be played after loading.

Range binary
Feedback Play/pause button

[ChannelN]play_indicator
[PreviewDeckN]play_indicator
[SamplerN]play_indicator

Provides information to be bound with the a Play/Pause button e.g blinking when play is possible
Range binary, read-only
Feedback Play/pause button

Baru pada versi 2.0.0.
[ChannelN]play_latched
[PreviewDeckN]play_latched
[SamplerN]play_latched

This is set to 1 when the track is playing, but not when previewing (see play).
Range binary, read-only
Feedback Play/pause button

16.5. Mixxx Controls 149



Mixxx User Manual, Rilis 2.3.0

Baru pada versi 2.3.0.
[ChannelN]play_stutter
[PreviewDeckN]play_stutter
[SamplerN]play_stutter

A play button without pause. Pushing while playing, starts play at cue point again (Stutter).
Range binary
Feedback Play/Stutter button

Baru pada versi 2.0.0.
[ChannelN]playposition
[PreviewDeckN]playposition
[SamplerN]playposition

Sets the absolute position in the track.
This is a ControlPotMeter control.

Range -0.14 to 1.14 (0 = beginning -> Midi 14, 1 = end -> Midi 114)
Feedback Waveform

[ChannelN]pregain
[PreviewDeckN]pregain
[SamplerN]pregain

Adjusts the pre-fader gain of the track (to avoid clipping)
This is a ControlPotMeter control.

Range 0.0..1.0..4.0
Feedback GAIN knob

[ChannelN]quantize
[PreviewDeckN]quantize
[SamplerN]quantize

Aligns Hot-cues and Loop In & Out to the next beat from the current position.
Range binary
Feedback Hot-cues or Loop In/Out markers

Baru pada versi 1.10.0.
[ChannelN]rate
[PreviewDeckN]rate
[SamplerN]rate

Speed control
This is a ControlPotMeter control.

Range -1.0..1.0
Feedback Speed slider

[ChannelN]rate_dir
[PreviewDeckN]rate_dir
[SamplerN]rate_dir

Indicates orientation of speed slider.
Range -1 or 1

[ChannelN]rate_perm_down
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[PreviewDeckN]rate_perm_down
[SamplerN]rate_perm_down

Sets the speed one step lower (4 % default) lower
Range binary
Feedback Perm down button & Speed slider

[ChannelN]rate_perm_down_small
[PreviewDeckN]rate_perm_down_small
[SamplerN]rate_perm_down_small

Sets the speed one small step lower (1 % default)
Range binary
Feedback Perm down button & Speed slider

[ChannelN]rate_perm_up
[PreviewDeckN]rate_perm_up
[SamplerN]rate_perm_up

Sets the speed one step higher (4 % default)
Range binary
Feedback Perm up button & Speed slider

[ChannelN]rate_perm_up_small
[PreviewDeckN]rate_perm_up_small
[SamplerN]rate_perm_up_small

Sets the speed one small step higher (1 % default)
Range binary
Feedback Perm up button & Speed slider

[ChannelN]rate_temp_down
[PreviewDeckN]rate_temp_down
[SamplerN]rate_temp_down

Holds the speed one step lower while active
Range binary
Feedback Temp down button & Speed slider

[ChannelN]rate_temp_down_small
[PreviewDeckN]rate_temp_down_small
[SamplerN]rate_temp_down_small

Holds the speed one small step lower while active
Range binary
Feedback Temp down button & Speed slider

[ChannelN]rate_temp_up
[PreviewDeckN]rate_temp_up
[SamplerN]rate_temp_up

Holds the speed one step higher while active
Range binary
Feedback Temp up button & Speed slider

[ChannelN]rate_temp_up_small
[PreviewDeckN]rate_temp_up_small
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[SamplerN]rate_temp_up_small
Holds the speed one small step higher while active

Range binary
Feedback Temp up button & Speed slider

[ChannelN]rateRange
[PreviewDeckN]rateRange
[SamplerN]rateRange

Sets the range of the Speed slider (0.08 = 8%)
This is a ControlPotMeter control.

Range 0.0..4.0
Feedback none, until you move the Speed slider

[ChannelN]rateSearch
[PreviewDeckN]rateSearch
[SamplerN]rateSearch

Seeks forward (positive values) or backward (negative values) at a speed determined by the value
This is a ControlPotMeter control.

Range -300..300
Feedback Deck seeks

[ChannelN]rateEngine
[PreviewDeckN]rateEngine
[SamplerN]rateEngine

Actual rate (used in visuals, not for control)
[ChannelN]reloop_andstop
[PreviewDeckN]reloop_andstop
[SamplerN]reloop_andstop

Activate current loop, jump to its loop in point, and stop playback.
Range binary
Feedback Loop range in waveform activates or deactivates and play position moves to loop in point.

Baru pada versi 2.1.0.
[ChannelN]reloop_toggle
[PreviewDeckN]reloop_toggle
[SamplerN]reloop_toggle

Toggles the current loop on or off. If the loop is ahead of the current play position, the track will keep playing
normally until it reaches the loop.

Range binary
Feedback Loop range in waveform activates or deactivates.

Baru pada versi 2.1.0.
[ChannelN]repeat
[PreviewDeckN]repeat
[SamplerN]repeat

Enable repeat-mode for the specified deck
Range binary
Feedback when track finishes, song loops to beginning
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Baru pada versi 1.9.0.
[ChannelN]reset_key
[PreviewDeckN]reset_key
[SamplerN]reset_key

Resets the key to the original track key.
Range binary

Baru pada versi 2.0.0.
[ChannelN]reverse
[PreviewDeckN]reverse
[SamplerN]reverse

Toggles playing the track backwards
Range binary
Feedback REV button

[ChannelN]reverseroll
[PreviewDeckN]reverseroll
[SamplerN]reverseroll

Enables reverse and slip mode while held (Censor)
Range binary
Feedback REV button

Baru pada versi 2.0.0.
[ChannelN]scratch2
[PreviewDeckN]scratch2
[SamplerN]scratch2

Affects absolute play speed & direction whether currently playing or not when [ChannelN],
scratch2_enabled is active. (multiplicative). Use JavaScript engine.scratch functions to manipulate
in controller mappings.

Range -3.0..3.0
Feedback Waveform

Baru pada versi 1.8.0.
[ChannelN]scratch2_enabled
[PreviewDeckN]scratch2_enabled
[SamplerN]scratch2_enabled

Takes over play speed & direction for [ChannelN],scratch2.
Range binary
Feedback Waveform

Baru pada versi 1.8.0.
[ChannelN]slip_enabled
[PreviewDeckN]slip_enabled
[SamplerN]slip_enabled

Toggles slip mode. When active, the playback continues muted in the background during a loop, scratch etc. Once
disabled, the audible playback will resume where the track would have been.

Range binary
Feedback Slip mode button
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Baru pada versi 1.11.0.
[ChannelN]stars_up
[PreviewDeckN]stars_up
[SamplerN]stars_up

Increase the rating of the currently loaded track (if the skin has star widgets in the decks section).
Range binary
Feedback Star count is increased in the deck's star widget and in the library table.

Baru pada versi 2.3.0.
[ChannelN]stars_down
[PreviewDeckN]stars_down
[SamplerN]stars_down

Decrease the rating of the currently loaded track (if the skin has star widgets in the decks section).
Range binary
Feedback Star count is decreased in the deck's star widget and in the library table.

Baru pada versi 2.3.0.
[ChannelN]start
[PreviewDeckN]start
[SamplerN]start

Jump to start of track
Range binary
Feedback Track jumps to start

[ChannelN]start_play
[PreviewDeckN]start_play
[SamplerN]start_play

Start playback from the beginning of the deck.
Range binary
Feedback Deck plays from beginning

Baru pada versi 1.10.0.
[ChannelN]start_stop
[PreviewDeckN]start_stop
[SamplerN]start_stop

Seeks a player to the start and then stops it.
Range binary
Feedback Deck stops at the beginning.

Baru pada versi 1.10.0.
[ChannelN]stop
[PreviewDeckN]stop
[SamplerN]stop

Stops a player.
Range binary
Feedback Pause Button. Deck pauses at the current position.

Baru pada versi 1.10.0.
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[ChannelN]sync_enabled
[PreviewDeckN]sync_enabled
[SamplerN]sync_enabled

Syncs the tempo and phase (depending on quantize) to that of the other track (if BPM is detected on both). Click
and hold for at least one second activates sync lock on that deck.

Range binary
Feedback If enabled, the Sync button stays lit and tempo slider snap to the appropriate value. Slider

adjustments are linked on all decks that have sync lock enabled.
Baru pada versi 2.0.0.

[ChannelN]sync_master
[PreviewDeckN]sync_master
[SamplerN]sync_master

Sets deck as leader clock.
Range binary
Feedback If enabled, the Sync button stays lit and tempo slider snap to the appropriate value. Slider

adjustments are linked on all decks that have sync lock enabled.
Baru pada versi 2.0.0.
Berubah pada versi 2.3.0: This button just enables sync lockmode (similar to [ChannelN],sync_enabled),
it does not actually guarantee the deck will be the sync leader. This will be fixed in a future version.

[ChannelN]sync_mode
[PreviewDeckN]sync_mode
[SamplerN]sync_mode

Baru pada versi 2.0.0.
Range

Value Meaning
0 Sync lock disabled for that deck
1 Deck is sync follower
2 Deck is sync leader

[ChannelN]sync_key
[PreviewDeckN]sync_key
[SamplerN]sync_key

Feedback Key value widget
Match musical key.
Baru pada versi 2.0.0.

[ChannelN]track_color
[PreviewDeckN]track_color
[SamplerN]track_color

Color of the currently loaded track or -1 if no track is loaded or the track has no color.
Range 3-Byte RGB color code (or -1)
Feedback Track color changes in the library view.

Baru pada versi 2.3.0.
[ChannelN]track_loaded
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[PreviewDeckN]track_loaded
[SamplerN]track_loaded

Whether a track is loaded in the specified deck
Range binary, read-only
Feedback Waveform and track metadata shown in deck

Baru pada versi 2.1.0.
[ChannelN]track_samplerate
[PreviewDeckN]track_samplerate
[SamplerN]track_samplerate

Sample rate of the track loaded on the specified deck
Range absolute value, read-only
Feedback None

Baru pada versi 1.9.0.
[ChannelN]track_samples
[PreviewDeckN]track_samples
[SamplerN]track_samples

Number of sound samples in the track loaded on the specified deck
Range absolute value, read-only
Feedback None

[ChannelN]volume
[PreviewDeckN]volume
[SamplerN]volume

Adjusts the channel volume fader
This is a ControlPotMeter control.

Range default
Feedback Deck volume fader

[ChannelN]mute
[PreviewDeckN]mute
[SamplerN]mute

Mutes the channel
Range binary
Feedback Mute button

Baru pada versi 2.0.0.
[ChannelN]vinylcontrol_enabled
[PreviewDeckN]vinylcontrol_enabled
[SamplerN]vinylcontrol_enabled

Toggles whether a deck is being controlled by digital vinyl.
Range binary
Feedback When enabled, a vinyl indication should appear onscreen indicating green for enabled.

Baru pada versi 1.10.0.
[ChannelN]vinylcontrol_cueing
[PreviewDeckN]vinylcontrol_cueing
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[SamplerN]vinylcontrol_cueing
Determines how cue points are treated in vinyl control relative mode.

Range

Value Meaning
0 Cue points ignored
1 One Cue - If needle is dropped after the cue point, track will seek to that cue point
2 Hot Cue - Track will seek to nearest previous hotcue

Baru pada versi 1.10.0.
[ChannelN]vinylcontrol_mode
[PreviewDeckN]vinylcontrol_mode
[SamplerN]vinylcontrol_mode

Determines how vinyl control interprets needle information.
Range

Value Meaning
0 Absolute Mode (track position equals needle position and speed)
1 Relative Mode (track tempo equals needle speed regardless of needle position)
2 Constant Mode (track tempo equals last known-steady tempo regardless of needle in-

put

See Control Mode for details.
Feedback 3-way button indicates status

Baru pada versi 1.10.0.
[ChannelN]vinylcontrol_status
[PreviewDeckN]vinylcontrol_status
[SamplerN]vinylcontrol_status

Provides visual feedback with regards to vinyl control status.
Range 0.0-3.0, read-only
Feedback Off for control disabled, green for control enabled, blinking yellow for when the needle

reaches the end of the record, and red for needle skip detected
Baru pada versi 1.10.0.

[ChannelN]visual_bpm
[PreviewDeckN]visual_bpm
[SamplerN]visual_bpm

BPM to display in the GUI (updated more slowly than the actual BPM).
Range ?
Feedback BPM value widget

Baru pada versi 2.0.0.
[ChannelN]visual_key
[PreviewDeckN]visual_key
[SamplerN]visual_key

Current musical key after pitch shifting to display in the GUI using the notation selected in the preferences
Range ?
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Feedback Key value widget
Baru pada versi 2.0.0.

[ChannelN]visual_key_distance
[PreviewDeckN]visual_key_distance
[SamplerN]visual_key_distance

The distance to the nearest key measured in cents
This is a ControlPotMeter control.

Range -0.5..0.5
Feedback Key value widget

Baru pada versi 2.0.0.
[ChannelN]VuMeter
[PreviewDeckN]VuMeter
[SamplerN]VuMeter

Outputs the current instantaneous deck volume
This is a ControlPotMeter control.

Range default
Feedback Deck VU meter

[ChannelN]VuMeterL
[PreviewDeckN]VuMeterL
[SamplerN]VuMeterL

Outputs the current instantaneous deck volume for the left channel
This is a ControlPotMeter control.

Range default
Feedback Deck VU meter L

[ChannelN]VuMeterR
[PreviewDeckN]VuMeterR
[SamplerN]VuMeterR

Outputs the current instantaneous deck volume for the right channel
This is a ControlPotMeter control.

Range default
Feedback Deck VU meter R

[ChannelN]waveform_zoom
[PreviewDeckN]waveform_zoom
[SamplerN]waveform_zoom

Zooms the waveform to look ahead or back as needed.
Range 1.0 - 10.0
Feedback Waveform zoom buttons

Baru pada versi 1.11.0.
[ChannelN]waveform_zoom_up
[PreviewDeckN]waveform_zoom_up
[SamplerN]waveform_zoom_up

Waveform Zoom Out
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Range ?
Feedback Waveform zoom buttons

Baru pada versi 1.11.0.
[ChannelN]waveform_zoom_down
[PreviewDeckN]waveform_zoom_down
[SamplerN]waveform_zoom_down

Waveform Zoom In
Range ?
Feedback Waveform zoom buttons

Baru pada versi 1.11.0.
[ChannelN]waveform_zoom_set_default
[PreviewDeckN]waveform_zoom_set_default
[SamplerN]waveform_zoom_set_default

Return to default waveform zoom level
Range ?
Feedback Waveform zoom buttons

Baru pada versi 1.11.0.
[ChannelN]wheel
[PreviewDeckN]wheel
[SamplerN]wheel

Affects relative playback speed and direction persistently (additive offset & must manually be undone).
Range -3.0..3.0
Feedback Waveform

Deprecated controls

These controls have been deprecated, new controller mappings should use the alternatives.
[ChannelN]beatloop
[PreviewDeckN]beatloop
[SamplerN]beatloop

Setup a loop over the set number of beats.
Range positive real number
Feedback A loop is shown over the set number of beats.

Ditinggalkan sejak versi 2.1.0: Use [ChannelN],beatloop_size and [ChannelN],beatloop_toggle instead.
[ChannelN]reloop_exit
[PreviewDeckN]reloop_exit
[SamplerN]reloop_exit

Toggles the current loop on or off. If the loop is ahead of the current play position, the track will keep playing
normally until it reaches the loop.

Range binary
Feedback Loop range in waveform activates or deactivates.

Ditinggalkan sejak versi 2.1.0: Use [ChannelN],reloop_toggle instead.
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[ChannelN]jog
[PreviewDeckN]jog
[SamplerN]jog

Affects relative playback speed and direction for short instances (additive & is automatically reset to 0).
Range -3.0..3.0
Feedback waveform

Ditinggalkan sejak versi ??: Use the JavaScript engine.scratch functions instead.
[ChannelN]scratch
[PreviewDeckN]scratch
[SamplerN]scratch

Affects playback speed and direction ([differently whether currently playing or not](https://bugs.launchpad.net/
mixxx/+bug/530281)) (multiplicative).

Range -3.0..3.0
Feedback Waveform

Ditinggalkan sejak versi ??: Use the JavaScript engine.scratch functions instead.
[ChannelN]filter
[PreviewDeckN]filter
[SamplerN]filter

Toggles the filter effect.
Range binary
Feedback Filter button

Baru pada versi 2.0.0.
Ditinggalkan sejak versi 2.0.0: Use [QuickEffectRack1_[ChannelN]_Effect1],enabled instead.

[ChannelN]filterDepth
[PreviewDeckN]filterDepth
[SamplerN]filterDepth

Adjusts the intensity of the filter effect.
Range default
Feedback Filter depth knob

Baru pada versi 2.0.0.
Ditinggalkan sejak versi 2.0.0: Use [QuickEffectRack1_[ChannelN]],super1 instead.

[ChannelN]filterLow
[PreviewDeckN]filterLow
[SamplerN]filterLow

Adjusts the gain of the low EQ filter.
Range 0.0..1.0..4.0
Feedback Low EQ knob

Ditinggalkan sejak versi 2.0.0: Use [EqualizerRack1_[ChannelN]_Effect1],parameter1 instead.
[ChannelN]filterLowKill
[PreviewDeckN]filterLowKill
[SamplerN]filterLowKill

Holds the gain of the low EQ to -inf while active
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Range binary
Feedback Low EQ kill switch

Ditinggalkan sejak versi 2.0.0: Use [EqualizerRack1_[ChannelI]_Effect1],
button_parameter1 instead.

[ChannelN]filterMid
[PreviewDeckN]filterMid
[SamplerN]filterMid

Adjusts the gain of the mid EQ filter..
Range 0.0..1.0..4.0
Feedback Mid EQ knob

Ditinggalkan sejak versi 2.0.0: Use [EqualizerRack1_[ChannelI]_Effect1],parameter2 instead.
[ChannelN]filterMidKill
[PreviewDeckN]filterMidKill
[SamplerN]filterMidKill

Holds the gain of the mid EQ to -inf while active.
Range binary
Feedback Mid EQ kill switch

Ditinggalkan sejak versi 2.0.0: Use [EqualizerRack1_[ChannelI]_Effect1],
button_parameter2 instead.

[ChannelN]filterHigh
[PreviewDeckN]filterHigh
[SamplerN]filterHigh

Adjusts the gain of the high EQ filter.
Range 0.0..1.0..4.0
Feedback High EQ knob

Ditinggalkan sejak versi 2.0.0: Use [EqualizerRack1_[ChannelI]_Effect1],parameter3 instead.
[ChannelN]filterHighKill
[PreviewDeckN]filterHighKill
[SamplerN]filterHighKill

Holds the gain of the high EQ to -inf while active.
Range binary
Feedback High EQ kill switch

Ditinggalkan sejak versi 2.0.0: Use [EqualizerRack1_[ChannelI]_Effect1],
button_parameter3 instead.

[ChannelN]beatloop_X
[PreviewDeckN]beatloop_X
[SamplerN]beatloop_X

Setup a loop over X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64
Range toggle
Feedback A loop is shown over X beats.

Baru pada versi 1.10.0.
Ditinggalkan sejak versi 2.0.0: Use [ChannelN],beatloop_X_activate instead.
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Global Sampler controls

These controls can be used to control all samplers.
[Samplers]show_samplers

Range binary
Feedback Shows Sampler bank(s)

[Sampler]SaveSamplerBank
Save sampler configuration. Make currently loaded tracks in samplers instantly available at a later point.

Range binary
Feedback Opens file dialog. Configuration file can be named and saved.

[Sampler]LoadSamplerBank
Load saved sampler configuration file and add tracks to the available samplers.

Range binary
Feedback Opens file dialog. Select configuration file.

16.5.4 Microphones and Auxiliary Channels

In contrast to decks, preview decks and samplers, microphones and auxiliary channels are input channels. You can map
audio interface's inputs to mixxx's auxiliary input channels and connect external audio source to it (cellphone, mp3 player).
Then you can use yourMIDI controller to control its volume and some other parameters (orientation, gain, volume), apply
effects and use the prelisten function.

Catatan: Although the first auxiliary group is named [Auxiliary1], the group for the first microphone is just called
[Microphone], not [Microphone1].

[MicrophoneN]enabled
[AuxiliaryN]enabled

1 if a channel input is enabled, 0 if not.
Range binary
Feedback Microphone is enabled.

Baru pada versi 1.10.0.
Ditinggalkan sejak versi 2.0.0: Use [MicrophoneN],input_configured instead.

[MicrophoneN]input_configured
[AuxiliaryN]input_configured

1 if there is input is configured for this channel, 0 if not.
Range binary, read-only
Feedback Configured channel in the sound preferences.

[MicrophoneN]master
[AuxiliaryN]master

Hold value at 1 to mix channel input into the master output. For [MicrophoneN] use [MicrophoneN],
talkover instead. Note that [AuxiliaryN] also take [AuxiliaryN],orientation into account.

Range binary
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Feedback Auxiliary: Play button Microphone: N/A
[AuxiliaryN]orientation

Set channel orientation for the crossfader.
Range

Value Meaning
0 Left side of crossfader
1 Center (not affected by crossfader)
2 Right side of crossfader

Feedback None
Baru pada versi 1.10.0.

[MicrophoneN]orientation
Baru pada versi 1.10.0.
Ditinggalkan sejak versi 1.10.0: The control is not processed in theMixer, which is also why there are no orientation
controls for Microphones in the GUI.

[MicrophoneN]PeakIndicator
[AuxiliaryN]PeakIndicator

Indicates when the signal is clipping (too loud for the hardware and is being distorted)
This is a ControlPotMeter control.

Range binary
Feedback Microphone Clip light

Baru pada versi 1.10.0.
[MicrophoneN]PeakIndicatorL
[AuxiliaryN]PeakIndicatorL

Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the left channel
This is a ControlPotMeter control.

Range binary
Feedback Clip light (left)

Baru pada versi 2.0.0.
[MicrophoneN]PeakIndicatorR
[AuxiliaryN]PeakIndicatorR

Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the right channel
This is a ControlPotMeter control.

Range binary
Feedback Clip light (right)

Baru pada versi 2.0.0.
[MicrophoneN]pfl
[AuxiliaryN]pfl

Toggles headphone cueing (PFL).
Range binary
Feedback Headphone button
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[MicrophoneN]talkover
[AuxiliaryN]talkover

Hold value at 1 to mix channel input into the master output. For [AuxiliaryN] use [AuxiliaryN],
master instead. Note that [AuxiliaryN] also take [AuxiliaryN],orientation into account.

Range binary
Feedback Microphone: Talk button Auxiliary: N/A

Baru pada versi 1.10.0.
[MicrophoneN]volume
[AuxiliaryN]volume

Adjusts the channel volume fader
This is a ControlPotMeter control.

Range default
Feedback Microphone volume fader changes

Baru pada versi 1.10.0.
[MicrophoneN]pregain
[AuxiliaryN]pregain

Adjusts the gain of the input
This is a ControlPotMeter control.

Range 0.0..1.0..4.0
Feedback Microphone gain knob

[MicrophoneN]mute
[AuxiliaryN]mute

Mutes the channel
Range binary
Feedback Mute button

Baru pada versi 2.0.0.
[MicrophoneN]VuMeter
[AuxiliaryN]VuMeter

Outputs the current instantaneous channel volume
This is a ControlPotMeter control.

Range default
Feedback Microphone VU meter changes

Baru pada versi 1.10.0.
[MicrophoneN]VuMeterL
[AuxiliaryN]VuMeterL

Outputs the current instantaneous deck volume for the left channel
This is a ControlPotMeter control.

Range default
Feedback Deck VU meter L

Baru pada versi 2.0.0.
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[MicrophoneN]VuMeterR
[AuxiliaryN]VuMeterR

Outputs the current instantaneous deck volume for the right channel
This is a ControlPotMeter control.

Range default
Feedback Deck VU meter R

Baru pada versi 2.0.0.

16.5.5 The [VinylControl] group

The [VinylControl] group can toggle the vinyl control feature.
[VinylControl]Toggle

Moves control by a vinyl control signal from one deck to another if using the single deck vinyl control (VC) feature.
Range binary
Feedback If VC isn't enabled on any decks, enable it on the first one we're receiving samples for. If

VC is enabled on a single (exclusive) deck, and another deck is setup to receive samples, disable
it on the former deck and enable it on the next eligible deck (ordered by deck number). If VC is
enabled on multiple decks, don't do anything.

Baru pada versi 1.10.0.
[VinylControl]show_vinylcontrol

Toggle the vinyl control section in skins.
Range binary
Feedback Vinyl controls are shown

Baru pada versi 1.10.0.
[VinylControl]gain

Allows to amplify the "phono" level of attached turntables to "line" level. This is equivalent to setting the turntable
boost in Options ‣ Preferences ‣ Vinyl Control

Range binary
Feedback position of Boost slider inOptions ‣ Preferences ‣ Vinyl Control (is not updated while viewing

this Preferences page)
Baru pada versi 1.10.0.

16.5.6 The [Recording] controls

The controls in the [Recording] group can be used to query and control the recording of your mix.
[Recording]toggle_recording

Turns recording on or off.
Range binary
Feedback Recording icon

[Recording]status
Indicates whether Mixxx is currently recording.
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Range

Value Meaning
0 Recording Stopped
1 Initialize Recording
2 Recording Active

Feedback Recording icon

16.5.7 AutoDJ controls

The [AutoDJ] controls allow interacting with AutoDJ.
[AutoDJ]enabled

Turns Auto DJ on or off.
Range binary
Feedback AutoDJ button

Baru pada versi 1.11.0.
[AutoDJ]shuffle_playlist

Shuffles the content of the Auto DJ playlist.
Range binary
Feedback Order of tracks in the AutoDJ playlist changes.

Baru pada versi 1.11.0.
[AutoDJ]skip_next

Skips the next track in the Auto DJ playlist.
Range binary
Feedback Skipped track is removed from the AutoDJ playlist.

Baru pada versi 1.11.0.
[AutoDJ]fade_now

Triggers the transition to the next track.
Range binary
Feedback Crossfader slider moves to the other side.

Baru pada versi 1.11.0.

16.5.8 The [Library] controls

The controls in the [Library] group can be used to navigate the library. Note that [Library],MoveUp and other
Move and Scroll controls emulate keypresses and therefore require the Mixxx window to be focused.
[Library]MoveUp

Equivalent to pressing the Up key on the keyboard
Range Binary
Feedback Currently selected item changes
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Baru pada versi 2.1.0.
[Library]MoveDown

Equivalent to pressing the Down key on the keyboard
Range Binary
Feedback Currently selected item changes

Baru pada versi 2.1.0.
[Library]MoveVertical

Move the specified number of locations up or down. Intended to be mapped to an encoder knob.
Range Relative (positive values move down, negative values move up)
Feedback Currently selected item changes

Baru pada versi 2.1.0.
[Library]ScrollUp

Equivalent to pressing the PageUp key on the keyboard
Range Binary
Feedback Currently selected item changes

Baru pada versi 2.1.0.
[Library]ScrollDown

Equivalent to pressing the PageDown key on the keyboard
Range Binary
Feedback Currently selected item changes

Baru pada versi 2.1.0.
[Library]ScrollVertical

Scroll the specified number of pages up or down. Intended to be mapped to an encoder knob.
Range Relative (positive values move down, negative values move up)
Feedback Currently selected item changes

Baru pada versi 2.1.0.
[Library]MoveLeft

Equivalent to pressing the Left key on the keyboard
Range Binary
Feedback Currently selected item changes

Baru pada versi 2.1.0.
[Library]MoveRight

Equivalent to pressing the Right key on the keyboard
Range Binary
Feedback Currently selected item changes

Baru pada versi 2.1.0.
[Library]MoveHorizontal

Move the specified number of locations left or right. Intended to be mapped to an encoder knob.
Range Relative (positive values move right, negative values move left)
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Feedback Currently selected item changes
Baru pada versi 2.1.0.

[Library]MoveFocusForward
Equivalent to pressing the Tab key on the keyboard

Range Binary
Feedback Currently focused pane changes

Baru pada versi 2.1.0.
[Library]MoveFocusBackward

Equivalent to pressing the Shift + Tab key on the keyboard
Range Binary
Feedback Currently focused pane changes

Baru pada versi 2.1.0.
[Library]MoveFocus

Move focus the specified number of panes forward or backwards. Intended to be mapped to an encoder knob.
Range Relative (positive values move forward, negative values move backward)
Feedback Currently focused pane changes

Baru pada versi 2.1.0.
[Library]GoToItem

Triggers different actions, depending on which interface element currently has keyboard focus:

Search bar
text box moves focus to tracks table
Clear but-
ton

clears search text

Sidebar
collapsed
node

expands the item (except Tracks and Auto DJ)

leaf node moves focus to tracks table
Tracks
table

Performs the action selected in Preferences ‣ Library ‣ Track Double-Click Action (default is "Load
selected track"). Also see Preferences ‣ Decks ‣ Playing track protection

Dialogs /
popups

presses Enter. Note: the Move.. controls allow to move button focus.

Range Binary
Feedback Context dependent

Baru pada versi 2.1.0.
[Library]AutoDjAddBottom
[Playlist]AutoDjAddBottom

Add selected track(s) to Auto DJ Queue (bottom).
Range Binary
Feedback Append track(s) to Auto DJ playlist

Baru pada versi 2.0.0.
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[Library]AutoDjAddTop
[Playlist]AutoDjAddTop

Add selected track(s) to Auto DJ Queue (top).
Range Binary
Feedback Prepend track(s) to Auto DJ playlist

Baru pada versi 2.0.0.
[Library]show_coverart

Toggle the Cover Art in Library
Range Binary

[Library]font_size_increment
Increase the size of the library font. If the row height is smaller than the font-size the larger of the two is used.

Range Binary
Feedback Library view

Baru pada versi 2.0.0.
[Library]font_size_decrement

Decrease the size of the library font
Baru pada versi 2.0.0.

Range Binary
Feedback Library view

[Library]font_size_knob
Increase or decrease the size of the library font
Baru pada versi 2.0.0.

Range Relative
Feedback Library view

[Library]sort_column
Indicates the sorting column the track table

Range

Value Description Library Playlist Crate Browse
1 Artist X X X X
2 Title X X X X
3 Album X X X X
4 Albumartist X X X X
5 Year X X X X
6 Genre X X X X
7 Composer X X X X
8 Grouping X X X X
9 Tracknumber X X X X
10 Filetype X X X X
11 Native Location X X X X
12 Comment X X X X
13 Duration X X X X
14 Bitrate X X X X

berlanjut ke halaman berikutnya
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Table 2 – lanjutan dari halaman sebelumnya
Value Description Library Playlist Crate Browse
15 BPM X X X X
16 ReplayGain X X X X
17 Datetime Added X X X X
18 Times Played X X X X
19 Rating X X X X
20 Key X X X X
21 Preview X X X X
22 Coverart X X X
23 Position X
24 Playlist ID X
25 Location X
26 Filename X
27 File Modified Time X
28 File Creation Time X
29 Sample Rate
30 Track Color X X X

Feedback Sorting indicator in the column headers of the track table
Baru pada versi 2.3.0.

[Library]sort_column_toggle
Equivalent to clicking on column headers. A new value sets [Library],sort_column to that value and
[Library],sort_order to 0, setting the same value again will toggle [Library],sort_order.

Range Same as for[Library],sort_column or value 0 for sorting according the current column
with the cursor on it

Feedback Sorting indicator in the column headers of the track table
Baru pada versi 2.3.0.

[Library]sort_order
Indicate the sort order of the track tables.

Range Binary (0 for ascending, 1 for descending)
Feedback Sorting indicator in the column headers of the track table

Baru pada versi 2.3.0.
[Library]track_color_prev

Set color of selected track to previous color in palette.
Range Binary
Feedback Track color changes in the library view.

Baru pada versi 2.3.0.
[Library]track_color_next

Set color of selected track to next color in palette.
Range Binary
Feedback Track color changes in the library view.

Baru pada versi 2.3.0.

16.5. Mixxx Controls 170



Mixxx User Manual, Rilis 2.3.0

16.5.9 The [Shoutcast] controls

[Shoutcast]enabled
Shows if live Internet broadcasting is enabled.

Range ?
Feedback shoutcast only supports mp3 format as field

[Shoutcast]status
This control displays whether broadcasting connection to Shoutcast server was successfully established.

Range binary
Feedback None

16.5.10 The [Playlist] controls

[Playlist] controls allow navigating the sidebar and tracks table directly without considering the currently focused
widget. This is helpful when another application's window is focused. This group is going to be deprecated at some point,
with its controls added to [Library] above.
Lihat juga:
See bug #1772184 for the current status.
[Playlist]SelectPlaylist

Scrolls the given number of items (view, playlist, crate, etc.) in the side pane (can be negative for reverse direction).
Range relative value
Feedback Library sidebar highlight

[Playlist]SelectTrackKnob
Scrolls the given number of tracks in the track table (can be negative for reverse direction).

Range relative value
Feedback Library track table highlight

[Playlist]LoadSelectedIntoFirstStopped
Loads the currently highlighted song into the first stopped deck
Ditinggalkan sejak versi 2.1.0: Use [Library],GoToItem instead.

[Playlist]SelectNextPlaylist
Switches to the next view (Library, Queue, etc.)
Ditinggalkan sejak versi 2.1.0: Use [Library],MoveDown instead.

[Playlist]SelectPrevPlaylist

range binary
feedback Library sidebar

Switches to the previous view (Library, Queue, etc.)
Ditinggalkan sejak versi 2.1.0: Use [Library],MoveUp instead.

[Playlist]ToggleSelectedSidebarItem
Toggles (expands/collapses) the currently selected sidebar item.
Baru pada versi 1.11.0.
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Ditinggalkan sejak versi 2.1.0: Use [Library],GoToItem instead.
[Playlist]SelectNextTrack

Scrolls to the next track in the track table.
Ditinggalkan sejak versi 2.1.0: Use [Library],MoveDown instead.

[Playlist]SelectPrevTrack
Scrolls to the previous track in the track table.
Ditinggalkan sejak versi 2.1.0: Use [Library],MoveUp instead.

16.5.11 The [Controls] controls

The [Controls] group contains controls that didn't fit in any other group.
[Controls]touch_shift

Once enabled, all touch tab events are interpreted as right click. This control has been added to provide touchscreen
compatibility in 2.0 and might be replaced by a general modifier solution in the future.

Range binary
Feedback All Widgets

Baru pada versi 2.0.0.
[Controls]AutoHotcueColors

If enabled, colors will be assigned to newly created hotcues automatically.
Range binary
Feedback None

Baru pada versi 2.3.0.
[Controls]ShowDurationRemaining

Represents the current state of the remaining time duration display of the loaded track.
Range

Value Meaning
0 currently showing elapsed time, sets to remaining time
1 currently showing remaining time , sets to elapsed time
2 currently showing both (that means we are showing remaining, set to elapsed

Feedback None

16.5.12 The Effects Framework

In the list below,
• EffectRack1 leaves room for future expansion to multiple EffectRacks.
• N ranges from 1 to [EffectRack1],num_effectunits, inclusive.
• M ranges from 1 to [EffectRack1_EffectUnitN],num_effectslots, inclusive. (For a given value
of N)

• K ranges from 1 to[EffectRack1_EffectUnitN_EffectM],num_parameters, inclusive. (For given
values of N and M)
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• I ranges from 1 to [Master],num_decks, inclusive.
• J ranges from 1 to [Master],num_samplers, inclusive.

Baru pada versi 2.0.0.

Linking Values

Effect parameters can be linked to the effect's metaknob. This linkage can be user-controlled by changing the
link_type and the link_inverse control of the parameter. The default link type is loaded from the effect param-
eter's manifest's linkHint property.

Link Type Integer Value Interpretation
None 0 Not controlled by the metaknob
Linked 1 Controlled by the metaknob as it is
Linked Left 2 Controlled by the left side of the metaknob
Linked Right 3 Controlled by the right side of the metaknob
Linked Left Right 4 Controlled by both sides of the metaknob

Link Inverse Integer Value Interpretation
Normal 0 Linked in equal relation
Inverse 1 Linked in an inverse relation.

EQs and Filters

Equalizers and filters are special effects units. The EQs are controlled by [Equalizer-
Rack1_[ChannelI]_Effect1] and the filter knob is controlled by [QuickEffectRack1_[ChannelI]],
super1 and [QuickEffectRack1_[ChannelI]_Effect1],enabled. Users can choose between several
options for the effects loaded in these racks in the Equalizers section of the Preferences window.

Controls

[EffectRack1]show
Show the Effect Rack

Range binary
[EffectRack1]num_effectunits
[EqualizerRack1]num_effectunits
[QuickEffectRack1]num_effectunits

The number of EffectUnits in this rack
Range integer, read-only

[EffectRack1]clear
[EqualizerRack1]clear
[QuickEffectRack1]clear

Clear the Effect Rack
Range binary

[EffectRack1_EffectUnitN]chain_selector
[EqualizerRack1_[ChannelI]]chain_selector
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[QuickEffectRack1_[ChannelI]]chain_selector
Select EffectChain preset. > 0 goes one forward; < 0 goes one backward.

Range +1/-1
[EffectRack1_EffectUnitN]clear
[EqualizerRack1_[ChannelI]]clear
[QuickEffectRack1_[ChannelI]]clear

Clear the currently loaded EffectChain in this EffectUnit.
Range binary

[EffectRack1_EffectUnitN]enabled
[EqualizerRack1_[ChannelI]]enabled
[QuickEffectRack1_[ChannelI]]enabled

If true, the EffectChain in this EffectUnit will be processed. Meant to allow the user a quick toggle for the effect
unit.

Range binary, default true
[EffectRack1_EffectUnitN]focused_effect
[EqualizerRack1_[ChannelI]]focused_effect
[QuickEffectRack1_[ChannelI]]focused_effect

0 indicates no effect is focused; > 0 indicates the index of the focused effect. Focusing an effect only does something
if a controller mapping changes how it behaves when an effect is focused.

Range 0..num_effects
[EffectRack1_EffectUnitN]group_[ChannelI]_enable
[EqualizerRack1_[ChannelI]]group_[ChannelI]_enable
[QuickEffectRack1_[ChannelI]]group_[ChannelI]_enable

Whether or not this EffectChain applies to Deck I
Range binary

[EffectRack1_EffectUnitN]group_[Headphone]_enable
Whether or not this EffectChain applies to the Headphone output

Range binary
[EffectRack1_EffectUnitN]group_[Master]_enable

Whether or not this EffectChain applies to the Master output
Range binary

[EffectRack1_EffectUnitN]group_[SamplerJ]_enable
Whether or not this EffectChain applies to Sampler J

Range binary
[EffectRack1_EffectUnitN]loaded
[EqualizerRack1_[ChannelI]]loaded
[QuickEffectRack1_[ChannelI]]loaded

Whether an EffectChain is loaded into the EffectUnit
Range binary, read-only

[EffectRack1_EffectUnitN]mix
[EqualizerRack1_[ChannelI]]mix
[QuickEffectRack1_[ChannelI]]mix

The dry/wet mixing ratio for this EffectChain with the EngineChannels it is mixed with
This is a ControlPotMeter control.
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Range 0.0..1.0
[EffectRack1_EffectUnitN]next_chain
[EqualizerRack1_[ChannelI]]next_chain
[QuickEffectRack1_[ChannelI]]next_chain

Cycle to the next EffectChain preset after the currently loaded preset.
Range binary

[EffectRack1_EffectUnitN]num_effects
[EqualizerRack1_[ChannelI]]num_effects
[QuickEffectRack1_[ChannelI]]num_effects

The number of Effects that this EffectChain has
Range integer, read-only

[EffectRack1_EffectUnitN]num_effectslots
[EqualizerRack1_[ChannelI]]num_effectslots
[QuickEffectRack1_[ChannelI]]num_effectslots

The number of effect slots available in this EffectUnit.
Range integer, read-only

[EffectRack1_EffectUnitN]prev_chain
[EqualizerRack1_[ChannelI]]prev_chain
[QuickEffectRack1_[ChannelI]]prev_chain

Cycle to the previous EffectChain preset before the currently loaded preset.
Range binary

[EffectRack1_EffectUnitN]show_focus
[EqualizerRack1_[ChannelI]]show_focus
[QuickEffectRack1_[ChannelI]]show_focus

Whether to show focus buttons and draw a border around the focused effect in skins. This should not bemanipulated
by skins; it should only be changed by controller mappings.

Range binary
[EffectRack1_EffectUnitN]show_parameters
[EqualizerRack1_[ChannelI]]show_parameters
[QuickEffectRack1_[ChannelI]]show_parameters

Range binary
Whether to show all the parameters of each effect in skins or only show metaknobs.

[EffectRack1_EffectUnitN]super1
[EqualizerRack1_[ChannelI]]super1
[QuickEffectRack1_[ChannelI]]super1

The EffectChain superknob. Moves the metaknobs for each effect in the chain.
This is a ControlPotMeter control.

Range 0.0..1.0
[EffectRack1_EffectUnitN_EffectM]clear
[EqualizerRack1_[ChannelI]_Effect1]clear
[QuickEffectRack1_[ChannelI]_Effect1]clear

Clear the currently loaded Effect in this Effect slot from the EffectUnit.
Range binary

[EffectRack1_EffectUnitN_EffectM]effect_selector

16.5. Mixxx Controls 175



Mixxx User Manual, Rilis 2.3.0

[EqualizerRack1_[ChannelI]_Effect1]effect_selector
[QuickEffectRack1_[ChannelI]_Effect1]effect_selector

Select Effect -- >0 goes one forward, <0 goes one backward.
Range +1/-1

[EffectRack1_EffectUnitN_EffectM]enabled
[EqualizerRack1_[ChannelI]_Effect1]enabled
[QuickEffectRack1_[ChannelI]_Effect1]enabled

If true, the effect in this slot will be processed. Meant to allow the user a quick toggle for this effect.
Range binary, default true

[EffectRack1_EffectUnitN_EffectM]loaded
[EqualizerRack1_[ChannelI]_Effect1]loaded
[QuickEffectRack1_[ChannelI]_Effect1]loaded

Whether an Effect is loaded into this EffectSlot
Range binary, read-only

[EffectRack1_EffectUnitN_EffectM]next_effect
[EqualizerRack1_[ChannelI]_Effect1]next_effect
[QuickEffectRack1_[ChannelI]_Effect1]next_effect

Cycle to the next effect after the currently loaded effect.
Range binary

[EffectRack1_EffectUnitN_EffectM]num_parameters
[EqualizerRack1_[ChannelI]_Effect1]num_parameters
[QuickEffectRack1_[ChannelI]_Effect1]num_parameters

The number of parameters the currently loaded effect has.
Range integer, read-only, 0 if no effect is loaded

[EffectRack1_EffectUnitN_EffectM]num_parameterslots
[EqualizerRack1_[ChannelI]_Effect1]num_parameterslots
[QuickEffectRack1_[ChannelI]_Effect1]num_parameterslots

The number of parameter slots available.
Range integer, read-only

[EffectRack1_EffectUnitN_EffectM]num_button_parameters
[EqualizerRack1_[ChannelI]_Effect1]num_button_parameters
[QuickEffectRack1_[ChannelI]_Effect1]num_button_parameters

The number of button parameters the currently loaded effect has.
Range integer, read-only, 0 if no effect is loaded

[EffectRack1_EffectUnitN_EffectM]num_button_parameterslots
[EqualizerRack1_[ChannelI]_Effect1]num_button_parameterslots
[QuickEffectRack1_[ChannelI]_Effect1]num_button_parameterslots

The number of button parameter slots available.
Range integer, read-only

[EffectRack1_EffectUnitN_EffectM]meta
[EqualizerRack1_[ChannelI]_Effect1]meta
[QuickEffectRack1_[ChannelI]_Effect1]meta

Controls the parameters that are linked to the metaknob.
This is a ControlPotMeter control.

Range 0..1
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[EffectRack1_EffectUnitN_EffectM]prev_effect
[EqualizerRack1_[ChannelI]_Effect1]prev_effect
[QuickEffectRack1_[ChannelI]_Effect1]prev_effect

Cycle to the previous effect before the currently loaded effect.
Range binary

[EffectRack1_EffectUnitN_EffectM]parameterK
[EqualizerRack1_[ChannelI]_Effect1]parameterK
[QuickEffectRack1_[ChannelI]_Effect1]parameterK

The scaled value of the Kth parameter. See the Parameter Values section for more information.
This is a ControlPotMeter control.

Range double
[EffectRack1_EffectUnitN_EffectM]parameterK_link_inverse
[EqualizerRack1_[ChannelI]_Effect1]parameterK_link_inverse
[QuickEffectRack1_[ChannelI]_Effect1]parameterK_link_inverse

The link direction of the Kth parameter to the effect's metaknob.
Range bool

[EffectRack1_EffectUnitN_EffectM]parameterK_link_type
[EqualizerRack1_[ChannelI]_Effect1]parameterK_link_type
[QuickEffectRack1_[ChannelI]_Effect1]parameterK_link_type

The link type of the Kth parameter to the effects's metaknob.
Range enum

[EffectRack1_EffectUnitN_EffectM]parameterK_loaded
[EqualizerRack1_[ChannelI]_Effect1]parameterK_loaded
[QuickEffectRack1_[ChannelI]_Effect1]parameterK_loaded

Whether or not the Kth parameter slot has an effect parameter loaded into it.
Range binary, read-only

[EffectRack1_EffectUnitN_EffectM]parameterK_type
[EqualizerRack1_[ChannelI]_Effect1]parameterK_type
[QuickEffectRack1_[ChannelI]_Effect1]parameterK_type

The type of the Kth parameter value. See the Parameter Value Types table.
Range integer, read-only

[EffectRack1_EffectUnitN_EffectM]button_parameterK
[EqualizerRack1_[ChannelI]_Effect1]button_parameterK
[QuickEffectRack1_[ChannelI]_Effect1]button_parameterK

The value of the Kth parameter. See the Parameter Values section for more information.
Range double

[EffectRack1_EffectUnitN_EffectM]button_parameterK_loaded
[EqualizerRack1_[ChannelI]_Effect1]button_parameterK_loaded
[QuickEffectRack1_[ChannelI]_Effect1]button_parameterK_loaded

Whether or not the Kth parameter slot has an effect parameter loaded into it.
Range binary, read-only

[EffectRack1_EffectUnitN_EffectM]button_parameterK_type
[EqualizerRack1_[ChannelI]_Effect1]button_parameterK_type
[QuickEffectRack1_[ChannelI]_Effect1]button_parameterK_type

The type of the Kth parameter value. See the Parameter Value Types table.
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Range integer, read-only

16.5.13 Removed controls

These controls have been removed from Mixxx. Skins and controller mappings that attempt to use them will not work
correctly.
[ChannelN]flanger

Toggles the flanger effect.
Ditinggalkan sejak versi 2.0.0: This control has been removed without a direct replacement. Use the effects
framework instead.

[ChannelN]Hercules1
[ChannelN]Hercules2
[ChannelN]Hercules3
[ChannelN]Hercules4

Ditinggalkan sejak versi ??: This control has been removed.
[ChannelN]NextTask

Ditinggalkan sejak versi ??: This control has been removed.
[ChannelN]NextTrack

Ditinggalkan sejak versi ??: This control has been removed.
[ChannelN]PrevTask

Ditinggalkan sejak versi ??: This control has been removed.
[ChannelN]PrevTrack

Ditinggalkan sejak versi ??: This control has been removed.
[ChannelN]transform

Ditinggalkan sejak versi ??: This control has been removed.
[Flanger]lfoDepth

Adjusts the intensity of the flange effect
Ditinggalkan sejak versi 2.0.0: This control has been removed without a direct replacement. Use the effects
framework instead.

[Flanger]lfoDelay
Adjusts the phase delay of the flange effect in microseconds
Ditinggalkan sejak versi 2.0.0: This control has been removed without a direct replacement. Use the effects
framework instead.

[Flanger]lfoPeriod
Adjusts the wavelength of the flange effect in microseconds
Ditinggalkan sejak versi 2.0.0: This control has been removed without a direct replacement. Use the effects
framework instead.
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16.6 The Mixxx Settings Directory

The Mixxx settings directory contains all user data and settings of your Mixxx installation.

16.6.1 Location

Linux
~/.mixxx/

Note: make sure you have "Show hidden files" enabled in your file manager in order to show all dot-files and
directories.

Windows
Vista and up: %LOCALAPPDATA%\Mixxx
XP and below: %USERPROFILE%\Local Settings\Application Data\Mixxx\

Type either of those into the location bar of a Computer or Folder window.
macOS

Mixxx 2.3: ~/Library/Containers/org.mixxx.mixxx/Data/Library/Application
Support/Mixxx

Mixxx 2.2 and earlier: ~/Library/Application Support/Mixxx

16.6.2 Content

analysis This contains all waveform analysis data. This is used to compose a track's scrolling waveform and track
overview. If not existent, this data will be recreated each time a track is loaded into a Mixxx deck. Thus it does
not belong to the essential data that needs to be backed up.

broadcast_profiles All broadcast profiles you have configured.
controllers All controller mappings you stored. This can be downloaded and self-built mappings, as well as built-in

mappings that you modified in Preferences > Controllers > YourController manually or with the MIDI Wizard.
effects.xml The current configuration of the 4 effect units, incl. the state of all controls.
mixxx.cfg Everything you configured in the Preferences, deck settings, skin settings, AutoDJ configuration, effect routing

etc.
mixxx.log[.NN] Log files of the last few Mixxx sessions, with mixxx.log being the most recent one, followed by

mixxx.log.1 etc.
mixxxdb.sqlite The Mixxx library database. All track locations, all track metadata, saved cues, loops, colors, playlists,

crates, ...
samplers.xml Stores tracks currently loaded to sample decks.
sandbox.cfg This is used under macOS to track which files Mixxx will have access to
soundconfig.xml Sound device configuration from Preferences > Sound Hardware
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16.7 Additional Resources

Got questions? Need more information? Want to contribute? There are a variety of other resources where you can find
out more:

• MixxxWebsite: For general information and updates, as well as the latest news onMixxx, go to: https://mixxx.org
• MixxxWiki: For up-to-date information about supported DJ hardware, documentation on making controller map-
pings, and other tips and tricks, go to: https://github.com/mixxxdj/mixxx/wiki

• Keyboard Shortcuts: This a list for all default Mixxx keyboard shortcuts. Please note that these shortcuts are
for keyboards configured in English layout and default shortcuts may be different if your language setting is not
English. default keyboard mappings

• Mixxx Community Forums: To search for answers, post your question or answer other DJ's questions, go to:
https://mixxx.org/forums

• Mixxx Zulip Chat: Hang out with Mixxx developers and users on our Zulip chat. Stand-alone apps for Zulip can
be configured to use the server mixxx.zulipchat.com.

• Mixxx Source Code: To download the source code for Mixxx, go to: https://github.com/mixxxdj/mixxx
• Mixxx Bug Tracker: To report a bug or request a feature, go to: https://bugs.launchpad.net/mixxx
• Mixxx Translations: To translate Mixxx and promote your mother tongue, go to: https://www.transifex.com/
mixxx-dj-software/public/. Please read the Translation FAQ first.

• Social Media: Follow us on Twitter, and Facebook.

16.8 Changelog

16.8.1 2.3.2 (Unreleased)

• Playlist: Enable sorting by color #4352 lp:1945976
• Fix crash when using Doubling/Halving/etc. BPM from track's Properties window on tracks without BPM #4587
lp:1955853

• Fix writing metadata on Windows for files that have never been played #4586 lp:1955331
• Preserve file creation time when writing metadata on Windows #4586 lp1955314
• Fix handling of file extension when importing and exporting sampler settings #4539
• Fix crash when using an empty directory as resource path using the --resource-path command line option
#4575 lp1934560

Packaging

• Downloads of external dependencies are placed in build/downloads
• The sources for libkeyfinder are now expected in build/downloads/libkeyfinder-2.2.5.zip instead of
build/download/libkeyfinder/v2.2.5.zip

• CMake: Adjust the download directory and name of external dependencies #4511
• Fix/Improve Appstream metainfo #4344 #4346 #4349
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16.8.2 2.3.1 (2021-09-29)

• Added mapping for the Numark DJ2GO2 Touch controller #4108 #4287
• Added mapping for the Numark Mixtrack Pro FX controller #4160
• Updated mapping for Behringer DDM4000 mixer #4262
• Updated mapping for Denon MC7000 controller #4021
• Hercules Inpulse 300: Add better FX controls and other minor improvements #4246
• Denon MC7000: Improve slip mode and jog wheel handling #4021 #4324
• Disabled detection of keyboards and mice as HID controllers #4243
• Disabled detection of all HID controllers with Apple's vendor ID. Apple doesn't build actual controllers. #4260
#4273

• Add support for HiDPI scale factors of 125% and 175% (only with Qt 5.14+) lp1938102 #4161
• Fix unhandled exception when parsing corrupt Rekordbox PDB files lp1933853 #4040
• Fix Echo effect adding left channel samples to right channel #4141
• Fix bad phase seek when starting from preroll lp1930143 #4093
• Fix bad phase seek when a channel's audible status changes #4156
• Tango skin: Show crossfader assign buttons by default #4046
• Fix keyfinder library in arm64 builds #4047
• Fix wrong track being recorded in History lp1933991 #4041 #4059 #4107 #4296
• Fix support for relative paths in the skin system which caused missing images in third-party skins #4151
• Fix relocation of directories with special/reserved characters in path name #4146
• Update keyboard shortcuts sheet #4042
• Library: resize the Played checkbox and BPM lock with the library font #4050
• Don't allow Input focus on waveforms #4134
• Fix performance issue on AArch64 by enabling flush-to-zero for floating-point arithmetic #4144
• Fix custom key notation not restored correctly after restart #4136
• Traktor S3: Disable scratch when switching decks to prevent locked scratch issue #4073
• FFmpeg: Ignore inaudible samples before start of stream #4245
• Controller Preferences: Don't automatically enable checkbox if controller is disabled #4244 lp:1941042
• Tooltips: Always show tooltips in preferences #4198 lp:1840493
• Tooltips: Use item label for tooltips in library side bar and show ID when debugging. #4247
• Library sidebar: Also activate items on PageUp/Down events. #4237
• Fix handling of preview button cell events in developer mode. #4264 lp:1929141
• Auto DJ: Fix bug which could make an empty track stop Auto DJ. #4267 lp:1941743
• Fix Auto DJ skipping tracks randomly #4319 lp1941989
• Fix high CPU load due to extremely high internal sync clock values #4312 lp1943320
• Fix preference option for re-analyzing beatgrids imported from other software #4288
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• Fix wrong base tag used for deployment and displayed in About dialog #4070

Packaging

• It is no longer necessary to manually copy the udev rule file in packaging scripts. Now pkg-config is used to
determine the udevdir used to install the rules file in the CMake install step when CMAKE_INSTALL_PREFIX
is / or /usr. #4126

• Various build issues on FreeBSD are fixed #4122 #4123 #4124
• .desktop file has be renamed to org.mixxx.Mixxx.desktop according to Freedesktop standards #4206
• Uses system provided hidapi library if version >= 0.10.1 #4215
• Please update PortAudio to 19.7 if you have not done so already. This is required for Mixxx to work with PipeWire
via the JACK API for many devices.

• Install multiple sizes of rasterized icons #4204 #4315 #4254
• CMake: Fixed detection of SoundTouch pkgconfig file and version #4209
• Fix AppStream metainfo #4205 #4317

16.8.3 2.3.0 (2021-06-28)

Hotcues

• Add hotcue colors and custom labels by right clicking hotcue buttons or right clicking hotcues on overview wave-
forms #2016 #2520 #2238 #2560 #2557 #2362

• Mouse hover cues on overview waveform to show time remaining until the cue #2238

Hotcue & Track Colors

• Add configurable color per track #2470 #2539 #2545 #2630 lp:1100882
• Add customizable color palettes for hotcue and track colors #2530 #2589 #3749 #2902
• Add hotcue color find-and-replace tool #2547

Importing From Other DJ Software

• Import cue points, track colors, and playlists from Serato file tags & database #2480 #2526 #2499 #2495 #2673
#3885

– Note: Mixxx does not yet support multiple loops per track. We are working on this for Mixxx 2.4. In Mixxx
2.3, if you import a track with multiple loops from Serato, Mixxx will use the first loop cue as the single loop
Mixxx currently supports. The imported loops are still stored in Mixxx's database and are treated as hotcues
in Mixxx 2.3. If you do not delete these hotcues, they will be usable as loops in Mixxx 2.4. Serato keeps
loops and hotcues in separate lists, but Mixxx does not, so loops from Serato are imported starting as hotcue
9.

• Import cue points, track colors, and playlists from Rekordbox USB drives #2119 #2555 #2543 #2779
– Note: The first Rekordbox memory cue is imported for the main cue button in Mixxx and the remaining
Rekordbox memory cues are imported as Mixxx hotcues, starting with the next hotcue number after the last
hotcue from Rekordbox.
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– Note: Mixxx does not yet support multiple loops per track. Imported loops from Rekordbox are treated like
imported loops from Serato, so refer to the note above for details.

Intro & Outro Cues

• Add intro & outro range cues with automatic silence detection #1242
• Show duration of intro & outro ranges on overview waveform #2089
• Use intro & outro cues in AutoDJ transitions #2103

Deck cloning

• Add deck cloning (also known as "instant doubles" in other DJ software) by dragging and dropping between decks
#1892 and samplers #3200

• Clone decks by double pressing the load button on a controller (with option to disable this) #2024 #2042

Skins & GUI

• Aesthetically revamped LateNight skin #2298 #2342
• Right click overview waveform to show time remaining until that point #2238
• Show track info dialog when double clicking track labels in decks #2990
• Show track context menu when right clicking text in decks #2612 #2675 #2684 #2696
• Add laptop battery widget to skins #2283 #2277 #2250 #2228 #2221 #2163 #2160 #2147 #2281 #2319 #2287
• Show when passthrough mode is active on overview waveforms #2575 #2616
• Changed format of currently playing track in window title from "artist, title" to "artist - title" #2807
• Workaround Linux skin change crash #3144 lp:1885009
• Fix touch control lp:1895431
• Fix broken knob interaction on touchscreens #3512
• AutoDJ: Make "enable" shortcut work after startup #3242
• Add rate range indicator #3693
• Allow menubar to be styled #3372 #3788
• Add Donate button to About dialog #3838 #3846
• Add Scrollable Skin Widget #3890
• Fix minor visual issues in Skins #3958 #3954 #3941 #3938 #3936 #3886 #3927 #3844 #3933 #3835 #3902 #3931
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Music Feature Analysis

• Multithreaded analysis for much faster batch analysis on multicore CPUs #1624 #2142 lp:1641153
• Fix bugs affecting key detection accuracy #2137 #2152 #2112 #2136

– Note: Users who have not manually corrected keys are advised to clear all keys in their library by pressing
Ctrl + A in the library, right clicking, going to Reset -> Key, then reanalyzing their library. This will freeze
the GUI while Mixxx clears the keys; this is a known problem that we will not be able to fix for 2.3. Wait
until it is finished and you will be able to reanalyze tracks for better key detection results.

• Remove VAMP plugin support and use Queen Mary DSP library directly. vamp-plugin-sdk and vamp-hostsdk are
no longer required dependencies. #926

• Improvements BPM detection on non-const beatgrids #3626
• Fix const beatgrid placement #3965 #3973

Music Library

• Add support for searching for empty fields (for example crate:"") lp:1788086
• Improve synchronization of track metadata and file tags #2406
• Library Scanner: Improve hashing of directory contents #2497
• Rework of Cover Image Hashing lp:1607097 #2507 #2508
• MusicBrainz: Handle 301 status response #2510
• MusicBrainz: Add extended metadata support lp:1581256 #2522
• TagLib: Fix detection of empty or missing file tags lp:1865957 #2535
• Fix caching of duplicate tracks that reference the same file #3027
• Use 6 instead of only 4 compatible musical keys (major/minor) #3205
• Fix possible crash when trying to refocus the tracks table while another Mixxx window has focus #3201
• Don't create new tags in file when exporting metadata to it #3898
• Fix playlist files beginning with non-english characters not being loaded #3916
• Enable sorting in "Hidden Tracks" and "Missing Tracks" views #3828 lp:1828555 lp:1924616
• Fix track table being empty after start #3935 lp:1930546 lp:1924843

Audio Codecs

• Add FFmpeg audio decoder, bringing support for ALAC files #1356
• Include LAME MP3 encoder with Mixxx now that the MP3 patent has expired lp:1294128 buildserver:#37 build-
server:9e8bcee

• Add Opus streaming and recording support. lp:1338413
• Remove support for SoundSource plugins because the code was not well-maintained and could lead to crashes
lp:1792747

• Add HE-AAC encoding capabilities for recording and broadcasting #3615
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Audio Engine

• Fix loss of precision when dealing with floating-point sample positions while setting loop out position and seeking
using vinyl control #3126 #3127

• Prevent moving a loop beyond track end #3117 lp:1799574
• Fix possible memory corruption using JACK on Linux #3160
• Fix changing of vinyl lead-in time lp:1915483 #3781
• Fix tempo change of non-const beatgrid track on audible deck when cueing another track #3772
• Fix crash when changing effect unit routing #3882 lp:1775497
• Make microphone ducking use strength knob the same way in automatic & manual mode #2750

Controllers

• Improve workflow for configuring controller mappings and editing mappings #2569 #3278 #3667
• Improve error reporting from controller scripts #2588
• Make hotcue and track colors mappable on controllers #2030 #2541 #2665 #2520
• Add way to change library table sorting from controllers #2118
• Add support for velocity sensitive sampler buttons in Components JS library #2032
• Add logging when script ControlObject callback is disconnected successfully #2054
• Add controller mapping for Roland DJ-505 #2111
• Add controller mapping for Numark iDJ Live II #2818
• Add controller mapping for Hercules DJControl Inpulse 200 #2542
• Add controller mapping for Hercules DJControl Jogvision #2370
• Add controller mapping for Pioneer DDJ-200 #3185 #3193 #3742 #3793 #3949
• Add controller mapping for Pioneer DDJ-400 #3479
• Add controller mapping for ION Discover DJ Pro #2893
• Add controller mapping for Native Instrument Traktor Kontrol S3 #3031
• Add controller mapping for Behringer BCR2000 #3342 #3943
• Add controller mapping for Behringer DDM4000 #3542
• Update controller mapping for Allen & Heath Xone K2 to add intro/outro cues #2236
• Update controller mapping for Hercules P32 for more accurate headmix control #3537
• Update controller mapping for Native Instruments Traktor Kontrol S4MK2 to add auto-slip mode and pitch fader
range #3331

• Fix Pioneer DDJ-SB2 controller mapping auto tempo going to infinity bug #2559 lp:1846403
• Fix Numark Mixtrack Pro 3 controller mapping inverted FX on/off control #3758
• Gracefully handle MIDI overflow #825
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Other

• Add CMake build system with ccache and sccache support for faster compilation times and remove SCons
#2280 #3618

• Make Mixxx compile even though QT_NO_OPENGL or QT_OPENGL_ES_2 is defined (fixes build on Raspberry
Pi) lp:1863440 #2504

• Fix ARM build issues #3602
• Fix missing manual in DEB package lp:1889776 #2985
• Add macOS codesigning and notarization to fix startup warnings #3281
• Don't trash user configuration if an error occurs when writing #3192
• Enable CUE sheet recording by default #3374
• Fix crash when double clicking GLSL waveforms with right mouse button #3904
• Derive Mixxx version from git describe #3824 #3841 #3848
• Improve tapping the BPM of a deck #3790 lp:1882776
• And countless other small fixes and improvements (too many to list them all!)

16.8.4 2.2.4 (2020-06-27)

• Store default recording format after "Restore Defaults" lp:1857806 #2414
• Prevent infinite loop when decoding corrupt MP3 files #2417
• Add workaround for broken libshout versions #2040 #2438
• Speed up purging of tracks lp:1845837 #2393
• Don't stop playback if vinyl passthrough input is configured and PASS button is pressed #2474
• Fix debug assertion for invalid crate names lp:1861431 #2477
• Fix crashes when executing actions on tracks that already disappeared from the DB #2527
• AutoDJ: Skip next track when both deck are playing lp:1399974 #2531
• Tweak scratch parameters for Mixtrack Platinum #2028
• Fix auto tempo going to infinity on Pioneer DDJ-SB2 #2559
• Fix bpm.tapButton logic and reject missed & double taps #2594
• Add controller mapping for Native Instruments Traktor Kontrol S2 MK3 #2348
• Add controller mapping for Soundless joyMIDI #2425
• Add controller mapping for Hercules DJControl Inpulse 300 #2465
• Add controller mapping for Denon MC7000 #2546
• Add controller mapping for Stanton DJC.4 #2607
• Fix broadcasting via broadcast/recording input lp:1876222 #2743
• Only apply ducking gain in manual ducking mode when talkover is enabed lp:1394968 lp:1737113 lp:1662536
#2759

• Ignore MIDI Clock Messages (0xF8) because they are not usable in Mixxx and inhibited the screensaver #2786

16.8. Changelog 186

https://github.com/mixxxdj/mixxx/pull/2280
https://github.com/mixxxdj/mixxx/pull/3618
https://bugs.launchpad.net/mixxx/+bug/1863440
https://github.com/mixxxdj/mixxx/pull/2504
https://github.com/mixxxdj/mixxx/pull/3602
https://bugs.launchpad.net/mixxx/+bug/1889776
https://github.com/mixxxdj/mixxx/pull/2985
https://github.com/mixxxdj/mixxx/pull/3281
https://github.com/mixxxdj/mixxx/pull/3192
https://github.com/mixxxdj/mixxx/pull/3374
https://github.com/mixxxdj/mixxx/pull/3904
https://github.com/mixxxdj/mixxx/pull/3824
https://github.com/mixxxdj/mixxx/pull/3841
https://github.com/mixxxdj/mixxx/pull/3848
https://github.com/mixxxdj/mixxx/pull/3790
https://bugs.launchpad.net/mixxx/+bug/1882776
https://bugs.launchpad.net/mixxx/+bug/1857806
https://github.com/mixxxdj/mixxx/pull/2414
https://github.com/mixxxdj/mixxx/pull/2417
https://github.com/mixxxdj/mixxx/pull/2040
https://github.com/mixxxdj/mixxx/pull/2438
https://bugs.launchpad.net/mixxx/+bug/1845837
https://github.com/mixxxdj/mixxx/pull/2393
https://github.com/mixxxdj/mixxx/pull/2474
https://bugs.launchpad.net/mixxx/+bug/1861431
https://github.com/mixxxdj/mixxx/pull/2477
https://github.com/mixxxdj/mixxx/pull/2527
https://bugs.launchpad.net/mixxx/+bug/1399974
https://github.com/mixxxdj/mixxx/pull/2531
https://github.com/mixxxdj/mixxx/pull/2028
https://github.com/mixxxdj/mixxx/pull/2559
https://github.com/mixxxdj/mixxx/pull/2594
https://github.com/mixxxdj/mixxx/pull/2348
https://github.com/mixxxdj/mixxx/pull/2425
https://github.com/mixxxdj/mixxx/pull/2465
https://github.com/mixxxdj/mixxx/pull/2546
https://github.com/mixxxdj/mixxx/pull/2607
https://bugs.launchpad.net/mixxx/+bug/1876222
https://github.com/mixxxdj/mixxx/pull/2743
https://bugs.launchpad.net/mixxx/+bug/1394968
https://bugs.launchpad.net/mixxx/+bug/1737113
https://bugs.launchpad.net/mixxx/+bug/1662536
https://github.com/mixxxdj/mixxx/pull/2759
https://github.com/mixxxdj/mixxx/pull/2786


Mixxx User Manual, Rilis 2.3.0

16.8.5 2.2.3 (2019-11-24)

• Don't make users reconfigure sound hardware when it has not changed #2253
• Fix MusicBrainz metadata lookup lp:1848887 #2328
• Fix high DPI scaling of cover art #2247
• Fix high DPI scaling of cue point labels on scrolling waveforms #2331
• Fix high DPI scaling of sliders in Tango skin #2318
• Fix sound dropping out during recording lp:1842679 #2265 #2305 #2308 #2309
• Fix rare crash on application shutdown #2293
• Workaround various rare bugs caused by database inconsistencies lp:1846971 #2321
• Improve handling of corrupt FLAC files #2315
• Don't immediately jump to loop start when loop_out is pressed in quantized mode lp:1837077 #2269
• Preserve order of tracks when dragging and dropping from AutoDJ to playlist lp:1829601 #2237
• Explicitly use X11 Qt platform plugin instead of Wayland in .desktop launcher lp:1850729 #2340
• Pioneer DDJ-SX: fix delayed sending of MIDI messages with low audio buffer sizes #2326
• Enable modplug support on Linux by default lp:1840537 #2244 #2272
• Fix keyboard shortcut for View > Skin Preferences lp:1851993 #2358 #2372
• Reloop Terminal Mix: Fix mapping of sampler buttons 5-8 lp:1846966 #2330

16.8.6 2.2.2 (2019-08-10)

• Fix battery widget with upower <= 0.99.7. #2221
• Fix BPM adjust in BpmControl. lp:1836480
• Disable track metadata export for .ogg files and TagLib 1.11.1. lp:1833190
• Fix interaction of hot cue buttons and looping. lp:1778246
• Fix detection of moved tracks. #2197
• Fix playlist import. #2200 lp:1687828
• Fix updating playlist labels. lp:1837315
• Fix potential segfault on exit. lp:1828360
• Fix parsing of invalid BPM values in MP3 files. lp:1832325
• Fix crash when removing rows from empty model. #2128
• Fix high DPI scaling of RGB overview waveforms. #2090
• Fix for OpenGL SL detection on macOS. lp:1828019
• Fix OpenGL ES detection. lp:1825461
• Fix FX1/2 buttons missing Mic unit in Deere (64 samplers). lp:1837716
• Tango64: Re-enable 64 samplers. #2223
• Numark DJ2Go re-enable note-off for deck A cue button. #2087
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• Replace Flanger with QuickEffect in keyboard mapping. #2233

16.8.7 2.2.1 (2019-04-22)

• Include all fixes from Mixxx 2.1.7 and 2.1.8
• Fix high CPU usage on MAC due to preview column lp:1812763
• Fix HID controller output on Windows with common-hid-packet-parser.js
• Fix rendering slow down by not using QStylePainter in WSpinny lp:1530720
• Fix broken Mic mute button lp:1782568
• added quick effect enable button to the control picker menu
• Fix Cover Window close issue with empty cover arts
• Fix Numark Mixtrack 3 mapping. #2057

16.8.8 2.2.0 (2018-12-17)

General

• Update from Qt4 to Qt5.
• Use Qt5's automatic high DPI scaling (and remove the old scaling option from the preferences).
• Vectorize remaining raster graphics for better HiDPI support.

Effects

• Add mix mode switch (Dry/Wet vs Dry+Wet) for effect units.
• Add support for LV2 effects plugins (currently no way to show plugin GUIs).
• Add preference option for selecting which effects are shown in the list of available effects in the main window (all
LV2 effects are hidden by default and must be explicitly enabled by users).

Skins

• Add 8 sampler and small sampler options to LateNight.
• Add key / BPM expansion indicators to Deere decks.
• Add skin settings menu to LateNight.
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Controllers

• Add controller mapping for Numark Mixtrack Platinum.
• Update controller mapping for Numark N4.
• Add spinback and break for Vestax VCI-400 mapping.

Miscellaneous

• Add preference option to adjust the play position marker of scrolling waveforms.
• Add preference option to adjust opacity of beatgrid markers on scrolling waveforms.
• Support IRC/AIM/ICQ broadcast metadata.

16.8.9 2.1.8 (2019-04-07)

• Fix a rare chance for a corrupt track file while writing metadata in out of disk situations. lp:1815305
• Fix export of BPM track file metadata. lp:1816490
• Fix sending of broadcast metadata with TLS enabled libshout 2.4.1. lp:1817395
• Fix resdicovering purged tracks in all cases. lp:1821514
• Fix dropping track from OSX Finder. lp:1822424

16.8.10 2.1.7 (2019-01-15)

• Fix syncing to doublespeed lp:1808697
• Fix issues when changing beats of a synced track lp:1808698
• Fix direction of pitch bend buttons when inverting rate slider lp:1770745
• Use first loaded deck if no playing deck is found lp:1784185
• Encode file names correctly on macOS lp:1776949

16.8.11 2.1.6 (2018-12-23)

• Fix crash when loading a Qt5 Soundsource / Vamp Plug-In. lp:1774639
• Validate effect parameter range. lp:1795234
• Fix crash using the bpm_tap button without a track loaded. lp:1801844
• Fix possible crash after ejecting a track. lp:1801874
• Fix wrong bitrate reported for faulty mp3 files. lp:1782912
• Fix Echo effect syncing lp:1793232
• Fix iTunes context menu lp:1799932
• Fix loading the wrong track after delete search and scroll. lp:1803148
• Improve search bar timing. lp:1635087
• Fix quoted search sentence. lp:1784141
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• Fix loading a track formerly not existing. lp:1800395
• Fix importing m3u files with blank lines. lp:1806271
• Fix position in sampler overview waveforms. lp:1744170
• Don't reset rate slider, syncing a track without a beatgrid. lp:1783020
• Clean up iTunes track context menu. lp:1800335
• Collapsed sampler are not analyzed on startup. lp:1801126
• search for decoration characters like "˚". lp:1802730
• Fix cue button blinking after pressing eject on an empty deck. lp:1808222

16.8.12 2.1.5 (2018-10-28)

• Code signing for Windows builds. lp:1517823
• Fix crash on exit when preferences is open. lp:1793185
• Fix crash when analyzing corrupt MP3s. lp:1793387
• Fix crash when importing metadata from MusicBrainz. lp:1794993
• Library search fixes when single quotes are used. lp:1784090 lp:1789728
• Fix scrolling waveform on Windows with WDM-KS sound API. lp:1729345
• Fix right clicking on beatgrid alignment button in Tango and LateNight skins. lp:1798237
• Improve speed of importing iTunes library. lp:1785545
• Add 2 deck mapping for DJTechTools MIDI Fighter Twister.

16.8.13 2.1.4 (2018-08-29)

Fix track selection not getting shown in the track table on Windows. There are no changes to the source code, but the
Jenkins build configuration was changed to delete the Jenkins workspace before each build. lp:1751482

16.8.14 2.1.3 (2018-08-20)

Fix a severe performance regression on Windows: Mixxx 2.1.2 running much slower than 2.1.1

16.8.15 2.1.2 (2018-08-10)

Yet another bugfix release of Mixxx 2.1. Here is a quick summary of what is new in Mixxx 2.1.2:
• Allow maximum deck speed of 4x normal.
• Don't always quantize hotcues, a 2.1.1 regression. lp:1777429
• Fix artifacts using more than 32 samplers. lp:1779559
• store No EQ and Filter persistently. lp:1780479
• Pad unreadable samples with silence on cache miss. lp:1777480
• Fixing painting of preview column for Qt5 builds. lp:1776555
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• LateNight: Fix play button right click. lp:1781829
• LateNight: Added missing sort up/down buttons.
• Fix sampler play button tooltips. lp:1779468
• Shade: remove superfluid margins and padding in sampler.xml. lp:1773588
• Deere: Fix background-color code.
• ITunes: Don't stop import in case of duplicated Playlists. lp:1783493

16.8.16 2.1.1 (2018-06-13)

After two months it is time to do a bugfix release of Mixxx 2.1. Here is a quick summary of what is new in Mixxx 2.1.1:
• Require Soundtouch 2.0 to avoid segfault. lp:1577042
• Improved skins including library view fix. lp:1773709 lp:1772202 lp:1763953
• Fix crash when importing ID3v2 APIC frames. lp:1774790
• Synchronize execution of Vamp analyzers. lp:1743256
• DlgTrackInfo: Mismatching signal/slot connection.
• Detect M4A decoding errors on Windows. lp:1766834
• Fix spinback inertia effect.
• Fix decoding fixes and upgrade DB schema. lp:1766042 lp:1769717
• Fix integration of external track libraries. lp:1766360
• Fix memory leak when loading cover art. lp:1767068
• Fix clearing of ReplayGain gain/ratio in file tags. lp:1766094
• Fix crash when removing a quick link. lp:1510068
• Fidlib: Thread-safe and reentrant generation of filters. lp:1765210
• Fix unresponsive scrolling through crates & playlists using encoder. lp:1719474
• Swap default values for temp/perm rate changes. lp:1764254

16.8.17 2.1.0 (2018-04-15)

After two years of hard work, we are pleased to announce Mixxx 2.1. We have overhauled the effects system, redesigned
the skins, added and improved lots of controller mappings, rewrote the audio file decoders twice, and of course fixed a
bunch of bugs. Download it!
Here is a quick summary of what is new in Mixxx 2.1.0:

• Graphical interface scales for high resolution screens
• Overhauled Deere and LateNight skins
• New Tango skin
• Effects are synchronized to the tempo
• Effects are processed post-fader and post-crossfader and can be previewed in headphones
• One metaknob per effect with customizable parameter control for intuitive use of effect chains
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• Nine new effects: Autopan, Biquad Equalizer, Biquad Full Kill Equalizer, Loudness Contour, Metronome, Para-
metric Equalizer, Phaser, Stereo Balance, Tremolo

• Loaded effects and their parameters are saved and restored when Mixxx restarts
• More transparent sounding equalizers (Biquad Equalizer and Biquad Full Kill Equalizer)
• Improved scratching sounds with jog wheels, vinyl control, and dragging waveforms with the mouse
• Simplified looping and beatjump controls
• Configurable rows of 8 samplers with up to 8 rows available for a total of 64 samplers
• Files loaded to samplers are reloaded when Mixxx restarts
• Improved volume normalization algorithm (EBU-R 128)
• Filter library table by crates
• Sort musical keys in library table by circle of fifths
• Write metadata tags back to audio files
• New JavaScript library for controller mapping
• Configure multiple Internet broadcasting stations and use multiple stations at the same time
• Broadcast and record microphones with direct monitoring and latency compensation
• Broadcast and record from an external mixer
• Booth output with independent gain knob for using sound cards with 6 output channels without an external mixer
• Prevent screensaver from starting while Mixxx is running
• CUP (Cue And Play) cue button mode
• Time remaining and time elapsed now take into account the tempo fader
• Clicking cover art now shows it full size in a separate window
• and of course, lots and lots of bug fixes.

Here are controllers with mappings that have been added or updated since the 2.0 release. Mappings marked with an
asterisk (*) have been updated for the new effects interface:

• American Audio VMS2
• American Audio VMS4
• Allen & Heath Xone K2/K1*
• Behringer CMD Micro
• Behringer CMD MM1*
• Behringer CMD Studio 4a
• Denon MC4000*
• Denon MC6000 Mk2*
• FaderFox DJ2
• Hercules DJ Console 4-Mx*
• Hercules DJ Control MP3 LE / Glow
• Hercules DJ Control Compact
• Hercules P32*
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• Ion Discover DJ
• Korg Nanokontrol 2
• Korg KAOSS DJ
• M-Audio Xponent
• Native Instruments Traktor Kontrol S4 Mk2*
• Novation Launchpad Mk1 & Mk2
• Novation Twitch
• Numark Mixtrack Pro 3 & Numark Mixtrack 3*
• Pioneer DDJ-SB2*
• Pioneer DDJ-SX*
• Reloop Beatmix 2
• Reloop Beatmix 4
• Reloop Digital Jockey 3 ME
• Reloop Terminal Mix 2
• Reloop Terminal Mix 4
• Vestax VCI-100 Mk2
• Vestax Typhoon

For users upgrading from older versions of Mixxx, we have a few important announcements. First, if you are using
Windows, you will have to uninstall any old versions of Mixxx before you can install 2.1. How to uninstall Mixxx varies
on different versions of Windows:

• Windows Vista, 7, and 8: Start > Control Panel > Programs > Uninstall a Program
• Windows 10: Start > Control Panel > Programs > Programs And Features > look for Mixxx > Uninstall

If you are upgrading from an older version of Mixxx and have MP3 files in your library, we have another important
announcement. The good news is that we fixed a bug where the waveforms and audio playback of MP3 files were mis-
aligned. The bad news is that we have no way of knowing whichMP3 files were affected or howmuch the offset was. That
means that waveforms, beatgrids, cues, and loops from older versions of Mixxx may be offset by an unknown amount
for any MP3 file. Only MP3 files were affected by this bug; other audio file types are unaffected. You can either correct
your beatgrids and cue points manually for each track, or you can clear this information for all MP3s and start fresh.
Regardless, we recommend clearing the waveforms for all MP3 files. To clear these, type "location:mp3" into the library
search bar, press Control + A to select all tracks, right click, and select the information you want to clear from the menu.
In the works for Mixxx 2.2, we have a big redesign of the library GUI. Along with that will come saving & restoring
search queries plus nested crates. We are also planning on adding support for saving and loading custom effect chain
presets with the ability to import and export them to share online.
Want to help make Mixxx even more awesome? The biggest thing we need is more people. You do not need to be a
programmer to help out. Giving feedback on the design of new features as they are being made is very valuable. Refer
to the Testing page on the wiki for more information on how to get involved with that. Reporting bugs and telling us
your ideas on the Launchpad bug tracker is a big help too! We cannot fix problems we do not know about, so please let
us know if you find any issues with Mixxx. If you would like to help translate Mixxx into another language, refer to the
Internationalization wiki page. Of course, more programmers could always help. Read the Developer Documentation on
the wiki for tips on getting started contributing code to Mixxx.
We hope you have as much fun with Mixxx as we do!
For a full list of new features and bugfixes, check out the 2.1.0 milestone on Launchpad.
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16.8.18 2.0.0 (2015-12-31)

• 4 Decks with Master Sync
• New Effects Framework with 4 Effect Units and 5 Built-in Effects:

– Flanger, Bit Crusher, Reverb, Echo, Filter
– More to come!

• Configurable, Resizeable User Interface with 3 Brand New Skins
• Cover Art Display
• Music Key Detection and Shifting
• Vinyl Audio Pass-Through
• 4 Microphone inputs and 4 Auxiliary inputs
• MIDI Mapping GUI and Improved Learning Wizard
• MusicBrainz metadata fetching
• RGB Musical Waveforms
• Hundreds of Bug Fixes and Improvements
• New Pitch-Independent Algorithm for Better-Sounding Key-lock

For a full list of new features and bugfixes, check out the 2.0.0 milestone on Launchpad.
Lihat juga:
For an overview of previous versions, take a look at the timeline.
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CHAPTER17

Hardware Manuals

17.1 Controllers

Mixxx supports the following controllers out of the box. Additional third-party controller mappings that were contributed
by the community (but are not yet included in Mixxx) can be found at Mixxx' Controller Mapping Forum.
Lihat juga:
Using MIDI/HID Controllers describes how to configure Mixxx to use controllers.

17.1.1 Akai LPD8

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.10.1.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.2 Akai MPD24

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.8.
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Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.3 Allen & Heath Xone:K2

The Allen & Heath Xone:K2 is a flexible controller that is mapped to control Mixxx’s decks, effects, or both. It has an
integrated 4 channel audio interface with 2 RCA jacks and an 1/8" stereo headphone jack. The Xone K1 is the same as
the Xone K2 but without the built in audio interface and does not come with the EVA travel case that the K2 comes with.

• Manufacturer’s product page
• Forum thread
• Manufacturer’s User Guide
• Blank template diagrams

Baru pada versi 1.11.

Audio Setup

The Xone:K2 is setup in Mixxx > Preferences > Sound Hardware > Output

Output Device Channel
Master XONE:K2 Channel 3 - 4
Headphones XONE:K2 Channel 1 - 2

Note: This Channel setup is the opposite of what most DJ controllers with an integrated audio interface use. The design
choice to not use Channel 1 - 2 for Master Output is known to cause problems, when users want to use the Xone:K2
as default system audio output as the operating system will always use Channel 1 - 2. Thus system audio will go to the
headphones.
There are no hardware controls for the volume so they are always at max volume. Adjusting the volume of master and
headphone outputs is done by adjusting the gain for those outputs in Mixxx using the controller mapping.

Setup

Requirement: The Xone K2 must have Latching Layers turned off, which is the default. Refer to the Xone K2 manual
page 12 for details. The K1 does not have Latching Layers.
This mapping can used with one or multiple Xone K2s/K1s. Multiple Xone K2s/K1s can be connected to each other via
X-Link with one of them connected to the computer via USB. Alternatively, when using 2 K2s/K1s, they can both be
connected with their own USB cable and this same mapping can be loaded for each.
The layout of the mapping depends on the configured MIDI channel of the controller. Change the MIDI channel of the
controller by pressing the bottom right encoder (labeled “Power On Setup/Scroll/Set”) while plugging in the controller.
Scroll with the encoder to select a MIDI channel. The letter in parentheses corresponds to the last lit button when selecting
the channel:

• Channel 15 (O, default out of the box): two decks + two effect units with decks in the middle
• Channel 14 (N): two decks + two effect units with effect units in the middle
• Channel 13 (M): two decks + two effect units with decks on left
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• Channel 12 (L): two decks + two effect units with decks on right
• Channel 11 (K): four decks ordered 3 1 2 4
• Channel 10 (J): four decks ordered 1 2 3 4
• Channel 9 (I): four effect units ordered 3 1 2 4
• Channel 8 (H): four effect units ordered 1 2 3 4

Global Controls

These are available on any configuration with decks, but not the 4 effect unit layout.
• Bottom left encoder:
• adjust tempo of all decks with sync enabled
• press and turn: PFL/master mix in headphones
• shift: headphone gain
• press with shift: toggle split cue mode
• Bottom right encoder
• scroll through tracks in library
• press and release: load selected track into first stopped deck
• press and hold: load selected track into a deck by pressing the play button of the deck
• shift: master gain

Decks

The bottom right button is the shift button. The bottom left button toggles the bottom button grid between a loop layer
(amber) and a hotcue layer (red). Holding shift then holding the bottom left layer button at the same time activates
supershift mode.

• Top encoder: jog
– shift: gain
– supershift: adjust key

• Top encoder press: reset gain
– shift: master sync
– supershift: reset key

• Knobs: high/mid/low equalizer knobs
• Top button 1: headphones/PFL

– shift: reset tempo
– supershift: set beatgrid to current position

• Top button 2: cue
– shift: go to beginning of track and stop
– supershift: keylock
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• Top button 3: play
– shift: reverse
– supershift: quantize

• Fader: volume
• Bottom buttons (intro/outro cue layer, amber): Intro/outro cues from top to bottom are ordered: - Intro start - Intro
end - Outro start - Outro end

– press: jump to that cue or sets it if it is not set
– shift: seek forward/back. The top two (intro) buttons seek quickly; the bottom two (outro) seek slowly
– supershift: delete cue

• Bottom buttons (hotcue layer, red): Hotcues are ordered 1-4 from top to bottom
– press: jump to that hotcue or sets it if it is not set
– shift: seek forward/back. The top two buttons seek quickly; the bottom two seek slowly
– supershift: delete hotcue

• Bottom buttons (loop layer, green):
• Bottom button 1 (red): reloop/disable loop

– shift: jump to to beginning of loop, stop playback, and activate loop
– supershift: set loop in point. Hold to move loop in point with play position.

• Bottom button 2 (green): activate loop of selected size
– shift: activate rolling loop of selected size
– supershift: set loop out point. Hold to move loop out point with play position.

• Bottom button 3 (amber): double loop size
– shift: beatjump forward by selected size if no loop is enabled. If loop is enabled, move the loop forward by
the beatjump size.

– supershift: double beatjump size
• Bottom button 4 (amber): halve loop size

– shift: beatjump backward by selected size if no loop is enabled. If loop is enabled, move the loop backward
by the beatjump size.

– supershift: halve beatjump size

Effects

The top part of the column uses the Standard Effects Mapping. Pressing the top encoder acts as the effect focus button.
When no effect is focused, the buttons are red. When holding the top encoder to choose an effect to focus, the buttons
are green. When an effect is focused, the buttons are amber.
The fader acts as the mix knob.
The bottom buttons assign the effect unit to different input channels and light up red. On the two deck layouts, from top
to bottom, they assign the effect unit to deck 1, deck 2, master mix, and headphones. On the four effect unit layouts, they
assign the effect unit to decks 1-4 going down the column. You can look down a column to see which decks an effect unit
is assigned. You can look across a row to see which effect units are assigned to a deck. When shift is pressed, the bottom
two buttons switch to controlling the routing buttons for the master and headphones channels and light up amber.
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The bottom encoders are not mapped in the 4 effect unit layout.

Effect unit focusing

In addition to focusing one effect in a unit at a time with the Standard Effects Mapping, the Xone K2/K1 has another
mode for focusing a whole effect unit. This allows for controlling the parameters of all 3 effects in the unit at a time. This
mode is only available on the 4 effect unit layouts. To access it, press the Layer button in the bottom left. Press one of
the top encoders to choose which effect unit to focus.
In this mode, each horizontal row of knobs and buttons controls one effect. The knobs control the parameters of the
effects. Turning any of the knobs with shift loads different effects. The button in the leftmost column controls the enable
button of the effect and turns amber when it is on. The rest of the buttons control the button parameters of the effect and
turn green when active (not all effects have button parameters). The faders still control the dry/wet knobs and the bottom
button grid still controls the routing buttons.
To get back to controlling all 4 effect units, press the Layer button again. The next time Layer is pressed, the effect unit
that was focused before will be remembered (but it will not be remembered after restarting Mixxx).

Troubleshooting

If general functionality or supershift are not working, double check that Latch Layers is turned off and MIDI CH is
selected. Refer to the Xone K2 manual page 12 for details.

Known Issues

There are a few known issues with the Xone K2/K1 firmware:
• Since there is no way for Mixxx to ask the controller about the positions of all the knobs and faders when Mixxx
starts, they are out of sync with the state of Mixxx until they are first moved.

• When the USB connection is interrupted and the controller stays powered on, such as leaving the controller plugged
into a powered USB hub and disconnecting the hub from the computer, the controller will not send MIDI input
until it is powered down (unplugged) and plugged back in.

If you would like these issues to be fixed, please let Allen & Heath Support know.

17.1.4 American Audio Radius 2000

A CD and USB media player that can control Mixxx over USB with MIDI. It can also play timecode from CDs or USB
drives which can control Mixxx when they are connected by a sound card.

• Manufacturer’s product page
Baru pada versi 1.10.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.5 American Audio VMS2

The American Audio VMS2 is a 2-deck all-in-one controller. It is a USB class compliant MIDI and audio device that
works with GNU/Linux, Mac OS X, and Windows. It features a 4 channel input and 4 channel output sound card with
2 phono preamps. The main output has XLR and RCA outputs (do not use both at once). There is a separate RCA
booth output. The VMS2 can also be used as a stand-alone mixer with analog sources without a computer by setting the
USB/Analog switches on the front of the device to “Analog”.

• Manufacturer’s product page, provides manual and drivers for download.
• Forum thread, for discussion of mapping options.
• Pull Request, which this wiki page describes.

Baru pada versi 1.11.

Audio Setup

No driver needs to be installed on GNU/Linux or Mac OS X. However, on Windows, it is recommended to install the
driver from the manufacturer to be able to use the ASIO sound API.
Unlike most controllers with built in sound cards, which rely on Mixxx to do all mixing in software, the VMS2 mixes
signals from the sound card in hardware. To use it with Mixxx:

• Bypass the built-in hardware equalizer of the VMS2 (i.e. use Post-EQ Mode). Hold the forward search button on
the right deck as you turn the VMS2 on to switch between Post-EQ and Pre-EQ modes. See section 15 of the
manufacturer’s manual for details.

• Set the USB/Analog switches on the front side of the VMS2 to “USB”
• In Mixxx’s Sound Hardware Preferences:
• Set the sample rate to 48000 Hz
• Select channels 1-2 for Deck 1 output
• Select channels 3-4 for Deck 2 output

Note: You cannot use the preview deck to pre-listen in this setup, as Mixxx routes the preview deck to Mixxx’s headphone
output, which is not mixed with the Deck 1/2 outputs. You could use a separate soundcard and route the headphone output
there to also pre-listen using the preview deck. Of course, if you do so, attach the headphones to that other soundcard
instead of the VMS2.

Input and Recording

The analog inputs are captured by the built-in soundcard as input signals. They can be used for timecode signals (e.g. time-
code vinyl), as the VMS2 also features built-in phono preamps. FIXME I did not try that, please verify!
The microphone input is mixed directly into the master output signal of the VMS2 in hardware and cannot be captured
through software. If you want to record voice over using the Mixxx software, you will need a different solution. You can
use a separate microphone attached to the computer, but that signal will not be routed to the VMS2 and therefore not be
on the VMS2 master output (but in the Mixxx recording from the software master/record output).
Mixxx’s Deck 1/2 outputs are affected by the Mixxx software EQs. However, the VMS2’s volume faders and crossfader
(as well as the headphone buttons) control the VMS2’s hardware mixer and do not affect Mixxx’s Deck 1 and Deck 2
output signals. Therefore, a recording using the Mixxx software will sound different from what is played through the
VMS2 master output, as the crossfader curve and signal mixing are not the same in hardware and software. If you require
a recording that captures exactly what the audience will hear, use a separate soundcard and recording software to record
from the VMS2 booth output.
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Mapping description

Mixer section

All main functions are mapped straightforwardly:

VMS2 Control Mixxx Control
Crossfader Crossfader
Volume Fader Volume Fader
Cue (PFL) PFL
Cue Mix Cue Mix (PFL / Master)
Headphone Gain Headphone Gain
Channel Gain Channel Gain
Master Gain Master Gain

As noted in the #Audio Setup section, these control the VMS2’s hardware mixer. Although the state of the controls is
reflected on screen in Mixxx, the actual mixing is done by the VMS2’s hardware mixer.

Deck Control

Deck control is straightforward, too:

VMS2 Control Mixxx Control
Play Toggle deck play/pause
Pause Pause the deck
Cue Cue Point (configure behavior in software)
Pitch +/- Temporary pitch bend +/-
Pitch Fader Pitch Fader
Range (Shift+Sync) Cycle pitch fader range (+-8/10/30/100%)
Sync Sync to other deck
Search <</>> Search through currently loaded track
Keylock (Shift+Vinyl) Toggle pitch independent time stretch (KeyLock)
Vinyl Toggle between Scratch mode and Pitch mode
Platter Touch sensitive platters! Scratch or Pitchbend
Shift + Platter Scroll through library quickly

In Pitch mode, moving the platters from either the top or side will only bend the pitch of the deck. In Scratch mode, the
platters act like vinyl turntables and can be used for scratching. Touching and holding them from the top stops the deck.
Moving them from the edge does not stop the deck.

Library and Track loading

Use the encoder in the center of the controller to browse through the library. Press the encoder to switch between library
main window and sidebar. Unfortunately there seems to be no way to expand entries in the sidebar through the controller
script.
Use the [LOAD] buttons to load the currently selected track into either the left or right deck.
The four directional buttons around the knob also control the library:
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Button Library function
Up Previous library entry
Down Next library entry
Left Previous sidebar entry
Right Next sidebar entry

If you hold Shift and then rotate a platter, you can scroll through the library much faster.

Equalizer

The per deck EQ rotaries are mapped to their software counterparts. The VMS2 has no dedicated kill switches for the
EQ. However, in Mixxx, pressing the following buttons with Shift acts as EQ kill switches.

VMS2 Control Mixxx Control
Shift+IN Kill Switch Low
Shift+OUT Kill Switch Mid
Shift+RELOOP Kill Switch High

Hotcues

The VMS2 can control 6 hotcues per deck.

VMS2 Control Mixxx Control
1 / 2 / 3 Set/Jump HotCue 1 / 2 / 3
Vinyl + 1 / 2 / 3 Delete HotCue 1 / 2 / 3
4 / 5 / 6 = (Shift + 1 / 2 / 3) Set/Jump HotCue 4 / 5 / 6
Vinyl + 4 / 5 / 6 = (Vinyl + Shift + 1 / 2 / 3) Delete HotCue 4 / 5 / 6

Pressing the vinyl/keylock button will not toggle scratch mode or keylock as long as a hotcue is deleted before releasing
the vinyl/keylock button.

Loops

VMS2 Control Mixxx Control
IN Mark beginning of loop
OUT Mark end of loop
RELOOP Leave / Reenter current loop
LOOP Start a 4 Beat loop from current position
Smart (Shift + Loop) Toggle quantize
(:2) / (*2) Halve or double the current loop length

As Mixxx currently only supports one active loop per deck, the secondary loop controls have been remapped to EQ kill
switches.
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17.1.6 American Audio VMS4/4.1

The original VMS4 has problems with sound quality. The microphone input impedance is off and the output volume is
low. The VMS4.1 is the same controller, except that those hardware issues have been fixed. The Traktor edition has
different labels on some buttons & knobs, but it’s otherwise the same hardware as the VMS4.1.

• VMS4
• VMS4.1
• VMS4.1 Traktor edition

Baru pada versi 1.9.

Setup

Catatan: Mixxx expects the VMS4 to be set to “Post EQ” mode for best sound quality. Do this by holding down the
Headphone Cue button on Midilog 4 while powering on the unit. You only need to do this once. (Each time you do, it
changes the mode back and forth.) Consult the user manual for more information.
To check the status of this in Linux, at a console, issue the command lsusb -v|grep 'iSerial\|iProduct'
and look at the serial number under the VMS4 device per the instructions in the user manual. As of this writing, the
leading digit should be 1.

1. Make sure the VMS4 is off
2. Slide the switch on the front of the VMS4 to “8 OUT”

• If you’re using vinyl control or aux devices (or Mixxx 1.11 & below) set the switch to “4 OUT” for 2-deck
output and 2-deck input

3. Turn on the unit (and plug in the USB cable if you haven’t yet)
4. Start Mixxx
5. Open Preferences
6. Click Sound Hardware. In the right pane:

1. Set the sample rate to 44100Hz
2. Set the Master output to None
3. Set the Headphone output to None
4. Set the Deck 1 output to theVMS4 device andChannel 3-4 (may show as “USBAudio Device” onWindows)
5. Set the Deck 2 output to the VMS4 device and Channel 5-6
6. Set the Deck 3 output to the VMS4 device and Channel 1-2
7. Set the Deck 4 output to the VMS4 device and Channel 7-8

• If you’re using 4 OUT mode, (for vinyl control/aux input or Mixxx 1.11 & below):
1. Set the Deck 1 output to the VMS4 device and Channel 1-2
2. Set the Deck 2 output to the VMS4 device and Channel 3-4
3. For vinyl control, set the Vinyl Control 1 input to the VMS4 device and Channel 1-2, connect a

turntable to Midilog 1, and set it to Analog.
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4. For vinyl control, set the Vinyl Control 2 input to the VMS4 device and Channel 3-4, connect a
turntable to Midilog 4, and set it to Analog.

7. Plug your headphones into the VMS4’s jack on the front. You will use the VMS4’s CUE buttons and knobs for
headphone control.

8. Still in the Preferences, expand “Controllers” on the left
9. Select the “VMS4 MIDI” device (may show as “USB Audio Device” on Windows)

• Do not choose the the HID one. That’s for the little mouse pad and button area.
10. Click the Enable checkbox in the right pane
11. Click the drop-down and choose the American Audio VMS4 preset
12. Click OK and the controller should light up. (In 1.9.x, the controller will light up when you load a track to a deck.)
13. Continue reading below to know how everything is mapped

Direct deck output implications

This setup uses direct deck outputs because mixing takes place in the VMS4 hardware. The down side to this is that you
won’t be able to use Mixxx features that play to Master or Cue buses like the Preview Deck or Samplers. Using these
features with a hardware + MIDI mixer like the VMS4 is not really feasible unless you used a separate sound interface or
controlled Mixxx’s internal mixer another way.

Control

This guide explains how the VMS4 is mapped by default in Mixxx.
Easy customization: We have provided the following customization variables at the top of the script you can set to your
liking:

1. RateRanges: Set the pitch slider range each time you toggle it with Shift+Sync.
Just open the midi/American-Audio-VMS4-scripts.js file in your favorite text editor (Wordpad works too)
and you’ll see these variables right near the top. Edit & save, then restart Mixxx and enjoy.

Deck controls

Catatan: There are a number of different face plates in the wild so these images and control descriptions may not exactly
match yours. The locations of the controls are the key things to pay attention to.

The controls are the same on both sides of the controller. The left side controls Deck 1 and the right side controls Deck 2.

• Sync/Range button - Changes the BPM of this deck to match that of the other. When shifted, toggles the pitch
slider range. (See top of page to customize.)

• Hot cue buttons - Press to set or recall a hot cue. The buttons light up red when one is set. Hold Shift and press
to access hot cues 5-8. (The buttons light up blue for these.) Hold Vinyl and press to delete the cue. (Note: there
is a bug in some firmware versions that causes hot cues 5 and 6 to be deleted simultaneously.) the cue.

• Pitch Bend +/-
• Momentarily speeds up or slows down the deck while the button is held down.
• Hold Shift and press to adjust the key (pitch) of the song (independent of the tempo.)
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• Loop In - Set the in point of a loop
• Loop Out - Set the out point of a loop
• Reloop - Toggle a previously-set loop. Lights red when a loop is active.
• Loop/Smart Start a 4-beat loop. Hold Shift and press to toggle quantization (locking to the nearest beat.)
• Vinyl/Keylock - (Does nothing on its own when un-shifted at the moment.) When shifted, toggles key lock.
• << Search/ /2 - Fast-rewind Hold Shift and press to halve the current loop length
• Search >>/ *2 - Fast-forward Hold Shift and press to double the current loop length
• Touch strip Scroll through the respective Library panes. (Left for the folders/crates list, right for the track list.)
Hold Shift and touch: - to affect the Dry/Wet knob on the respective effect unit while the deck is playing - for
Needle drop - search through the track while the deck is stopped

• Wheel Move the wheel while touching the top to scratch the current track like a vinyl record Move the wheel
without touching the top (so on the sides) to perform a temporary pitch bend

• CUE - Operates according to the Cue mode set in Mixxx's preferences Hold Shift and press to play immediately
from the cue point (known as Cue+Play or CUP.)

• Play - Press to toggle deck playback Hold Shift and press to set this deck as the master for syncing with another
• Pause - Stops the deck playback

Effects section

The left side controls effect unit 1 and the right side controls effect unit 2.
• Select knob
• Rotate to choose the effect chain preset
• Press to toggle whether the effect unit is on or not
• Control knob
• Adjusts the wet/dry ratio
• When Parameter is on, this becomes the Wonder Knob, adjusting all effect parameters at once
• On/Off - Toggles the effect for the deck matching the effect unit number
• Parameter - Toggles what the above Control knob adjusts

Sample section

The left side of the controller controls Sampler 1, and the right, Sampler 2.
• Select knob Rotate to move the highlight in the library. Press to load the currently highlighted track into the
sampler. Hold Shift and press to eject the current track from the sampler (when the sampler is not playing.)

• Volume knob - Adjusts the volume of the sampler
• Play Press to play the sample from the beginning. Press while playing for a stutter-play effect (play again from the
beginning.) Hold Shift and press to stop playing.

• Rec - Currently does nothing
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Mixer controls

The volume sliders don’t control the ones in Mixxx because direct Deck outputs are affected by Mixxx’s internal ones.
• Midilog 1: This strip controls Deck 3/C
• Midilog 2: This strip controls Deck 1/A
• Midilog 3: This strip controls Deck 2/B
• Midilog 4: This strip controls Deck 4/D

17.1.7 Behringer BCD2000

The Behringer B-Control Deejay BCD2000 features a USB 4-channel audio interface plus 24-bit A/D andD/A converters.
This controller has been discontinued. The Behringer BCD3000 is its successor.

• Manufacturer's product page
• Forum thread

Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.8 Behringer BCD3000

• Manufacturer's page
The B-Control Deejay BCD3000 controller is a 4-channel audio interface. It offers a fully fitted controller console with
24-bit A/D und D/A converters, a USB audio interface with a microphone preamplifier, a 3-band kill EQ for each channel,
faders, a crossfader and talkover function.
By default, the input channels 1-2 use the RCA phono inputs for the source signal. On Windows, this can be switched to
the microphone in the ASIO driver control panel. On GNU/Linux and Mac OS X, a particular MIDI message must be
sent to switch channels 1-2 to the microphone input.
Baru pada versi 1.6.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.9 Behringer BCR2000

• Manufacturer's product page
• Forum thread

The B-CONTROL BCR2000 is a general-purpose USB MIDI controller containing 20 buttons, 24 rotary encoders and 8
push encoders. Every control is backed by LEDs that show the current value. As a pure MIDI controller it contains no
interfaces for audio or microphones.
The controller can be be configured extensively. It offers 32 presets that may be programmed by the user.
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Figure1: Behringer BCR2000 (schematic view)
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Baru pada versi 2.3.

Compatibility

This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on
GNU/Linux, Mac OS X, and Windows.

Setup

Controller Preset

The default mapping works out-of-the-box for the factory settings of controller preset 1.
If you don't want to use this preset, you can choose one of the following options:

1. Load the dump file bcr_Only_Controllers.syx via Sysex to any other preset slot and update the preset
number in the init function in the file Behringer-BCR2000-scripts.js. The dump file and instructions
how to install it in the controller is available on the manufacturer's webpage.

2. Factory reset the controller.

Button Behaviour

It is recommended, but not required, to change the button behaviour from Toggle On (default) to Toggle Off. Both
behaviours send an On message on button press, but the action to send an Off message is different: Toggle Off responds
to a button release while Toggle On ignores the release and requires a second press. To change the behaviour:

1. Hold EDIT, press a button, then release both
2. Turn the MODE encoder until the display shows toFF
3. Press the EXIT button

To make the change persistent, press Store twice. See the controller manual for details.

Mapping Description

The BCR2000 is a general purpose controller that allows different mappings.
The file Behringer-BCR2000-scripts.js contains a default mapping which works out-of-the-box for a factory-
reset controller, but may be customized freely according to your needs.
The controls are divided into five parts:

• Top left area (4 push encoders + 4 buttons): loop, reverse & pitch controls for Deck 1
• Top right area (4 push encoders + 4 buttons): loop, reverse & pitch controls for Deck 2
• Middle left area (4 buttons + 4 encoders): controls for Effect Unit 1
• Middle right area (4 buttons + 4 encoders): controls for Effect Unit 2
• Bottom right area (4 buttons): controls for assignment of effect units to decks
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Control Description
Location Affects Hardware control
Push Encoder Row Deck 1 Encoder 1 (TYPE) • Rotate: Manipulates

the key of the track
in semitones.

• Push: Resets the key
to the original track
key.

Deck 2 Encoder 5 (VAL 2)

Deck 1 Encoder 2 (CH) • Rotate: Increases or
decreases the size of
the current loop in
beats.

Deck 2 Encoder 6 (VAL 2)

Deck 1 Encoder 3 (PAR) • Rotate: Moves the
current loop left or
right.Deck 2 Encoder 7

Deck 1 Encoder 4 (VAL 1) • Rotate: Increases or
decreases the num-
ber of beats to move
the loop.

Deck 2 Encoder 8

Button Row 1 Deck 1 Button 1 • Press: Toggles key-
lock.

• Shift + Press: Tog-
gles vinyl control
mode.

Deck 2 Button 5

Deck 1 Button 2 • Press: Toggles a
loop that ends at
the current play po-
sition.

• Shift + Press:
Toggles a rolling
loop. Playback will
resume where the
track would have
been if it had not
entered the loop.

Deck 2 Button 6

Deck 1 Button 3 • Press: Toggles re-
verse playback.

• Shift + Press: Tog-
gles rolling reverse
playback. Playback
continues where the
track would have
been if it had not
been temporarily
reversed.

Deck 2 Button 7

berlanjut ke halaman berikutnya

17.1. Controllers 210



Mixxx User Manual, Rilis 2.3.0

Table 1 – lanjutan dari halaman sebelumnya
Control Description
Location Affects Hardware control

All controls Button 4 • Press: Toggles shift.
Shift changes the
behaviour of con-
trols as described
in this table, and
additionally the
behaviour of the
effect units. See
Standard Effects
Mapping for details.

Catatan: Both Shift
buttons have the same ef-
fect, they are not deck-
specific. This design deci-
sion was made to keep the
layout symmetric so that
you don't have to press a
button on the left side when
you're working on the right
side.

All controls Button 8

Button Row 2 Effect Unit 1 Button 1 • Press: Toggles effect
focus mode.

• Shift + Press: Tog-
gles effect unit.

Effect Unit 2 Button 5

Effect Unit 1 Button 2 • Press: Toggles pa-
rameter button 1.Effect Unit 2 Button 6

Effect Unit 1 Button 3 • Press: Toggles pa-
rameter button 2.Effect Unit 2 Button 7

Effect Unit 1 Button 4 • Press: Toggles pa-
rameter button 3.Effect Unit 2 Button 8

Encoder Row 1 Effect Unit 1 Encoder 1 • Rotate: Adjusts the
mixing of the dry
(input) signal with
the wet (output) sig-
nal of the effect unit.

Effect Unit 2 Encoder 5

Effect Unit 1 Encoder 2 • Rotate: Controls the
parameter of effect
1.Effect Unit 2 Encoder 6

Effect Unit 1 Encoder 3 • Rotate: Controls the
parameter of effect
2.Effect Unit 2 Encoder 7

Effect Unit 1 Encoder 4 • Rotate: Controls the
parameter of effect
3.Effect Unit 2 Encoder 8

Button Box Row 1 Deck 1 Left Button • Press: Toggles as-
signment of Effect
Unit 1.Deck 2 Right Button

berlanjut ke halaman berikutnya
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Table 1 – lanjutan dari halaman sebelumnya
Control Description
Location Affects Hardware control
Button Box Row 2 Deck 1 Left Button • Press: Toggles as-

signment of Effect
Unit 2.Deck 2 Right Button

Overlay

Overlay to print on cardboard or paper for lamination:
• PDF, DIN A4

• PDF, DIN A3

• ODG (LibreOffice)
• SVG (without labels)

17.1.10 Behringer CMD Micro

Figure2: Behringer CMD Micro (schematic view)

The Behringer CMDMicro is a simple controller for basic two-channel mixing. This device does not have a built in sound
card, so it would require a splitter cable or separate audio interface to be able to preview tracks in headphones.

• Manufacturer’s product page
Baru pada versi 2.1.

Mapping description

• Cue, Play/Pause, Sync, Load A, Load B, the Level / Browse knobs, and the crossfader all behave as labeled.
• Cue A and Cue B send the respective track to the headphones.
• The inner vertical sliders control the track’s volume.
• The outer sliders control the playback speed.
• The 1, and 2 buttons toggle a 4 and 8 beat loop, respectively.
• The Pitch Bend buttons temporarily adjust the playback rate. They can be configured to change the key of the
track instead by setting the PitchBendsKey option to true at the top of the JS file (open the JS file in a text
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editor such as Notepad, TextEdit, or gEdit to change this). With the PitchBendsKey option, when both buttons are
pressed simultaneously, the key is reset to the track’s default key.

Jog Wheels

The jog wheels are touch enabled. When the top is pressed, they emulate turntable scratching. When the side is touched,
they affect the playback speed (jog).

17.1.11 Behringer CMD MM-1

The Behringer CMDMM-1 is a flexible controller that controls 4 decks by default. The mapping can be easily configured
to control any combination of decks and effect units. The Behringer CMD DC-1 and Behringer CMD DV-1 are designed
to be used together with the CMD MM-1, but the CMD MM-1 can be used alone or with other controllers (especially
the Novation Launchpad).

• Manufacturer's product page
• Forum thread

Baru pada versi 2.1.

Mapping description

Architecture

The controller has four strips of channels, each of which can be configured to control a different Deck or even an Effec-
tUnit. These options can be changed during runtime via the Buttons in the of the ThirdLayer. You can find more about
how to use this at the end of this document.

Mapping options

There are a few user configurable options available for you to customize. You can change these by opening the
Behringer-CMD-MM-1-scripts.js file with your text editor of choice (such as Notepad, TextEdit, Kate, or
gEdit) and editing the lines at the very top of the file.

• channelNumber: change this if your controller LEDs do not light up.
• invertColor: Swaps the colors which suits certain skins more
• defaultChannelSequence: Defines how the channels are mapped when Mixxx starts
• channelMode: Defines if a channel is in Deck or FX Mode when Mixxx starts
• faderMode: Defines how the faders behave in FX Mode by default
• standardKnobBehavior: Defines the mapping of the knobs when Mixxx starts
• navEncoderScale: the factor of speedup when using the encoder with a modifier

17.1. Controllers 213

https://www.behringer.com/product.html?modelCode=P0AJE
https://mixxx.discourse.group/t/advanced-behringer-cmd-mm-1-mapping/16753


Mixxx User Manual, Rilis 2.3.0

Top row

Figure3: Behringer CMD MM-1 (top row)

The top left knobs control the Master balance and Master gain. The top right knobs control the headphone gain and cue
mix (PFL/master mix in Headphones output).
You can see the L/R buttons besides the encoder as [SHIFT] and [CTRL] buttons. These allow each button to have up
to four functionalities. They behave like the Shift and Control keys on a computer keyboard.

Knobs

The Knobs have three different modes which can be cycled while in operation. The knobs in each mode, from top to
bottom, control:

1. Deck: High, Mid, Low, QuickEffect (filter by default)
2. Deck: Gain, High, Mid, Low
3. Effect Unit: Meta 1, Meta 2, Meta 3, Mix

The Effect Unit number is the same as the channel/deck number, so the channel that controls the knobs/buttons/faders of
deck 1 also controls the knobs of EffectUnit1, Channel 2 controls EffectUnit2, and so on.

FX Mode

The Knobs in FxMode overwrite the assigned mapping and are mapped as [Effect 1 Meta, Effect 2 Meta, Effect 3 Meta,
Super] and the fader is also mapped to the mix of the EffectUnit. The buttons are documented in their own section.

Middle button

• Normal: recenter Crossfader
• Shift: Cycle Knob assignment (swaps the mapping of the knobs as mentioned earlier)
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Buttons

Deck Mode

[1]&[2] Buttons:
• Normal: Change Crossfader side (Orientation)
• Shift: Toggle Fx1&2 for desired Channel
• Ctrl: Toggle Fx3&4 for desired Channel
• Third: Change ChannelNumber/Assignment

[CUE] Buttons:
• Normal: Pre-Fader-Listening
• Shift: Load selected Track to Deck
• Ctrl: enable Sync for the Deck.
• Third: Change Channelmode

FX Mode

Figure4: Behringer CMD MM-1 (FX mode)

[1]&[2] Buttons:
• Normal: Toggle Effect 1&2 in desired FxUnit
• Shift: Toggle Channel1&2 for desired FxUnit
• Ctrl: Toggle Channel3&4 for desired FxUnit
• Third: Change ChannelNumber/Assignment

[CUE] Buttons:
• Normal: Toggle Effect 3 for desired FxUnit
• Shift: Pre-Fader-Listening for FxUnit
• Ctrl: change mix_mode of Unit
• Third: Change Channelmode
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Faders

DeckMode:
• Normal: Volume Fader

FxMode:
• EffectUnit Mix (dry/wet)
• Third: Reconfigure Fader to control Rate/BPM/Pitch of the Channel as if it was in Deckmode

Reassigning channel mode and number

The channel modes and numbers can be set by changing the #mapping options at the top of the script. They can also be
changed while using the controller when in thirdMode. Pressing the cue- button toggles between Deck and FX Mode.
The Channel number is assigned with the [1]&[2] buttons.
They are mapped in a sort of two bit encoded system:

• ☐ & [ ] = Channel 1
• ☒ & [ ] = Channel 2
• ☐ & [x] = Channel 3
• ☒ & [x] = Channel 4

So you can change between channel 1&3 by pressing the [1] button, and channel 2&4 by pressing the [2] button.
You can change the Channel mode (Deck/Fx) via the Cue Button. (Note: there is a rare issue where you have to change
the Channel mode after the assignment for it to work. So it is suggested that you always change the assignment first).

Troubleshooting

Controller does not light up

The issue is probably the MIDI channel of your MM-1. Behringer had a tool that can set the controller to a different
MIDI channel, however this is no longer available for download from Behringer’s website. So you will have to modify the
controller mapping to use the MIDI channel that your controller is set to.
Once you know the MIDI channel of your controller, open the file Behringer-CMD-MM-1-scripts.js file with
your text editor of choice (such as Notepad, TextEdit, Kate, or gEdit) and replace the number 5 in the line where it says
var CHANNELNUMBER = 5;. Then, open the file Behringer CMD-MM-1.midi.xml in the same folder and
replace the 4 at the end of 0x94, 0x84 and 0xB4 with your channel number - 1. Restart Mixxx, reload the mapping in
Mixxx’s preferences, and then it should work.
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17.1.12 Behringer CMD STUDIO 4a

The Behringer CMD STUDIO 4a is a 2 deck controller that supports 4 virtual decks and has a built in 4 channel (one
stereo master, one stereo headphones) USB sound card built in.

• Manufacturer’s product page
• Mixxx Forum Thread

Baru pada versi 2.1.

Mixxx Sound Hardware Preferences

• Master output: channels 1-2
• Headphone output: channels 3-4

Mapping description

Most of the buttons and knobs on the controller behave as they are labelled:

Figure5: Behringer CMD STUDIO 4a (top view)

The only major departure from the above are the 4 “FX Control” knobs and buttons at the top of each deck.
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Mixer

• The HIGH, MID, and LOW EQ knobs & kill buttons, deck faders, cross-fader, master, and headphone monitoring
(mix & volume) knobs all operate as labelled.

• Each deck also has a gain knob (leftmost “FX Control” knob).

Navigation Control

• The BROWSE knob scrolls thorough the track list in the library panel.
• The BROWSE LEFT/RIGHT buttons move through the library tree (and can also select effects, see later).
• The ENTER button expands/collapses library tree items.

Deck Select Buttons

• The deck select buttons (A, B, C, D) make the respective “virtual” deck active.
• On the left deck: A = Channel 1, C = Channel 3.
• On the right deck: B = Channel 2, D = Channel 4.

Transport Control

• The deck LOAD buttons will load the currently highlighted track in the library window into that deck.
• The deck CUE, PLAY, SYNC, and LOOP buttons work as labelled (SYNC toggles master sync for the deck).

Wheels

• While a track is playing, spinning the wheels temporarily speeds up or slows down the track.
• When a track is stopped, spinning the wheels results in a fast search.
• When the top wheel surface is touched the wheels act as as a precision jog.
• When the SCRATCH button is activated, moving the wheel while touching the top surface scratches the track.

Hot Cue Buttons

• If not currently set, pressing a HOT CUE button sets that hot cue at the current playback position.
• If already set, pressing a HOT CUE button jumps to that hot cue position.
• If the DEL button is *held*, pressing an already set HOT CUE button will clear that hot cue.
• Tapping the DEL button toggles #DEL-mode. The button will light up blue. DEL-mode alters some of the other
button functions like a shift button on other controllers.

17.1. Controllers 218



Mixxx User Manual, Rilis 2.3.0

Playback Pitch/Rate

• The pitch sliders control the pitch.
• The PITCH BEND +/- buttons step the playback rate up or down (pressing both resets the rate back to normal).
• The LOCK buttons turn on key lock so the pitch doesn’t change when the playback rate changes.
• The PITCH BEND button lights will indicate whether the current pitch is higher or lower than normal.

FX Control Buttons

These do not control effects; they have other functions:
• FX Control button 1 toggles the deck slip-mode on/off, (button lights blue when active). Slip-mode is not available
in any Mixxx skin yet so may be unfamiliar. When slip-mode is active, playback continues (muted in the back-
ground) during a loop/scratch etc. Once disabled, playback will resume where the track would have been if the
loop/scratch has not taken place (thus preserving the track beat).

• FX Control button 2 toggles the deck repeat mode, (button lights blue when active).
• FX Control button 3 can be tapped to adjust the beat-grid position.
• FX Control button 4 toggles the deck quantise mode on/off, (button lights blue when active).

FX Control knobs

• FX Control knob 1 = Deck gain.
• FX Control knob 2 = FX 1 “super” control (FX unit 1 on left deck, unit 3 on right deck).
• FX Control knob 3 = FX 2 “super” control (FX unit 2 on left deck, unit 4 on right deck).
• FX Control knob 4 = Deck “quick effect” control (by default this is a filter effect but can be changed in Mixxx’s
preferences).

FX Assign Buttons

• Tapping either of the 2 FX ASSIGN buttons on each deck will toggle the deck’s output to one (or both) of two
effects in the (default) 4-unit effects rack. The left deck (A or C) can be assigned to effect units 1 and/or 2. The
right deck (B or D) can be assigned to effect units 3 and/or 4.

• *Holding* an FX ASSIGN button allows the effect in that effect unit to be changed using the BROWSE
LEFT/RIGHT buttons.

DEL-mode

DEL-mode is activated by tapping the deck’s hot cue DEL button (the button will light up blue). This is equivalent to a
shift button on other controllers and so changes the behaviour of a number of the controller buttons as follows:

• The HOTCUE buttons act as auto-loop triggers (when *held*) in DEL-mode. The button layout follows the default
“LateNight” skin (i.e. top row = [1/8] to [1], bottom row = [2] to [16] beats). Longer auto-loops can be “locked”
(so the HOT CUE button doesn’t have to be held) by pressing the LOOP ON/OFF button after an auto-loop is
selected, (locked/playing auto-loops can also be resized by selecting a different auto-loop and then re-locking the
new size with the LOOP ON/OFF button).
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• The CUE button triggers reverse playback (while *held*).
• The PLAY button triggers reverse-slip playback (while *held*). NB: if you already have slip-mode activated before
you trigger reverse-slip playback, (e.g. by having pressed FX-Control button 1), then slip-mode will be turned off
as soon as you release the PLAY button (and you will return to the playback point where you would have been if
you hadn’t altered the playback).

• The PITCH BEND +/- buttons step the key up/down without altering the playback rate. If both PITCH BEND
buttons are pressed together, the playback key is reset to normal.

Auto-Loops and Slip-Mode

There are no “slip-mode aware” skins in Mixxx yet so the auto-loop behaviour of this controller (which *is* “slip-mode
aware”) may be a little different than you might expect to take advantage of this feature.

• Auto-loop buttons are (by default) only active when held.
• In slip-mode, releasing an auto-loop button will immediately “re-sync” playback (by disabling, then immediately
re-enabling slip mode), you may see the slip-mode button flash briefly when this happens. This allows for some
very interesting “slip-auto-loop” effects.

17.1.13 Behringer DDM4000

The Digital ProMixer DDM4000 is a 5-Channel Digital DJMixer with Sampler, 4 FX Sections, BPMCounters andMIDI
support. Each of the following sections can be configured separately to be used either for audio or as MIDI controller:

• Channel 1-4
• Microphone Channel
• Crossfader
• Sampler

The mixer contains no digital interfaces for audio or microphones.
• Manufacturer's product page
• User Manual
• Forum thread

Baru pada versi 2.3.

Compatibility

This controller contains aMIDI interface with 5-pin DIN jacks In/Out/Thru. If your soundcard does not offer DIN jacks,
a separate USB/MIDI interface is required to use it on GNU/Linux, Mac OS X, and Windows.
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Figure6: Behringer DDM4000 (schematic view)
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Setup

Configure at least one mixer section as MIDI controller:
1. Long press the CONSOLE SETUP knob
2. Select MIDI SETTINGS by turning and pressing the CONSOLE SETUP knob
3. Select the sections that you want to use as MIDI controller
4. Press the ESC button to exit MIDI Setup
5. To make the change persistent, save the settings in a user preset. See the controller manual for details.

Controller Mapping

A schematic drawing with the control numbers that are used here can be found on the specified page in the User Manual
in the Links section.

Stereo channels 1 – 4 (p. 6)

No. Control Function
4 HIGH / MID / LOW knobs Adjust high/mid/low-frequencies.
6 P1 / P2 / P3 buttons Toggle the kill function for high/mid/low-frequencies.
7 PFL button Toggle headphone pre-fader listening.
8 Channel faders Adjust the output volume.
10 CF ASSIGN button Assign the channel to either side of the crossfader.

Catatan: On some units of this mixer, the LEDs of the buttons P1 / P2 / P3 show an unexpected behavior in MIDI
mode. When such a LED is turned on via MIDI, it flashes shortly but does not stay lit. The problem occurs only when at
least 1 channel is in audio (non-MIDI) mode. It does not occur when all channels are in MIDI mode. Firmware version
1.02 (Dec 14 2007) is known to show this behavior, and there's no fix available according to a reply from the technical
support:

"I see the issue, but sorry, the code is 15 years old and getting the 15 year old tools (plus license, plus old
windows version) needed to compile it, together with finding the bug in a very complex code base (without
access to the developer) makes fixing this nearly impossible."

---[MUSIC Tribe Care] Behringer - Technical Support (08 Sep 2021)

Microphone (p. 6)

No. Control Function
19 TALK ON Switch the Talkover function.
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Figure7: Stereo channels strips
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Figure8: Microphone channel

Crossfader section (p. 7)

No. Control Function
20 Crossfader Fade between the signals that are assigned to its two sides A and B.
21 CF ON button Toggle crossfader function. When disabled, the crossfader control in the Mixxx user inter-

face is hidden.
24 CURVE knob Adjust the response of the crossfader.
25 REVERSE

HOLD button
Toggle a permanent reverse of the crossfader sides A and B. This means that A and B are
interchanged.

26 REVERSE
TAP button

Toggle a momentary reverse of the crossfader sides A and B. This means that A and B are
interchanged as long as the TAP push button is held down.
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Figure9: Crossfader section

Figure10: Sampler section
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Sampler (p. 8)

No. Control Function
55 VOLUME/MIX

knob
Control the volume of sampler 1.

57 PFL button Toggle headphone pre-fader listening for sampler 1.
58 SAMPLE

LENGTH but-
tons

Adjust the beatloop size of sampler 1.

61 MODE buttons for
bank 1/2

Select the playback type for the selected sampler (Reverse or Loop). A short press
toggles the Reverse function, a long press toggles the Loop function.

62 PLAY/OUT but-
tons for bank
1/2

Start or stop playback for the selected sampler. When the Loop function is disabled, the
sample is only played back while the button is pressed.

63 SMP FX ON but-
ton

Toggle effect unit 1 for sampler 1.

65 CF ASSIGN but-
ton

Assign sampler 1 to either side of the crossfader.

17.1.14 Denon DN-HS5500

• Manufacturer’s product page (archived)
Baru pada versi 2.0.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.15 Denon DN-SC2000

• Forum thread
Baru pada versi 1.8.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.16 Denon MC3000

• Manufacturer’s product page (archived)
Baru pada versi 2.0.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.17 Denon MC4000

The MC4000 is a 2-deck DJ controller for the professional entertainer wrapping in-demand audio manipulation tools in
a robust steel chassis for rugged durability. In addition to precision touch-activated jog wheels, performers get access to
dedicated hot cue and sample pads for on-the-fly remixes.

• Manufacturer’s product page
• Manual / Midi commands
• Forum thread

Themicrophone and auxiliary inputs are mixed with themaster output in hardware. They are not available to the computer
through the MC4000’s sound card, so this controller’s sound card is not suitable for broadcasting or recording the inputs.
You could use the controller with a separate USB sound card that has a microphone input for that purpose.
Baru pada versi 2.1.

Mapping Description

TheMixxxmapping is mostly the same as the standard Serato mapping, with a few exceptions which are highlighted below
with underlined text where a specific functionality that exists in Serato is not (yet) implemented in the Mixxx mapping.
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Figure11: Denon MC4000 (layout)

1. Channel Level: Adjust the level of the pre-fader, pre-EQ audio signal
2. Channel EQ: Boost or cut the high, mid-range, and low frequencies
3. Channel Filter: Turn counterclockwise to apply a low-pass filter. Turn clockwise to apply a high-pass filter.
4. Channel Cue: Send the channel’s pre-fader signal to the headphones’ cue channel.
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5. Channel Fader: Adjust the channel’s volume level.
6. Crossfader: Mix between the two decks.
7. Shift: Press and hold this button to access secondary functions of other controls.
8. Sync / Sync Off: Automatically match the corresponding Deck’s tempo with the opposite Deck’s tempo and phase.

Unlike Serato, Shift + sync is not mapped to anything.

9. Cue / Track Start: Behavior changes according to the cue mode selected in Mixxx’s preferences. Hold Shift and
press this button to return to the start of the track.

10. Play/Pause / Stutter: Play/pause playback. Hold Shift and press to “stutter-play” the track from the cue point.
11. Hot Cues: Press a pad to set or jump to a hot cue point. To set a hot cue point, press an unlit pad at the desired

location in the track (the pad will then be lit). To jump to that hot cue point, press the lit pad. To delete a hot cue
point, hold Shift and press a lit pad.

12. Pad Mode: Currently unmapped
13. Platter: This capacitive, touch-sensitive platter controls the audio playhead when the wheel is touched and moved.

When the Vinyl button is on, move the platter to “scratch” the track like a vinyl record. When the Vinyl button is
off (or if you are touching only the side of the platter), move the platter to temporarily adjust the track’s speed.

14. Vinyl / Censor: Toggle “vinyl mode” for the platter. When activated, you can use the platter to scratch the track as
you would with a vinyl record. Hold Shift and this button to activate the Censor feature: the playback of the track
will be reversed, but when you release the button, normal playback will resume from where it would have been if
you had never engaged the Censor feature (i.e., as if the track had been playing forward the whole time).

15. Key Lock / Range: Toggle Key Lock. When Key Lock is activated, the track’s key will remain the same even if
you adjust its speed. Hold Shift and press to cycle through the available ranges of the pitch fader (+/- 8%, 16%,
50%). Other ranges for the fader can be selected in Mixxx’s Preferences in the Interface section, but pressing this
button with Shift will only cycle through 8%, 16%, and 50%.

16. Pitch Bend -/+ : Hold one of these buttons to momentarily reduce or increase (respectively) the speed of the track.
Hold Shift and then press and hold one of these buttons to rewind or fast-forward (respectively) through the track.

17. Pitch Fader: Move this fader to adjust the speed (pitch) of the track. You can adjust its total range with the Key
Lock / Range button.

18. FX Level: Turn the knobs on the left side of the controller to adjust the effect intensity (i.e. “meta” parameter) for
the effects in Effect Unit 1. Turn the knobs on the right side of the controller to adjust the meta parameter for the
effect in Effect Unit 2. The FX On button under the knob must be lit for the effect to be enabled.

19. FX Beats: Currently changes the wet/dry ratio of the effect chain. This will probably change in the future.
20. FX On / Select: Press to toggle the corresponding effect on or off. Hold Shift and press to assign a different effect

to this slot.
21. FX Tap: Currently not mapped
22. Auto-Loop / Auto 4: Toggle a 4 beat loop on or off. Hold Shift and press to toggle beat quantize on or off (I.e

quantization of loop start / end points to the nearest beat). Note: this behavior is different from Serato.
23. X 1/2 Loop / Loop In: Halve the length of the current loop. Hold Shift and press to create a Loop In point at the

current location.
24. X 2 Loop / Loop Out: Double the length of the current loop. Hold Shift and press to create a Loop Out point at

the current location.
25. Reloop: Exit the current loop if a loop is active, or skip to the last-played loop and activate it immediately if there

is no loop active.
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26. Browse / Library Knob: Turn to browse through the items in the currently focused pane (i.e. library or sidebar).
Press shift and turn to scroll quickly through the items in the currently focused pane. Press the knob to select the
current item.

27. Load: Load the currently selected track to the deck.
28. Back / Panel: Change the currently focused pane (i.e. library or sidebar) to the next or previous pane.
29. Load Prep / Open Prep: Load the currently selected track to the preview deck. Hold Shift and press to eject the

current track from the preview deck. (Different from Serato mapping).
30. Sampler Pads: Press to play the corresponding samples in the software’s sampler (1–4). Hold Shift and press a

pad to stop its sample playback.
31. Sample Level: Turn this knob to adjust the volume level of the software’s samplers (1–4).
32. Level Meters: These LEDs display the level of the audio signal depending on the state of each deck and Channel

Fader. The meters are not affected by the position of the Master Knob.
33. Mic Volume: Adjust the input gain of the microphone. This adjusts the hardware microphone preamplifier, not

Mixxx’s mic gain. The microphone input is not available to the computer through the MC4000’s sound card; it is
mixed with the master output in hardware.

34. Mic Echo: Toggle an echo effect on the microphone input. This effect is done in hardware, not in Mixxx.
35. Mic Talk Over / Post: Toggle microphone talkover, which automatically reduces the volume of the music when

using the microphone. Hold shift and press to toggle whether the microphone input is routed to the booth output.
These controls are done by the MC4000 in hardware and do not affect Mixxx.

36. Master: Adjust the master output level of the sound card. This does not affect the master gain in Mixxx.
37. Booth: Adjust the booth output level of the sound card. This does not affect anything in Mixxx.
38. Aux: Adjust the auxiliary output level of the sound card. This does not affect anything in Mixxx.

17.1.18 Denon MC6000MK2

• Manufacturer’s product page (archived)
• Forum thread
• Mixxx maintainer

Baru pada versi 2.0.
The number in the first column refers to the corresponding label in the Owner’s Manual in the chapter Part names and
functions starting on page 20.

# User Manual Control Modifier Context Function
1 BEATS/V.FX SEL. Knob is turned Effect unit dry/wet mix

Knob is pressed Focus/unfocus effect unit
2 TAP NONE Toggle (enable/disable) EFX unit
3 EFX 1/2/3 KNOB Effect meta knob
4 EFX 1/2/3 ON Enable/disable effect
5 EFX CH. ASSIGN NONE Assign/unassign deck

SHIFT Assign deck exclusively
6 LOOP IN NONE Set loop in point

SHIFT Delete loop
6 LOOP OUT NONE Set loop out point

berlanjut ke halaman berikutnya
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Table 2 – lanjutan dari halaman sebelumnya
# User Manual Control Modifier Context Function

SHIFT Delete loop out point
7 AUTO LOOP NONE Loop is undefined Activate a loop over beatloop size beats

SHIFT Loop is undefined Activate a rolling loop over beatloop size beats
NONE Loop is defined Toggle reloop
SHIFT Loop is defined Delete loop

7 LOOP + NONE Double beatloop size beats
SHIFT Move loop forward by beatloop size beats

7 LOOP - NONE Halve beatloop size beats
SHIFT Move loop backward by beatloop size beats

8 HOT CUE 1/2/3/4 NONE Deck is stopped Jump to hot cue and start playing while pressed
NONE Deck is playing Jump to hot cue
SHIFT Delete hot cue

8 SAMPLE 1/2/3/4 NONE Sampler is empty Load selected track into sampler
NONE Press button Play track from beginning while pressed
NONE Release button Stop playback
SHIFT Release button Continue playback
SHIFT Press button Eject track from sampler

9 DECK Switch active deck
10 SHIFT Modifier that activates a 2nd layer of functions. It does not matter which of the two shift buttons is pressed.
11 KEY LOCK Enable/disable key lock mode
12 HOT CUE / SAMPLE Switch between hot cues and samplers
13 JOG WHEEL NONE Bend or scratch (vinyl mode)

SHIFT Deck is stopped Fast track seek (wheel search)
14 PITCH SLIDER Change playback speed
15 SYNC Trigger sync mode by short/long press
16 CUE NONE Trigger cue according to configured cue mode

SHIFT Stop playback and jump to beginning of track
17 PLAY NONE Start/stop/continue playback

SHIFT Reverse playback direction
18 SLIP/CENSOR NONE Censor: Enable reverse and slip mode while pressed

SHIFT Toggle (enable/disable) slip mode permanently
19 PITCH BEND + Deck is stopped Fast forward

NONE Deck is playing Pitch bend up
SHIFT Deck is playing Pitch bend up (small)

19 PITCH BEND - Deck is stopped Fast rewind
NONE Deck is playing Pitch bend down
SHIFT Deck is playing Pitch bend down (small)

20 VINYL Enable/disable vinyl mode (scratching)
23 X-F LINK Not yet mapped
21 PANEL Not yet mapped
22 VIEW Not yet mapped
24 AREA Not yet mapped
25 LIST Toggle maximized library view
26 BACK NONE Scroll up

SHIFT Move focus backward to previous panel
26 FWD NONE Scroll down

SHIFT Move focus forward to next panel
27 SELECT KNOB NONE Knob is turned Move through focused panel/list

SHIFT Scroll through focused panel/list
berlanjut ke halaman berikutnya
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Table 2 – lanjutan dari halaman sebelumnya
# User Manual Control Modifier Context Function

NONE Knob is pressed Go to the selected item
SHIFT Move focus backward to previous panel

28 LOAD NONE Load selected track into active deck
SHIFT Eject loaded track from active deck

29 FILTER ON Enable/disable filter effect for deck 1/3 or 2/4
30 FILTER KNOB Control filter effect (low/high pass) for deck 1/3 or 2/4
31 MIC LEVEL 1/2 Not yet mapped
32 MIC ON 1/2 Not yet mapped
33 MIC DUCKING Not yet mapped
34 MIC ECHO ON 1/2 Not yet mapped
35 CUE MIX NONE Enable/disable cue mix

SHIFT Enable solo cue mix (only this channel)
36 VU METER DISP. SWITCH Select channel(s) for display
37 CHANNEL FADER Control channel output volume
38 CROSS FADER Control balance between assigned channels
39 VU METER Display channel/master output volume
40 BOOTH ASSIGN Select source for booth output
41 BOOTH LEVEL Control booth output volume
42 MASTER LEVEL Control master output volume
43 HI KNOB Control channel EQ (high freq.)
43 MID KNOB Control channel EQ (mid. freq.)
43 LOW KNOB Control channel EQ (low freq.)
44 LEVEL KNOB Control channel gain
45 CHANNEL INPUT SELECT Select channel input source

17.1.19 Denon MC7000

The Denon MC7000 is a professional DJ controller which has got 4-channel capability and dual USB connections. These
two USB audio interfaces enable two DJs to play together. This controller includes Denon’s high build quality and superior
24-bit audio reproduction, makes this suited to both mobile and club DJs.
Baru pada versi 2.2.4.
Berubah pada versi 2.3.0: Fixed a vinyl mode bug on deck 4 and added new features, like library sorting, searching
through track with jog wheel, ejecting track from deck, waveform zoom, fixed loops and an experimental beat counter
(slicer-like) and improved parameter and censor/reverse/spinback button mappings.
Berubah pada versi 2.3.1: Some improvements for slip mode, sampler play and rate range toggle. Added browsing through
library using jog wheel.

Useful links

• Denon MC7000 Mapping thread
• Manufacturer’s product page
• User Guide
• Hardware Setting Specification
• Mixxx showcase on YouTube
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Compatibility

• Mac users should be just fine connecting the MC7000 and go.
• Windows users need to install the latest Windows Driver from Denon Download Site.
• Linux users need a minimum LTS Kernel version 4.19.105 or 5.4.21. All Kernels 5.6.x and following are sup-
porting the device out-of-the-box.

Mapping

Figure12: Denon MC7000 (schematic view)

This controller is made for Serato DJ and most of the mapping is made for Mixxx accordingly. Anyhow, there are several
differences for functions not matching the Serato mapping. If you have any wishes to improve the mapping, then please
discuss it in the Denon MC7000 Mapping thread.
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User Variables

User variables can be set to suit individual needs inside the Denon-MC7000-scripts.js mapping file:
• MC7000.experimental activate experimental beat count feature (default: false)
• MC7000.needleSearchPlay activate NEEDLE DROP sensor while a track is playing (default: false)
• MC7000.prevSamplerStop set to single play samplers (default: true)
• MC7000.rateRanges set the available Pitch Fader ranges (default: 4, 6, 8, 10, 16, 24, 50, 90)
• MC7000.modeSingleLED set single LED on or off (default: 1). Can be toggled with SHIFT + Deck
• MC7000.VinylModeOn set the Vinyl Mode on or off at Mixxx start which also triggers the Platter Ring LED
function (default: 1)

• MC7000.scratchParams set Scratch Parameters (default: 33+1/3, 1/10, 1/10/32)
• MC7000.jogSensitivity set the Jog Sensitivity (default: 1)
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Mixer Section

No.Control Function
1 Input Selector Switch Set to the desired audio source for this channel.

LINE/PHONO will disable the corresponding Deck (switches off all LEDs and the
controller will not send MIDI signals to control Mixxx). This allows the mixer to
use an external source.
USB will turn the corresponding Deck on and allows to control Mixxx via USB
connection.

2 USB1 / USB2 Press to select whether the deck is controlling the computer connected to USB Port
1 or USB Port 2. If only one USB Port is connected the controller activates this
automatically.

3 LEVEL Turn to adjust the level of the pre-fader, pre-EQ audio signal for the channel.
4 Channel Level Meters Display the audio signal level of the channel as in Mixxx GUI.
5 Channel EQ Turn to boost or cut the HI, MID and LOW frequencies for the channel.
6 FILTER Turn this knob to adjust the filter applied to the channel. Turn the knob counter-

clockwise to apply a low-pass filter. Turn the knob clockwise to apply a high-pass
Filter.

7 CUE Press to send the channel’s pre-fader signal to the headphones’ cue channel.
8 Channel fader Use to adjust the channel’s volume level.
9 Crossfader Assign Routes the audio playing on the corresponding channel to either side of the cross-

fader (A or B), or bypasses the crossfader and sends the audio directly to the program
mix (THRU).

10 Crossfader Use this crossfader to mix between the left and right decks.
12 SAMPLER LEVEL Turn this knob to adjust the volume level of the software’s sampler. If the volume

is set to 0 then the Sampler banks are hidden, otherwise shown.
13 Master Level Meters These LEDs show the Master Audio signal.
14 MASTER LEVEL Turn to adjust the volume level of the master outputs.
15 BOOTH LEVEL Turn to adjust the volume level of the booth outputs.
20 PHONES LEVEL Turn to adjust the volume level of the headphones.
21 PHONES MIX Adjusts the software’s audio output to the headphones, mixing between the cue out-

put and the master mix output.
22 SPLIT Press to switch Headphone 'split' mode. When this switch is lit, the headphone audio

will be 'split' such that all channels sent to cue channel are summed to mono and
sent to the left headphone channel and the master mix is summed to mono and sent
to the right channel. When the switch is unlit, the cue channel and master mix will
be 'blended' together.

59 X FADER CONTOUR Turn to adjust the slope of the crossfader curve, to the left for a smooth fade (mixing)
or to the right for a sharp cut (scratching.

Catatan: The Input source selection, Master Level Meters, USB1 / USB2, MASTER LEVEL, BOOTH LEVEL,
PHONES LEVEL, PHONES MIX and SPLIT are handled by the controller. The status of Mixxx will not be changed.
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Microphone Section

No.Control Function
16 MIC ON/OFF Press to activate/deactivate the microphones.
17 MIC LEVEL Turn to adjust the volume levels of the corresponding microphone inputs.
18 MIC 1 HI/MIC

1 LOW (left
deck)

Turn to boost or cut the high or low frequencies for Microphone 1.

18 MIC 2 TONE
(right deck)

Turn to adjust the tone (high-low) for Microphone 2.

18 ECHO MIC
1&2 (right
deck)

Turn to adjust the amount of the echo effect for both Microphones.

19 TALKOVER
MIC 1&2 (left
deck)

Press to use the 'talkover' feature, which automatically reduces the volume level of the master
mix when you speak into the microphones.

19 SHIFT +
TALKOVER
MIC 1&2 (left
deck)

Press to activate/deactivate the 'Post' feature. When on, the microphones signal will be sent to
the Booth Outputs. When off, the microphones signal will not be routed to the Booth Outputs.

19 ECHO MIC
1&2 (right
deck)

Press this button to activate or deactivate the echo effect on the microphones’ audio signal.

Catatan: All functions are handled by the controller in hardware. The status of Mixxx will not be changed.

FX Section

No.Control Function
11 FX ASSIGN Press assign FX 1 and/or FX 2 to the corresponding channel.
55 FX ON Press to turn the corresponding effect on or off.
55 SHIFT + FX ON Press to select an effect from the list that was enabled in the Mixxx Preferences FX

section.
56 FX 1, FX 2, FX 3 Turn to adjust the level of the corresponding effect. The FX ON button under the

knob must be lit for this knob to function.
57 FX BEATS Turn to adjust the Wet/Dry rate of the effects.
58 FX TAP Press to activate effects for the Master output. This can be overlapped with Channel

Effects.
58 SHIFT + FX TAP Press to activate effects for headphones cue.
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Library Section

No.Control Function
48 SELECT/LOAD Turn to navigate through lists. Press the left side button to load a track into the

active Deck (1 or 3), press the right side button to load a track into the active Deck
(2 or 4).
When you keep the knob pressed down longer than 0,5 sec an actual loaded track
will be ejected from the deck upon release of the knob.

48 SHIFT + SELECT/LOAD Turn to browse quickly through the tracks in the library or push the knob to open
folders on the left side of the library.

49 SORT Press and hold to activate sort functions.
50 BACK Press to switch between right and left side of the library.
50 SHIFT + BACK Press to move through frames inside the GUI.
50 SORT + BACK Press to sort the tracks by Beats Per Minute.
51 L.PREP Press to load the currently selected track to the Preview Deck.
51 SHIFT + L.PREP Press to start and stop playing the track in Preview Deck.
51 SORT + L.PREP Press to sort the tracks by their Key.
52 FILES Press to maximize the library. Press this button again to exit maximized library.

While the library is maximized you can use the jog wheel to navigate quickly
through lists.

52 SORT + FILES Press to sort the tracks by Artist.
53 PANEL Press to open and close the FX panel inside the GUI.
53 SORT + PANEL Press to sort the tracks by Title.

Deck Section

No.Control Function
23 DECK Selects which deck in the software is controlled by that hardware deck. The left

deck can control Deck 1 or 3; the right deck can control Deck 1 or 4.
23 SHIFT + DECK Press to switch Platter Ring LED Mode. Refer to the LEDs section for details.
24 SHIFT Press and hold this button to access secondary functions of other controls.
25 SYNC Press to automatically match the corresponding deck’s tempo with the tempo and

phase of the opposite deck. Press again to deactivate Sync. Hold this button down
for one sec to permanently match the tempo.

26 CUE If a cue point is not set then press this button to set it at the current track position.
During playback, press this button to return the track to the cue point.
If the deck is paused, press and hold this button to play the track from the cue
point. Release the button to return the track to the cue point and pause it. To
continue playback without returning to the cue point, press and hold this button and
then press the PLAY button, afterwards release cue button.

26 SHIFT + CUE Press to return to the start of the track.
27 PLAY / PAUSE Press to pause or resume playback.
27 SHIFT + PLAY / PAUSE Press to stutter play the track from the last set cue point.

berlanjut ke halaman berikutnya
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Table 3 – lanjutan dari halaman sebelumnya
No.Control Function
28 Jog Wheel Controls the audio playhead when the wheel is touched and moved.

When the VINYL button is lit, move the platter to 'scratch' the track as you would
with a vinyl record.
When the VINYL button is unlit (or if you are touching only the side of the platter),
move the platter to temporarily adjust the track’s speed.
If the library is maximized (use FILES button) turning the jog wheel will scroll the
current table view (currently playing track is not affected). Be careful though: after
exiting the maximized library view the jog wheel will immediately return to jog or
scratch mode.

28 SHIFT + Jog Wheel Navigates quickly through the track. This only applies if touching the side of the
platter or with VINYL deactivated.

29 STOP TIME Controls the rate at which the track slows to a complete stop ('brake time') during
backspin. This also affects how quickly the track starts after a backspin ('Soft Start').

30 VINYL Press to activate/deactivate a 'vinyl mode' for the platter. When activated, you can
use the platter to 'scratch' the track as you would with a vinyl record.

31 Pitch Fader Move to adjust the speed (pitch) of the track.
32 PITCH BEND –/+ Press to momentarily reduce or increase the speed of the track.
32 SHIFT + PITCH BEND –

/+
Press to set the Pitch Fader range. You may adjust the steps in JavaScript file

33 KEY LOCK Press to activate/deactivate Key Lock. When Key Lock is activated, the track’s key
will remain the same even if you adjust its speed.

33 SHIFT + KEY LOCK Press to automatically match the corresponding deck’s key with the key of the op-
posite deck.

34 KEY SELECT/RESET Turn to raise or lower the key of the track. Press to reset the track’s key to its original
key.

34 SHIFT + KEY SE-
LECT/RESET

Turn to zoom in and out the waveform or push the knob to reset the Waveform
zoom to the level set in preferences.

35 Performance Pads refer to the Performance Pads section for details.
40 AUTO LOOP Press to create an auto-loop with the length set with loop length. You may change

the length of beats by using the X1/2 or X2 buttons.
40 SHIFT + AUTO LOOP Press to toggle the current loop on or off. If the loop is ahead of the current play

position, the track will keep playing normally until it reaches the loop.
41 X1/2 Press to halve the length of the current loop.
41 SHIFT + X1/2 Press to create a loop in point at the current Location.
42 X2 Press to double the length of the current loop.
42 SHIFT + X2 Press to create a loop out point at the current Location.
43 </> PARAM 1 2 Press to add/remove rating stars to the loaded track.
43 SHIFT + </> PARAM 1 2 Press to change the track color in the library.
44 SLIP Press to enable or disable Slip Mode. In Slip Mode, you can jump to cue points,

trigger loops or use the platters, while the track’s timeline continues. In other words,
when you deactivate Slip Mode, the track will resume normal playback from where
it would have been if you had never done anything (i.e., as if the track had been
playing forward the whole time).
After scratch, hot cue play, reverse play and backspin the slip mode releases itself
so the timeline of the track jumps back to original position after the action is done.
Slip mode reactivates itself after 50ms so you can continue with more actions in slip
mode almost immediately after.

berlanjut ke halaman berikutnya
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Table 3 – lanjutan dari halaman sebelumnya
No.Control Function
45 CENSOR Press and hold this button to play the track in REVERSE.When releasing the button,

the track immediately starts playing from it's momentary position.
If SLIP was active then after releasing the CENSOR button the track continues as
it had been playing forward the whole time (CENSOR). Slip mode stays enabled so
you can continue with more actions in slip mode.

45 SHIFT + CENSOR Press to activate a backspin with the length set by the STOP TIME knob.
If SLIP was active then after releasing the CENSOR button the track continues as
it had been playing forward the whole time. Slip mode stays enabled so you can
continue with more actions in slip mode.

46 BEAT GRID ADJUST Press to adjust the Beat Grid to the current play position.
46 SHIFT + BEATGRIDAD-

JUST
Press to activate Quantize mode.

47 BEAT GRID SLIDE Press to adjust the Beat Grid to another playing track.
54 NEEDLE DROP Place your finger on a point along this sensor to jump to that point in the track (strip

represents entire track).
54 SHIFT + NEEDLE DROP Press to jump to a position while a track is currently playing.

Petunjuk: The jog sensitivity and scratch parameters (28), the default vinyl mode (30), the pitch fader ranges (32) as
well as the needle drop activity (54) can be set by modifying the variables inside the JavaScript file accordingly.

Catatan: Use SHIFT + CENSOR for a backspin while SLIP is active. Backspin using the platter is only possible while
SLIP is disabled.

Performance Pads

Mode Selection

No.Control Function
35 Performance Pads Press to perform action with one of those buttons.
36 CUE Press to switch to 'Hot Cue' mode.
37 ROLL Press to switch to 'Roll' mode.
37 SAVED LOOP Press ROLL one more time to get into 'Fixed Loop' mode.
38 SLICER Press to switch to 'Beatjump' mode.
39 SAMPLER Press to switch to 'Sampler' mode.

Hot Cue Mode (blue LED)

8 Hot Cue positions can be defined in this mode.

Press one of the pad buttons to set or play a Hot Cue.
Use SHIFT + pad button to delete an existing Hot Cue.
If SLIP is active then press and hold a pad button to play from the Hot Cue position. After releasing the Hot Cue button
the track continues as it had been playing forward the whole time. Slip mode stays enabled so you can continue with
more actions in slip mode.
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Roll Mode (turquoise LED)

This mode lets you repeat a number of beats while keep pushing a pad button down.
The SLIP function remains active so that the track continues at the position where it had been playing forward the whole
time.

Fixed Loop Mode (yellow LED)

This mode lets you set a dedicated loop from current position.
Another push on the pad button will turn the loop off.
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Beatjump Mode (red LED)

This mode lets you jump a number of beats while pushing a pad button once.

Press and hold "SHIFT" and then push a pad button to jump even more beats.
16, 32, 64 and 128 forward on the upper row and backwards on the lower row.

Petunjuk: If experimental features were set to true in the JavaScript file then the pad LEDs counting the beat after the
main CUE point.

Sampler Mode (pink LED)

8 samplers can be triggered from either Deck.

Add samplers to the sampler bank pushing a pad button.
If a sampler is loaded, then another push on the pad button will play the sampler from its Cue point.
Push the pad button again while playing will replay the sampler from Cue point.
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When a sampler is started while another one is still playing, then the initial sampler stops and only the newly triggered
sampler plays (single play).

Use SHIFT + pad button to stop a sampler while playing or eject a sampler when stopped.

Petunjuk: To use default Mixxx behaviour and allow playing multiple samplers at the same time you can set the user
variable MC7000.prevSamplerStop inside the JavaScript file to false.

LEDs

The Channel Volume Meters matches to the ones shown in Mixxx GUI. Only when clipping the red LED illuminates.
The Master Volume Meter is not correlated to Mixxx GUI as the controller handles that in Hardware.
Button LEDs are fully mapped for the first function. As you press and hold SHIFT then the secondary functions have
only got some flashing LEDs mapped, e.g. TAP and KEY SYNC, when activated.
Press SHIFT + Deck to switch Platter Ring LED Mode.

• Mode 0 - Single 'off' LED chase (all other LEDs are 'on')
• Mode 1 - Single 'on' LED chase (all other LEDs are 'off')
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Petunjuk: The default mode can be set to 0 or 1 inside the JavaScript file.

Platter Ring LEDs are correlated with the VINYL button.
• If vinyl mode is enabled, the LED imitates a turntable platter spinning at 33.3 rpm.
• If vinyl mode is disabled, the current track position is indicated by the Platter LEDs starting at the top.

Catatan: The Platter Ring LEDs are not moving while the track position is 'negative'. That means if the position is
before the track starts then the position LED keeps staying at most up position.

Known Issues

• Some Performance Pad modes are not available (Cue Loop, Flip, Slicer Loop, Velocity Sampler, Pitch).
• The Effect Units don't use Mixxx' Standard Effects Mapping

17.1.20 DJ Tech CDJ 101

DJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps. There is no (longer) a product page for this discontinued device.

• Forum thread
Baru pada versi 1.11.

Mapping description

Needs the CDJ 101 to be on midi channel 1 for deck 1 and on channel 2 for deck 2.
• Pitch slider works as you’d expect
• Holding down the push button works as a “shift” to activate secondary functions
• Rotate push button: navigate tracks
• Shift + rotate push button: switch between playlists
• Cue button: default cue behaviour
• Play: toggle play
• Shift + play: sync
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While track is playing

• Surface of jog wheel: scratch
• Edge of jog wheel: tempo bend
• Shift + edge of jog wheel: fine tempo bend

While deck is paused

• Press push button: load a track
• Surface of jog wheel: scratch thru track
• Shift + surface of jog wheel: scan through track quickly
• Edge of jog wheel: jog though track slowly
• Shift + Cue: move beatgrid

17.1.21 DJ Tech DJM 101

DJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps. There is no (longer) a product page for this discontinued device.

• Forum thread
Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.22 DJ Tech iMix Reload

DJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps. There is no (longer) a product page for this discontinued device.

• Forum thread
Baru pada versi 1.10.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.23 DJ Tech Kontrol One

DJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps. There is no (longer) a product page for this discontinued device.

• Forum thread
Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.24 DJ-Tech MIX-101

Baru pada versi 2.0.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.25 DJ Tech Mixer One

DJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps.

• Manufacturer’s product page
Baru pada versi 1.10.1.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.26 DJ TechTools MIDI Fighter Classic

A simple 16 button controller that has been discontinued.
The default Mixxx mapping has the buttons mapped to hotcues 1-8 for decks 1 & 2.
Baru pada versi 1.8.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.27 DJ TechTools MIDI Fighter Twister

• Manufacturer’s product page
Baru pada versi 2.1.5.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.28 EKS Otus

This controller has been discontinued as EKS is went out of business.
Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.29 Electrix Tweaker

The Electrix Tweaker is an unconventional MIDI controller that can control most aspects ofMixxx. Instead of jog wheels,
it fits an 8x4 grid of multicolor backlit buttons, 8 velocity-sensitive buttons, and 6 push encoders with LED rings into a
relatively small package. It does not have a built in sound card, so it requires a separate sound card or splitter cable
(although it does include 5-pin MIDI in and out ports).

• Manufacturer’s website
• Forum topic
• Manufacturer’s manual

Baru pada versi 2.0.

Compatibility and setup

The Tweaker is a USB MIDI class compliant device, so it does not require any special drivers on any operating system.
Just plug it in and load the Mixxx mapping on any OS that Mixxx runs on.
Use it with the Tweaker MIDI 1 port (Tweaker MIDI 2 is the 5-pin MIDI I/O on the Tweaker).

Mapping description

Global controls

1. Scroll through library. Press to toggle big library view
2. Scroll up left panel of library
3. Scroll down left panel of library
4. Samplers
• Off when empty, red when loaded
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Figure13: Electrix Tweaker (global controls)
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• Press a button to load the selected sample into a sampler and play it
• Press a button to play a sample. When the button is released, the sample will stop playing.
• Press [[#top-shift-layer|top shift]] and a sampler button to eject a sample from a sampler
• Samples will play with their volume proportional to how much force was used to strike the button. You can adjust
the sensitivity or disable the velocity sensitivity (and make them work as on/off switches) by adjusting options at
the top of the JavaScript file in a text editor.

5. Crossfader

Top shift layer

7

8

9

10

11

12

1 5 16

13
6 2 3

4

5
1

Figure14: Electrix Tweaker (top shift layer controls)

This layer is active while the top shift button (#1 in the diagram) is held down.
With the exception of the headphone mix encoder (#8 in the diagram), pressing the encoders 7-12 resets them to center.

1. Top shift button
2. Eject left deck
3. Eject right deck
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4. Expand/collapse selected item in left library pane
5. Expand/collapse selected item in left library pane
6. Scroll through library quickly. Push to load selected track into first stopped deck.
7. Headphone gain
8. Headphone cue/master mix in headphones. Press to toggle split cue mode. The blue LED below encoder is lit when

split cue mode is enabled.
9. Channel gain for active deck on left side
10. Master output gain
11. Master output balance
12. Channel gain for active deck on right side
13. Eject sampler
14. Delete hotcue
15. Deck shift button. Press to enable [[#vinyl timecode mode]] on the deck that is active on the left side (press top

shift button first, then this button while holding down top shift)
16. Deck shift button. Press to enable [[#vinyl timecode mode]] on the deck that is active on the right side (press top

shift button first, then this button while holding down top shift)

Deck controls

The deck controls are the same on each half of the controller. Which deck each side controls can be switched with the
deck toggle button, labeled #11 in the diagram. When controlling deck 1 or 2, the switches on that side (9, 11, 13, 14,
and 15 in the diagram) are blue when enabled, as shown on the left side of the diagram. When controlling deck 3 or 4,
the switches on that side are magenta when enabled, as shown on the right side of the diagram.

1. Filter (low pass filter left of center; high pass filter right of center)
2. Load track selected in library into deck
3. Toggle encoders between EQ and loop mode (see [[#channel-encoder-layers|below]])
4. Headphone cueing
5. Volume
6. Play/pause
7. Hotcues. Press an unlit button to set a hotcue. When slip mode is disabled (see #9 below), pressing a hotcue simply

jumps to that hotcue. When slip mode is on, hotcues can be previewed on a stopped deck. While previewing a
hotcue, press the play button to let the track keep playing after the hotcue is released. Pressing a hotcue while a
deck is playing and slip mode is on will jump to the hotcue then jump back to where the track would have been
once the last hotcue button is released.

8. Jump 4 beats forward (with quantize enabled)
9. Slip mode. When active, loops and hotcues will only play as long as they are held down. When they are released,

the track will jump to where it would have been if the loop or hotcue was not pressed.
10. [[#deck-shift-layer|Deck shift]]
11. Deck toggle between decks 1 & 3 on the left and decks 2 & 4 on the right.
12. Jump 4 beats backward (with quantize enabled)
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Figure15: Electrix Tweaker (deck controls)
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13. Quantize. In addition to snapping cues, loops, and play button presses to the nearest beat, this changes the behavior
of the controller’s navigation buttons. When enabled, the navigation buttons are white as shown by 8 & 11 in the
diagram. With quantize enabled, the navigation buttons jump by 4 beats or 1 beat with [[#deck-shift-layer|deck
shift (#10)]] pressed. When disabled, the navigation buttons are green as shown by 15 & 16 in the diagram. With
quantize disabled, the navigation buttons fast forward and rewind the track. When quantize is disabled and deck
shift is pressed, the navigation buttons are temporary pitch bend buttons.

14. Key lock
15. Sync lock
16. Fast forward (with quantize disabled)
17. Rewind (with quantize disabled)

Deck Shift layer

1
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3

4

5 9 11
14 15

8

13

6

12

7
16
17

1 0

Figure16: Electrix Tweaker (deck shift layer)

This layer is active while the yellow deck shift button on that side of the controller is held down.
1. Pitch (only adjusts tempo with keylock on)
2. Jump 32 beats forward or backward
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3. Scroll through hotcue pages. The pages are color coded, in order, cyan, green, red, and white. The LED around
the encoder indicates the hotcue page number. The active page on a deck is remembered when toggling between
decks (see [[#deck-controls|deck controls (#11)]] above).

4. Exit loop
5. Volume
6. Cue. When previewing from the cue point on a stopped deck, release this cue button to stop playing and jump back

to the cue point. Release deck shift to continue playing.
7. Move hotcue to current position
8. Jump forward 1 beat (with quantize enabled, see [[#deck-controls|deck controls #13]])
9. Manually place loop start point
10. Deck shift button
11. Manually place loop end point
12. Jump back 1 beat (with quantize enabled, see [[#deck-controls|deck controls #13]])
13. Align beatgrid with current position
14. Sync key. If key has been changed from track’s original key, reset the key.
15. Reset tempo
16. Temporarily raise pitch while pressed (with quantize disabled, see [[#deck-controls|deck controls #13]])
17. Temporarily lower pitch while pressed (with quantize disabled, see [[#deck-controls|deck controls #13]])

Channel encoder layers

The encoder layer buttons (#4 and #8 in the diagram) toggle the encoders between EQ and loop layers.
The left side of the diagram shows EQ mode. In EQ mode, pressing encoders toggles that EQ’s kill switch. The blue
LED below the encoder is lit while the kill switch is on. Pressing the encoder while holding deck shift (see deck controls
#10) resets the EQ to center.
Tip: You can go to Options > Preferences > Equalizers and check “Reset equalizers on track load”. On most controllers,
this would be an issue because the physical knobs would be misaligned with the values in software when the EQs were
reset, but because the Tweaker has LED rings around encoders instead of knobs, this is not an issue.
The right side of the diagram shows loop mode. The LEDs on the loop move length and loop length encoders represent
numbers of beats. Center means 1 beat. Each step to the right doubles the beats and each step to the left halves the beats.
For example, the default loop length is 4 beats, so the center LED and 2 LEDs to the right are lit (2 x 2 = 4).

1. High EQ
2. Mid EQ
3. Low EQ
4. Encoder mode button. Press to switch to loop mode.
5. Loop move length
6. Move loop
7. Loop length. Press to toggle loop. When in slip mode (see [[#deck-controls|deck control button #9]]), the loop is

only active while this is held down. The blue LED below the encoder is lit while
8. a loop is active.
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Figure17: Electrix Tweaker (channel encoder layers)
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9. Encoder mode button. Press to switch to EQ mode.

Vinyl Timecode Mode

3
4

1

2

Figure18: Electrix Tweaker (vinyl timecode mode)

1. Top Shift
2. Toggle vinyl timecode mode by pressing deck shift (#2 in the diagram) while holding top shift (#1 in the the

diagram). This replaces the navigation buttons for that deck with buttons that toggle options for timecode control.
3. Cycle through vinyl control modes: absolute (LED off), relative (LED indicates cuemode), and constant (LED red).

If the deck is in relative mode and playing, pressing the button cycles through cue modes: off (white), cue (yellow),
hotcue (green). When the deck is playing in relative mode, pressing the button with deck shift (#2) switches to
constant mode.

4. toggle vinyl control. Turns green when vinyl control is enabled. With deck shift (#2) pressed, it toggles passthrough
mode and turns white. Pressing the button while passthrough mode is enabled turns passthrough mode off (without
toggling whether vinyl control is enabled).
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17.1.30 Evolution X-Session

This product has been discontinued.
Baru pada versi 1.6.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.31 FaderFox DJ2

• Manufacturer’s product page
Baru pada versi 1.6.

Setting up the controller

In order for this mapping to work, you will need to use these settings. First, enter System Mode by pressing the two black
buttons in the top right encoder section. There is a vertical System label next to these two buttons. The orange Sys/Mon
LED in the center bottom should be on and not blinking.
You can now modify various settings by pressing each of the 4 black buttons of the encoder section. There are two
possible settings for each function, On or Off, depending which of the corresponding LED is lit. There is also a brief
explanation of these settings on a gray sticker in the back of the controller.

• The top left button controls the Auto Switch function. If the Seek/Scratch green LED, is on, the function is off.
If the List/load red LED is on, the function is on. If the Auto Switch function is on, the encoder will switch to
Seek/Scratch after pressing the encoder to load a track. This function is up to the user’s preference and will not
affect the mapping.

• The bottom left button must be set to the Gain green LED for this mapping to work. If set to the red Pitch
LED, the transport buttons will have different CC numbers. This is useful if you own a second controller which
already has transport functions.

• The top right button must be set to the Seek/Scratch green LED. If set to the List/Load red LED, the Auto
Play function will be on, meaning that loading a track from the List/load encoder will trigger playback. You don’t
want this function on since it will conflict with the play button of the transport section which would have the same
CC number.

• The bottom right button must be set to the Gain green LED. If set to the red LED, the joystick will have
different CC numbers, and its mapping won’t work properly.

• If the green FX1 LED is on, the controller’s will use MIDI channel 1, and channel 16 if the FX2 LED is on. This is
useful if you want to control four decks using two FaderFox DJ2 controllers. If you use only one controller, leave
this setting to FX1. To change the setting, press the Shift button and the lower left black button of the encoder
section for channel 1, or the lower right black button of the encoder section for channel 16.

Important : changes to your settings won’t be saved if you just turn off the controller on SystemMode. To save the settings,
exit System Mode by pressing again the two black buttons of the left encoder section.
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Encoders Section

The two encoders on top of the controller control various parameters. They can of course be turned but also act as push
buttons. You can select which function is used for each of the encoders by pushing the black buttons of the encoders
section. LEDs indicate which function is currently selected.

• List/Load (top red LED is on) lets you browse your playlist. Push the left encoder to load the highlighted track into
Deck A or the right encoder for Deck B.

• Seek/Scratch (top green LED is on) acts as a jogwheel. Turn the left encoder for Deck A or the right encoder for
Deck B. Pushing the encoder on that setting will activate Sync on that deck.

• Gain (bottom green LED is on) controls the gain of the channel. Pushing the encoder on that setting will mute the
track.

• Pitch (bottom red LED is on) controls the tempo of the deck. Unfortunately there is no MIDI CC number emitted
when pushing the encoder on that position.

Joystick

The joystick can be set to control either the first or the second unit of the effect rack. To control the first effect unit, press
Shift + the lower black button of the left encoder section (FX1 green LED is on). To control the second effect unit, press
Shift + the lower black button of the right encoder section (FX2 green LED is on).
The horizontal axis of the joystick controls the Mix knob of the effect unit. The vertical axis control the Super Knob of
the unit.

Mixer Section

• Using the knobs and faders should be straightforward as the controls follow the labels printed on the controller.
• The Cue Mix knob controls the headphone mix. The Cue A and Cue B are used to pre-listen the selected deck.
• The green FX ctrl buttons are used to activate a desired effect unit on the selected deck.
• the left green button enables effect unit 1 on that deck
• the right green button enables effect unit 2 on that deck
• Shift + left green button enables effect unit 3 on that deck
• Shift + right green button enables fx unit 4 on that deck
• The Kill button controls Low Kill and Shift + Kill controls High Kill. To use Mid Kill, press Shift + Cue A (Deck
A) or Shift + Cue B (Deck B)

Transport Section

The left transport section controls Deck A transport functions, and the right transport section those of Deck B.
• The top left gray button (labeled with a pause symbol) of each section controls the Align beatgrid to current play-
position function. Shift + this button controls the Quantize function.

• The top right gray button (without any label) controls the Keylock. Shift + this button controls the Reverse function.
• The bottom left gray button (Play/pause label) controls Play. Shift + this button will make the playback jump one
beat backward on this deck.

• The bottom right gray button (play label) controls Cue (depending on the settings in Mixxx’s preferences). Shift +
this button will make the playback jump one beat forward on this deck.
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• The top blue button holds down the speed (temporary pitch bend) and the bottom blue button holds the speed up
according to the labels on the controller. Pressing Shift + these blue buttons will act similarly but with a smaller
pitch bending.

17.1.32 Gemini CDMP-7000

• Manufacturer’s product page
Baru pada versi 2.0.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.33 Gemini FirstMix

• Manufacturer’s product page (archived)
• Forum thread

Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.34 Hercules DJ Console 4-Mx

The Hercules DJ Console 4-Mx is a USB controller with a built in sound card. It is very similar to the [[Hercules DJ
Console RMX]], but with switches for 4 decks.

• Manufacturer's product page
Baru pada versi 1.11.

Audio

The DJ Console 4-Mx is not a USB class compliant MIDI device, although it is a USB Audio device. Drivers for Mac
OS X and Windows can be found on the Hercules support page.

Peringatan: The controller will not work on Linux out of the box. You will need to use the Linux usermode driver.
The device will only produce audio if the device hasn’t been configured for ASIO under windows previously. Also,
check the volumes in alsamixer.

The sound card has 4 inputs and 4 outputs (2 stereo in/out). The inputs are switchable between line-in and phono, and
also is possible to select different line levels (consumer -10dBV, Pro +4dBu and boost +8dBu ), so you can connect both
CD players and turntables on the inputs. * Inputs are RCA. * Outputs are RCA or 1/4" TRS balanced. * Microphone
input is 1/4" TS * Headphone jack is 1/4" (6.35 mm) TRS stereo
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Hercules Tray Icon configuration

The drivers for Windows and OS X install an application that can be used to configure the audio and controller settings.
Most of the settings work well on the default setting.

• Volume/Pan/Mute: Sets the volume output for channels 1-2 and channels 3-4. Note that the volume of the
channels 3-4 refers to the line output from behind. In other words. It does not affect the volume of the headphones.

• Line in mode: Sets the line level of the inputs. In case of line 1-2, it also allows to redirect the microphone to the
line 1-2. Else, it is mixed in hardware to the master out.

• Talkover attenuation: Sets how much to attenuate the master output when activating the hardware mixed micro-
phone.

• Enable/Disable jog wheels: Allows to disable the jog wheels, in case the user desires not to use them.
• Sensitivity: Alters the sensitivity of the jog wheels. If you change this, change also the sensitivity option in the
script, as described below.

• Audio Mode: Enables the WDM drivers (non-asio) or the specific ASIO-only driver.
• MIDI pitch resolution: Sets the resolution of the pitch sliders. Mixxx will work with any of the two settings, but
it is recommended to set it to 14bit (8bit used) which doubles the precision versus 7bit.

• ASIO: You can configure the samplerate, bit depth and latency for the ASIO driver.
• MIDI channel for controls: Keep these at 1-2 (Default) when you use it with Mixxx.
• Crossfader settings: Allows to configure how does the crossfader react. Mixxx also offers an alternate invert
option in the crossfader settings.

• Headphone channels: Allows to setup which input channels are sent to the headphone output.
• Channels 1-2 hardware mix: Allows mixing the line in or the microphone directly in hardware to the speaker
output.

• Deck mode: Leave this at 4 Decks (Default) if you want to use four decks with Mixxx. Else, you will only be able to
use two decks.

Options

There are several options that can be configured for this mapping. You can edit these by opening the JavaScript file in a
text editor like Notepad, TextEdit, or gEdit and editing the values at the top of the file.

• autoHeadMix: Indicates if the Headphone/Master mix should automatically be set to master when none of the
headphone cue buttons are activated.

• autoHeadcueOnLoad: Automatically enable the headphone cue select (PFL) of the deck when a song is loaded.
(Like in virtual-dj)

• beatFlashLed: set which LED, if any, blinks with the beat
• useVuMeters: Simulate vuMeters using the kill and source buttons’ LEDs. If enabled, shows master VUs, or deck
VU depending if prefader listen button is enabled or not.

• naviScrollSpeed: KeyRepeat speed for navigating up/down, in milliseconds. 100 is a good value. Lower values
make it scroll faster.

• crossfaderScratchCurve: The controller has two modes to report the crossfader position. The default/beatmix
curve, and the scratch curve. The default curve reports the real position of the control. The scratch curve just
crossfades on the edges. Setting this setting to true, the curve will change to scratch curve when the scratch mode
is on (scratch button). Setting it to false will not change it, so it will use the setting configured in the DJHercules
Tray-icon configuration.
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• vinylSpeed: Playback speed of the virtual vinyl that is being scratched. 45.00 and 33.33 are the common speeds.
(Lower number equals faster scratch)

• sensitivity: Jog wheel sensitivity. You should configure this setting to the same value than in the DJHercules tray
icon configuration. (Normal means 1/1). If crossfaderScratchCurve is true, or the setting is changed while Mixxx
is active, this value will be detected automatically.

• alpha: alpha value for the scratch filter (start with 1/8 (0.125) and tune from there)
• beta: beta value for the scratch filter (start with alpha/32 and tune from there)
• FXbuttonsSetup: This indicates which mapping for the FX buttons should Mixxx use. The possible values are:
mixxx21, mixxx20, and original (Hercules Manual and the default setup in Virtual DJ 7 LE)

Master / Global controls

Con-
trol

Mode Function

Cross-
Fader

Fades between left and right decks

Vol.
Main

Controls the Master volume knob of Mixxx.

Scratch Toggles scratch mode. When scratch mode is enabled, pressing a jog wheel controls scratching
Auto Enable AutoDJ. Stop decks 1 and 2 to disable it using the controller.
Auto Au-

toDJ
on

Fade to next song.

Fold-
ers /
Files

Switches between browsing the sidebar in the library, or the list. If Folders is pressed twice,
opens/closes the tree branch

Files Au-
toDJ
on

The next song in the Auto DJ cue is skipped

Up /
Down

Moves up and down in the library track list. If held down and any of the jog wheels is moved, then
the jog wheel takes over the cursor movement until the up/down button is released

Cue/Mix Control mix of master and PFL (cue) output in headphones
Mic
On/Off

Enables or disables the microphone. The microphone is always mixed in hardware. The trayicon
driver configuration allows to choose between direct mixing, or mix it only when enabled with the
button. It no longer tries to activate Mixxx microphone talkover.

Note: The Microphone volume and the Headphone volume controls are hardware controls (i.e. they don’t control Mixxx’s
interface)

Deck / Channel specific controls

Control Mode Function
Shift key When this button is pressed and released, it toggles between keypad functions 1-6 to keypad functions 7-12. When keypad functions 7-12 are active, the shift button is lit orange.
Shift key When this button is pressed and released, it toggles between keypad functions 1-6 to k Hold it
P lay/Pause Play track if it is not playing; pause it if track is playing
P lay/Pause Shift Play backwards. If slip mode is enabled (triangle image in Deere skin), it will resume beyond the previous position (i.e. the playback continues muted until the button is released)
Stop Moves the cursor to the beginning, or to the cue point if it is set, and stops playing it, if it was playing.

berlanjut ke halaman berikutnya
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Table 4 – lanjutan dari halaman sebelumnya
Control Mode Function
Stop Shift Brake (Slow it down progressively). Releasing it will continue playing, except if it has slowed a lot, in which case it stops.
Cue Depends on the cue mode set in Mixxx preferences
Jog wheel Seeks forwards and backwards in a stopped track Temporarily changes the playback speed for playing tracks
Jog wheel Scratch on and jog pressed If Scratch is on and the jog is pressed, moving it will do a scratch effect
Jog wheel Up/Down presssed Moves up / down in the tracklist if either Up or Down are held down
Jog wheel LED If the beatflash led has been set to jogwheel in the JavaScript file, the light of this button will be flashing following the beats of the song.
Forward / Backward Seeks at high speed.
Forward / Backward Seeks forward or backward in the track in steps of 4 beats (when the beatgrid has already been detected).
Forward / Backward Pressed for 500ms seeks at high speed.
Forward / Backward Shift Seeks forward or backward in the track in steps of 1 beats
Sync Automatically sets the pitch fader speed to match the BPM of the other deck.
Sync LED If the beatflash led has been set to Sync in the JavaScript file, the light of this button will be flashing following the beats of the song.
Sync Pressed for 500ms Activates master sync for this deck.
Sync Shift Activates the beatgrid edit mode
Sync Beatgrid edit mode When the track is stopped, aligns the beatgrid with the current playback position. If playing, synchronizes the beatgrid to align with that of the other playing track.
Pitch fader Adjusts playback speed (range and direction can be adjusted in Mixxx preferences)
Pitch bend +/- Adjusts playback speed temporarily (range can be adjusted in Mixxx preferences)
Pitch bend +/- Beatgrid edit mode Increases or decreases the BPM of the track (the detected one).
Pitch bend +/- Shift Adjust playback speed permanently (range can be adjusted in Mixxx preferences)
Pitch Scale +/- These controls have a different meaning in Mixxx: They have been mapped to change the musical key
Pitch Scale +/- Beatgrid edit mode Move the beatgrid to the left or to the right
Pitch Scale - Shift Activates or deactivates the (musical) keylock mode
Pitch Scale + Shift Activates or deactivates the quantize (to beat) mode
Pitch Reset This is triggered when both pitch scale buttons are pressed at the same time. This control has a different meaning in Mixxx: It resets the musical key to the track’s default.
Pitch Reset LED This led has a different meaning in Mixxx: If the beatflash led has been set to pitchreset in the JavaScript file, the light of this button will be flashing following the beats of the song. Else, the led is on if the key lock button is enabled for this deck.
Deck A/C, B/D Switches the deck to control between Deck A/C or between Deck B/D. Lights are changed accordingly
Vol. Deck Controls a deck’s output volume
Cue Select Deck Toggles on and off this deck’s output to the monitor/prefader listen (headphones) By default, it is configured in the JavaScript to activate it automatically when a new track is loaded in the deck.
Cue Select Deck Shift Set this deck to control the “Preview Deck”. Press it again to leave this mode What works: Load track, stop, cue, play, forward, rewind, jog wheel, Gain and some Fx buttons, like hotcues. The preview deck is not a fully featured deck, so no pitch, sync, EQ or audio Fx.
Cue Select Deck LED The led is active when the monitoring with headphones is active. The button led will flash if the “preview deck” mode is active.

Load On Left/Right Deck
Bass knob EQ low frequencies
Medium knob EQ mid frequencies
Treble knob EQ high frequencies
Gain Controls a deck’s gain before the volume fader
Kill (Bass/ Medium/ Treble) Toggles that frequency band completely off
Kill (Bass/ Medium/ Treble) LED If the useVuMeters option is activated in the JavaScript file, these LEDs will simulate a VU meter of the master or the deck (if prefader-listen is on). They will flicker if the sound clips. If EQ kill is enabled, the vumeter is temporarily disabled
Source 1/2 Toggles the deck to use the input channel 1/2 as its audio source instead of Mixxx’s deck. Concretely, it activates vinyl passthrough mode.
Source 1/2 LED If the vumeter is activated in the JavaScript file, they will show a vumeter of the master or the deck (if prefader-listen is on). If kill is enabled, the vumeter is temporarily disabled
Keypad 1 to 4 Set/Unset a beatloop of 0.5, 1, 2 or 4 beats. They act like the corresponding buttons in Mixxx. When a loop is set that isn’t one of these four main cases, buttons 3 and 4 will light to indicate a loop is present
Keypad 1 to 4 Shift Set/Unset a beatloop. buttons 1 and 2 use a beatloop size of 0.125 and 0.25, and buttons 3 and 4 act as loop end/reloop button.
Keypad 5 to 6 Reveses playback direction when held down. keypad 6 does it with audio roll (censor-like)
Keypad 7 to 10 Set/Unset the hotcues 1 to 4
Keypad 7 to 10 Shift The corresponding hotcue is cleared
Keypad 11 to 12 Enables the effect rack 1 and 2 for this specific deck
Keypad 1 Sets the loop begin and Activates the loop edit mode
Keypad 1 Shift Same as click, but it will be a rolling loop (slip mode)
Keypad 1 Loop edit mode Exits the loop edit mode
Keypad 1 Loop active Disable the loop

berlanjut ke halaman berikutnya
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Table 4 – lanjutan dari halaman sebelumnya
Control Mode Function
Keypad 1 LED The led is on if the loop is active
Keypad 2 Reloop (Enable or disable the previously existing loop)
Keypad 2 Loop edit mode Sets the loopend and exits the loop edit mode
Keypad 2 LED The led is on if a loop exists
Keypad 3 to 4 Sets a loop of 4 or 16 beats.
Keypad 3 to 4 Shift Same as click, but it will be a rolling loop (slip mode)
Keypad 3 to 4 LED If a beatloop of 1 or 4 beats is enabled.
Keypad 5 to 6 starts or stops a sampler 1 or 2 (buttons on the left deck), or the sampler 3 or 4 (buttons on the right deck)
Keypad 3 to 6 Loop edit mode Sets a beatloop of 2, 8, 16 or 32 beats
Keypad 7 to 10 Set/Unset the hotcues 1 to 4
Keypad 7 to 10 Shift The corresponding hotcue is cleared
Keypad 11 to 12 Enables the effect rack 1 or 2 for this specific deck
Fx knob Filter knob (the Quick Effect set in the equalizer preferences)
Fx knob Shift Move the filter knob slowly (the Quick Effect set in the equalizer preferences)
Fx knob Beatgrid edit mode Move the beatgrid position
Fx knob Loop edit mode Increase or decrease the loop size
Fx knob audio effect pressed If a keypad number is mapped to an audio effect, holding such button and moving the knob changes the “super” knob of that effect
Fx knob pitch Scale +/- pressed Increases or decreases the musical key (it doesn’t matter which of the pitch scale numbers is pressed)
Fx knob Loop edit mode Move the loop forward or backward in steps of one beat
Fx knob keypad 1 held down Increase or decrease the loop size

Note: The actions of the Keypad buttons can be changed from the JavaScript. There are three preconfigured presets
corresponding to Manual/Virtual DJ LE, Mixxx 2.0 and Mixxx 2.1.

17.1.35 Hercules DJ Console (Mac Edition)

Baru pada versi 1.7.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.36 Hercules DJ Console MK1

Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.37 Hercules DJ Console MK2

Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.38 Hercules DJ Console MK4

Baru pada versi 1.8.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.39 Hercules DJ Console RMX

• Manufacturer’s product page
The Hercules DJ Console RMX is a USB controller with a built in sound card. It is a class compliant USB Audio and
HID device. Older versions of Mixxx that did not support HID required using Hercules’ MIDI driver, but it is now
recommend to not use the Hercules driver on GNU/Linux. If you have it installed, it is recommended to uninstall the
driver and upgrade to the latest version of Mixxx if you have not already. On Windows (and Mac OS X?) the driver is
still recommended.
Baru pada versi 1.11.

Audio

The sound card has 4 inputs and 4 outputs (2 stereo in/out). The inputs are switchable between line-in and phono, so you
can connect both CD players and turntables on the inputs. The inputs require a high input signal (~10mV+) for turntables
if you want to record audio or mix it to the output. Time-coded vinyls, for Vinyl Control, should work okay with lower
input signal.

MIDI Mappings

Regular mapping
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Global controls

Con-
trol

Function

Cross-
Fader

Fades between left and right deck

Vol.
Main

Controls output volume of your mix

Bal-
ance

Controls balance between left and right audio channel of your mix

Scratch Toggles scratch on and off which changes the function of the deck jog wheels Effect Shift when held down
shifts function of each decks Bass, Medium, Treble to control effect parameters

Up /
Down

Moves up and down in the library track list When held down changes the jog wheels behaviour to scroll the
library list

Left /
Right

Moves up and down between the library sections

Moni-
tor

Fades monitor output (headphones) between cue selected tracks output and the main mix
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Deck / Channel specific controls

Control Function
Play/Pause Starts playing a loaded track if stopped. If track is currently playing it stops the track
Stop Stops a currently playing track and moves to the beginning.
Cue Sets the cue point if a track is stopped and not at the curren cue point Stops track and returns to the

current cue point if a track is playing. Plays preview if a track is stopped at the cue point for as long
as it's held down

Jog wheel Seeks forwards and backwards in a stopped track Temporarily changes the playback speed for playing
tracks Scratches both stopped and playing tracks when scratch mode is on Moves up / down in the
tracklist if either Up or Down is held down

Forward /
Backward

Seeks at high speed in a track

Load Deck
A/B

Loads the currently selected track in the track list to the related deck

Cue Select Toggles this decks output to the monitor (headphones) on and off
Pitch Adjusts playback speed +/-10% (can be adjusted in the preferences)
Sync Automatically sets pitch so the BPM of the other deck is matched
Pitch Reset Resets the pitch to the tracks normal playback speed
Bass Adjusts the volume of a channels low frequency content (ex. bass drum) Adjusts flanger period when

Effect Shift is held down
Medium Adjusts the volume of a channels mid frequency content (ex. vocals) Adjusts flanger delay when Effect

Shift is held down
Treble Adjusts the volume of a channels high frequency content (ex. hi-hats) Adjusts flanger depth when

Effect Shift is held down
Kill (Bass /
Medium /
Treble)

Toggles output of a frequency band on and off

Gain Controls a decks input volume
Vol. Deck
A/B

Controls a decks output volume

Keypad 1 Toggles a channels flanger effect on and off
Keypad 4 Reveses playback direction when held down

Advanced mapping

The advanced mapping works similar to the normal RMX mapping, but also supports loops and hot cues. This mapping
was added to not brake the previous (Mixxx -1.7.2) behaviour. Controls that differ between the normal and advanced
mappings are described here.

Global controls

Con-
trol

Function

ScratchToggles scratch on and off which changes the function of the deck jog wheels Effect Shift when held down:
- Shifts function of each decks Bass, Medium, Treble to control effect parameters - Shifts the Keypad (1-6)
functions to effects. Currently flanger and reverse
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Deck / Channel specific controls

Control Function
Stop Deck shift changes behaviour of other controls related to this deck when held down
Forward
/ Back-
ward

Adjusts position of loop in/out and hot cues when a loop / hot cue button is held down

Bass Adjusts the volume of a channels low frequency content (ex. bass drum) Soft takeover when Deck Shift
is held down, lets you move knob in position before adjusting Adjusts flanger period when Scratch is held
down

Medium Adjusts the volume of a channels mid frequency content (ex. vocals) Soft takeover when Deck Shift is
held down, lets you move knob in position before adjusting Adjusts flanger delay when Scratch is held
down

Treble Adjusts the volume of a channels high frequency content (ex. hi-hats) Soft takeover when Deck Shift is
held down, lets you move knob in position before adjusting Adjusts flanger depth when Scratch is held
down

Keypad 1 Go to hotcue 1 Set hotcue 1 when Deck Shift is held down Toggles a channels flanger effect on and off
when Effect Shift is held down

Keypad 2 Go to hotcue 2 Set hotcue 2 when Deck Shift is held down
Keypad 3 Go to hotcue 3 Set hotcue 3 when Deck Shift is held down
Keypad 4 Hold down to adjust loop in position with Forward / Backward Set loop in when Deck Shift is held down

Reveses playback direction when held down if Effect Shift is held down
Keypad 5 Hold down to adjust loop out position with Forward / Backward Set loop out when Deck Shift is held

down
Keypad 6 Re-loop / exit turns looping on and off Half loop when Deck Shift is held down

17.1.40 Hercules DJ Console RMX2

• Manufacturer’s product page
• Forum thread
• Previous forum thread

This all-in-one DJ controller features a built in 4 channel sound card with balanced XLR master outputs and a balanced
microphone input. It is a USB class compliant MIDI and audio device (unlike older Hercules controllers).
Baru pada versi 1.11.

User Options

To change the mapping’s user options, you have to open the script file (.js). At the top of the file under **USER OPTIONS*
the following settings can be made:

• DJCRMX2.jogwheelSensivity: Sets the jogwheel sensitivity. 1 = default, 2 is twice as sensitive, 0.5 is half as
sensitive.

• DJCRMX2.jogwheelShiftMultiplier: Sets how much more sensitive the jogwheels get when holding [SHIFT].
Set it to 1 to disable jogwheel sensitivity increase when holding [SHIFT].

• DJCRMX2.twinkleVumeterAutodjOn: If true, level-meter twinkles if AutoDJ is enabled.
• DJCRMX2.autoPFL: If true, PFL / Cue (headphone) is being activated by loading a track into certain deck.
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• DJCRMX2.vuMeterOutputMaster: If true, deck vu meters show master output (L = Deck A, R = Deck B). If
false, deck vu meter shows deck output (mono).

• DJCRMX2.showHideSamplersEffectsOnPadMode: If true, Samplers and EffectRack get shown or hidden de-
pending on the Pad-Mode.

General Functions

Managed by Mixxx

Figure [SHIFT]? Long-
press?

Control Name Description

11 ✘ ✘ [MAIN VOL-
UME]

Controls Master volume

13 ✘ ✘ [VINYL] Split headcue
13 ✓✓✓ ✘ [VINYL] Maximize library
20 ✘ ✘ [CROSS

FADER]
Controls crossfader

21 ✘ ✘ [CUE TOMIX] Controls mix in headphones between PFL and master
signal

7 ✘ ✘ [MIC ON/OFF] Toggle microphone on/off and talkover on/off
15
(Right)

✘ ✘ [FILES] Go To Item in Library

15
(Right)

✓✓✓ ✘ [FILES] Add to bottom of Auto DJ playlist

15 (Left) ✘ ✘ [FOLDERS] Move focus backward in Library
15 (Left) ✓✓✓ ✘ [FOLDERS] Toggle Auto DJ
15 (Up) ✘ ✘ [UP] Move vertically up in Library
15 (Up) ✘ ✓✓✓ [UP] Scroll vertically up in Library
15
(Down)

✘ ✘ [DOWN] Move vertically down in Library

15
(Down)

✘ ✓✓✓ [DOWN] Scroll vertically down in Library

Managed by the controller

The following functions directly affect the controller’s sound card, so adjusting these will not change anything on screen
in Mixxx:

Figure [SHIFT]? Long-press? Control Name Description
22 ✘ ✘ [HEADPHONES VOLUME] Controls the headphones output volume
6 ✘ ✘ [MIC VOLUME] Controls the microphone volume (gain)
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Deck Functions

Figure [SHIFT]? Long-press? Control Name Description
3 (-) ✘ ✘ [PITCH BEND MINUS] Pitch bend down
3 (-) ✓✓✓ ✘ [PITCH BEND MINUS] Decrement (halve) pitch range
3 (+) ✘ ✘ [PITCH BEND PLUS] Pitch bend up
3 (+) ✓✓✓ ✘ [PITCH BEND PLUS] Increment (double) pitch range
2 (Left) ✘ ✘ [REWIND] Fast backward in loaded track
2 (Left) ✓✓✓ ✘ [REWIND] Spinback effect
2 (Right) ✘ ✘ [REWIND] Fast forward in loaded track
2 (Right) ✓✓✓ ✘ [REWIND] Brake effect
9 ✘ ✘ [SOURCE] Toggle pass thru
17 ✘ ✘ [PREVIEW] Toggle pfl
17 ✓✓✓ ✘ [PREVIEW] Toggle keylock
30 ✘ ✘ [PLAY] Play Button
30 ✓✓✓ ✘ [PLAY] Play Button
29 ✘ ✘ [CUE] Cue Button
29 ✓✓✓ ✘ [CUE] Cue Button
28 ✘ ✘ [SYNC] Sync Button
28 ✓✓✓ ✘ [SYNC] Sync Button
16 ✘ ✘ [LOAD] Load selected track
16 ✓✓✓ ✘ [LOAD] Eject track
8 ✘ ✘ [LOOP MODE] encoder Adjust beatloop size
8 ✓✓✓ ✘ [LOOP MODE] encoder Move loop forward/backward
8 ✘ ✘ [FX MODE] encoder EffectUnit’s mix knob, in EffectFocusMode in combination with ParameterEditMode - Controls effect’s parameters
8 ✓✓✓ ✘ [FX MODE] encoder EffectUnit’s super knob
8 ✘ ✘ [SAMPLE MODE] encoder Switch between 4 sampler banks (each of 4 samplers)
8 ✘ ✘ [CUE MODE] encoder Adjust key of loaded track
24-1 ✘ ✘ [LOOP PAD 1] Toggles beatloop over beatloop size
24-2 ✘ ✘ [LOOP PAD 2] Toggles beatloop over 2 beats
24-3 ✘ ✘ [LOOP PAD 3] Toggles beatloop over 4 beats
24-4 ✘ ✘ [LOOP PAD 4] Toggles beatloop over 8 beats
24-1 ✓✓✓ ✘ [LOOP PAD 1] Toggles beatlooproll over 1/16 beats
24-2 ✓✓✓ ✘ [LOOP PAD 2] Toggles beatlooproll over 1/8 beats
24-3 ✓✓✓ ✘ [LOOP PAD 3] Toggles beatlooproll over 1/4 beats
24-4 ✓✓✓ ✘ [LOOP PAD 4] Toggles beatlooproll over 1/2 beats
24-1 ✘ ✘ [FX PAD 1] Enables effect 1, in EffectFocusMode toggles effect button parameter 1, in ParameterEditMode gives encoder control of effect parameter 1
24-2 ✘ ✘ [FX PAD 2] Enables effect 2, in EffectFocusMode toggles effect button parameter 2, in ParameterEditMode gives encoder control of effect parameter 2
24-3 ✘ ✘ [FX PAD 3] Enables effect 3, in EffectFocusMode toggles effect button parameter 3, in ParameterEditMode gives encoder control of effect parameter 3
24-4 ✘ ✘ [FX PAD 4] Shows/hides focus of EffectUnit
24-1 ✘ ✓✓✓ [FX PAD 1] In EffectFocusMode enables ParameterEditMode and gives encoder control of effect parameter 1
24-2 ✘ ✓✓✓ [FX PAD 2] In EffectFocusMode enables ParameterEditMode and gives encoder control of effect parameter 2
24-3 ✘ ✓✓✓ [FX PAD 3] In EffectFocusMode enables ParameterEditMode and gives encoder control of effect parameter 3
24-4 ✘ ✓✓✓ [FX PAD 4] Enables EffectFocusMode (+ press [FX PAD 1..3] to focus an effect)
24-1 ✓✓✓ ✘ [FX PAD 1] Enables effect 1 of EffectUnit and controls meta its meta knob by velocity
24-2 ✓✓✓ ✘ [FX PAD 2] Enables effect 2 of EffectUnit and controls meta its meta knob by velocity
24-3 ✓✓✓ ✘ [FX PAD 3] Enables effect 3 of EffectUnit and controls meta its meta knob by velocity
24-4 ✓✓✓ ✘ [FX PAD 4] Cycle through effectUnit numbers array
24-1 ✘ ✘ [SAMPLE PAD 1] Load selected track into Sampler (Index 1) if empty, else go to cue point and play - velocity (volume) controlled
24-2 ✘ ✘ [SAMPLE PAD 2] Load selected track into Sampler (Index 2) if empty, else go to cue point and play - velocity (volume) controlled

berlanjut ke halaman berikutnya

17.1. Controllers 268



Mixxx User Manual, Rilis 2.3.0

Table 5 – lanjutan dari halaman sebelumnya
Figure [SHIFT]? Long-press? Control Name Description
24-3 ✘ ✘ [SAMPLE PAD 3] Load selected track into Sampler (Index 3) if empty, else go to cue point and play - velocity (volume) controlled
24-4 ✘ ✘ [SAMPLE PAD 4] Load selected track into Sampler (Index 4) if empty, else go to cue point and play - velocity (volume) controlled
24-1 ✓✓✓ ✘ [SAMPLE PAD 1] Stop Sampler (Index 1) if playing, else eject loaded track
24-2 ✓✓✓ ✘ [SAMPLE PAD 2] Stop Sampler (Index 2) if playing, else eject loaded track
24-3 ✓✓✓ ✘ [SAMPLE PAD 3] Stop Sampler (Index 3) if playing, else eject loaded track
24-4 ✓✓✓ ✘ [SAMPLE PAD 4] Stop Sampler (Index 4) if playing, else eject loaded track
24-1 ✘ ✘ [CUE PAD 1] Hotcue 1 Button
24-2 ✘ ✘ [CUE PAD 2] Hotcue 2 Button
24-3 ✘ ✘ [CUE PAD 3] Hotcue 3 Button
24-4 ✘ ✘ [CUE PAD 4] Hotcue 4 Button
24-1 ✓✓✓ ✘ [CUE PAD 1] Hotcue 1 Button
24-2 ✓✓✓ ✘ [CUE PAD 2] Hotcue 2 Button
24-3 ✓✓✓ ✘ [CUE PAD 3] Hotcue 3 Button
24-4 ✓✓✓ ✘ [CUE PAD 4] Hotcue 4 Button
1 ✘ ✘ [JOGWHEEL] Jog/Scratch loaded track
1 ✓✓✓ ✘ [JOGWHEEL] Jog/Scratch loaded track using DJCRMX2.jogwheelShiftMultiplier option
10 ✘ ✘ [GAIN] Controls pregain
18/19 ✘ ✘ [VOLUME FADER] Controls volume
4 ✘ ✘ [PITCH FADER] Controls rate (speed control)
12 ✘ ✘ [KILL TREBLE] High frequencies kill
12 ✘ ✘ [KILL MEDIUM] Middle frequencies kill
12 ✘ ✘ [KILL BASS] Low frequencies kill
14 ✘ ✘ [TREBLE] High frequencies control
14 ✘ ✘ [MEDIUM] Middle frequencies control
14 ✘ ✘ [BASS] Low frequencies control
14 ✓✓✓ ✘ [BASS] Filter (QuickEffectRack) control

17.1.41 Hercules DJControl AIR

This is one of the cheapest Hercules DJ controller from Hercules leisure DJ controllers brand. There are actually many
versions of it:

• DJControl AIR (The one shown in picture above)
• DJControl AIR Street Edition (Limited Edition)
• DJControl AIR S Series
• DJControl AIR for iPad

This controller have built-in soundcard with mixer output (3.5mm jack) and headphones output (6.35mm jack).
The main fun and uncommon feature of this controller is its proximity sensor (IR) located above EQ potentiometers and
between top horizontal vu-meter.

• Manufacturer’s product page
• Forum Thread

Baru pada versi 1.11.
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Sound Hardware settings

• Sample rate: 44100 Hz
• Master Output: Channels 1 - 2
• Headphones Output: Channels 3 - 4

Mapping Description

Figure19: Hercules DJControl AIR (schematic view). This picture is taken from the Getting Started Tutorial (courtesy
of Guillemot Corporation S.A.).

We assume from the annotated picture above that each decks have same controls.

Jogs / Jogs Wheels (1)

Pressing Jogs enable the scratch mode.
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PADs (2)

Loops Effects Samples

1 Loop In Flanger (Mixxx 1.10) Sample 1
2 Loop Out Align Beat Grid to current position Sample 2
3 Loop Double Toggle Quantitize Sample 3
4 Reloop/Exit Toggle KeyLock Sample 4

Proximity Sensor (4)

Currently not mapped

Library Navigation (8)

• Folder : Switch to previous view (library, playlist…)
• Files : Switch to next view (library, playlist…)
• Up : Scroll to previous track in library/playlist
• Down : Scroll to next track in library/playlist

Load track to Deck (9)

This button load track to the selected deck (A => Deck 1, B => Deck 2)

Headphone listen (PFL) (10)

This toggle the Pre Fader Listen for the selected Deck(s)

Rec (11)

Currently not mapped

Load selected track to sample (12)

This is done by pressing and holding theMagic button while pressing on the desired sample PAD.
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SpinBack(13)

Currently not mapped

Sync (16)

Synchronize the tempo to the other deck one (One-time beat sync, tempo/phase).

Speed Adjustment (17)

Adjust speed slower [ - ] or faster [ + ] in Coarse mode.

17.1.42 Hercules DJControl Compact

• Manufacturer’s product page
• MIDI mapping manual

The Hercules DJControl Compact is a simple controller for basic two-channel mixing. This device does not have a built
in sound card, so it would require a splitter cable or separate audio interface to be able to preview tracks in headphones.
It also does not have buttons for routing decks to headphones.
Thanks to Hercules for supporting the development of this mapping by providing a controller.
Baru pada versi 2.1.

Mapping description

Much of the Compact’s behavior is hard-coded into its firmware, including shift button messages and button mode selec-
tions.
Shift + Play jumps to the beginning of the track and stops playback.
The cue button behaves differently depending on the cue mode set in Mixxx’s Preferences.
The sync button synchronizes the tempo to the other deck. Press and hold sync to engage Sync Lock.
There is only one each of the Mode, Shift, and Scratch buttons, so they affect both decks.
Shift + Scratch (Automix) toggles AutoDJ on/off.

Jog Wheels

When Scratch is off, turning a jog wheel bends the pitch of the track. When Scratch is on, turning a jog wheel scratches
that deck. Holding Shift and turning a jog wheel adjusts the playback rate (tempo). Enable keylock on a deck by clicking
the music note button on screen if you do not want the pitch to change when adjusting the tempo.
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Pad Grid

Press the MODE button to cycle through each pad mode.

Loop mode

In loop mode, the buttons are mapped in a way that’s more artistically expressive:
• Button 1 enables and disables the loop
• Button 2 enables an 8 beat loop
• Button 3 divides the current loop in half
• Button 4 doubles the length of the current loop
• Shift + Button 1 performs an 1/8th beat roll
• Shift + Button 2 performs an 1/4th beat roll
• Shift + Button 3 performs an 1/2th beat roll
• Shift + Button 4 performs an 1 beat roll

FX mode

• Button 1 enables and disables the first FX chain for Channel 1
• Button 2 enables and disables the second FX chain for Channel 1
• Button 1 enables and disables the first FX chain for Channel 2
• Button 2 enables and disables the second FX chain for Channel 2

Shift-FX buttons are not mapped.

Sampler mode

• Left side buttons play Sample Decks 1 through 4
• Right side buttons play Sample Decks 5 through 8
• Shift + Buttons stops Sample Deck and puts the playhead at the cue point

Cue mode

• Each button activates the hotcue with that number
• Shift + button clears the hotcue with that number

17.1. Controllers 273



Mixxx User Manual, Rilis 2.3.0

17.1.43 Hercules DJControl Inpulse 200

• Manufacturer’s product page
• Manufacturer’s support and downloads page
• Forum thread

Baru pada versi 2.3.0.

Compatibility

This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on
GNU/Linux, Mac OS X, and Windows. However, if you wish to use the ASIO sound API under Windows, please
install the latest driver package available from the Support page.

Sound Card Setup

This controller has built-in 4 channel output sound card, withMASTER output (RCA) andHEADPHONE output (3.5mm
jack).

1. Open Preferences > Sound Hardware
2. Select the Output tab
3. From the Main drop-down menu, select the audio interface, then Channels 1 - 2
4. From the Headphones drop-down menu, select the audio interface, then Channels 3 - 4
5. Click Apply to save the changes.

Lihat juga:
The example setups section provides more details about the audio configuration in Mixxx.

Catatan: The MASTER and HEADPHONE knobs, as well as the MASTER button are hardware controls and interact
directly with the integrated sound card’s output. Although they also send MIDI messages, they have NOT been mapped
in Mixxx, so do not expect an on-screen reaction when using them. This was done to prevent the knobs to adjust both the
gain on the controller’s sound card and in Mixxx.

Mapping description

All controls not mentioned behave as labeled.
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Decks

Control Function
SYNC button Toggle Sync Lock.
SHIFT + SYNC button Set deck as Sync leader.
CUE button Specifies, plays or recalls temporary cue point.
SHIFT + CUE button Return to the beginning of the track.
Play button Play/Pause the current track.
SHIFT + Play button Cue Stutter.
VINYL button Toggle scratch mode (default: on)
Loop IN button Enable Beatloop.
SHIFT + Loop IN button Halve the current loop size.
Loop OUT button Disable Beatloop.
SHIFT + Loop OUT button Double the current loop size.
Beat Align LED Track end warning (make sure BEATMATCH GUIDE is on for this to work)

Browser

Control Function
BROWSER encoder (turn) Move up/down list.
BROWSER encoder
(press)

Switch focus between list and file view.

SHIFT + Encoder (press) Maximize/Minimize library view.
ASSISTANT button Toggle AutoDJ (be sure a playlist was created for AutoDJ before activating this func-

tion).

Performance Pads

Hot Cue Mode

Control Function
Pad 1 - 4 Set and trigger hotcue 1 - 4
SHIFT + Pad 1 - 4 Delete hotcue 1 - 4.

Roll Mode

Control Function
Pad 1 Set Beatloop of 1 beat size.
Pad 2 Set Beatloop of 2 beat size.
Pad 3 Set Beatloop of 4 beat size.
Pad 4 Set Beatloop of 8 beat size.
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FX Mode

When using Firmware v1.68 and earlier, each FX pad will send multiple and different Note and CC messages. As these
could not all be used properly with Mixxx current effect framework, a simplified configuration was assigned using the pad
in SHIFT mode for convenience.

Control Function
SHIFT + Pad 1 - 3 Toggle Effect 1 - 3.
SHIFT + Pad 4 (deck A) Toggle Effect Rack 1.
SHIFT + Pad 4 (deck B) Toggle Effect Rack 2.

However, after applying Firmware v1.72, each FX pad now sends a simple Note On/Note Off (as is the case in every
other Pad mode). This makes it easier to use the pads to control effect and the latest mapping take advantage of this
possibility by removing the use of the SHIFT button.

Control Function
Pad 1 - 3 Toggle Effect 1 - 3.
Pad 4 (deck A) Toggle Effect Rack 1.
Pad 4 (deck B) Toggle Effect Rack 2.

Lihat juga:
Read the update guide for more details about updating the firmware.

Sampler Mode

Control Function
Pad 1 - 4 (deck A) Trigger Sampler 1 - 4.
Pad 1 - 4 (deck B) Trigger Sampler 5 - 8.

Unmapped Controls

The following controls are not mapped because they are controlled by the hardware.
• MASTER knob
• HEADPHONE knob
• MASTER buttons
• BEATMATCH guide
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17.1.44 Hercules DJControl Inpulse 300

• Manufacturer’s product page
• Manufacturer’s support and downloads page
• Forum thread

Baru pada versi 2.2.4.

Compatibility

This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on
GNU/Linux, Mac OS X, and Windows. However, if you wish to use the ASIO sound API under Windows, please install
the latest driver package available from the Support page.

Catatan: Firmware upgrade (v1.72) is required for pads to work correctly in FX Mode.
When using Firmware v1.68 and earlier, pads in FX Mode will not work as expected.
For more details about upgrading the Firmware.

Sound card setup

This controller has built-in 4 channel output sound card, withMASTER output (RCA) andHEADPHONE output (3.5mm
jack).

• Open Preferences > Sound Hardware
• Select the Output tab
• From theMaster drop-down menu, select the audio interface, then Channels 1-2
• From the Headphones drop-down menu, select the audio interface, then Channels 3-4
• Click Apply to save the changes.

Lihat juga:
The example setups section provides more details about the audio configuration in Mixxx.

Catatan: TheMaster and Headphone knobs, as well as theMaster button are hardware controls and interact directly
with the integrated sound card’s output. Although they also send MIDI messages, they have NOT been mapped in Mixxx,
so do not expect an on-screen reaction when using them. This was done to prevent the knobs to adjust both the gain on
the controller’s sound card and in Mixxx.

17.1. Controllers 277

https://www.hercules.com/en-us/product/djcontrolinpulse300//
https://support.hercules.com/en/product/djcontrolinpulse300-en//
https://mixxx.discourse.group/t/hercules-djcontrol-inpulse-300/17854/
https://support.hercules.com/en/product/djcontrolinpulse300-en//
https://www.djuced.com/change-your-pad-fx-on-hercules-djcontrol-inpulse-firmware-update-guide


Mixxx User Manual, Rilis 2.3.0

Mapping description

Decks

Control Function
SYNC button Toggle Sync Lock.
SHIFT + SYNC button Set deck as Sync leader.
CUE button Specifies, plays or recalls temporary cue point.
SHIFT + CUE button Return to the beginning of the track.
Play button Play/Pause the current track.
SHIFT + Play button Cue Stutter.
VINYL button Toggle scratch mode (default: on)
Loop IN button Enable Beatloop 4 beats.
SHIFT + Loop IN button Halve the current loop size.
Loop OUT button Disable Beatloop.
SHIFT + Loop OUT button Double the current loop size.
Beat Align LED Track end warning (make sure BEATMATCH GUIDE is on for this to work).
SLIP Toggles splip mode.
Q Toggles quantize.
SHIFT + Q Adjusts beatgrid so closest beat is aligned with the current playposition.

Browser

Control Function
BROWSER encoder (turn) Move up/down list.
SHIFT + BROWSER encoder
(turn)

Move left/right (fold/unfold) list.

BROWSER encoder (press) Switch focus between list and file view.
SHIFT + Encoder (press) Maximize/Minimize library view.
ASSISTANT button Toggle AutoDJ (be sure a playlist was created for AutoDJ before activating this

function).

FX

Control Function
ON pad Toggle FX 3 on/off.
SHIFT + ON pad (select) Cycle to the next effect after the currently loaded effect.
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Performance Pads

Hot Cue Mode

Control Function
Pad 1 - 8 Set and trigger hotcue 1 - 8
SHIFT + Pad 1 - 8 Delete hotcue 1 - 8.

Roll Mode

Control Function
Pad 1 Activate Beatloop of 1/8 beat size.
Pad 2 Activate Beatloop of 1/4 beat size.
Pad 3 Activate Beatloop of 1/2 beat size.
Pad 4 Activate Beatloop of 1 beat size.
Pad 5 Activate Beatloop of 2 beat size.
Pad 6 Activate Beatloop of 4 beat size.
Pad 7 Activate Beatloop of 8 beat size.
Pad 8 Activate Beatloop of 16 beat size.

FX Mode

Control Function
Pad 1 - 3 Toggle Effect 1 - 3.
Pad 5 - 7 Cycle to the next effect for Effect 1 - 3.
Pad 4 Toggle Effect Unit 1.
Pad 8 Toggle Effect Unit 2.
Shift + Pad 1 - 3 Toggle Effect 1 - 3. (Effect Unit 3 / 4 for deck A / B)
Shift + Pad 5 - 7 Cycle to the next effect for Effect 1 - 3 (Effect Unit 3 / 4 for deck A / B).
Shift + Pad 4 Toggle Effect Unit 3.
Shift + Pad 8 Toggle Effect Unit 4.

Sampler Mode

Control Function
Pad 1 - 8 (deck A) Trigger Sampler 1 - 8.
Pad 1 - 8 (deck B) Trigger Sampler 9 - 16.
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Beatjump Mode

Control Function
Pad 1 - 2 Jump backward/forward by 1 beat.
Pad 3 - 4 Jump backward/forward by 2 beats.
Pad 5 - 6 Jump backward/forward by 4 beats.
Pad 7 - 8 Jump backward/forward by 8 beats.

Known issues

Controls not included in this mapping

• Master knob (Hardware control)
• Headphone knob (Hardware control)
• Master buttons (Hardware control)
• Beatmatch guide (Hardware control)
• PADS: Slicer/Slicer Loop
• PADS: Toneplay

17.1.45 Hercules DJControl Instinct (S)

This is the cheapest all-in-one controller with an integrated sound card. The DJControl Instinct S is functionally identical
to the DJ Control Instinct, but has a brushed stainless finish.

• Manufacturer's product page
• Forum thread

Baru pada versi 1.10.1.

Setup

The controller is a class compliant MIDI controller, so you should be able to just plug it in and it should be recognized in
Mixxx. No need for drivers.
Make sure to select the correct mapping for the controller and enable it.

Audio Channels

There are two outputs on the controller itself: the headphones output with builtin volume control on the side facing you
and the speakers output.
In Mixxx the headphones output is on channels 3 and 4, so select the “Channels 3-4” item to get stereo output. The
speakers output is on channels 1 and 2, so to get stereo output you want to select the “Channels 1-2” item.
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Figure20: Hercules DJControl Instinct (schematic view). This picture is taken from product poster (courtesy of Guillemot
Corporation S.A.).

1. Jog Wheel for the deck on the side of the wheel
2. Action buttons for the deck on the side of the controls, depending on the mode they do the following:

• Hot Cue:
– 1: Set and play (by holding it) from Hot Cue 1
– 2: Set and play (by holding it) from Hot Cue 2
– 3: Reset Hot Cue 1
– 4: Reset Hot Cue 2

• Loop
– 1: Set Loop start
– 2: Set loop end
– 3: Shrink loop (halves it)
– 4: Exit loop
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• Effect
– 1: Toggle Effect 1
– 2: Toggle Effect 2
– 3: Toggle Effect 3
– 4: Toggle Effect 4

• Sample
– 1: Play Sample 1
– 2: Play Sample 2
– 3: Play Sample 3
– 4: Play Sample 4

3. Mode status display. The current mode is glowing or if none is on, Hot Cues are enabled.
4. Headphone volume controls
5. No direct use, used as a button to add a second layer of controls
6. Switch the current mode for both decks
7. Knobs to adjust the EQ of the deck they are on. Top knob adjusts highs, middle knob the mids and bottom know

the lows.
8. Buttons to browse your library. The up and down button go up and down in the current playlist, The folder/left

button goes up in the playlist list and the Files/right button goes down in the playlist list.
9. Load the currently selected track to the respective deck (A is the left deck, B is the right deck)
10. Listen to this deck unmixed on the headphones
11. Deck volume adjusts the output volume of the respective deck
12. Crossfader
13. Temporary pitch shift. Pressing the Vinyl button increases the shift.
14. Adjust tempo. Pressing both buttons together resets to the original tempo. Pressing the Vinyl button takes the steps

bigger.
15. Fast forward and backward buttons for the respective decks
16. Sync tempo of this deck to the tempo of the other deck
17. If pressed while paused sets the cue and when held plays from the cue, when pressed during playback jumps to the

cue.
18. Play and pause playback of the respective decks
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17.1.46 Hercules DJControl Jogvision

• Manufacturer's product page
• Manufacturer's support and downloads page
• Forum thread

Whether you’re just getting started DJing or you’ve already refined your skills, you can let your creativity run wild. Enjoy
excellent precision and comfort to create your mixes using the circular displays on the jog wheels to guide your movements
and perfect your scratches, and have fun with the amazing contactless AIR Control sensor. Your adventure starts right
here and now. It’s your turn!

Compatibility

This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on
GNU/Linux, Mac OS X, and Windows. For Windows, please install the latest driver package available from the manu-
facturer's product page.

Sound card setup

This controller has built-in 4 channel output sound card, with:

Channel Port
Master Output RCA and 3.5mm jack
Booth Output RCA and 3.5mm jack
Headphone Output 6.35mm and 3.5mm jack
Microphone Input 6.35mm jack
Auxiliary Input 3.5mm jack

• Open Preferences ‣ Sound Hardware
• Select the Output tab
• From the Master drop-down menu, select the audio interface, then Channels 1-2
• From the Headphones drop-down menu, select the audio interface, then Channels 3-4
• Click Apply to save the changes.

Please refer to the user manual for more details about the audio configuration in Mixxx.

Catatan: The MASTER and HEADPHONE knobs, as well as the MASTER button are hardware controls and interact
directly with the integrated sound card’s output.
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Mapping configuration

Edit the Hercules_DJControl_Jogvision-scripts.js, and change the CFG.(user|fine) variables to
fit your needs:

Petunjuk: This controller mapping can be customized by editing the corresponding Javascript file and editing the
configuration options at the top of the file.

All controls act as labeled, but there are some additional functionalities that have been added:

Control Description
MODE + LOOP ON Set a loop_in mark (with currently defined loop_size), activate it, and enable slip

mode
MODE + LOOP X½ / LOOP X2 Do a beatjump backward/forward
MODE + LOOP SIZE knob Decrease/Increase pitch (only key, not tempo!)
MODE + Jog Wheel plate (play-
ing)

Scratch with 'Slip' on (deactivate 'Slip' when plate is released)

MODE + Jog Wheel plate
(stopped)

Move song position backward/forward faster

MODE + BROWSER knob turn Move library's selected position multiple elements forward/backward
MODE + LOAD buttons Toggle 'quantize' for deck where MODE button is pressed
SHIFT + LOAD buttons Eject track from deck where SHIFT key is pressed
SHIFT + BROWSER knob press Activate (double-click) currently selected item in browser
SHIFT + LOOP SIZE knob Move existing loop forward/backward
SHIFT + Jog Wheel touch Do a backspin
SHIFT + MULTI FX Set beatgrid to current position
SHIFT + AIR CONTROL Filter Do the reverse than standard, that is, high-pass filter

17.1.47 Hercules DJControl MP3

Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.48 Hercules DJControl MP3 e2 / MP3 LE / Glow

The Hercules DJ Control MP3 e2, MP3 LE, and Glow are USB controllers that have identical controls and share the same
mapping. These controllers do not have a built in sound card, so a splitter cable or separate audio interface is recommended
for use with it.
Baru pada versi 1.11.
Berubah pada versi 2.3.0.
This new version is intended to work in a more intuitive way. Once you click on a button, it does its original function.
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Catatan: These controllers are not class compliant MIDI devices. On Linux, older versions of Mixxx required using a
custom Hercules kernel module. This is neither necessary not recommended anymore.

Figure21: Hercules DJControl MP3 e2 (schematic view)
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Mapping description (by function)

Library

Number Control Function
6 Folder Toggle playlist selection
10 Files Toggle track selection
8 Up arrow Go one playlst/track up
8 Down arrow Go one playlst/track down
18 Load A/Load B Loads the currently highlighted track into the corresponding deck (A or B)

Master/Headphones

Number Control Function
19 Crossfader Fades between left (channel 1) and right (channel 2) deck
20 Headphone monitor Toggles deck output to the headphones monitor on/off

Decks / Channels

Playing

Num-
ber

Control Function

18 Load
A/Load
B

Loads the currently highlighted track into the corresponding deck (A or B)

14 Play Starts or stop a loaded track
15 Cue Sets the cue point if a track is stopped and not at the current cue point. Stops track and returns to

the current cue point if a track is playing. Plays preview if a track is stopped at the cue point for
as long as it’s held down

12 Forward
/ Back-
ward

Move Forward/Backward in track

7 Scratch Enable or disable the scratch mode on all two decks
16 Jog

wheel
Seeks forwards and backwards in a stopped track. Temporarily changes the playback speed for
playing tracks. Absolute sync of the track speed to the jog wheel if scratch mode enabled

Volume / Equalizer / Effects

Number Control Function
17 Deck volume slider Controls the deck output volume, with soft takeover on deck switch.
5 Equalizer knobs Adjusts the gain of the low/medium/high equalizer filter. No soft takeover.
4 Shift Toggle Effects Selection
11 Button 1/2/3 Toggle Effect 1/2/3 for corresponding deck (with shift activated)
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Loops

Number Control Function
11 Button 1 Loop 1
11 Button 2 Loop 2
11 Button 3 Loop 4
11 Button 4 Loop 8

Pitch / Syncing

Number Control Function
1 Pitchbend -/+ Temporary Holds the pitch 4% lower or higher while pressed
3 Pitch knobs Adjust playback pitch / speed
13 Sync Automatically sets pitch so the BPM of the other deck is matched
2 Master Tempo Enable and lock Sync Mode

Troubleshooting

Jog wheels not working or controller not responding

If your jog wheels doesn’t work, or nothing works on the controller even when you have carefully read all other resources,
you should be aware that this controller stores at least two configuration options in the controller:

• Enable/disable Jog Wheels
• MIDI channel to use

and maybe a third one: Jog wheel sensitivity
With factory default settings, the jog wheels are enabled and the MIDI channel used is channel 1. The mapping is made
for channel 1 only. If your controller is configured for another channel, nothing will work and if you launch Mixxx with
-`-controllerDebug` parameter, you will have lines like this one showing in the logs when you press a button on the
controller :

Debug [Controller]: "DJ Control MP3 e2 : 3 bytes: B3 38 38 "

note the B3 here. it’s B<MIDI Channel # - 1>. So this controller is configured on channel 4. controller configured on
channel 1 will show B0, which is correct.
To change these parameters, you have to use the configuration tool that comes with the Hercules driver on on the Hercules
support page. Unfortunately, the configuration tool is only available for Windows and Mac OS X. We are not aware of
any solution for Linux. So if you normally use Linux, you will have to find a computer with Windows or Mac OS X,
install the Hercules driver, plug-in the controller and change configuration. You will only need to do this once, then the
controller should work with Linux.
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Controller not recognized as bulk controller

It has been reported that when the Hercules drivers are installed on a Windows, the driver takes over the bulk communi-
cation with the controller so it cannot be recognized by Mixxx as a bulk controller. Uninstall the Hercules driver and use
it as a USB bulk controller.

17.1.49 Hercules DJControl Starlight

Ultra-compact, ultra-light, ultra-practical and ultra-unique with its lights, the DJControl Starlight packs all the features
needed to mix and scratch. With its built-in audio interface, the DJControl Starlight offers pre-listening in the headphones
so you can then play your mix on speakers, which is perfect for learning or creating new mixes. The system is so com-
prehensive for its size that it boasts all the essential features such as bass equalization/filter knobs for smooth transitions
or touch-sensitive jog wheels for easy scratching. The added bonus: the bright and powerful RGB backlighting.

• Manufacturer’s product page
• Manufacturer’s support and downloads page
• Forum thread

Baru pada versi 2.3.

Compatibility

This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on
GNU/Linux, macOS, and Windows. However, if you wish to use the ASIO sound API under Windows, please install the
latest driver package available from the Support page.

Sound card setup

This controller has built-in 4 channel output sound card, with master and headphone output (both 3.5mm jack).
• Open Preferences > Sound Hardware
• Select the Output tab
• From theMaster drop-down menu, select the audio interface, then Channels 1-2
• From the Headphones drop-down menu, select the audio interface, then Channels 3-4
• Click Apply to save the changes.

Lihat juga:
More details about audio configuration can be found in the here.

Catatan: The Master and Headphone knobs are hardware controls and interact directly with the integrated sound
card’s output. Although they also send MIDI messages, they have NOT been mapped in Mixxx, so do not expect an
on-screen reaction when using them. This was done to prevent the knobs to adjust both the gain on the controller’s sound
card and in Mixxx.
The gain staging section of this manual explains how to set your levels properly when using Mixxx.
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Mapping description

The base LED is linked to the VU Meter for light show effect on each deck respectively.
All controls not listed here work as labeled.

Decks

Button Description
SYNC Sync lock
SHIFT + SYNC Set deck as sync leader
CUE Cue point
SHIFT + CUE Return to beginning of loaded song
PLAY Play/Pause
SHIFT + PLAY Cue Stutter
VINYL Scratch On/Off (Default: on)

When Vinyl is on, turning a jog wheel scratches that deck. When Vinyl is off, turning a jog wheel bends the pitch of the
track.

Pads

Pad Mode Button Description
Hot Cue Pads 1-4 Set and trigger Hot Cue 1-4
Hot Cue SHIFT + Pads 1-4 Pad = Delete Hot Cue 1-4.
Loop Pad 1 Beatloop 1/2 beat
Loop Pad 2 Beatloop 1 beat
Loop Pad 3 Beatloop 2 beats
Loop Pad 4 Beatloop 4 beats
FX Pads 1-3 FX 1-3 on/off
FX SHIFT + Pads 1-3 FX 1-3 select
FX Pad 4 FX Rack 1/2 On/Off (Deck A/B respectively)
Sampler Pads 1-4 (Deck A) Sampler 1-4
Sampler Pads 1-4 (Deck B) Sampler 5-8

17.1.50 Hercules P32 DJ

• Manufacturer’s product page
• Manufacturer’s technical support page
• Forum thread

The Hercules P32 DJ is a relatively compact DJ controller with a built-in sound card. Rather than jog wheels, it has a
4 x 4 multicolor (red/blue/purple) pad grid for each deck. The pad grids can be switched between 4 different layers to
perform a variety of functions.
Thanks to Hercules for supporting the development of this mapping by providing a controller.
Baru pada versi 2.1.
Berubah pada versi 2.3.0: Add pitch controls in loop mode and increased head mix knob precision.
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Figure22: https://www.hercules.com/wp-content/uploads/2018/05/HerculesDJ_HerculesP32DJ_top-1400x747.jpg

Compatibility

This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on
GNU/Linux, Mac OS X, and Windows. However, it recommended to install the driver on Windows to be able to use the
ASIO sound API.

Sound card setup

This device has a built in 4 channel output sound card. There are 2 RCA outputs for the main output and a 1/4" TRS
stereo headphone jack. There are buttons in the center of the controller that adjust the sound card’s headphone output
volume in hardware. These do not adjust the headphone gain in Mixxx.

Peringatan: There is no master output volume control on the device, but the master output volume of the sound
card can be controlled from the OS mixer. The device comes with the main output set to 45%. So, for the best gain
staging, turn the volume of the main output all the way up in your operating system mixer.

Mapping description

User configurable options

There are a few user configurable options available for you to customize. You can change these by opening the
Hercules-P32-scripts.js file with your text editor of choice (such as Notepad, TextEdit, Kate, or gEdit) and
editing the lines at the very top of the file.

• loopEnabledDot: whether to use the dot on the loop size LED display to indicate that a loop is active. This restricts
loop sizes to 2-32 beats and may be helpful if you never use loops less than 2 beats long. Otherwise the dot indicates
a loop size equal to 1/(# on the LED display).
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• samplerCrossfaderAssign: whether to assign the samplers to the crossfader. If true, the samplers controlled by
the left pad grid are assigned to the left of the crossfader and the samplers controlled by the right pad grid are
assigned to the right of the crossfader.

• toggleEffectUnitsWithDecks*: whether to automatically toggle the effect unit controls between units 1 & 3 on
the left and units 2 & 4 on the right when toggling decks between decks 1 & 3 and 2 & 4

Encoders

The encoders do not behave exactly as labeled.
• Browse encoder: scrolls through library. Pushing toggles big library view. Turning with shift controls the cue/main
mix going to the headphone output. Pushing with shift toggles split cue mode (left ear of headphone output plays
cue signal, right ear plays main signal).

The mapping of the encoders does not match their labels. They are labeled on the controller symmetrically, but they are
mapped asymmetrically like the rest of the deck controls:

• Left encoder: Turning halves/doubles the loop size. Turning with shift beatjumps by 1 beat forward/backward,
or if a loop is enabled, moves the loop 1 beat forward/backward. Pushing (de)activates a loop. Pushing with shift
reactivates a disabled loop, or if a loop is enabled, jumps to the loop in point and stops the deck.

• Right encoder: Turning adjusts the pitch, or with keylock on, just the tempo. Pushing resets the pitch to the track’s
default. Turning with shift jumps forward/backwards by the beatjump size. If a loop is enabled, turning with shift
moves the loop by the beatjump size. Hold shift, push, and turn to adjust the beatjump size, shown on the LED
display on the controller. When the encoder is released, the LED display goes back to showing the loop size.

Effects

Refer to the Standard Effects Mapping page for details on how to use the effects sections.
When the pad grid is in Slicer mode, the pads in the top left of the grid assign the deck to Effect Units 1-4.
Pressing the headphone button with shift assigns the effect unit on that side to the headphone channel. This is useful for
previewing an effect on a playing deck before using it. The headphone (PFL) button must also be pressed on the deck to
hear the effect on it in headphones.

Other controls

• Record button: toggles recording on and off.
• Slip button: toggles slip mode on and off for all decks. With shift, toggles between decks 1 & 3 on the left and
decks 2 & 4 on the right.

• Pad grid: Press the Hotcue/Loop/Slicer/Sampler buttons to activate different modes
• Hotcue mode: Press an unlit pad to set a hotcue. Press a red pad to activate a hotcue. Press a red pad with shift
to delete a hotcue.

• Loop mode: Control manual loops and other miscellaneous functions. On the top row, from left to right, the pads
set the loop in point, loop out point, and toggle the loop (without changing its size). Hold the loop in or loop out
button while moving the waveform with the mouse to adjust the loop in/out point (new in Mixxx 2.1). On the
bottom row, the two purple buttons temporarily decrease/increase the playback speed while they are held down for
beatmatching. The button to the right of those shifts the beat grid to the current position. The right column is for
pitch management, from top to bottom: match the key with the other track, pitch up, pitch down, and reset to the
default key of the track.
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• Slicer mode: refer to Effects section above
• Sampler mode: Press an unlit pad to load the track selected in the library to that sampler. Pads are blue when the
sampler is loaded but not playing and red when playing. Press a blue pad to play the sample from its cue point.
Press a red pad to jump back to the sample’s cue point. Press a red pad with shift to stop a playing sample. Press a
blue pad with shift to eject a sample. Note that samplers are independent from decks; the left grid controls samplers
1-16 and the right grid controls samplers 17-32.

• Sync: Short press to sync to other deck. Press and hold to enable master sync.
• Shift + sync: toggle quantize
• Shift + cue: jump to beginning of track and stop
• Shift + play: toggle reverse playback
• Shift + load: ejects a track from the deck
• EQ knobs, volume faders, crossfader, headphone button, play, cue, sync, and load all behave as labeled.

17.1.51 ION Discover DJ

The ION Discover DJ is a cheap budget MIDI controller meant to “discover DJ-ing” for people with a potential interest.
It does not have a built in sound card, so a splitter cable or separate audio interface is required to use headphones with it.

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.8.

Compatibility

This controller is USB MIDI class compliant, so it is plug-and-play on all platforms without having to install any special
drivers. The manufacturer’s page only mentions Windows and Mac but it’s confirmed working on Linux as well.

Library browsing

The controls for library browsing are in the center of the controller.

Control Function
Rotary encoder Track selection
Load buttons Loads currently highlighted track to the corresponding deck (only if no audio is playing)
Pushing rotary encoder Maximizes/minimizes the library

Jog wheels

The button in the center can be used to switch the jog wheels between search and scratch mode. In search mode, the jog
wheels can be used to seek to different parts of a song when paused. When that deck is playing, the jog wheels can be
pushed/pulled to speed up/slow down the playback. This is useful for beatmatching.
Pressing the center button will put the jog wheels in scratch mode, which means that the deck in Mixxx will follow the
absolute movement of the jog wheels. In this mode the Scratch button is lit.
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Equalizers

This controller only has a 2-band equalizer but Mixxx uses a 3-band EQ. Therefore, the volume knob has been mapped
to the low EQ, the bass knob has been mapped to the mid EQ, and the treble knob has been mapped to the high EQ. For
controlling the volume of the decks, use the crossfader.

Other buttons

The pitch buttons will control the tempo which also controls the pitch, except when keylock is on (padlock icon on screen).

Button Function Light
Sync Matches the BPM of that deck to the song playing in the other deck Blinks according to the beatgrid
Rev While held the deck plays in reverse only lights when pressed
CUE Attached to the cue control in mixxx follows cue button on screen
play/pause Play/pause the deck follows play button on screen

The behavior of the cue and play buttons can be configured in Mixxx’s preferences <interface-cue-modes>.

17.1.52 ION Discover DJ Pro

Ion Discover DJ Pro is a 2-deck controller with integrated audio interface and iPhone dock.

Figure23: ION Discover DJ Pro (schematic view)

• Mixxx User Forum
Baru pada versi 2.2.5.
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Compatibility

This controller is USB MIDI class compliant, so it is plug-and-play on all platforms without having to install any special
drivers. The manufacturer’s page only mentions Windows and Mac but it’s confirmed working on Linux as well.

Controller Mapping

Deck section

1

24

5

6

7
9
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8

3
Figure24: ION Discover DJ Pro (deck section)
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No. Control Function
1 JOG WHEEL Scratches the track
2 PLAY/PAUSE button Plays/pauses a track in the respective Deck
3 CUE button While playing: go to cue point, while stopped: set cue point
4 SYNC button Sync the tempo to other playing track
5 SCRATCH button Toggle the scratch mode
6 TEMPO slider Adjust the track playing speed
7 PITCH BEND buttons -/+ Lower (-) or Raise (+) the pitch temporarily
8 REVERSE PLAY button Hold for reverse play
9 BASS/MID/TREBLE knobs Adjust the low/mid/high-frequency regions of the song
10 MUTE buttons Mute low/mid/high-frequency regions

Mixer section

No. Control Function
1 Channel faders Adjust the output level for each channel
2 Cross fader Fades between left and right deck.
3 A CUE / B CUE buttons Sends the selected channel's audio to the headphone output
4 LOAD A / LOAD B buttons Load the selected library track to deck A / B
5 CUE VOLUME knob Control the output volume of the headphones output
6 BROWSE knob Browse the library
7 MASTER VOLUME knob Control the output volume of the master output

Known Issues

Controls not yet working:
• STUTTER button
• ALL MUTE button
• AUTOLOOP buttons
• iPod dock

17.1.53 Keith McMillen QuNeo

• Manufacturer’s product page
Keith McMillen QuNeo is a USB multi purpose pad controller and features tactile pads, sliders, rotary sensors and
switches. Works with USB, MIDI or OSC and will communicate most music software environments right out of the
box.
Features

• 27 pads, sliders and rotary sensors are pressure, velocity, and location sensitive. Even the 17 switches respond to
how hard you press.

• LED Light Feedback - variably diffusive elastomers with 251 multi-color LEDs, 16 square pads provide 127 levels
of Velocity response, X-Y location and continuous pressure.

• 2 rotary sensors allow you to scrub, trigger, stretch, pinch and play phrases and sound files, manipulate continuous
controllers and more .
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Figure25: ION Discover DJ Pro (mixer section)
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• Each rotary sensor measures angle, pressure and distance from the center.
• 9 touch sensitive sliders can thomann be mapped to fader and effects controls.
• LEDs within each slider act as VU meters.
• QuNeo is the size of an iPad (V1) and can fit in iPad accessories such as mic clips, stands and more.
• Advanced users and programmers can use the development kit and API to create their own code to respond to
QuNeo’s sensor data. Hack away to control your world in ways never before possible!

Baru pada versi 1.11.

Mapping Description

Figure26: Keith McMillen Quneo (schematic view)

The mapping is included with the QuNeo installer, make sure to click the “Mixxx” check box when prompted during the
installation. Alternatively download the Installer from www.keithmcmillen.com. The MIDI mapping goes with QuNeo’s
factory preset number 12. To change the factory preset, select the blue MODE button on the device and press tab #12.
Also see Youtube - Setting up Mixxx with QuNeo.
It turns QuNeo into a full fledged DJ controller using Mixxx. It includes controls for 2 players: play, sync, cue, tempo
controls, crossfading, scratching, and various volume controls accessible from QuNeo.
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17.1.54 Kontrol DJ KDJ500

• Forum thread
Baru pada versi 1.10.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.55 Korg Kaoss DJ controller

2-deck controller with touch controlled jogwheels, built-in 4-channel soundcard and a Korg Kaoss Pad as built-in effect
section (can be switched off for using software effects).

• Manufacturer’s product page
• Forum thread
• Pull request on Github

Baru pada versi 2.1.

Mapping

Figure27: Korg Kaoss DJ (schematic view)
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No. Name Function Shifted Operation
1 Headphone knob Adjusts the headphone level
2 Balance knob Adjusts the balance between the master level and the headphone monitor level
3 Master knob Adjust the master volume level
4 Browse knob Selects a song from the library Moves between levels (TODO)
5 Display Indicates the effect number or parameter Indicates the key or scale
6 Touchpad Mode Button Switches the touchpad between the Controller, KAOSS Effect, and Sampler modes (long press for blue LED)
7 Program/Value Knob Selects an effect Selects a key, selects a scale
8 Tap Button Sets the tempo Long-press this button to access the auto BPM function Key setting mode
9 Hold Button Enables/disables the touchpad’s hold function Scale setting mode
10 Touchpad (controller mode) Controls the effects of the DJ software. The vertical axis controls the mix (dry/wet) knob and the horizontal axis controls the super knob. Adjusts the Beats Multiplier (TODO)

Touchpad (Kaoss Effect mode) Controls the KAOSS effect Adjusts the depth of the KAOSS Effect
Touchpad (sampler mode) Controls the sampler function of the DJ software

11 Crossfader Adjusts the balance between Decks A and B
12 Touch Slider mode button Switches between the three touch slider mode
13 Touch Slider (Normal mode) Left Side - Nudges (pitch -) Center - Enables the touch wheel's Scratch mode Right Side - Nudges (pitch +) Moves to the specified position in the song (slider)

Touch Slider (Hot Cue mode) Left Side - Sets Hot Cue 1, and moves to Hot Cue 1 Center - Sets Hot Cue 2, and moves to Hot Cue 2 Right Side - Sets Hot Cue 3, and moves to Hot Cue 3 Deletes Hot Cue 1 Deletes Hot Cue 2 Deletes Hot Cue 3
Touch Slider (Loop mode) Left Side - Auto Loop × 1/2 Center - Loop on/off Right Side - Auto Loop × 2 Sets the Loop In point Auto Loop × 1 Sets the Loop Out point

14 EQ Boosts or Cuts the Hi EQ Boosts or Cuts the Mid EQ Boosts or Cuts the Lo EQ
15 Gain knob Adjusts the gain
16 Load button Loads the song into the selected deck
17 Fx button Left - FX1 rack mix knob can be manipulated when enabled Right - FX2 rack mix knob can be manipulated when enabled
18 Headphone cue button Turns the headphone monitor on/off Switches the function of the level meter between Deck A/B and the Master level
19 Touch wheel Scratches (in scratch mode) or adjusts the pitch Search function (in scratch mode) or moves beatgrid
20 Pitch fader Adjusts the pitch
21 Level meter Indicates the input level to deck A/B or the master level
22 Shift button Holding this button provides access to the controllers SHIFT functions
23 Play / pause button Starts/pauses the song Key Lock On/Off
24 Sync button Synchronizes the tempo of Deck A and Deck B Cancels tempo synchronization
25 Cue button Sets the cue point or moves to the cue point Returns to the beginning of the song.
26 Level fader Adjusts the level of deck A/B

17.1.56 Korg nanoKONTROL

This controller has been discontinued in favor of the Korg nanoKONTROL 2.
• Forum thread

Baru pada versi 1.8.2.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.57 Korg nanoKONTROL2

There are two mappings for this controller included in Mixxx. The one labeled “Korg Nanokontrol 2 (alternative)” takes
advantage of features introduced in Mixxx 2.0 such as master sync and cue modes.

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.58 Korg nanoPAD2

Baru pada versi 1.11.0.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.59 M-Audio X-Session Pro

This device has been discontinued. M-Audio discontinued its DJ products after the company was bought by inMusic in
2012.
Baru pada versi 1.6.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.60 M-Audio Torq Xponent

This device has been discontinued. M-Audio discontinued its DJ products after the company was bought by inMusic in
2012. This device is a class compliant USB audio and MIDI device, so it does not require a special driver on any OS that
Mixxx runs on.
Baru pada versi 1.6.
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Note for Windows users

Typically, the ASIO sound API is the best option on Windows and it requires an ASIO driver from the sound card
manufacturer. However, it seems that the current version of the Xponent ASIO driver for Windows interferes with the
ability to send MIDI control messages to the Xponent. As a result, if you are running M-Audio’s Xponent ASIO drivers
on Windows, the lights will not work. If you uninstall the drivers, the lights will work, but you can no longer use the
Xponent’s sound card with the ASIO sound API.
It is recommended to use the WDM-KS sound API instead. The sound card will appear as “Analog Connector 1
(Xponent Audio)” and “Analog Connector 2 (Xponent Audio)”. Connector 2 is the main out, and Connector 1 is the
headphones. The latency meter seems to run a bit higher than it did under ASIO, so keep this in mind, and test both
setups with your own system to see how they compare. If you require low latency as well as a lot of effects or time
stretching, you may want to run with the ASIO driver at the expense of the lights.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.61 Miditech Midicontrol

Baru pada versi 1.5.2.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.62 Mixman DM2

• Manufacturer’s product page (archived)
Baru pada versi 1.7.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.63 MixVibes U-Mix Control (Pro) 2

The MixVibes U-Mix Control Pro 2 is a MIDI DJ controller with an internal soundcard and two Inputs for Turntables
or any Audio-Source with RCA. It offers also a changeable Cross-fader, adjustable Cross-Fader Curve and individual
Touch-Level-Sensors. The U-Mix Control Pro differs only in Cue-Button-Labels The U-Mix Control 2 (without “Pro”
= internal soundcard) also. Both should work fine with this MIDI mapping.

• Manufacturer’s product page (archived)
• Forum thread

Baru pada versi 1.10.1.
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Figure28: Mixman DM2 (schematic view)

Mapping description

• Cross- Volume- and Pitchbend-Slider
• Master, Gain- and EQ-Nobs incl. Kill-Switches, Cue/Master-Mix (Headphone)
• Cue-, Play-, Sync-, Pitchbend-, HotCue-, Headphone, Load A/B-Buttions
• JogWheels (incl. Scratch & Jog)
• MediaKnob
• LEDs

1. Clipping
2. EQ-Kill
3. CUE/PLAY(BPM)/SYNC
4. HotCUEs
5. Headphone (A/B)
6. Load (A/B) - 20 Seconds end of Track
7. Jog (Keylock)
8. Bend

Special Functions
• BPM-Tap: Press “Shift” + “Sync”
• Keylock: Press “Jog”
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Currently not working
• Sample-Deck-Management
• Loop-Knob & Loop-Setting

Not MIDI-mappable
• MIC-Level-Control (MIC is hardwired through master output)
• Headphone-Level Control (Level-Adjustment in Mixxx and the Hardware-Nob are independent)
• Touch Level sensitivity (only Hardware)
• C.F. Curve (turn to fully left and change in Mixxx, if needed)

17.1.64 Native Instruments Traktor Kontrol F1

The Traktor Kontrol F1 is a small versatile controller that is intended to be used for remix decks but can easily be
repurposed for other uses such as hotcues.

• Manufacturer’s product page
Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.65 Native Instruments Traktor Kontrol S2 MK2

The Native Instruments Traktor Kontrol S2 MK2 is a 2 deck all-in-one controller with an integrated audio interface. It
has a pair of balanced 1/4" TRS outputs and a pair of unbalanced RCA outputs which both output the main mix, a 1/4"
TRS headphone jack, and a 1/4" TRS microphone input. The microphone input is digitized and available to the computer
for recording and broadcasting. The Kontrol S2 MK2 can run with only USB bus power and an optional power supply
can be connected to make the LEDs brighter and the headphone output louder.
The Kontrol S2 MK2 can be distinguished from the Mk1 by the jog wheels. The top of the jog wheels on the MK2 are
shiny aluminum; the top of the jog wheels on the Mk1 are black. The Kontrol S2 Mk3 does not have effects knobs at the
top.
Baru pada versi 2.3.

Compatibility

The Kontrol S2 MK2 is a USB audio and HID class compliant device. It is fully compatible with Linux, Windows, and
macOS. No proprietary driver is required on Linux or macOS. For Windows, download and install the latest driver from
Native Instruments’ website.
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Audio routing

Output Channels
Master Channel 1 - 2
Headphones Channel 3 - 4

Input Channels
Microphone 1 Channel 1 - 2

Do not configure the Record/Broadcast input in Mixxx.

Mapping

Decks

Jog Wheels

Touch the top of the jog wheel and turn it to scratch. Move the jog wheel from the edge without touching the top to
nudge the track. Hold SHIFT and spin the jog wheel to seek quickly.

Loop Section

The encoders work differently in Mixxx than in Traktor:
Left encoder Turning jumps forward/backwards by the beatjump size. If a loop is enabled, turning moves the loop by

the beatjump size. Push and turn to adjust the beatjump size. Turning with SHIFT adjusts the musical key. Pushing
with SHIFT resets the key to the track’s default.

Right encoder Turning halves/doubles the loop size. Turning with SHIFT beatjumps by 1 beat forward/backward, or
if a loop is enabled, moves the loop 1 beat forward/backward. Pushing (de)activates a loop. Pushing with SHIFT
reactivates a disabled loop, or if a loop is enabled, jumps to the loop in point and stops the deck.

LOOP IN/LOOP OUT buttons Manually set the loop in and out points. Press and hold while moving the jog wheel to
adjust the loop in or out point.

Top Pad Row

The top pad row has 3 different modes.
Hotcue mode This is the default mode when Mixxx starts. The pads control hotcues 1-4. The color of the hotcues is

shown on the pads. Press an unlit button to set a new hotcue. Press a lit pad to seek to the hotcue. Press a lit pad
with SHIFT to delete the hotcue.

Intro & Outro cue mode This mode is activated by pressing the FLUX button above the tempo fader. Pads 1 & 2 are
used for the intro start & end cues and light up green. Pads 3 & 4 are used for the outro start & end cues and light
up red.

Sampler mode This mode is activated by the button under the Remix knob in the center of the mixer. Press an unlit
pad to load the selected track in the library to the sampler. Loaded and stopped sampler pads are lit white. Press
a white pad to play a sampler. A playing sampler is lit magenta. Press a lit pad with SHIFT to stop a sampler, or
if it is already stopped, unload the sample.

17.1. Controllers 304



Mixxx User Manual, Rilis 2.3.0

Transport Controls

The transport controls work mostly as labelled on the controller:
SYNC button Press to sync tempo. Press and hold to enable sync lock. Press again to disable sync lock. Press with

SHIFT to enable sync lock without needing to hold.
CUE button Behavior depends on the cue mode set in the Mixxx preferences. Press with SHIFT to seek the beginning of

the track and stop.
PLAY button Play or pause the deck. Press with SHIFT to toggle key lock.
TEMPO fader Adjusts the tempo.
FLUX button Mixxx does not yet have a very useful flux/slip mode, so instead this button toggles the top pad row to the

intro/outro cues. Press the button when it is lit to return the top pad row to hotcue mode.
When slip mode is implemented in Mixxx in the future, this could be changed so SHIFT + FLUX button activates
intro & outro mode for the pads.

Mixer

Deck Columns

GAIN|FILTER encoder Controls the Quick Effect superknob for the deck. With SHIFT, controls gain. Press to reset
the Quick Effect superknob. Press with SHIFT to reset gain.

FX 1/FX 2 buttons Assign the deck to effect units 1 and 2.
HI/MID/LOW knobs Adjust the high, middle, and low frequencies.
CUE button Toggle whether the deck is routed to the prefader headphone output. With SHIFT, toggle quantize for the

deck.
Fader Control the deck volume.

Center Column

MAIN LEVEL knob Adjust the volume of the main output. This acts on the controller’s audio interface output in
hardware, so it is not mapped to the main mix gain knob in Mixxx (otherwise the gain would be applied twice).

REMIX knob Adjusts the gain of samplers 1-8.
REMIX ON A/REMIX ON B buttons Toggles the top pad row of the corresponding deck to control samplers. Press

when lit to return the pads to controlling hotcues.
BROWSE encoder Scroll through the music library. Push to maximize the library browser on screen. Turn with SHIFT

to scroll 5 rows at a time.
LOAD A/LOAD B buttons Load the track selected in the library to the corresponding deck. Press with SHIFT to

unload a track.
LEVEL meters The meters show the levels for each deck.
Crossfader Crossfade between the decks.
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Effects

The Kontrol S2 MK2 uses the standard Mixxx effects mapping.

Front panel

The cue volume knob adjusts the volume of the controller’s audio interface in hardware, so it is not mapped to Mixxx
(otherwise the gain would be applied twice). The cue mix knob is mapped to Mixxx. The Mic Engage button toggles
talkover for Microphone Input 1 in Mixxx.

17.1.66 Native Instruments Traktor Kontrol S2 MK3

The Kontrol S2 MK3 is a two-channel controller with an integrated sound card. It has two integrated stereo outputs (line
and 1/8" / 3.5 mm TRS), headphone outputs (1/8" / 3.5 mm TRS) and microphone inputs (1/4" / 6.3 mm TRS). TheMK3
uses the standard HID protocol to send and receive signals from a computer, so it can work with Mixxx. The Kontrol
S2 MK3 can run from USB bus power, and using a separate power supply has no impact on the output level or LED
brightness (as opposed to the MK2).

• Manufacturer’s product page
• Mapping forum thread

Baru pada versi 2.2.4.
Berubah pada versi 2.3: Unbind Master knob from Mixxx's Main Gain, because it controls the hardware volume.

Mixxx Sound Hardware Preferences

• Master output: channels 1-2
• Headphone output: channels 3-4

Mixxx mapping

Element Primary function Secondary function (+ SHIFT)

(1) REV Button
Reverse play while held Reverse play + slip mode while held

(2) FLX Button
Enable and disable slip mode

(3) Browse knob (turn) Scroll vertically in library Scroll horizontally in library
(3) Browse knob (press) Load selected track into deck Eject current track
(4) Preparation button Add selected track to AutoDJ queue

(bottom)
Add selected track to AutoDJ queue
(top)

(5) List view button Toggles maximizing the library

(6) Sync button
Syncs the BPM and phase (depend-
ing on quantize). Press longer to ac-
tivate master sync on that deck.

Syncs the phase to that of the other
track

(7) Keylock button Enable keylock for the deck
berlanjut ke halaman berikutnya
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Table 7 – lanjutan dari halaman sebelumnya
Element Primary function Secondary function (+ SHIFT)
(8) Loop knob (turn) Halve or double loop size
(8) Loop knob (press) Set a loop of the defined number of

beats and enables the loop
Toggles the current loop on or off

(9) Samples button Active sampler mode (for the number
buttons)

(10) Hotcues button Activate hotcue mode (for the num-
ber buttons)

(11) Move knob (turn) Beatjump backwards/forwards Halve or double beatjump size
(11) Move knob (press) Activates a rolling loop of the de-

fined number of beats. Once dis-
abled, playback will resume where
the track would have been if it had
not entered the loop

Activate current loop, jump to its
loop in point, and stop playback

(12) Jog wheels
Control scratching when touched
from the top (Missing: temporarily
bend the pitch when touched from the
side)

(13) Grid button
Adjust beatgrid so closest beat is
aligned with the current play position

Adjust beatgrid to match another
playing deck

(14) Shift button Activates secondary functions when
pressed

(15) CUE button
CUE default If the CUE point is set, jump to it and

stops

(16) Play button
Toggles playing Seeks a player to the start and then

stops it

(17) Number buttons Function depends on current mode
Hotcue mode If hotcue is set, seeks the player

to hotcue position. Otherwise set
hotcue at current position

Clear the hotcue

Samples mode If track is loaded into corresponding
slot, go to CUE point and play

If track is playing, CUE default be-
haviour. Otherwise eject track

(18) Tempo fader
Speed control

(19) Quantize button Toggles quantization for both decks

(20) Gain knob
Unmapped (adjusts the hardware
gain)

(21) Microphone button Toggles microphone talkover, long
press for permanent activation

(22) Pre-Gain knob Adjusts the pre-fader gain of the deck

(23) HI knob
High frequency filter

(24) MID knob
Middle frequency filter

berlanjut ke halaman berikutnya
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Table 7 – lanjutan dari halaman sebelumnya
Element Primary function Secondary function (+ SHIFT)

(25) LOW knob
Low frequency filter

(26) Effect Superknob Quick effect superknob for the cor-
responding deck

(27) Sample knob
Adjusts the pregain for all the sample
decks combined

(28) Headphone mix knob Adjusts the cue/main mix in the
headphone output

(29) Headphone gain knob Adjusts the headphone output gain
(30) Effect buttons Enable or disable effect units for both

decks
(31) Headphone buttons Toggles headphone cueing
(32) Volume fader Adjusts the channel volume fader for

the corresponding deck
(33) VuMeter LEDs Show the current instantaneous deck

volume

(34) Crossfader
Adjusts the crossfader between both
decks

17.1.67 Native Instruments Traktor Kontrol S3

The Kontrol S3 is an introductory 4 deck controller with good build quality and integrated sound card. This is the first
controller released with the "S3" name.
The Kontrol S3 can run from USB bus power. Using the separate power supply increases the brightness of the LEDs,
which is helpful for using it in daylight, and increases the volume of the headphone output.

• Manufacturer's product page
Baru pada versi 2.3.0.

Compatibility

Controller

The Kontrol S3 is a USB class compliant audio and HID device, so it is compatible with Mixxx without any proprietary
drivers on GNU/Linux and macOS. On Windows, it is recommended to install the driver from Native Instruments and
select the ASIO sound API in the Sound Hardware section of Mixxx's Preferences.
With the S3 plugged in, the device is listed as an available controller in Mixxx's Preferences. The controller uses HID
for the knobs, buttons, and other components on the device, so the mapping can only be loaded when you select the HID
device on the left side of Mixxx's Preferences.
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Figure29: Native Instruments Traktor Kontrol S2 MK3 (schematic view)

Audio Hardware setup

The S3 has a standard 4 channel sound card. You should configure the channels as follows:

Audio Output Channel Configuration
Master Channel 1-2
Headphones Channel 3-4

Audio Inputs

The S3 has two sets of inputs, but only one can be active at a time. There is a set of line-level RCA inputs on the back of
the controller, and a combo XLR / 1¼" mic jack on the front. Use SHIFT + EXT to switch between these inputs.

Mapping description

Note that Mixxx doesn't have the concept of a single "leader" deck for sync. Instead, push and hold the SYNC button to
"lock" sync on for all decks you want to remain in sync. Or you can push SHIFT + SYNC to lock sync on. Refer to Sync
Lock documentation for details.

Petunjuk: There are two SHIFT buttons, one for each side of the controller. Make sure you press the SHIFT button on
the same side as the control you want to modify.
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Mixer

• The GAIN and equalizer HIGH/MID/LOW knobs and the CUE (headphones) button behave as labelled.
• FX Enable buttons: See Effect section below.
• The FILTER knob controls the Quick Effect superknob. By default, this uses a high-/low-pass filter, but a different
effect can be chosen in the Equalizer section of Mixxx' Preferences.

• EXT: The EXT button changes the fourth channel pregain (knob), pfl, and volume (slider) adjustments to operate
with the Microphone input. The microphone does not respond to EQ or effects.

• SHIFT + EXT: Switches input sensitivity for the input connectors from Mic to Line and back again.
The Main Volume knob on the S3 controls the volume of the S3's main output in hardware, so it does not affect the
software main output gain knob in Mixxx by default. You can hold SHIFT and turn the knob to adjust Mixxx' main
output gain. Note that this will still also adjust the hardware gain, so after you release SHIFT you'll need to adjust the
knob again.
Peak display is only generated from software. So if you see clipping indicated, lower the gain of the playing decks or use
SHIFT + Main Volume knob.

Decks

Control Description
Library encoder
press

Load track selected in library to the deck.

SHIFT + Library
encoder press

Eject track.

Small play button While held, plays the current track in the preview deck. If you rotate the library encoder while
you hold the PLAY button, Mixxx will scan through the track being previewed.

Star button This button is not used.
List-plus button Adds the current track to the Auto DJ list.
VIEW button Move focus of library control between left-hand tree and main list.

Transport Mode Buttons

Control Description
REV Activates a reverse-roll (aka "censor") effect.
SHIFT + REV Turns on reverse playback mode.
GRID Turns on Quantize mode.
FLUX Turns on Slip mode.
JOG When on, touching the jog wheels enables Scratch mode.
SHIFT + Wheels Hold to use the wheels to quickly scroll through the track.
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Looping

Control Description
Right Encoder Turn Double/halve loop size.
SHIFT + Right Encoder Turn Move loop forward/backward by the beatjump size.
Right Encoder Press Activate loop of set size from current position, or disable active loop
SHIFT + Right Encoder Press Toggles the existing loop on and off.
Left Encoder Turn Beatjump forward/backward.
SHIFT + Left Encoder Turn Adjust beatjump size.
Left Encoder Press Activates beatloop roll.
SHIFT + Left Encoder Press Activates a loop and then stops.

Rate / Keylock

There are two ways the rate sliders can be mapped: Absolute, and Relative. Absolute mode is the default. In this mode,
the position of the pitch slider matches the on-screen pitch slider position. If the sliders are misaligned, Mixxx engages
"soft takeover mode" -- Mixxx won't update the value of the slider until the controller matches the GUI. In Relative mode,
moving the slider always adjusts the value of the pitch slider, even if they don't match.

• Absolute Mode:
– KEYLOCK: Press to toggle keylock mode.
– SYNC: Press to beatsync, or press and hold to activate Sync Lock Mode.
– Pitch slider: Adjusts playback speed.
– SHIFT + Pitch slider: Adjusts musical key

• Relative Mode:
– KEYLOCK: Press to toggle keylock mode (toggles when releasing the button).
– SYNC: Press to beatsync, or press and hold to activate Sync Lock Mode.
– Pitch slider: Adjusts playback speed.
– Keylock + Pitch Slider: adjusts musical key
– SHIFT + Pitch Slider: Allows the user to move the slider without any effect.

Button Pads

The grid of 8 buttons have two possible trigger modes: Hotcues, and Samplers.
In Hotcues mode, pressing the number button will set the hotcue if none exists, and activate it if one does. If you hold
SHIFT and press a button, it will clear that hotcue.
In Samplers mode, the buttons on the left side of the controller correspond to Samplers 1-8. The buttons on the right side
of the controller correspond to Samplers 9-16. By default, pressing a number button will activate a sample. Pressing the
button again will stop sample playback.
You can change this behavior by editing the javascript file to set TraktorS3.SamplerModePressAndHold = true;. In this
mode, the sample will play while the button is held, and stop when you let go.
In both modes, holding SHIFT and pressing a button will eject the sample if it is not playing, and will rewind the sample
back to the beginning if it was playing.
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Effects

Because the S3 has limited effects controls, the FX setup is unusual and a little complex. Each deck has a single effect
toggle button and one knob, and on the right-hand side of the mixer there are five buttons, one for each effect chain and
one for the QuickEffect. These buttons and knobs are used in different ways depending on how they are pushed, and
together allow the DJ to customize all of the effects.
There are three modes that the effect controls can be in: 1. The initial mode is Filter Mode. This mode is indicated when
the FILTER ENABLE buttons have the same colors as the individual decks. This mode is used for adjusting QuickEffects
and assigning Effect Chains to decks. 1. The next mode is Effect Chain Edit Mode. This mode is indicated when the
FILTER ENABLE buttons are all the same color as one of the effect buttons. This mode is used for turning individual
effects in a chain on and off, and adjusting each effect chain's mix knob. 1. The last mode is Effect Focus Mode. This
mode is indicated when FILTER ENABLE buttons are all the same color as one of the effects, and one of the FX SELECT
buttons is blinking. This mode is used for tuning individual parameters in an effect and enabling or disabling effect toggle
buttons.

Switching Effect Modes

At any time, you can push the FILTER FX SELECT button to return to Filter Mode. If you get lost, try pusing the
FILTER button to start over.
Press any FX SELECT button to enter Effect Chain mode for that number chain. If you press the same FX SELECT
button again, you'll return to Filter Mode. Press a different FX SELECT button to enter Effect Chain mode for that other
chain.
Press and hold an FX SELECT button, then press a FILTER ENABLE button to enter Effect Focus mode. The FX
SELECT button will start blinking. From left to right, the FILTER ENABLE buttons will focus on the first through
fourth effects in the chain. If you press any FX SELECT button, you'll return to Effect Chain mode.

Soft Takeover

The knobs have Soft Takeover mode enabled, which means you need to turn the physical knob to match the current
position of the UI knob before the value will change. If you are wondering why it seems like the values aren't changing,
you may need to rotate the knob more.

Assigning Effects

You can assign effect chains to individual decks in Filter Mode. Press and hold FILTER ENABLE, then press the desired
FX SELECT button or buttons. The FX SELECT buttons that are bright are the effect chains that are selected for that
deck.

Effect Chain Edit Mode

In Effect Chain Edit Mode, the FILTER ENABLE buttons change color to match the selected FX button. The lights will
be dim if the effect is disabled, and bright if it is enabled. Tap the FILTER ENABLE button to enable or disable the
effect. Turn the first three knobs to adjust the meta knob for each effect. The last filter knob adjusts the mix knob for the
whole chain. This is to prevent sudden changes in sound when navigating between modes.
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Effect Focus Mode

In Effect Focus Mode, the FILTER ENABLE buttons represent effect button parameters, while the four knobs adjust the
first four parameters of the selected effect.

Mapping options

There are two user-friendly customizations possible on the S3:
1. Toggle between Absolute and Relative pitch slider mode.
2. Customize the colors for decks A, B, C, and D.
3. Change the Sampler playback mode.
4. Whether wheel touch scratching is on by default.

To make these changes, you need to edit to the mapping script file.
1. Open Mixxx Preferences and select the Kontrol S3 in the side list.
2. There will be a box labeled Mapping Info, and that box will have a section labeled Mapping Files.
3. Select Traktor-Kontrol-S3-hid-scripts.js.
4. Either the file should open in an editor, or you should see a file browser window with that file selected. If you see

a file browser, right click the file and select an option to edit it.
5. At the top of the file will be short instructions explaining how to edit the file.

Changes you make will take effect as soon as you save the file.

17.1.68 Native Instruments Traktor Kontrol S4 MK2

The Kontrol S4 MK2 is a 4 deck all-in-one controller with a sturdy build quality and integrated sound card. The MK2 has
substantial improvements over the S4 MK1, including large multicolor buttons. The MK1 is not supported and cannot be
supported because it uses a proprietary communication protocol exclusive to Traktor. The MK2 uses the standard HID
protocol (also used by keyboards & mice) to send and receive signals from a computer, so it can work with Mixxx. The
easiest way to tell the MK1 apart from the MK2 is the appearance of the jog wheel. On the MK1, the top of the jog
wheel is black plastic; on the MK2, the top of the jog wheel is shiny aluminum.
The Kontrol S4 Mk2 can run from USB power. Using the separate power supply increases the brightness of the LEDs,
which is helpful for using it in daylight, and increases the volume of the headphone output.

• Manufacturer’s product page
Baru pada versi 2.1.

Compatibility

Controller

The Kontrol S4 MK2 is a USB class compliant audio, HID and MIDI device, so it is compatible with Mixxx without
any proprietary drivers on GNU/Linux and MacOS. On Windows, it is recommended to install the driver from Native
Instruments and select the ASIO sound API in the preferences.
With the S4 plugged in, a MIDI device is listed as an available controller in Mixxx’s Preferences. That is the MIDI
input/output ports on the back of the S4 for connecting external MIDI gear; no mapping for the S4 will appear in the
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menu for the MIDI device. The controller uses HID for the knobs, buttons, and other components on the device, so the
mapping can only be loaded when you select the HID device on the left side of Mixxx’s Preferences.

Timecode vinyl

The phono inputs on the S4 can be used with turntables for timecode vinyl control of Mixxx.
Lihat juga:
Read the Vinyl Control section for details.

Mapping Description

Push and hold the SYNC button to “lock” sync on for all decks you want to remain in sync. Push SHIFT + SYNC to
enable Sync Lock for details.
Mixxx does not have remix decks, so the four remix slot buttons control the samplers. There are some more bonus actions
that can be accessed by holding SHIFT and pressing certain buttons.

Mixer

Control Description
FILTER knob Controls QuickEffect superknob. This controls the Filter effect by default, but a different effect

can be chosen in the Equalizer section of Mixxs’s Preferences.
SNAP Toggles library fullscreen
LOOP RECORD Toggles recording
LOOP
RECORDER
PLAY

Hold down and press FLUX button on a deck to enable autoslip mode on that deck.

SHIFT + Gain Up/down will move the beatgrid
LOOP
RECORDER
PLAY + GAIN

Increase / decrease the BPM of the track by 0.5. Press the encoder to round the track the nearest
whole BPM. Best done to fix tracks with the wrong BPM with the pitch fader at 0.

BROWSE encoder Up/down will browse in the focused library pane. Pressing acts like a double click on themouse.

GAIN, effects routing, equalizer high/mid/low, and CUE (headphones) behave as labeled.
The Master Volume knob on the S4 controls the volume of the S4’s master output in hardware, so it does not affect
the software master gain knob in Mixxx. Peak display is only generated from software, however. So if you see or hear
clipping, lower the gain of the playing decks; adjusting the master volume knob on the S4 will not help.
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Decks

Control Description
LOAD Load track selected in library to the deck.
SHIFT + LOAD Eject track
Small buttons with pre-
view icons

Play a sampler from its cue point. If no track is loaded in the sampler, the track selected
in the library will be loaded.

SHIFT + small buttons
with preview icons

If sampler is playing, stop it. If sampler is not playing, the loaded track is ejected from
the sampler.

1-4 numbered buttons Set/activate hotcue
SHIFT + 1-4 numbered
buttons

Clear hotcue

SHIFT + Wheel nudge Fast search through track when not playing
FLUX button Enable slip mode (if shift is held down this decreases the range of the BPM slider, if

LOOP RECORDER PLAY is held down enter autoslip mode)
RESET button Reset key (if shift is held down increase the range of the BPM slider

Looping

Control Description
Right Encoder
(turn)

Double/halve loop size. The loop size is shown on the controller. A dot on the right indicates a
fractional loop size. Two dots indicates a loop size larger than 99 beats.

Right Encoder
(press)

Activate loop of set size from current position

SHIFT + Right
Encoder (turn)

Adjust key

SHIFT + Right
Encoder (press)

Reset key

Left Encoder
(turn)

Beatjump forward/backward by beatjump size (shown on screen but not on controller), or move
the loop by beatjump size if there is a loop enabled

Left Encoder
(press)

Re-enable a loop that has been set previously. Pressing this before a loop will keep playing until
the loop is entered.

SHIFT + Left En-
coder (turn)

Adjust beatjump size

SHIFT + Left En-
coder (press)

Jump to loop in point, activate loop, and stop playback. This is helpful for preparing to mix a
track in with a loop.

IN button Set loop in point manually. Hold pressed while moving the jog wheel to finely adjust the loop in
point.

OUT button Set loop out point manually. Hold pressed while moving the jog wheel to finely adjust the loop
out point.
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Effects

The knob on the left of each effect unit controls the mix (dry/wet) knob for all 3 effects in the unit. The other knobs
control the metaknobs of the effects. The buttons below the metaknobs control the effect enable buttons. When pressed
with shift, they cycle through the available effects. The button below the mix knob toggles whether the effect parameters
are showing on screen. This will be expanded in a future update to implement the Standard Effects Mapping.
The buttons at the top of each mixer column control which decks are routed to which effects units.

Mapping extras

Autoslip mode: Holding down LOOP RECORDER PLAY and pressing the FLUX on a deck will enable autoslip mode
on that deck. Autoslip turns on slip mode automatically before doing certain actions and turns it off after the actions is
finished. It works for beat loops, hot cues, and scratching (warning, can have weird effects when scratching).

Mapping options

If you choose, you can edit the controller script and change the Remix Slot buttons to perform loop rolls instead. Also by
default, SHIFT + CUE rewinds the track to the beginning but you can change this to a Reverse Roll (or “Censor”) effect
instead.
Making these changes is still a little awkward and we will be making controller preferences easier to change in the future.
For now you’ll have to make a small change to the mapping script file. Don’t worry, the actual edit only involves replacing
a single word in a text file.

1. Open Mixxx Preferences and select the Kontrol S4 in the side list.
2. Select Traktor-Kontrol-S4-MK2-hid-scripts.js.
3. Click Open Selected File.
4. Either the file should open in an editor, or you should see a file browser window with that file selected. If you see

a file browser, right click the file and select an option to edit it.
5. At the top of the file will be short instructions explaining what to do.

17.1.69 Native Instruments Traktor Kontrol X1

Baru pada versi 1.11.0.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.70 Nintendo Wiimote

The Wiimote is a motion-sensitive wireless game console controller.
• Forum thread

Baru pada versi 1.11.

17.1.71 Novation Dicer

• Manufacturer’s product page (archived)
• Forum thread

The Novation Dicer is a small controller designed to be placed on the corner of turntables for use with timecode vinyl.
They are sold in pairs.
Baru pada versi 1.10.

Mapping description

The mapping has all buttons mapped and mimics the overall layout of the DJ Tech Tools Dicer mapping for Traktor.

17.1.72 Novation Launchpad Mini

• Manufacturer’s product page
• Forum thread

Baru pada versi 2.0.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.73 Novation Launchpad MK1

• Forum thread
Baru pada versi 1.11.
Berubah pada versi 2.1.
This device is not USB MIDI class compliant. Its signals are translated to MIDI by special drivers on Windows and Mac
OS X. There is no driver available for Linux. It has been discontinued in favor of the Novation Launchpad MK2 which is
USB MIDI class compliant and has RGB pads.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.74 Novation Launchpad MK2

Novation Launchpad MK2 is an updated versions of the Launchpad. It introduces new features such as RGB, velocity
sensitive pads, and a redesigned layout scheme.
Baru pada versi 2.1.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.75 Novation Twitch

Baru pada versi 2.1.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.76 Numark DJ2GO

• Manufacturer’s product page
Baru pada versi 1.10.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.77 Numark DJ2GO2 Touch

The Numark DJ2GO2 Touch is a USB MIDI controller with an integrated audio interface. It is the successor to the
DJ2GO2, and features touch capable wheels.

• Manufacturer’s product page
• Mapping Forum Thread

Baru pada versi 2.3.1.

Audio Setup

The mapping relies on the following channel assignments:

Output Channels Assigned to
1-2 Master
3-4 Headphones
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Figure30: Numark DJ2GO2 Touch (schematic view)

Controller Mapping

Decks

No. Control Function
2 HEADPHONES Routes deck to headphones output
6 LOAD Loads a track into the deck.
7 LEVEL Hi / low pass filter effect.
9 PAD MODE Switches between modes of operation for pad buttons on both decks.
10 Jog Wheel (top surface) Perform scratch operation.
10 Jog Wheel (outer edge) Rotate to lower/raise playback speed and pitch.
11 PLAY/PAUSE Plays or pause the song.
12 Pads 4 buttons which can be used to control various features.
13 CUE Specifies, plays or recalls temporary cue point.
14 SYNC Match tempo and phase of other deck.
15 Tempo slider Adjust song playback speed.

Pads

The pad mode is changed using the PAD MODE button.

Pad
Mode

Function

CUES Set cue points, and trigger them by clicking.
AUTO Enable / disable beat loops, with pads 1, 2, 3, and 4 creating 1, 4, 8, and 16 bar loops respectively.
MAN-
UAL

Set a custom loop: pad 1 sets the loop in point, pad 2 sets the loop out point, pad 3 enables / disables the
loop, and pad 4 stops the loop and returns to the beginning.

SAM-
PLER

Load / trigger sample tracks.
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Mixer / Library

No. Con-
trol

Function

3 CUE
LEVEL

Adjusts the cue output level.

4 MAS-
TER
LEVEL

Adjusts the master output level.

5 Browse
en-
coder

Scroll in the track list. Preview tracks when clicking on a track in a tracklist, scrolling the encoder
allows seeking the previewed track. Clicking when a track is being previewed will stop the preview,
allowing you to scroll the tracklist again.

8 Cross-
fader

Fades between left and right deck.

Inputs / outputs

No. IO Function
1 USB Micro USB slot for data / power connection to the Mixxx host device.
16 Main (3.5mm) Master audio output for the onboard interface.
17 Headphones (3.5mm) Headphones audio output for the onboard interface.

17.1.78 Numark iDJ Live II

The Numark iDJ Live II is a budget MIDI controller similar to the Discover DJ <ion-discover-dj>. It does not have a built
in sound card, so a splitter cable or a separate audio interface is required to use headphones with it.

• Manufacturer's product page
Baru pada versi 2.3.0.

Compatibility

This controller is USB MIDI class compliant, so it is plug-and-play on all platforms without having to install any special
drivers.

Button mapping

Most of the mapping is self-explanatory and matches up to labels in the Mixxx GUI. The mapping script only handles the
jog wheels and scratch button, so you can remap everything else using the learning wizard if you'd like.
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Play/Cue/Sync buttons

Despite their appearance, the cue buttons don't seem to have LEDs. Only the play and sync buttons do.
The "SET" buttons set the cue point and the arrow buttons jump to the cue point. They do not change behavior depending
on whether the track is playing or paused.

Jog wheels and scratch button

The scratch button in the middle changes the mode of the jog wheels. When the scratch LED is off, you can use the
wheels to adjust the pitch of a playing track, or to quickly search through a paused track. The search mode moves exactly
32 beats for each revolution of the jog wheel.

Browse knob

The browse knob scrolls through your library, and the 1 and 2 buttons below it load a track into the corresponding deck.
Pressing down on the Browse knob toggles fullscreen library view.

17.1.79 Numark Mixtrack

This controller as the same as the Numark Mixtrack Pro but without a built-in sound card. It has been discontinued and
succeeded by the Numark Mixtrack 3.

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.8.2.

Mapping Description

1. USB cable
2. Channel Treble
3. Channel Mid
4. Channel Bass
5. Cue: send the corresponding track to the headphones
6. Cue Gain: adjust audio level of cue channel
7. Cue Mix: adjust mix between Cue and Audio out in the headphones.
8. Browser Knob: help browse through your collection without using a mouse or trackpad
9. Back: takes you up one level in your file hierarchy
10. Load A/Load B: Load the highlighted track to the corresponding Deck
11. Channel faders: control the volume of each channel
12. Master fader: adjust the output volume of mixxx
13. Crossfader
14. Jog Wheels (see below for details)
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Figure31: Numark Mixtrack (schematic view)

15. Scratch mode (see below for details)
16. Play/Pause
17. Stutter: press while music is playing to jump back to the cue point
18. CUE: plays from the cue point if hold. When released, jumps back to the cue point
19. SYNC: automatically matches the corresponding Deck’s tempo to the other Deck’s tempo
20. Pitch Faders
21. Pitch Bend: when pressed, the pitch will adjust -/+4%, when released, the tempo will set back to the right one
22. Keylock
23. View: dynamically set cue point for Deck A
24. Tick: dynamically set cue point for Deck B
25. Eq Kill Switches
26. Effect On/Off: turn on/off the flanger effect
27. On Deck A: control the Flagner’s LFO (unassigned on Deck B)
28. On Deck A: control the Flagner’s Depth and delay (unassigned on Deck B)
29. Loop Mode: press to alternate between manual or autolooping

• Manual Looping
– In: set loop start
– Out: set loop end
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– Reloop: exit or reenter loop
• Auto Looping

– 1/2 X: divide loop length by 2
– 1 Bar: make a loop of just one bar (the current one)
– 2 X: multiply loop length by 2

The Jogs

Not in scratch mode

When not in scratch mode, touching the jogs won’t pause the song. Turning them will slightly adjust the tempo, which
will resume slowly to its speed. This slowness to resume is somehow equivalent to what you would expect from drivebelt
turntables. I hate it, and I have not found a way to correct it… This is why I mostly mix using the pitch bend buttons,
which allow for an instant resume to the “pitch slider assigned” pitch for the track.

In scratch mode

In scratch mode, touching the jogs will pause the song. The jogs are very sensitive, and allow for scratching and launching
tracks on a given moments when “cueing them in your headphones”. Be very careful with this: never remain in scratch
mode if not needed, you will touch the jogs by error and put your tracks out of sync because one has pause, or worse,
produce a “blank”.

Known problems

• The pitch on the controller has a very short run. Thus, having it configured as a +10/-10 (or more) is tricky because
you will get a very low pitch precision. Configuring it as +8/-8 (Mk2 style) is highly recommended

• The autolooping functions, although implemented are quite flawed. The “loop one bar”, which is present since the
1.0b version, is making a loop between two bars, which are rarely fitted on real “measures”. As of mixxx 1.9, there
is no possibility to adjust the bars to make them fit perfectly to the tempo

• Pressing play while “cue previewing” should start the track for real, CDJ style. This is not implemented yet, and is
marked as a TODO in Mixxx code, so it is unlikely to get implemented on the controller mapping side. *NOTE:
If you use the mapping included with the software, this feature is supported. Controls in this mapping are different
than the community made one, so be careful.*

• Final remark on the hardware design: be very, very careful not to press the “Load A” or “Load B” button, instead
of the corresponding track’s “cue” button. They are very near, the error is easy and produces the most dire effect
in a party: an awful blank !
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17.1.80 Numark Mixtrack Platinum

• Manufacturer’s product page
• Forum thread

The Numark Mixtrack Platinum is a 2 channel (with 4 channel layering) entry level DJ controller with an integrated audio
interface. The stand out feature of the Mixtrack Platinum is the LCD displays integrated into the jog wheels. It is a USB
Audio and MIDI Class compliant device and works with Linux, macOS, and Windows.
Baru pada versi 2.2.

Audio interface

Configure Mixxx’s Master output for channels 1-2 and Headphones output for Channels 3-4.
The microphone input on this controller is not available to the computer through the controller’s audio interface. It is
mixed with the master output in hardware, so this controller’s audio interface is not suitable for broadcasting or recording
the inputs. If you want to use the controller for broadcasting or recording, a separate audio interface with a microphone
input is suggested.

Configuration Options

Configuration options can be set in the mapping. You will need to edit the values below at the very top of the JavaScript
file Numark-Mixtrack-Platinum-scripts.js and save changes. Allowed values are “true” or “false” unless
specified.

• EnableWheel: if true, wheel/vinyl mode will be enabled by default (defaults to true)
• ShowTimeElapsed: if true, time elapsed will be show by default on the displays, otherwise time remaining will
be displayed (defaults to true)

• UseManualLoopAsCue: if true, the manual loop controls will behave as hotcues 5-8. When enabled, the normal
loop control behavior can be activated using shift+pad mode+mode button and pad mode+mode to use the hotcue
behavior (defaults to false)

• UseAutoLoopAsCue: if true, the auto loop controls will behave as hotcues 5-8. When enabled, the normal
loop control behavior can be activated using shift+pad mode+mode button and pad mode+mode to use the hotcue
behavior (defaults to false)

• UseCueAsSampler: if true, the hotcues will control sampler slots 5-8when samplermode is active. When enabled,
the normal hotcue control behavior can be activated using shift+pad mode+sampler while pad mode+sampler will
activate the special behavior (defaults to false)

• ShiftLoadEjects: if true, pressing shift + load will eject a track (defaults to false)

Mapping

1. Browse Knob: Rotate this knob clockwise to scroll down, counter clockwise to scroll up. Press the Knob to load
tracks into the inactive deck, expand entries in the library view, and select playlists and crates.
Shift + Turn: Page down/page up, allows you to scroll by page instead of by item.
Shift + Push: Focus next library pane, allows you to toggle between the left and right panes.

2. Master Gain: Adjusts the master volume in the software.
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Figure32: Numark Mixtrack Platinum (schematic view)

Note: This control does not affect the microphone volume which is summed with the final output of the Master Gain to
the Master Output. Use the Mic Gain knob to control the microphone volume.

3. Cue Mix: Adjusts the software’s audio output to the headphones, mixing between the cue (PFL) output and the
master mix output.

4. Cue Gain: Adjusts the volume for headphone cueing in the software.
Shift+Cue Gain: adjust the volume of the first 8 sampler banks

5. VUMeter: Monitor the volume levels of the master output and each channel. When cue/pfl is active on ANY channel,
the meter shows the mono levels each channel (left meter shows the deck on the left, right meter for the deck on the right).
Otherwise the meter shows the stereo levels of the master output.

6. Load: Press one of these buttons while a track is selected in the library window to assign it to Deck 1 and 2 (or 3 and
4), respectively, in the software.
Shift + Load: Load the track and play (or if the ShiftLoadEjects option is set, eject the track)

7. Gain Knobs: Adjust the gain of the deck.
Shift + Gain: Adjust parameter 2 of the currently focused effect on this deck.

8. High EQ Knobs: Adjust the volume of the high frequencies of the deck.
Shift + High: Adjust parameter 3 of the currently focused effect on this deck.

9. Mid EQ Knobs: Adjust the volume of the mid frequencies of the deck.
Shift + Mid: Adjust parameter 4 of the currently focused effect on this deck.
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10. Low EQ Knobs: Adjust the volume of the low frequencies of the deck.
Shift + Low: Adjust parameter 5 of the currently focused effect on this deck.

11. Filter: Adjusts the amount of the filter effect. Turning the knob left controls the low pass filter; turning it right
controls the high pass filter. The effect applied here can be configured (the Quick Effect option in the Equalizer
preferences).
Shift + Filter: With no effect focused, this controls the Superknob of the effects unit. With an effect focused, this
adjusts parameter 1 of the currently focused effect on this deck.

12. Cue/PFL/Headphones: Sends pre-fader audio to the headphone output. If any channels have the cue button active,
the VU meter will show channel output levels instead of master output levels on all decks.
13. Volume fader: Adjusts the volume of the deck.
14. Crossfader: Controls the blend between the two decks.

15-16. Pitch Bend Down/Up: Press and hold to momentarily reduce the speed of the track.
Shift + Pitch Bend: adjust the key of the playing track up or down. Press both buttons to reset the key.
Pitch Bend Up + Pitch Bend Down: toggle keylock

17. Pitch Fader: Adjust the speed of the music (activate keylock to adjust tempo without affecting pitch). Note that
moving the fader down increases speed, as marked by the “+” at the bottom of the fader on the controller. This can be
reversed in Mixxx’s preferences under Interface > Speed slider direction.

18. Touch Strip: Use the Touch Strip to adjust the deck’s Effect Unit Superknob. When an effect is focused, the touch
strip controls that effect’s meta knob.
Shift + Touch Strip: search through a track’s timeline

19. Beats Knob: Adjusts the Dry/Wet mix of the deck’s Effect Unit.

20. FX 1 On/Off: Toggle FX 1 of the deck’s Effect Unit
Shift + FX 1: Cycle to the next effect.
Hold + FX 1: Enable this effect in instant mode, after the button is released the effect will be disabled again.
Tap + FX 1: Focus this effect to allow adjusting its metaknob with the touch strip.

21. FX 2 On/Off: Toggle FX 2 of the deck’s Effect Unit
Shift + FX 2: Cycle to the next effect.
Hold + FX 2: Enable this effect in instant mode, after the button is released the effect will be disabled again.
Tap + FX 2: Focus this effect to allow adjusting its metaknob with the touch strip.

22. FX 3 On/Off: Toggle FX 3 of the deck’s Effect Unit
Shift + FX 3: Cycle to the next effect.
Hold + FX 3: Enable this effect in instant mode, after the button is released the effect will be disabled again.
Tap + FX 3: Focus this effect to allow adjusting its metaknob with the touch strip.
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23. Tap BPM: Press this button several times on beat to manually enter a new BPM. The software will ignore the
track’s BPM and follow your manually entered tempo.
24. Wheel button: If active you can use the platter/jog wheel to grab and move the audio, scratching the track like a
vinyl record.
Shift + Wheel: Toggle elapsed time or time remaining on the deck’s display.

25. Platter/Jog Wheel: If Wheel is enabled, touching the platter will result in vinyl scratching, when disabled, nothing
will happen and the entire jog wheel behaves as if the side was touched.
Touch side: Pitch bend (nudging) if track is playing
Shift + Touch platter: Quickly scroll through the track
Shift + Touch side: Beat jump
26. Jog Wheel Display: The display is fully functional with this mapping. It will display the position of the spinner,
play position, bpm, and keylock status.

27. Deck Switch: Allows switching between decks 1/3 and 2/4.
28. Shift: Allows alternate options to be activated for various controls.

29. Sync: Set the BPM of this deck to match the opposite deck. Press: Press once to synchronize the tempo (BPM) to
that of to that of the other track
Long Press: Enable master sync. Press again to disable.
Shift + Sync: Toggle quantize mode.

30. Cue (Transport Control): Behavior depends on the cue mode set in the Mixxx preferences.
Shift + Cue: return the play head to the start of the track and stop the deck.

31. Play/Pause: Starts and stops playback.
Shift + Play/Pause: stutter the track from the last set cue point. If a cue point has not been set, the play head will
return to the start of the track.

32. Pad Mode: Hold this button to see the currently selected pad mode, while holding select between Manual Loop,
Auto Loop, and Sampler modes. Additionally control of hotcues 5-8 can be activated using shift+pad mode+loop mode
(either manual or auto loop). Setting either of the UseManualLoopAsCue or UseAutoLoopAsCue options will
reverse the selection of hotcue vs loop mode when shift is held.
Pad Mode+Manual Loop: set the top row of pads to manual loop control mode (see below)
Pad Mode+Auto Loop: set the top row of pads to auto loop/loop roll control mode (see below)
Pad Mode+Sampler: set the top row of pads to sampler control mode (see below)
Shift+Pad Mode+Manual Loop: set the top row of pads to control hotcues 5-8 (see below)
Shift+Pad Mode+Auto Loop: set the top row of pads to control hotcues 5-8 (see below)
Shift+Pad Mode+Sampler: set the bottom row of pads to control sampler banks 5-8 (see below)

33. Performance Pads:
The top row of pads is for controlling loops and samples. To select a mode, hold down the Pad Mode button and press
one of the upper pads. An LED under the pad section indicates the currently selected mode. See the subsections below
for details about each mode.
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The bottom row of pads is used to trigger hotcue points. If a hotcue point has not already been set for the loaded track,
this control will mark the hotcue point. If a hotcue point has already been set, this control will jump to it.
Shift + Hot Cue: Deletes the assigned hotcue point

Note: the top row can be made to control hotcues 5-8 using shift+pad mode+loop mode (being Auto Loop or Manual
Loop). This can also be made the default using a config option (see documentation above and below).

Manual Loop Mode

Hold Pad Mode and press the pad marked Manual Loop (silkscreened above the pad) to assign the upper 4 pads to the
functions listed below:

• Loop In – Sets the beginning of a loop: When assigned, the Pad LED will light blue
• Loop Out – Sets the end point for the loop: When assigned, the Pad LED will light blue
• On/Off – (De)activate the loop. If a loop has not been set, this button will have no effect.: When assigned, the Pad
LED will light blue

• Loop x1/2 – Halve the length of the loop. Press Shift + Loop x1/2 to double the length of the loop. Note that this
does not update the beatloop size shown on screen.

If Manual Loop is selected with Shift and Pad Mode held down this will activate control of hotcues 5-8 on the upper row
instead of the looping controls. Select Manual Loop again while holding Pad Mode to restore the default behavior. There
will be no indication of which mode is selected (beyond the LEDs on the keys themselves, which will vary depending on
loop and hotcue status). The UseManualLoopAsCue config option can be set in the mapping file (see above) to swap
the default “shadow” mode of the looping controls such that hotcue control will be the default and manual loop control
with be selected when Shift is used.

Auto Loop Mode

Hold Pad Mode and press the pad marked Auto Loop to assign the upper 4 pads to the functions listed below:
* Auto 1: – Sets and starts playback of a 1-beat autoloop.

• Auto 2: – Sets and starts playback of a 2-beat autoloop.
• Auto 3: – Sets and starts playback of a 4-beat autoloop.
• Auto 4: – Sets and starts playback of a 8-beat autoloop. * Shift + Auto 1: – When held, starts a 1/16-beat loop
roll.

• Shift + Auto 2: – When held, starts a 1/8-beat loop roll.
• Shift + Auto 3: – When held, starts a 1/4-beat loop roll.
• Shift + Auto 4: – When held, starts a 1/2-beat loop roll.

Note: loop rolls activate slip mode so the play position continues to advance normally, such that when the loop is released,
play continues from the place it would have been if no loop had been activated.
If Auto Loop is selected with Shift and Pad Mode held down this will activate control of hotcues 5-8 on the upper row
instead of the looping controls. Select Auto Loop again while holding Pad Mode to restore the default behavior. There
will be no indication of which mode is selected (beyond the LEDs on the keys themselves, which will vary depending on
loop and hotcue status). The UseAutoLoopAsCue config option can be set in the mapping file (see above) to swap the
default “shadow” mode of the looping controls such that hotcue control will be the default and auto loop control with be
selected when Shift is used.
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Sample Mode

Hold Pad Mode and press the pad marked Sampler to enter sampler mode (hold down shift as well to control slots 5-8
using the hotcue buttons). A press of any of the sample buttons will load a sample if the sampler is not loaded. Shift +
sample pad will unload a sample if it is not playing. Pressing a pad when a sample is loaded will play the sample, pressing
shift + sample pad while a sample is playing will stop it.
Use shift+cue gain to adjust the volume of the sampler. When switching to the pad mode to sampler, hold down shift
to control slots 5-8 using the hotcue buttons.
Note: the 8 sample slots on each deck all control the same 8 slots in Mixxx no matter which deck the sampler is active on.
This is because the controller sends the same MIDI codes for button presses on each side, so there is no way for Mixxx
to tell whether a sampler button was pressed on the left or right side of the controller.

17.1.81 Numark Mixtrack Pro

This is the same as theNumarkMixtrackwith the addition of an integrated sound card. This product has been discontinued
and succeeded by the Numark Mixtrack Pro 3.

• Manufacturer’s product page
Baru pada versi 1.8.2.

Mapping Description

Figure33: Numark Mixtrack Pro (schematic view)

1. USB: This USB connection sends and receives control information to/from a connected computer.
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2. CHANNEL TREBLE: Adjusts the high (treble) frequencies of the corresponding channel.
3. CHANNEL MID: Adjusts the mid-range frequencies of the corresponding channel.
4. CHANNEL BASS: Adjusts the low (bass) frequencies of the corresponding channel.
5. CUE: Sends pre-fader audio to the Cue Channel for headphone monitoring.
6. CUE GAIN: Adjusts the audio level of the Cue channel.
7. CUE MIX: Turn to mix between Cue and Program in the Headphone channel. When all the way to the left, only

channels routed to CUE will be heard. When all the way right, only the Program mix will be heard.
8. BROWSE KNOB: Turn this knob to scroll through lists of tracks / library. When a file is selected, press the knob

to load the currently highlighted song into the first stopped deck.
9. BACK: This button will switch the Browse Knob to scroll into the track list (FILE LED will illuminate) or into

the library section (FOLDER LED will illuminate).
10. LOAD A / LOAD B: Press one of these buttons while a track is selected to assign it to Deck A or Deck B,

respectively. *Only if the track is paused. Put the pitch in 0% at load(without mattering where the slider is).
11. CHANNEL FADER: Adjusts the audio level on the corresponding channel.
12. MASTER FADER: Adjusts the output volume of the Program mix.
13. CROSSFADER: Blends audio playing between Decks A and B. Sliding this to the left plays Deck A and sliding

to the right plays Deck B.
14. JOG WHEEL: When the deck is playing, the JOG WHEEL will bend the track’s pitch. When the SCRATCH

button is on, touching the top of the JOG WHEEL will scratch the selected track (can do backspin effect), and
touching the border of the JOG WHEEL will bend the track’s pitch. When the deck is not playing, rotating the
JOG WHEEL will scan through the track.

15. SCRATCH: Turns Scratch Mode on or off. If Scratch Mode is on, the button will light up and the JOG WHEEL
will scratch like a turntable when you spin it.

16. PLAY / PAUSE: Starts or resumes playback if the Deck is paused. Pauses playback if the Deck is playing. LED
ON when playing. LED OFF when stopped.

17. STUTTER: Adjust BeatGrid in the correct place (useful to sync well). *LED Blink at each Beatof the grid.
18. CUE: The CUE button will return and pause the track at the last set cue point. For temporary play of the cue

point, you can hold down the CUE button. The track will play for as long as the button is held down and will return
to the cue point once it has been released (Until it has been pressed PLAY before release CUE, then playback will
continue). LED ON when stopped. LED OFF when playing. *LED Blink at each Beat in the last 30 seconds
of song. *Don’t set Cue accidentally at the end of the song (return to the latest cue).

19. SYNC: Automatically matches the corresponding Deck’s tempo and phase with the other Deck. *If the other
deck is stopped, only sync tempo (not phase). *LED Blink at Clip Gain(Peak indicator). ***Pressing
DELETE**before SYNC: Set Pitch to 0%.

20. PITCH FADER: Controls the track’s playback speed. An LED next to the fader will light up when set at 0%.
* Pitch slide are inverted, to match with the screen(Up: +, Down: -, otherwise is very confusing). *** Soft-
takeover to prevent sudden wide parameter changes**when the on-screen control diverges from a hardware control.
The control will have no effect until the position is close to that of the software, at which point it will take over and
operate as usual.

21. PITCH BEND ( + / – ): Press or hold down either of these buttons to temporarily adjust the track’s playback
speed. When released, the track playback will return to the speed designated by the PITCH FADER.

22. KEYLOCK: This feature allows you to change the speed of the song without changing the key.
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23. HOT CUE BUTTONS (1-3): Assigns a Cue Point or returns the track to that Cue Point. When a HOT CUE
BUTTON is unlit, you can assign a Cue Point by pressing it at the desired point in your track. Once it is assigned,
the HOT CUE BUTTON will light. To return to that Cue Point, simply press it. *Pressing DELETE before HOT
CUE: Clear Hotcue.

24. DELETE: Press this to enable second functions to some buttons (LED on). On having pressed another button,
it is deactivated and LED turn off. Combinations: Delete + EFFECT: Brake Effect (maintain pressed). Flanger
Delay (Left. EFFECT CONTROL): Adjust the speed of Brake. Delete + HOTCUE: Clear Hotcue. Delete +
RELOOP: Clear Loop. Delete +MANUAL: Set Quantize ON (for best manual loop) or OFF. Delete + SYNC:
Set Pitch to 0%.

25. EFFECT:Activate / deactivate Flanger. SELECT modify the Depth and LEFT. EFFECT CONTROL change the
Delay. *Pressing DELETE before EFFECT: Brake (maintain pressed). Adjust Speed with Flanger Delay (Left.
EFFECT CONTROL).

26. EFFECT SELECT:Modify the Depth of Flanger effect, which will be displayed in the software.
27. LEFTEFFECTCONTROL:Modify the Depth of Flanger effect, which will be displayed in the software. *Used

for change the speed of Brake effect too. RIGHT EFFECT CONTROL: Gain control of the deck (up to clip).
28. MODE: Press this to switch between Autoloop Mode and Manual Mode, which changes the functions of the

LOOP CONTROL buttons. *Pressing DELETE before MODE: Set Quantize ON (for best manual loop), or
OFF. Autoloop Mode (LED ON): • 1/2 X: Press this to halve the length of the loop. • 1 BAR: Press this to set a
4 beat loop automatically and enable it (LED ON). Press again to exit loop. • 2 X: Press this to double the length
of the loop. Manual Mode (LEDOFF): • IN: Press this to set a “Loop In” point where your loop will begin (LED
ON). • OUT: Press this to set a “Loop Out” point where your loop will end, and enable it (LED ON). • RELOOP:
If the Deck is already looping when you press it (LED ON), exit loop. If not, jump to the start of the loop and
enable it. (If no loop is set, nothing will happen.) *Pressing DELETE before RELOOP: Clear Loop.

29. OUTPUT 1 (RCA): This stereo RCA connection will output the Master Mix from your computer. Please use a
stereo RCA cable to connect this output to a powered speaker or amplifier system.

30. OUTPUT 2 (RCA): This stereo RCA connection will output the Cue Channel from your computer for monitoring
purposes. Please note that the Cue Channel is also output through the HEADPHONES output on the front panel.

31. HEADPHONES: This stereo 1/4" output will output the signal being routed to the Cue Channel.
32. MIC GAIN: This knob controls the microphone level being sent to the Master Mix.
33. MIC THROUGH: This is a 1/4" microphone input. The signal from this input will be sent directly to the Master

Mix.

Known problems

• The pitch on the controller has a very short run. Thus, having it configured as a +10/-10 (or more) is tricky because
you will get a very low pitch precision. Configuring it as +8/-8 (Mk2 style) is highly recommended.

• Each slide/knob needs to be moved on Mixxx startup to match levels with the Mixxx UI.
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17.1.82 Numark Mixtrack (Pro) 3

• Manufacturer’s product page
• Manufacturer's User Manual
• Forum thread

The NumarkMixtrack 3 and NumarkMixtrack Pro 3 are the same controller except that the Pro version has an integrated
4 channel output sound card and costs $50more. If you use the non-Pro version, you would need a splitter cable or separate
audio interface to be able to preview tracks in headphones.
The microphone input on the Pro version is not available to the computer through the controller’s sound card. It is mixed
with the master output in hardware, so this controller’s sound card is not suitable for broadcasting or recording the inputs.
If you want to use the controller for broadcasting or recording, getting the non-Pro version with a separate audio interface
with a microphone input is suggested.
Baru pada versi 2.1.

Configuration options

Configuration options can be set in the mapping. You will need to edit the values below at the very top of the JavaScript
file “Numark-Mixtrack-3-scripts.js” and save changes. Allowed values are “true” or “false” unless specified.

• TrackEndWarning: whether the Wheel button flashes near the end of a track
• iCutEnabled: whether to enable iCut with the jog wheel. See #platter/jog wheel section for details
• fastSeekEnabled: whether to enable fast seeking with the jog wheel. See #platter/jog wheel section for details
• smartPFL: When the Load button is used, the Cue/PFL button is automatically activated on the deck being loaded
and deactivated on the other deck

• beatlooprollActivate: Use beatlooproll (slip mode loop) instead of beatloop command when using pads in Au-
toloop mode

• DarkMetalSkin: Specify if Dark Metal skin is used for your installation. This is required in order for Expand
Library feature to work properly.

• FXMode: Select FX Mode based on skin used:
– value “1”: (Deere skin): Each deck is assigned its own Effect Unit with 3 effects per deck (e.g. Deck 1 =
Effect Unit 1, Deck 2 = Effect Unit 2, etc…\

– value “2”: (other skins): FX button 1 = Effect Unit 1, Effect 1, FX Button 2 = Effect Unit 2, Effect 1, FX
button 3 = Effect Unit 3, Effect 1. Effect settings are shared by each deck.\

• PitchBendOnWheelOff: allow nudge with wheel when wheel is not active.
• noPlayOnSyncDoublePress: Specify if Play is disabled on Sync button Double Press.
• ShiftFilterFX4: Specify Shift+Filter control behavior - FX parameter 4 (true) or Channel Gain (false)
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Mapping Description
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Figure34: Numark Mixtrack (Pro) 3 (schematic view)

1. Browser Knob

Rotate this knob to cycle through tracks in main library window. Press the Knob to expand library view.
SHIFT + Turn: allows selecting Play Lists and side navigation bar items.
SHIFT + Push: opens / closes selected side navigation bar item.

2. Master Gain

Adjusts the master volume in the software.
Note: This control does not affect the microphone volume which is summed with the final output of the Master Gain to
the Master Output. Use the Mic Gain knob to control the microphone volume.
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3. Cue Mix

Adjusts the software’s audio output to the headphones, mixing between the cue (PFL) output and the master mix output.

4. Cue Gain

Adjusts the volume for headphone cueing in the software.

5. Load

Press one of these buttons while a track is selected in the library window to assign it to Deck 1 and 2, respectively, in the
software.
SHIFT + LOAD: Activates Fader Start mode for the corresponding (PFL Button is then blinking). Fader start guide: In
fader start mode, not only you can press the play/pause button to play/pause the track, but if you move up the level fader
(the volume fader if you prefer) of the deck, the track will be played and if you close it to zero, the track will be paused.
Configurable option:
If the smartPFL option is set to true, the Cue/PFL button is automatically activated on the deck being loaded and
deactivated on the other deck.

6. High EQ Knobs

Adjust High frequencies of the deck
SHIFT + HIGH: Adjust parameter 1 of the currently focused effect on this deck.

7. Mid EQ Knobs

Adjust Mid frequencies of the deck
SHIFT + MID: Adjust parameter 2 of the currently focused effect on this deck.

8 Low EQ Knobs

Adjust Low frequencies of the deck
SHIFT + LOW: Adjust parameter 3 of the currently focused effect on this deck.

9. Filter

Adjusts the amount of the filter effect. Turning the knob left controls the low pass filter; turning it right controls the high
pass filter.
SHIFT + FILTER: Adjust parameter 4 of the currently focused effect on this deck.
If effect is unfocused then;
SHIFT + FILTER Adjust the gain of the deck.
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10. Cue/PFL/Headphones

Sends pre-fader audio to the headphone output
SHIFT + CUE/PFL: Toggle quantize mode

11. Volume fader

Adjusts the volume of the deck

12. Crossfader

Controls the blend between the two decks

13-14. Pitch Bend Down/Up

Press and hold to momentarily reduce the speed of the track.
SHIFT + PITCH BEND -/+: Jump 1 beat backward/forward

- If loop is activated, move loop by beatjump amount instead.

15. Pitch Fader

Adjust the speed of the music (activate keylock to adjust tempo without affecting pitch). Note that moving the fader
down increases speed, as marked by the “+” at the bottom of the fader on the controller. This can be reversed in Mixxx’s
preferences under Interface > Speed slider direction

16. Touch Strip

Use the Touch Strip to adjust the deck’s Effect Unit Superknob. If Effects are assigned to Instant FX , they will be
enabled instantly on touch, and disabled on finger lift.
SHIFT + Touch Strip: search through a track’s timeline

17. Beats Multiplier

Adjusts the Dry/Wet mix of the deck’s Effect Unit
TAP + BEATS: Moves the beat grid left (turn counterclockwise) or right (turn clockwise)
SHIFT + BEATS: Adjust beatjump amount
PADMODE + BEATS: Adjust Sampler Volume. Left beat knob will adjust Samplers 1-4; Right knob will adjust
Samplers 5-8
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18. FX 1 On/Off

Turns FX1 on and off
SHIFT + FX1: Select from the list of available effects for the respective effect.
PADMODE + FX1: Assign / unassign FX 1 to Instant FX. When assigned to Instant FX, the FX is instantly activated by
touching the Strip and stopped when finger is lifted.
TAP + FX1: Focus this effect to allow adjusting its metaknob with the touch strip.

19. FX 2 On/Off

Turns FX2 on and off
SHIFT + FX2: Select from the list of available effects for the respective effect.
PADMODE + FX2: Assign / unassign FX 1 to Instant FX. When assigned to Instant FX, the FX is instantly activated by
touching the Strip and stopped when finger is lifted.
TAP + FX2: Focus this effect to allow adjusting its metaknob with the touch strip.

20. FX 3 On/Off

Turns FX3 on and off
SHIFT + FX3: Select from the list of available effects for the respective effect.
PADMODE + FX3: Assign / unassign FX 1 to Instant FX. When assigned to Instant FX, the FX is instantly activated by
touching the Strip and stopped when finger is lifted.
TAP + FX3: Focus this effect to allow adjusting its metaknob with the touch strip.

21. Tap BPM

Press this 8 or more times on beat to manually enter a new BPM. The software will ignore the track’s BPM and follow
your manually entered tempo.
SHIFT + TAP: Toggles deck between deck 1-3 (left side) or deck 2-4 (right side). TAP LED will be RED when deck 3
is active (Left Tap) or deck 4 is active (Right Tap)
TAP + HOTCUE 1: Activates Brake effect
TAP + HOTCUE 2: Activates Spinback effect
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22. Wheel button

Activate this button to use the platter/jog wheel to grab and move the audio, scratching the track like a vinyl record.
SHIFT + WHEEL: Toggle slip mode on/off

23. Platter/Jog Wheel

Touch side: Pitch bend (nudging) if track is playing (Wheel On (always) & Wheel Off - if PitchBendOnWheelOff
configuration option is true) and / track positioning (Wheel On)
WHEEL On + Touch platter: scratching: touch the platter and move it
WHEEL Off + Touch platter: If track is not playing, allows positioning the track
SHIFT + WHEEL Off + Touch platter: fast seek through track
SHIFT + WHEEL On + Touch platter: iCut mode: simulates a scratch routine with the jog wheel. When the jog
wheel is turned back, the crossfader closes; when the jog wheel is turned forward the crossfader will open. As a visual
reference, TAP LED and Wheel button LED will be ON.

Configuration Options: The iCutEnabled and fastSeekEnabled options can be used to turn off iCut and fast seeking.
These options may be helpful to avoid accidentally using these features when touching the platter with shift lock on.

24. Shift

Allows multiple control commands to be triggered when pressed first along with other buttons

25. Pad Mode

This is used to change the operation mode of the top 4 performance pads. Pressing this button will light the pad indicating
the currently active mode (Manual Loop, Auto Loop or Sampler).

26. Sync

Enables BPM syncing between decks.
Short Press: Press once to synchronize the tempo (BPM) to that of to that of the other track
Double Press: press twice QUICKLY to play the track immediately synchronized to the tempo (BPM) and to the phase
of the other track, if the track was paused
Long Press (Sync Lock): Hold for at least half of a second to enable sync lock for this deck. Decks with sync locked
will all play at the same tempo, and decks that also have quantize enabled will always have their beats lined up. If the
Sync Lock was previously activated, it just deactivates it regardless of the Short press/Double Press
SHIFT + SYNC: Toggle Key Lock

Configuration Options: The noPlayOnSyncDoublePress option can be used to turn off Play on Sync Double Press.
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27. Cue (Transport Control)

Behavior depends on the cue mode set in the Mixxx preferences.
SHIFT + CUE: Return the play head to the start of the track.

28. Play/Pause

Starts and suspends playback. If no track is loaded, loads the selected track (if any) and play.
SHIFT + PLAY/PAUSE: Stutter the track from the last set cue point. If a cue point has not been set, the play head will
return to the start of the track.

29. Performance Pads

The top row of pads is for controlling loops and samples. To select a mode, hold down the Pad Mode button and press
one of the upper pads. An LED under the pad section indicates the currently selected mode. See the subsections below
for details about each mode.

The bottom row of pads is used to trigger hotcue points. If a hotcue point has not already been set for the loaded track,
this control will mark the hotcue point. If a hotcue point has already been set, this control will jump to it.
SHIFT + HOTCUE: Deletes the assigned hotcue point

Manual Loop Mode

Hold PADMODE and press the pad marked Manual Loop (silkscreened above the pad) to assign the lower 4 pads to the
functions listed below:

• Loop In – Sets the beginning of a loop: When assigned, the Pad LED will light blue
• Loop Out – Sets the end point for the loop: When assigned, the Pad LED will light blue
• On/Off – (De)activate the loop. If a loop has not been set, this button will have no effect.: When assigned, the Pad
LED will light blue

• Loop x1/2 – Halve the length of the loop. Press SHIFT + Loop x1/2 to double the length of the loop. x1/2 button
is disabled unless the corresponding deck is set to be quantized

Auto Loop Mode

Hold Pad Mode and press the pad marked Autoloop to assign the lower 4 pads to the functions listed below: When
assigned, the respective Pad LED will blink Yellow

• Auto 1 – Sets and starts playback of a 2-beat autoloop.
• Auto 2 – Sets and starts playback of a 4-beat autoloop.
• Auto 3 – Sets and starts playback of a 8-beat autoloop.
• Auto 4 – Sets and starts playback of a 16-beat autoloop.
• SHIFT + Auto 1 – Sets and starts playback of a 1/8-beat autoloop.
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• SHIFT + Auto 2 – Sets and starts playback of a 1/4-beat autoloop.
• SHIFT + Auto 3 – Sets and starts playback of a 1/2-beat autoloop.
• SHIFT + Auto 4 – Sets and starts playback of a 1-beat autoloop.

If the pad is held down more than .5 second (Long Press), the Autoloop will be disabled once pad is released. On Short
Press, the pad will behave as a normal button (ON on first press, OFF on second press)

Sample Mode

Hold Pad Mode and press the pad marked Sampler to assign the lower 4 pads to the functions listed below. When
assigned, the respective Pad LED will blink Purple
Shift + Sample X will play loaded sample, but with Sampler unit Sync disabled

• Deck 1 - Sample 1 – Plays the sample assigned to Sample Pad 1 with the unit Sync activated.
• Deck 1 - Sample 2 – Plays the sample assigned to Sample Pad 2 with the unit Sync activated.
• Deck 1 - Sample 3 – Plays the sample assigned to Sample Pad 3 with the unit Sync activated.
• Deck 1 - Sample 4 – Plays the sample assigned to Sample Pad 4 with the unit Sync activated.
• Deck 2 - Sample 1 – Plays the sample assigned to Sample Pad 5 with the unit Sync activated.
• Deck 2 - Sample 2 – Plays the sample assigned to Sample Pad 6 with the unit Sync activated.
• Deck 2 - Sample 3 – Plays the sample assigned to Sample Pad 7 with the unit Sync activated.
• Deck 2 - Sample 4 – Plays the sample assigned to Sample Pad 8 with the unit Sync activated.

If the pad is held down more than .5 second (Long Press), the sampler will be disabled once pad is released. On Short
Press, the pad will behave as a normal button (ON on first press, OFF on second press)

• Load sample by selecting track and pressing Sample X
• Pressing sample button when sample is already playing goes back to cue and plays
• Shift + sample to stop sample
• Eject sample by TAP + Sample X

30. Master Output LEDs

Displays the audio level going to the Master Output.

17.1.83 Numark Mixtrack Pro FX

Manufacturer's product page · Manufacturer's user manual · Forum thread
Baru pada versi 2.3.1.
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Overview
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See the tables below for controls descriptions.

Misc

# Name Function
1 BROWSE (rotate) Browse library
1 SHIFT + BROWSE (ro-

tate)
Zoom in/out waveform summary

1 BROWSE (press) Switch between tree and track list
1 SHIFT + BROWSE

(press)
Select item (collapse/extend tree branch or load track)

2 MASTER Adjust the volume level of master output. Does not affect the microphone volume
(adjusted separately with the MIC knob)

3 MIC Adjust the volume level of microphone input. Note that the microphone input is
mixed in hardware, so the corresponding GUI knob does not reflect the hardware
knob state.

4 CUE MIX Head/mix knob. Adjust the audio output to the headphones, mixing between the
cue output and the main mix output

5 CUE GAIN Adjust the headphone volume
15 Crossfader Controls the mix between the two decks
23 BPM Tap repeatedly to enter a new BPM on both decks
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Deck

Each of those controls exists in both decks and affects only the corresponding deck.

# Name Function
6 Main level meter Displays the audio level going to the main output
7 LOAD Load selected track
7 ·· INSTANT DOUBLES

(2x LOAD)
Load track from the opposite deck and seek to the same position. Deck cloning
must be enabled in Mixxx settings (Settings -> Preferences -> Decks -> Double-
press Load button to clone playing track).

8 LEVEL Adjust the pre-fader, pre-EQ audio level
9 TREBLE Adjust high frequencies
10 MID Adjust middle frequencies
11 BASS Adjust low frequencies
12 FILTER Adjust the filter effect
13 CUE Headphone button. Toggle sending channel to the cue (headphone) channel
14 Channel fader Adjust volume level
16 PITCH BEND - (hold) Temporarily reduce the speed of the track
16 PITCH RANGE

(SHIFT + PITCH BEND -
)

Change pitch range. Ranges are configurable in the script file, see Adjustable
values section.

17 PITCH BEND + (hold) Temporarily increase the speed of the track
17 KEYLOCK

(SHIFT + PITCH BEND
+)

Toggle key lock

18 Pitch fader Adjust the speed of the track
24 Jog wheel (top) If scratch mode is enabled (see the SCRATCH button below): scratch

If scratch mode is disabled: pitch bend
The behavior of jogwheel can be fine-tuned, see the Adjustable values section.

24 Jog wheel (edge) Pitch bend
24 SHIFT + jog wheel Seek track
25 SCRATCH Toggle scratch mode. Enabled by default.
25 BLEEP

(SHIFT + SCRATCH)
(hold)

Play the track in reverse, then release to continue playback from a point where the
track would have been if it had not been reversed

26 SHIFT Hold and then manipulate other controls to activate their secondary functions
27 SYNC If sync lock is disabled: set BPM to the other deck's BPM

If sync lock is enabled: disable sync lock
27 SYNC (hold, then release) Enable sync lock
27 SYNC OFF

(SHIFT + SYNC)
Toggle quantization

28 CUE If track is playing: stops the track and resets position to the main cue point
If playback is stopped: sets the main cue point

28 CUE (hold) Play the track frommain cue point, release to stop playback and return to the main
cue point. Playback must be initially stopped on main cue point.

28 SHIFT + CUE Stop the playback and return to the beginning of the track
29 Play/Pause Play/pause playback
29 SHIFT + Play/Pause Toggle reverse playback
35 LOOP If loop is disabled: enable loop, starting at current position

If loop is enabled: disable loop
berlanjut ke halaman berikutnya
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Table 8 – lanjutan dari halaman sebelumnya
# Name Function
35 RELOOP

(SHIFT + LOOP)
If loop is enabled: jump to loop IN point and stop playback
If loop is disabled: enable loop, without moving it

36 1/2 Decrease loop size by half
36 IN

(SHIFT + 1/2)
Set the loop IN point

37 x2 Double the loop size
37 OUT

(SHIFT + x2)
Set the loop OUT point

Petunjuk: The actual behavior of CUE and Play/Pause buttons depends onMixxx settings. See TheMixxx User Interface
for more info.

FX

# Name Function
19 BEATS Adjust FX param 1 of Effect 1 on Effect Unit 1 and 2
19 SHIFT + BEATS Adjust FX param 2 of Effect 1 on Effect Unit 1 and 2
20 Dry/Wet knob Adjust the Dry/Wet rate of Effect Unit 1 and 2
21 FX select buttons See below
22 FX toggle switches Toggle Effect 1 on Effect Unit corresponding to deck number

FX select buttons have different functions than what is printed on them. Below is the original layout (not used), and two
tables presenting button functions (and SHIFT + buttons functions).

Table9: Original layout of FX select buttons (not used)
HPF LPF FLANGER
ECHO REVERB PHASER

Table10: FX select/bonus functions buttons
Effect Unit 1 Effect 1 previous FX Adjust beatgrid on deck 1 Effect Unit 2 Effect 1 previous FX
Effect Unit 1 Effect 1 next FX Adjust beatgrid on deck 2 Effect Unit 2 Effect 1 next FX

Table11: FX select/bonus functions buttons (SHIFT)
Pitch up on deck 1 -- Pitch up on deck 2
Pitch down on deck 1 -- Pitch down on deck 2

Pitch up/down buttons change pitch by one semitone.

Petunjuk: For more info about Effect Units see Efek.
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Pads

The 8 pads in each deck have multiple functions, depending on the selected pad mode. Default pad mode is hotcues.
Current mode is selected by pressing one of the buttons above the pads. The button for currently active pad mode is lit
up (or blinking, when secondary pad mode is selected - secondary pad modes are: beatjump and sampler 2).
Pads support secondary (shift) actions in most pad modes. 4 bottom pads with "special" functions printed on them
(STUTTER, etc.) act the same as the top 4 pads, i.e. don't perform any special functions.

# Name Function
30 CUE Change pad mode to hotcues.

Pad press: set hotcue if not set. If set, go to hotcue position and start playback
SHIFT + pad press: remove hotcue (if set)
Pad lights indicate if a particular hotcue is set or not.

30 SHIFT + CUE Change pad mode to beatjump.
Pad press: beatjump forwards
SHIFT + pad press: beatjump backwards
If loop is active, loop is moved forwards/backwards instead.
Default beatjump values are: 1/16, 1/8, 1/4, 1/2, 1, 2, value set in Mixxx GUI (4
by default), 8. Values can be adjusted, see the Adjustable values section.

31 AUTO LOOP Change pad mode to auto-loop.
Pad press: activate auto-loop
SHIFT + pad press (hold): activate beatlooproll. When released, playback will
resume where the track would have been if it had not entered the loop.
Default auto-loop sizes are: 1/16, 1/8, 1/4, 1/2, 1, 2, 4, 8. Loop sizes can be
adjusted, see the Adjustable values section.

32 FADER CUTS Change pad mode to fader cuts
This pad mode emulates rapid crossfader movements.
Pad press (hold): activate a fader cut. The crossfader will rapidly move in one
of the 8 available patterns. The crossfader will return to the position of hardware
crossfader after the pad is released.
Note: this function is controlled by the hardware or firmware

33 SAMPLE Change pad mode to sampler 1 (samples 1-8)
Pad press: play a sample
SHIFT + pad press: stop sample playback

33 SHIFT + SAMPLE Change pad mode to sampler 2 (samples 9-16)
34 Performance pads Various functions, depending on selected pad mode
34 SHIFT + Performance

pads
Various functions, depending on selected pad mode
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Adjustable values

There are a few configurable values at the top of the script (Numark-Mixtrack-Pro-FX-scripts.js).

Vari-
able

Default value Description

pitchRanges[0.08, 0.16, 1] For adjusting the range of pitch fader. Pressing PITCH RANGE (SHIFT +
PITCH BEND -) cycles through available values. Number of values in the ar-
ray can be changed without further script modifications. Note that the default
(first) pitch range must be also selected independently in Mixxx settings (Settings
-> Preferences -> Decks -> Slider range).

wave-
formsSynced

true This variable should reflect the corresponding Mixxx option (Settings -> Pref-
erences -> Waveforms -> Synchronize zoom level across all waveforms). This
affects waveform summary zooming.

jogScratch-
Sen-
si-
tiv-
ity

1024 Scratching sensitivity

jogScratchAl-
pha

1 For controlling the alpha-beta filter used in scratching

jogScratch-
Beta

1/32 For controlling the alpha-beta filter used in scratching

jog-
Pitch-
Sen-
si-
tiv-
ity

10 Jogwheel pitch bend sensitivity

jogSeek-
Sen-
si-
tiv-
ity

10000 Jogwheel seek sensitivity

en-
able-
Blink

true Enable blinking of pad mode buttons when in secondary mode (beatjump or sam-
pler 2)

blinkDe-
lay

700 Blinking frequency of pad mode buttons when in secondary mode (in ms)

au-
toLoop-
Sizes

["0.0625", "0.125",
"0.25", "0.5", "1",
"2", "4", "8"]

Loop sizes for the auto-loop pad mode, each value corresponds to one of the pads.

beat-
Jump-
Val-
ues

["0.0625_",
"0.125_", "0.25_",
"0.5_", "1_", "2_",
"", "8_"]

Beatjump values for the beatjump pad mode, each value corresponds to one of
the pads. The empty value ("") means the value set in Mixxx (4 by default). Un-
derscores (_) are needed because of that control, which has one underscore in the
name, as opposed to beatjump controls with predetermined values which have two
underscores.

Petunjuk: See here for more info about constants used in scratching.
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Notes

• Pressing either SHIFT button will cause both decks to shift (e.g. when pressing SHIFT on deck 1 and then some
control on deck 2, the secondary function will be executed). This approach was chosen to be consistent with the
behavior of hardware - i.e. pressing either SHIFT changes midi codes of some controls on both decks.

• SHIFT + TAP does not trigger BPM rescan, as there is no Mixxx control for this action.

17.1.84 Numark Mixtrack Pro II

The Numark Mixtrack Pro II is the successor of Numark Mixtrack Pro and features the same hardware with some minor
design changes.

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.11.

Mapping Description

1. Browser Knob

Rotate the knob to cycle through folders and tracks.
Press: Same as Back button.

2. Load

Load the track selected in the library to the deck.

3. Back

Cycles between the file structure and the music library in the software.

4. Shift

Allows multiple control commands to be triggered when pressed and held first along with other buttons.

5. Play/Pause

Starts and suspends playback.
Shift + Play/Pause: Activates soft start effect if paused or brake effect if playing.
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6. Headphone Cue

Sends pre-fader audio to the Cue Channel for headphone monitoring.

7. Cue (Transport Control)

The behavior depends on the cue mode set in the Mixxx preferences. Shift + Cue: return the play head to the start of
the track.

8. Platter/Jog Wheel

This capacitive, touch-sensitive jog wheel controls the audio when the wheel is touched and moved. When the Scratch
button is not active, use the wheel to bend the pitch of the track. When the Scratch button is active, use the wheel to grab
and move the audio, “scratching” the track as you would with a vinyl record. You can also grab the non-touch-sensitive
outer wheel to bend the pitch of the track.

9. Scratch

Controls the behavior of the platters. When not active, the platter will function as Pitch Bend. When active, the platter
will have the ability to scratch.

10. Pitch Fader

Controls the tempo (speed) of the individual decks.

11. Pitch Bend -

Press and hold to momentarily reduce the speed of the track.
Shift + Pitch Bend -: Toggles keylock on/off.

12. Pitch Bend +

Press and hold to momentarily increase the speed of the track.
Shift + Pitch Bend +: Changes pitch fader range.

13. Sync

Enables BPM syncing between decks.

17.1. Controllers 346



Mixxx User Manual, Rilis 2.3.0

14. Effect Control

Adjusts effect metaknobs.
Shift + Effect Control: Selects effect.

15. Beats

Adjusts the Dry/Wet mix of the EffectUnit.
Shift + Beats: Adjust the deck’s QuickEffect.

16. Loop In

Function of this button depends on the current Pad Mode.
Shift + Loop In: Sets the current Pad Mode to “Loop Mode”.
Loop Mode: Press this pad to set the beginning of a loop.
Sample Mode: Plays the sample assigned to Sampler 1 (left deck) or Sampler 5 (right deck).
Cue Mode: If Hotcue 1 has not already been set for the loaded track, this control will set Hotcue 1 at current position
in the track. If Hotcue 1 has already been set, this control will jump to Hotcue 1.

17. Loop Out

Function of this button depends on the current Pad Mode.
Shift + Loop Out: Sets the current pad mode to “Sample Mode”.
Loop Mode: Set the end of a loop.
Sample Mode: Plays the sample assigned to Sampler 2 (left deck) or Sampler 6 (right deck).
Cue Mode: If Hotcue 2 has not already been set for the loaded track, this control will set Hotcue 2 at current position
in the track. If Hotcue 2 has already been set, this control will jump to Hotcue 2.

18. Reloop

Function of this button depends on the current Pad Mode.
Shift + Reloop: Sets the current pad mode to “Cue Mode”.
Loop Mode: Deactivate an active loop. If no loop is active, this will activate the loop and start playback from its Loop
In point.
Sample Mode: Plays the sample assigned to Sampler 3 (left deck) or Sampler 7 (right deck).
Cue Mode: If Hotcue 3 has not already been set for the loaded track, this control will set Hotcue 3 at current position
in the track. If Hotcue 3 has already been set, this control will jump to Hotcue 3.
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19. Loop x1/2

Function of this button depends on the current Pad Mode.
Loop Mode: Half the loop size.
Shift + Loop x1/2 when in Loop Mode: Double the loop size.
Sample Mode: Plays the sample assigned to Sampler 4 (left deck) or Sampler 8 (right deck).
Cue Mode: Toggles Hotcue Delete Mode. Press this button, and then press one of the other pads in the row to delete
that Hotcue.
Note: This button is lit when in Hotcue Delete Mode.

20. FX 1 On/Off

Toggle the 1st effect in the unit on/off.
Shift + FX 1: Sets and starts playback of a 1-beat autoloop.

21. FX 2 On/Off

Toggle the 2nd effect in the unit on/off.
Shift + FX 2: Sets and starts playback of a 2-beat autoloop.

22. FX 3 On/Off

Toggle the 3rd effect in the unit on/off.
Shift + FX 3: Sets and starts playback of a 4-beat autoloop.

23. Tap

Allows manual entry of song’s BPM by repeated pressing along the beats of the track.
Shift + Tap: Sets and starts playback of a 16-beat autoloop.
Note: This button will blink at each detected beat in the track.
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24. Channel Volume

Adjusts the volume of the deck.

25. Master Gain

Adjusts the volume of the master mix coming from the software.
Note: This does not affect the microphone volume. Use the Mic Gain knob to control the microphone volume.

26. Crossfader

Controls the blend between the two decks.

27. High EQ

Controls the treble frequencies for the deck.

28. Mid EQ

Controls the mid range frequencies for the deck.

29. Low EQ

Controls the bass frequencies for the deck.

30. Cue Gain

Adjusts the volume for headphone cueing in the software.

31. Cue Mix

Adjusts the software’s audio output to the headphones, mixing between the cue output and the master mix output.

32. Stutter

Press this button while the music is playing to jump back to the last set cue point, creating a “stutter” effect.
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17.1.85 Numark N4

The Numark N4 is a 4-deck DJ controller with seamless integration of external devices.
• Manufacturer’s product page
• Wiki page

Baru pada versi 1.10.

Mapping Description
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Figure35: Numark N4 (schematic view)

This mapping has some unusual features like per Deck shift buttons and multiple pages of hotcues. An annotated, ready-
to-print overlay of this mapping can be downloaded for DIN A3 and DIN A4 printers.

Definable Settings

Some settings in the script can be changed by editing them at the top of the script.

searchAmplification Defines the speedup-factor used when using the searchbutton and scrolling.
type: number
range: ]0;+∞[

warnAfterTime Time in seconds before the end of the track in which the controller should warn you.
type: number
range: [0;+∞]

blinkInterval Timeinterval for the triangular Leds in ms
type: number
range: [20;+∞[

encoderResolution Percent how much the value changes with each encoder tick
type: number
range: ]0;1]

resetHotCuePageOnTrackLoad The Hotcuepage should be reset to 1 when a new Track is loaded into the Deck
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type: boolean
range: true or false

cueReverseRoll If [SHIFT]+[CUE] should trigger a reverse_roll
type: boolean
range: true or false

rateRanges An array of rateRanges in percent
type: array
range: ]0;3]

Deck

TheDeck consists of the jogwheel, play, cue, the topContainer (which hold the eight square buttons and the four encoders),
pitchslider, pitchrange, search, keylock, tap, sync and pitchbend ±.

Special Features

The mapping features some peculiar features which might not be discoverable by standard trial-and-error.

Shift

A shift button is bound to its Deck, which means that you can’t use the shift button of Deck1 to access a shifted function
on any of the other three Decks. Moreover the shiftbuttons can also work as toggle switches instead of pushbuttons
(enabled via components.js Button.type.powerWindow). This means that if the shiftbutton is pressed for a longer period
than 275ms it will bounce back to its original state (like a regular shift-/pushbutton). If the Button was pressed for a
shorter period than 275ms, the button will remain in that state until it is pressed again (like a toggling button).

Hotcues

The four lower buttons of the topContainer are hotcues. They can be changed by using the corresponding Encoder
[HOTCUE PAGE]. The current assignment will then be shown for one second in the upper row. Currently up to 4 Pages
are supported (with 4 hotcues each). A demo of how this looks can be seen on JsFiddle (not done yet) (the slider represents
the Encoder).

Controls

Most of these controls behave as expected but they are listed in detail for the sake of completeness anyways.
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Play

Default: Starts regular Play.
Shifted: Plays Track in reverse.

Cue

Default: Standard Cue.
Shifted: reverse roll if shift is enabled (plays in reverse end enables slip) otherwise standard cue.

Pitchbend ±

Default: Change rate temporarily.
Shifted: Change rate temporarily small.

Sync

Default: Momentary BPM Sync
* Short Press: Momentary BPM & Phase Sync

• Long Press: Toggle Master Sync (Sync Lock)
Shifted: Toggles magnet (quantize)

Tap

Default: Tap the desired BPM of the Channel
Shifted: ^^
Note: This functionality is broken until #1811 gets merged

Search/Scratch

Default: Enable Scratching (otherwise it just works just like moving the Jog without the platter)
Shifted: Speeds up platter movement for searching within the track

Keylock

Default: Toggles track keylock
Shifted: Syncs Key
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Pitch Range

Default: Cycles Through pitchranges
Shifted: ^^

Pitch/Bpm slider

Default: Normal Pitchslider (Down plays faster; can be changed in the global mixxx preferences)
Shifted: ^^

TopContainer

The TopContainer holds four assignable Hotcue buttons, four loop buttons, which can enable FX via Shift, and four
Encoderknobs.

Hotcues

Default: set/active Hotcue_X
Shift: clear Hotcue_X
visit#special_featuresfor more info on how these work

Loop In

Default: Presses the Loop In button like in the UI
Shifted: Toggles EffectRack1

Loop Out

Default: Presses the Loop Out button like in the UI
Shifted: Toggles EffectRack2

Loop Here

Default: Creates a loop at the current position of current Loop Size.
Shifted: Toggles Slip
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Reloop

Default: De-/Re-activates the last loop
Shifted: Jumps to start of last loop and stops playback there

FX1 Knob

Default: Controls the Super Knob on EffectRack1.
Shifted: Controls the Mix Knob on EffectRack1.

FX2 Knob

Default: Controls the Super Knob on EffectRack2.
Shifted: Controls the Mix Knob on EffectRack2.

Hotcue Page

Default: visit #special_features for more info on what this encoder does
Shifted: Double/Halve current Loop Size

Beat Jump

Default: Jump in the direction turned
Shifted: Double/Halve current Beat Jump Size

Mixer

TheMixer features four channels with identical functionality and controls for the library and other miscellaneous features.

Channel

A channel consists of a volume fader, a gain knob, knobs for low,mid,high EQ a Loadbutton and a pflButton. These are
internally still part of the Deck which is why the shiftbutton of Deck 1 won’t work with the Loadbutton or gainknob of
Deck2/3/4.
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Volume

Default: Channel Volume

CUE

Default: Channel Pre-Fader-Listening
these work as usual on the N4: Clicking another one deselect all other. Press multiple at the same Time to PFL multiple
Channels

BASS

Default: EQ Low

MID

Default: EQ Mid

TREBLE

Default: EQ High

GAIN

Default: Gain
Shifted: QuickEffect1 (Usually Filter)

LOAD

Default: Load Track into Deck
Shifted: Eject Track from Deck

Library

The Library is managed via the Library Encoder. Any shiftbutton can be used to access shift functionanly
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Turn

Default: Move Library Cursor Vertically
Shifted: Move Focus between panes
sometimes the focus is stuck somewhere (eg when using the searchbox) and is only recoverable with user intervention via a
pointing device.

Button Default: Open/Close Folder / Load Item into first available Deck (Context-dependent)
Shift: Maximize Library

Miscellaneous

Crossfader

The Crossfader and its assignment buttons are integrated seamlessly with Mixxx.

Line/PC Input Source

Function as expected: Mutes the corresponding Deck in Mixxx if set to Line.

Crossfader Contour

Normal: Uses the crossfader parameters that were present when the mapping was loaded Scratch: Uses Scratch typical
parameters for hard cuts

Cue-Master Mix

Doesn’t manipulate the mixxx controls. Make sure the head gain is not zero and the mix is set to 100% PFL

Cue Volume

Make sure its high enough within mixxx

Booth/Gain Volume

Behaves as espected (but doesn’t manipulate any mixxx controls).

17.1. Controllers 356



Mixxx User Manual, Rilis 2.3.0

17.1.86 Numark NS7

This all-in-one controller features motorized jogwheels. This device is not USB MIDI class compliant and requires a
special driver which is only available for Windows and Mac OS X. There is no Linux driver. This controller has been
discontinued in favor of the NS7III.

• Manufacturer’s product page
Baru pada versi 1.9.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.87 Numark Omni Control

• Manfacturer’s product page
Baru pada versi 1.10.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.88 Numark Total Control

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.6.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.89 Numark V7

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.10.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.90 Pioneer CDJ-2000

This is a CD and USB media player that can control Mixxx over USB with MIDI or HID. It can also control Mixxx by
playing timecode from a CD or USB drive and running that signal into Mixxx through a sound card.

• Manufacturer’s product page
Baru pada versi 1.10: Support for MIDI mode.
Baru pada versi 1.11: Support for HID mode.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.91 Pioneer CDJ-350

This is a CD and USB media player that can control Mixxx via USB with MIDI. The device can also send HID signals
to computers, but no Mixxx mapping has been made for this device’s HID signals. It can also control Mixxx by playing
timecode from a CD or USB drive and running that signal into Mixxx through a sound card.

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.8.2: Support for MIDI mode.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.92 Pioneer CDJ-850

This is a CD and USB media player that can control Mixxx via USB with MIDI or HID. It can also control Mixxx by
playing timecode from a CD or USB drive and running that signal into Mixxx through a sound card.

• Manufacturer’s product page
Baru pada versi 1.10: Support for MIDI mode.
Baru pada versi 1.11: Support for HID mode.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.93 Pioneer DDJ-200

Figure36: Pioneer DDJ-200 (schematic view)

The Pioneer DDJ-200 is a 2 deck USB and Bluetooth DJ controller designed for WeDJ, djay, edjing Mix and Rekordbox.
• Manufacturer's Product Page
• Manufacturer's User Manual
• Manufacturer's Firmware Update
• Mixxx User Forum

Baru pada versi 2.2.5.

Controller Mapping

A schematic drawing with the control numbers that are used here can be found on the specified page in the User Manual
in the Links section.
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Figure37: Deck section (p. 8)
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Deck section (p. 8)

No. Control Function
1 Jog Wheel (top) Scratch (move play position)
1 Jog Wheel (outer) Pitch bend (nudge)
1 SHIFT + Jog Wheel (top) Scratch (move play position) faster
1 SHIFT (left) + JogWheel (outer) Move track selection in library
2 SHIFT button Switch function of controls
3 Pad 1 - 8 Set (if empty) or play (if set) hot cue point / loop 1 - 8
3 SHIFT + Pad 1 - 8 Unset / delete hot cue 1 - 8
4 CUE button Set or play cue point, change cue point with JOGWHEEL (top) + cue point
4 SHIFT + CUE button Return to cue point and stop
5 PLAY/PAUSE button Play / pause
6 BEAT SYNC button Match tempo and phase of other deck, long press to enable master sync
7 TEMPO slider Adjust track playing speed (can be adjusted via SHIFT + BEAT SYNC)

Mixer section (p. 10)

No. Control Function
1 MASTER button Toggle Master/Cue knob of headphones between left and right
1 SHIFT + MAS-

TER button
Toggle between 2- and 4-deck mode

2 HI/MID/LOW
knobs

Adjust high/mid/low-frequencies

3 CFX knobs Turns on the selected effects
4 HEADPHONE

CUE 1 button
Toggle headphone pre-fader listening of left deck.

4 HEADPHONE
CUE 2 button

Toggle headphone pre-fader listening of right deck.

4 SHIFT (left) +
HEADPHONE
CUE 1

Load selected track to left deck.

4 SHIFT (left) +
HEADPHONE
CUE 2

Load selected track to right deck.

4 SHIFT (right) +
HEADPHONE
CUE 1

Toggle between left deck between 1 / 3 in 4-deck mode (if LED is lit, deck 3 is active). If
4-deck mode is disabled, this behaves the same as SHIFT (left) + HEADPHONE CUE
1.

4 SHIFT (right) +
HEADPHONE
CUE 2

Toggle between right deck between 2 / 4 in 4-deck mode (if LED is lit, deck 4 is active).
If 4-deckmode is disabled, this behaves the same as SHIFT (left) + HEADPHONECUE
2.

5 Channel faders Adjust the output level for each channel
6 Transition FX But-

ton
Turns on AutoDJ

7 Cross fader Fade between left and right deck
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Figure38: Mixer section (p. 10)
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17.1.94 Pioneer DDJ-400

Figure39: Pioneer DDJ-400 (schematic view)

The Pioneer DDJ-400 is a 2 deck USB controller with an integrated audio interface designed for rekordbox.
• Manufacturer's Product Page
• Manufacturer's User Manual
• Manufacturer's Firmware
• Midi Mappings
• Hardware Diagram
• Mapping Forum Thread

Baru pada versi 2.3.0.

Firmware

Catatan: The release version of the firmware contains a bug which causes signals from the tempo sliders to be sent
without the sliders being touched.
It is therefore highly recommended that you update your controller's firmware.

You can download the latest firmware from the manufacturer's website.
Unfortunately Pioneer only offers aWindows andMac firmware installer, so to update your controller you will need access
to such a machine. Simply download the appropriate file for that OS, attach your device and run the installer.
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Compatibility

The Pioneer DDJ-400 is USB audio and MIDI class compliant and works with Linux, Windows, and macOS without
needing to install any drivers. However, updating the firmware is recommended as described above.

Audio Setup

Configure Mixxx's sound hardware settings as follows:

Output Channel
Master 1-2
Headphones 3-4

Catatan: It is not possible to record or broadcast input sent from the 1/4" unbalanced TS microphone jack on the
controller, as it is not routed back to the computer and cannot be configured as an input device.

Controller Mapping

The schematic drawings used here can be referenced in the manufacturer's manual on the given page number.

Browser section (p. 6)

Figure40: Pioneer DDJ-400 (browser section)

No. Control Function
1 LOAD

buttons
Load track selected in library into deck.

2 Rotary Selec-
tor

Press to toggle focus between the library sidebar and associated panels. Turn to move focus
up or down.
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Deck sections (p. 6)

Figure41: Pioneer DDJ-400 (deck section)
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No. Control Function
1 BEAT SYNC Press to sync tempo to the other playing track. Hold to enable sync lock.
1 SHIFT + BEAT

SYNC
Cycles through tempo ranges: +/-6%, +/-10%, +/-16%, +/-25%

2 CUE/LOOP
CALL>

Doubles the current loop size.

2 SHIFT +
CUE/LOOP
CALL>

Jumps 32 beats forwards.

3 CUE/LOOP
CALL<

Halves the current loop size.

3 SHIFT +
CUE/LOOP
CALL<

Jumps 32 beats backwards.

4 RELOOP/EXIT Enables/disables currently set loop.
4 shift +

RELOOP/EXIT
Jump to loop start, enable loop, and stop playback.

5 OUT Sets end of loop to the current playback position. If quantize is enabled, it is set to the
closest beat. If held during an active loop, sets the new end point when released.

5 shift + OUT When a loop is enabled, press to adjust the loop's end position with the jog wheel.
6 IN/-4BEAT Sets start of loop to the current playback position. If quantize is enabled, it is set to the

closest beat. If held during an active loop, sets the new start point when released.
6 shift + IN/-

4BEAT
When a loop is enabled, press to adjust the loop's start position with the jog wheel.

7 Jog Wheel (top) Scratch (move play position).
7 Jog Wheel

(outer)
Nudge tempo up or down temporarily.

8 HOT CUE
mode

Sets pads to hot cue mode.

9 BEAT LOOP
mode

Sets pads to beat loop mode.

10 BEAT JUMP
mode

Sets pads to beat jump mode.

11 SAMPLER
mode

Sets pads to sampler mode.

12 TEMPO slider Adjust playback speed.
13 Performance

pads
Functionality differs depending on the pad mode selected by 8-11.

14 PLAY/PAUSE Play/pauses a track).
15 CUE Behavior depends on the cue mode.

Pad Modes

The pad mode buttons change between different modes in which the performance pads operate. The main pad modes
described below are similar to those found in rekordbox.

Catatan: The secondary pad modes described in the manufacturer's manual (KEYBOARD PAD FX1 PAD FX2 and
KEYSHIFT) are not currently implemented by this mapping.
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Hot Cue Mode

Bookmark positions in the track and jump to them.

1 2 3 4

5 6 7 8

Figure42: Pioneer DDJ-400 (hot cue pads)

No. Control Function
1-8 Pad (unlit) Save current position as hot cue.
1-8 Pad (lit) Jump to hot cue. If the track is stopped, holding the pad will preview the hot cue until the

pad is released.
1-8 SHIFT + Pad

(lit)
Clear hot cue.

Beat Loop Mode

Press a pad to enable a loop from the current position. Press the pad again to disable the loop. The size of the loop is
assigned to the pads as follows:

1 2 3 4

5 6 7 8

Table12: Pioneer DDJ-400 (beat loop sizes)
1/4 beat 1/2 beat 1 beat 2 beats
4 beats 8 beats 16 beats 32 beats

Beat Jump Mode

Press a pad to jump forwards or backwards by the number of beats assigned to the pads below.
Press SHIFT + pad 7 to decrease or SHIFT + pad 8 to increase the jump values by a factor of 16.

Table13: Pioneer DDJ-400 (beat jump defaults)
1 beat back 1 beat forward 2 beats back 2 beats forward
4 beats back 4 beats forward 8 beats back 8 beats forward
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1 2 3 4

5 6 7 8

Sampler Mode

Load and play samples from the library. The pads on decks 1 and 2 correspond to the first and second sampler rows in
Mixxx respectively.

1 2 3 4

5 6 7 8

Figure43: Pioneer DDJ-400 (sampler pads)

No. Control Function
1-8 Pad (unlit) Load sample selected in library.
1-8 Pad (lit) Play a loaded sample. If the sample is already playing, playback starts from the beginning.
1-8 SHIFT + Pad (lit) Stop a loaded sample from playing. If the sample is already stopped, unload it.
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Figure44: Pioneer DDJ-400 (mixer section)
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Mixer section (p. 8)

No. Control Function
1 TRIM Adjusts deck prefader gain
2 MASTER Adjusts master output (this is hardware implemented and is notmapped to the software

gain in Mixxx).
3 MASTER CUE Sends master output to headphones (this is hardware implemented and is not visible

in the Mixxx interface).
4 EQs (LOW MID

HIGH)
Boosts or cuts channel frequencies

5 Channel level indica-
tors

Displays channel levels (before being sent through channel faders)

6 HEADPHONES
MIXING

Adjusts between headphone CUE and MASTER levels sent to headphones

7 FILTER QuickEffect superknob (by default controls a Filter, but this can be changed in the
preferences)

8 HEADPHONES
LEVEL

Adjusts output level from PHONES jack

9 Headphone CUE
(Channel)

Turn on to output channel to headphones

9 SHIFT + Headphone
CUE

Toggles quantize for the current channel

10 Channel fader Adjusts channel levels output to master
11 Crossfader Fade between left and right channels

Effect section (p. 9)

The BEAT FX controls above are mapped to Mixxx's first effect unit as follows:

No. Control Function
1 BEAT < Focus effect 1
1 SHIFT + BEAT < Load previous effect
2 BEAT > Focus effect 2
2 SHIFT + BEAT > Load next effect
3 FX SELECT Focus effect 3
4 Channel select switch Route deck 1, deck 2 or master mix to effect unit 1
5 LEVEL/DEPTH Controls the wet/dry mix knob
5 SHIFT + LEVEL/DEPTH Controls the metaknob of the currently focused effect
6 ON/OFF Enable/disable the currently focused effect
6 SHIFT + ON/OFF Disables all effects in the chain and kills the wet/dry mix

Catatan: Soft takeover is enabled on the LEVEL/DEPTH knob to prevent sudden changes to the wet/dry mix or effect
metaknob when changing between the two.
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Figure45: Pioneer DDJ-400 (effect section)

17.1.95 Pioneer DDJ-SB

The Pioneer DDJ-SB is an all-in-one 2 deck USBMIDI controller with a built in soundcard. Mixxx allows it to control 4
decks.

• Manufacturer’s product page
• Forum thread
• GitHub pull request

Baru pada versi 2.0.

Drivers

Windows

Windows Vista, Windows 7 and Windows 8 are supported. You can download the latest drivers and firmware from
http://www.pioneerdj.com/en/support/software/ddj-sb.

Catatan: If you're using Windows and have problems getting both sound outputs to work properly, please try using a
different Sound API in the preferences. DirectSound seems to have issues with this controller. WASAPI seems to work
fine, as does MME, although only with higher latencies. On Windows 10, only MME works.
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Mac OS X & Linux

You don’t need any drivers on Mac OS X and Linux.
The controller supports Mac OS X 10.6 and up.

Usage

Library browsing

The controls for library browsing can be found in the center top of the controller.

Control Function
Rotary knob Track selection
Load buttons Loads currently highlighted track to the corresponding deck
Pushing rotary
knob

Push: Loads currently highlighted track to the preview deck and plays it. – Release: jump to
30% position – Push again without rotary: Stop preview

Shift + rotary
knob

Library section selection

Shift + pushing
rotary knob

toggle expanding library section

Switching between decks

Pressing Shift + “Key Lock / Tempo Range” allows the left deck to switch between decks 1 and 3 and the right deck to
switch between decks 2 and 4.

Volume, equalizers & filters

Between the decks the usual faders, crossfader and EQ knobs can be found. A filter knob is also available.
Knobs are available for the master and headphones level. These are functional but are not reflected in Mixxx, as they
control the controller’s soundcard directly.
The filter fade button allows to use the crossfader in an innovative way that fades across songs through filtering instead of
fading.
There is no trim/gain knob, but the same effect can be achieved by using the filter knobs while holding shift.

Jogwheels, tempo & vinyl mode

When a deck is paused, the jogwheel allows you to browse through a track. If you want to browse faster, hold shift while
using the jogwheel.
When a deck is playing, using the jogwheel allows you to temporarily change the tempo of the playing track. Again,
holding shift exaggerates this effect.
The tempo slider allows changing the tempo of each deck. This normally changes the pitch of a track, you can make the
pitch stay constant by pressing the “key lock / tempo range” button.
Vinyl mode makes the jogwheels emulate the way turntables work. Vinyl mode can be toggled by pressing the “vinyl /
slip” button. Touching the outer plastic ring of the jogwheel will make it behave as with vinyl mode off. Touching the
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metal disc simulates touching the vinyl record, so just putting your hand on it will stop the “vinyl”. You can scratch in a
similar way as with turntables in vinyl mode.

Slip mode

By pressing shift + “vinyl / slip” you can toggle slip mode. When entering slip mode, Mixxx remembers what point exactly
of the track should be playing even if, for example, you scratch or make a loop. This allows to return to the original pace
of the track.

Pads - lower row

The play and cue pads should be self-explaining. The sync pad toggles master sync for a deck, which tries to beatmatch
the deck with the others, and also syncs the tempo between them, even when the tempo of one deck is changed.
Additional functions can be accessed by holding shift

Control Function
Shift + play Plays the track in reverse and enables slipping (see slip mode)
Shift + cue Brakes the track as if the power of the motor on a turntable was turned off
Shift + sync Enables quantize mode (this makes most actions, e.g. setting the cue point, fall to the nearest beat)

Pads - hot cue mode

In hot cue mode the upper row of pads control the hotcues. Pressing a pad that is not lit sets a hotcue. Pressing a pad that
is lit makes the track jump and play from that hotcue. Pressing a pad while holding shift deletes that hotcue.
You can control a set of 4 more hotcues by pressing shift + hot cue. The hot cue button will start blinking. The pads will
behave in the same way, but controlling hotcues 5 to 8.

Pads - auto loop mode

Pressing the pads in auto loop mode will make loops of a specific length measured in beats.

Control Function
Pad 1 1 beat loop
Pad 2 2 beat loop
Pad 3 4 beat loop
Pad 4 8 beat loop
Shift + pad 1 16 beat loop
Shift + pad 2 32 beat loop
Shift + pad 3 64 beat loop
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Pads - manual loop mode

This mode will make the pads control looping in the way labeled on them.

Control Function
Pad 1 Set loop in
Pad 2 Set loop out
Pad 3 Toggles loop
Pad 4 Halve loop length
Shift + pad 4 Double loop length
Shift + pad 1 Move loop one beat backward
Shift + pad 2 Move loop one beat forward

Pads - sampler mode

In sampler mode the sampler can be controlled. To load a file into a sampler, first press the sampler button while holding
shift, so that the sampler button starts blinking. Now pressing a pad will load the currently highlighted track on the library
into the corresponding sampler. Pressing a pad while holding shift will eject the sample.
To play samples, press the sampler button without holding shift (it should not blink). Pressing a pad will start playing the
corresponding sample, pressing a pad while holding shift will stop it.

Pads - loop roll (shift + auto loop)

By pressing the auto loop button while holding shift (it should start blinking) you can make loop rolls. This mode com-
bines auto loops with slip mode. The pads will start a loop in the current position with a determinate beat length while
simultaneously enabling slip mode, so that when releasing the pad the track will continue playing as if the loop never
happened.

Control Function
Pad 1 1/16th beat loop roll
Pad 2 1/8th beat loop roll
Pad 3 1/4th beat loop roll
Pad 4 1/2 beat loop roll
Shift + pad 1 1 beat loop roll
Shift + pad 2 2 beat loop roll
Shift + pad 3 4 beat loop roll
Shift + pad 4 8 beat loop roll

Pads - kill (shift + manual loop)

By pressing the manual loop button while holding shift (it should start blinking) you can make the pads behave as kill
switches.

Control Function
Pad 1 Kill low
Pad 2 Kill mid
Pad 3 Kill high
Pad 4 Mute
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Effects

Over the jogwheels there are sections allowing to control effects.
Turning the knobs will control the wet/dryness of an effect.
Turning the knobs while holding one of the three FX buttons will control the first, second or third parameter of an effect,
respectively.
If holding shift when using the knobs the “super” parameter can be controlled.
Pressing the central FX button (number 2) while holding shift will toggle the effect for the headphones, while the left
and right buttons (number 1 and 3) will toggle the effect for the active deck in the left and right sides of the controller
respectively.
You can choose between effects by entering “kill mode” and using pads 1 and 2 while holding shift.

Channel fader start

By moving a channel fader up from the very bottom while holding shift when a deck is paused, the deck will start playing.
Moving the fader back to the bottom without releasing shift stops the deck and moves it back to its original position.

17.1.96 Pioneer DDJ-SB2

The Pioneer DDJ-SB2 is an all-in-one USB MIDI controller with a built in sound card. It has controls for 2 decks that
can be toggled between decks to play with 4 decks.

• Manufacturer’s product page
• Forum thread

Baru pada versi 2.0.

Audio

The sound card has 2 RCA jacks for themain output. There are two headphone jacks, one small (1/8“) and one large (1/4”)
connector (each jack plays the same channels, they cannot be used for independent signals). There is a 1/4" microphone
input with an adjustable gain knob. The microphone input is mixed directly with the main RCA outputs in hardware. It
is not available to the computer, so cannot record or broadcast with the microphone input on the controller. You could
use the controller with a separate USB audio interface that has a microphone input for that purpose. The microphone
preamplifier is very noisy, so it is recommended to keep the microphone gain knob all the way down when not using a
microphone, otherwise there will be noise added to the main RCA outputs.

Windows

Pioneer has a driver for Windows versions 7 and newer. Select the ASIO sound API in Mixxx’s Sound Hardware Prefer-
ences.

17.1. Controllers 375

https://www.pioneerdj.com/en/product/controller/archive/ddj-sb2/black/overview/
https://mixxx.discourse.group/t/pinoneer-ddj-sb2-midi-mapping/15373/26
https://www.pioneerdj.com/en/support/software/ddj-sb2/


Mixxx User Manual, Rilis 2.3.0

Mac OS X & Linux

The DDJ-SB2 is a USB class compliantMIDI and audio device, so it works with Mac OS X and Linux without any special
drivers.

User Options

There are some user configurable options for this mapping. To change the options, open the .js file in your controller
for your Pioneer DDJ-SB2 with a text editor such as KWrite or GEdit on GNU/Linux, Notepad onWindows, or TextEdit
on Mac OS X.

• blinkingSync: If true the sync button blinks with the beat, if false led is lit when sync is enabled.
• invertVinylSlipButton: If true, the vinyl button activates slip. Vinyl mode is then activated by using shift. Allows
toggling slip faster, but is counterintuitive.

• jogwheelSensivity: Sets the jogwheels sensitivity. 1 is default, 2 is twice as sensitive, 0.5 is half as sensitive.
• jogwheelShiftMultiplier: Sets how much more sensitive the jogwheels get when holding shift. Set to 1 to disable
jogwheel sensitivity increase when holding shift.

• speedRateToNormalTime: Time per step (in ms) for pitch speed fade to normal
• showVumeterMaster: If true Level-Meter shows VU-Master left & right. If false shows level of channel: 1/3 2/4
(depending active deck)

• cutVumeter: Cut’s Level-Meter low and expand upper. Fore example, at 0.5 only signals greater 50% show on the
meter, expanded to full range

• twinkleVumeterAutodjOn: If true VU-Level twinkle if AutoDJ is ON.
• jumpPreviewEnabled: If true, when releasing the browser knob, the preview deck jumps forward to “position”.
• jumpPreviewPosition: The place in the track to jump to, on a scale from 0 (beginning of track) to 1 (end of
track).

Usage

Library browsing

The controls for library browsing can be found in the center top of the controller.

Control Function
Rotary knob Track selection
Load buttons Loads currently highlighted track to the corresponding deck
Pushing rotary knob Loads currently highlighted track to the preview deck and plays it
Pushing rotary knob again without rotate Stop the preview deck
Shift + rotary knob Library section selection (scroll through left pane of library)
Shift + pushing rotary knob Toggle expanding library section

Pushing the rotary knob to start playing a track in the preview deck then releasing it jumps forward in the preview deck.
This behavior can be disabled in the mapping’s user options and the place in the track it jumps to can also be configured.
Addition functions not belonging to library:

• Shift & load left -> toggle effects view in/out
• Shift & load right -> toggle sampler view in/out
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Switching between decks

Press the deck button. It lights when deck 3-4 is active.

Volume, equalizers & filters

Between the decks the usual faders, crossfader and EQ knobs can be found. A filter knob is also available.
Knobs are available for the master and headphones level. These control the controller’s built in sound card; they do not
control the software gains in Mixxx, so moving them does not move the master and headphone gain knobs on screen.
The filter fade button changes the crossfader from fading the volumes between decks to using filters to fade between decks.
The TRIM knob controls the deck’s gain.

Jogwheels, tempo & vinyl mode

When a deck is paused, the jogwheel allows you to browse through a track. If you want to browse faster, hold shift while
using the jogwheel.
When a deck is playing, using the jogwheel allows you to temporarily change the tempo of the playing track. Again,
holding shift exaggerates this effect.
The tempo slider allows changing the tempo of each deck. This normally changes the pitch of a track, but you can make
the pitch stay constant by pressing the “key lock / tempo range” button. Additionally, with shift, the “key lock / tempo
range” will fade the tempo slowly to 0. The fading speed can be customized with the speedRateToNormalTime mapping
option.
Vinyl mode makes the jogwheels emulate the way turntables work. Vinyl mode can be toggled by pressing the “vinyl /
slip” button. Touching the outer plastic ring of the jogwheel will temporarily change the tempo like when vinyl mode is
off. Touching the metal disc simulates touching the vinyl record, so just putting your hand on it will stop the “vinyl”. You
can scratch in a similar way as with turntables in vinyl mode.

Slip mode

By pressing shift + “vinyl / slip” you can toggle slip mode. When entering slip mode, Mixxx remembers what point exactly
of the track should be playing even if, for example, you scratch or make a loop. When you press shift + slip again, Mixxx
will jump back to that point.

Pads - lower row

The play and cue pads should be self-explaining. The sync pad toggles master sync for a deck, which tries to beatmatch
the deck with the others, and also syncs the tempo between them, even when the tempo of one deck is changed.
Additional functions can be accessed by holding shift

Control Function
Shift +
play

Plays the track in reverse and enables slipping (see slip mode)

Shift + cue Brakes the track as if the power of the motor on a turntable was turned off
Shift +
sync

Enables quantize mode (this makes most actions, e.g. pressing play or setting the cue point, fall to the
nearest beat)
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Pads - hot cue mode

In hot cue mode the upper row of pads control the hotcues. Pressing a pad that is not lit sets a hotcue. Pressing a pad that
is lit makes the track jump and play from that hotcue. Pressing a pad while holding shift deletes that hotcue.
You can control a set of 4 more hotcues by pressing shift + hot cue. The hot cue button will start blinking. The pads will
behave in the same way, but controlling hotcues 5 to 8.

Pads - auto loop mode

Pressing the pads in auto loop mode will make loops of a specific length measured in beats.

Control Function
Pad 1 set a loop of the selected number of beats
Pad 2 halve the selected loop length
Pad 3 double the selected loop length
Pad 4 reloop (reactivate a pre-existing loop)
Shift + pad
1

set a rolling loop of the selected number of beats

Shift + pad
2

beatjump backwards by the beatjump size, or move the loop backwards by the beatjump size if the loop
is enabled

Shift + pad
3

beatjump forwards by the beatjump size, or move the loop forwards by the beatjump size if the loop is
enabled

Shift + pad
4

enable loop, jump to loop in marker, and stop playback

Pads - manual loop mode

This mode allows you to set loops different from the fixed lengths of beats in auto loop mode.

Control Function
Pad 1 Set loop in
Pad 2 Set loop out
Pad 3 Toggles loop
Pad 4 Halve loop length
Shift + pad 4 Double loop length
Shift + pad 1 Move loop one beat backward
Shift + pad 2 Move loop one beat forward

Pads - sampler mode

In sampler mode the sampler can be controlled. To load a file into a sampler, first press the sampler button while holding
shift, so that the sampler button starts blinking. Now pressing a pad will load the currently highlighted track on the library
into the corresponding sampler. Pressing a pad while holding shift will eject the sample.
To play samples, press the sampler button without holding shift (it should not blink). Pressing a pad will start playing the
corresponding sample, pressing a pad while holding shift will stop it.
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Pads - loop roll (shift + auto loop)

By pressing the auto loop button while holding shift (it should start blinking) you can make loop rolls. This mode com-
bines auto loops with slip mode. The pads will start a loop in the current position with a determinate beat length while
simultaneously enabling slip mode, so that when releasing the pad the track will continue playing as if the loop never
happened.

Control Function
Pad 1 1/16th beat loop roll
Pad 2 1/8th beat loop roll
Pad 3 1/4th beat loop roll
Pad 4 1/2 beat loop roll
Shift + pad 1 1 beat loop roll
Shift + pad 2 2 beat loop roll
Shift + pad 3 4 beat loop roll
Shift + pad 4 8 beat loop roll

Pads - kill (shift + manual loop)

By pressing the manual loop button while holding shift (it should start blinking) you can make the pads behave as EQ kill
switches.

Control Function
Pad 1 Kill low
Pad 2 Kill mid
Pad 3 Kill high
Pad 4 Mute

Effects

The knob controls the dry/wet knob of the whole effect chain when no effect is focused. When an effect is focused, the
knob controls the metaknob of the focused effect. Focus an effect by pressing one of the effect buttons. To switch the
controller’s knob back to manipulating the dry/wet knob, unfocus by pressing the button of the focused effect again.
Press and hold an effect button to toggle the enable switch for that effect. The enable switches for each effect are not
shown on the controller’s LEDs, so you need to look at the screen to check whether an effect is on. All effects are off
when Mixxx starts.
Use shift and the mixer knobs to control the parameters of the focused effect. The trim knob controls parameter 1, the
equalizer knobs control parameters 2-4, and the filter knob controls parameter 5.
The DDJ-SB2 does not have enough buttons to control assigning effect units to different decks. You may want to set up a
custom keyboard mapping to have easy access to those switches. Otherwise, you can use your mouse to click the buttons
on screen.
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Auto DJ

Start/stop Auto DJ: Shift + DECK 4. If enabled in the user options enabled, the level meter LEDs twinkle.
Skip Track: Shift + DECK 3

Channel fader start

By moving a channel fader up from the very bottom while holding shift when a deck is paused, the deck will start playing.
Moving the fader back to the bottom without releasing shift stops the deck and moves it back to its original position.

17.1.97 Pioneer DDJ-SB3

Figure46: Pioneer DDJ-SB3 (schematic view)

The Pioneer DDJ-SB3 is a 4 deck USB DJ controller.
• Manufacturer's Product Page
• Manufacturer's User Manual
• Manufacturer's Firmware Update
• Mixxx User Forum

Baru pada versi 2.3.2.
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Audio Setup

The mapping relies on the following channel assignments:

Output Channels Assigned to
1-2 Master
3-4 Headphones

This controller mapping does not support any inputs. The controller itself has a microphone input, but that cannot be
controlled via MIDI or routed to the computer.

Controller Mapping

A schematic drawing with the control numbers that are used here can be found on the specified page in the User Manual
in the Links section.

Deck section (p. 6)

No. Control Function
1 TEMPO slider Adjust track playing speed (can be adjusted via SYNC)
2 Jog Wheel (top) Pitch bend (nudge) or scratch when vinyl mode is enabled
2 Jog Wheel (outer) Pitch bend (nudge)
2 SHIFT + Jog Wheel (top) Fast-forward or fast reverse track
3 HOT CUE Set hot cue mode
3 SHIFT + HOT CUE Set BEAT JUMP mode
4 FX FADE Set FX fade mode
4 SHIFT + FX FADE Set roll mode
5 PAD SCRATCH Set pad scratch mode
5 SHIFT + PAD SCRATCH Set slicer mode
6 SAMPLER Set sampler mode
6 SHIFT + SAMPLER Set trans mode
7 VINYL Toggle vinyl mode
7 SHIFT + VINYL Toggle slip mode
8 AUTO LOOP Toggle auto loop
8 SHIFT + AUTO LOOP Cancel loop or reloop
9 2X Double loop length
10 1/2X Halve loop length
11 Pad 1 - 8 Perform different functions depending on current mode
12 PLAY/PAUSE button Play / pause
12 SHIFT + PLAY/PAUSE button Return to temporary cue point
13 CUE button Set, play and call out cue points
13 SHIFT + CUE button Return to the beginning of the song
14 SYNC button Match tempo and phase to currently playing deck
15 SHIFT + button Switch function of controls
16 DECK X Switch deck
17 KEY LOCK Toggle key lock
17 SHIFT + KEY LOCK Toggle tempo slider range
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Figure47: Deck section (p. 6)
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Mixer section (p. 8)

Figure48: Mixer section (p. 8)
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No. Control Function
1 TRIM knob Adjust individual channel output gain
2 HI/MID/LOW

knobs
Adjust high/mid/low-frequencies

3 FILTER knob Low pass / high pass filter for each channel
4 HEADPHONE

CUE 1 button
Toggle headphone pre-fader listening of left deck.

4 HEADPHONE
CUE 2 button

Toggle headphone pre-fader listening of right deck.

5 Channel faders Adjust the output level for each channel
5 SHIFT Channel

faders
Fader start and adjust the output level for each channel

6 Cross fader Fade between left and right deck
7 MASTER knob Adjust master output level. This changes the master output level directly on the controller's

audio interface. The MAIN knob on the Mixxx UI will not change.
8 HEAD-

PHONES
knob

Adjust headphones output level. This changes the headphones' output level directly on the
controller's audio interface. The HEAD knob on the Mixxx UI will not change.

9 MASTER but-
ton

Output master to headphones

Effect section (p. 8)

Figure49: Effects section (p. 8)

No. Control Function
1 1 button Turns the effect on/off
1 SHIFT1 button Focuses the effect
2 2 button Turns the effect on/off
2 SHIFT2 button Focuses the effect
3 3 button Turns the effect on/off
3 SHIFT2 button Focuses the effect
4 LEVEL knob Adjusts the mix of the dry and wet signal of the effect unit
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Browser section (p. 13)

Figure50: Browser section (p. 13)

No. Control Function
1 LOAD button Loads track highlighted in the library to the left or right deck
2 BROWSE knob (rotate) Rotate the knob left or right highlights the previous or next track in the library
2 BROWSE knob (press) Starts / stops track preview of highlighted track

Performance Pads

You can use the Pad Mode Select buttons to select a mode for the performance pads. Performance pads are numbered
from top left to bottom right. First row is 1-4 and the second row is 5-8. Press shift and the pad mode select button to
access other pad modes.

Hot Cue Mode

Hot Cue mode is enabled by pressing the HOT CUE button. The button will light up when selected.

HOT  C U E
6

HOT  C U E
1

HOT  C U E
8

HOT  C U E
7

HOT  C U E
5

HOT  C U E
4

HOT  C U E
3

HOT  C U E
2

Figure51: Pioneer DDJ-SB3 (performance pads in hot cue mode)

Bookmark positions in the track and jump to them.
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No. Control Function
1-8 Pad (unlit) Save current position as hot cue.
1-8 Pad (lit) Jump to hot cue.
1-8 SHIFT + Pad (lit) Clear hot cue.

Beatjump Mode

Beatjump mode is enabled by holding SHIFT down and pressing the HOT CUE button. The button will flash when
selected. Use beatjump mode to jump back or forward on the track by a certain number of beats.

1 4

8765

32

Figure52: Pioneer DDJ-SB3 (performance pads in beatjump mode)

No. Control Function
1 Pad Decrease beatjump size
2 Pad Increase beatjump size
3 Pad Jump left
4 Pad Jump right
5 Pad Go back to beginning of track
6 Pad Search left
7 Pad Search right
8 Pad Censor

FX Fade Mode

FX Fade mode is enabled by pressing the FX FADE button. The button will light up when selected. FX fade is a set of
functions built-in to the controller.
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Filter
fade 2

Filter
fade 1

Filter
fade 4

Filter
fade 3

Loop
fade 2

Loop
fade 1

Back
spin 2

Back
spin 1

Figure53: Pioneer DDJ-SB3 (Fade mode performance pads)

No. Control Function
1 Pad (unlit) Applies a high-pass filter from off to max
1 Pad (blinking) Turn off filter
2 Pad (unlit) Applies a low-pass filter from off to max
2 Pad (blinking) Turn off filter
3 Pad (unlit) Apply 1 beat auto-loop and lower volume
3 Pad (blinking) Turn off loop and restore volume
4 Pad Perform a back-spin and resume
5 Pad Same as pad 1 but over more time
6 Pad Same as pad 2 but over more time
7 Pad Auto-loop with exponential size reduction
8 Pad Same as 4 but with a longer back-spin

Loop Roll Mode

Loop roll mode is enabled by holding SHIFT down and by pressing the FX FADE button. The button will blink when
selected. Press one of the pads to trigger a momentary loop roll. Once the pad is released, the track will resume playing.

1 4

8765

32

Figure54: Pioneer DDJ-SB3 (performance pads in loop roll mode)
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No. Control Function
1 Pad 1/16 beat loop roll
2 Pad 1/8 beat loop roll
3 Pad 1/4 beat loop roll
4 Pad 1/2 beat loop roll
5 Pad 1 beat loop roll
6 Pad 2 beat loop roll
7 Pad 4 beat loop roll
8 Pad 8 beat loop roll

Pad Scratch Mode

Pad scratch mode is enabled by pressing the PAD SCRATCH button. The button will light up when selected. Press one
of the pads to trigger one of the built in scratches.

Scratch 1

Scratch 5

Scratch 3

Scratch 7

Scratch 2

Scratch 6

Scratch 4

Scratch 8

Figure55: Pioneer DDJ-SB3 (performance pads in pad scratch mode)

Slicer Mode

Slicer mode is enabled by holding SHIFT down and by pressing the PAD SCRATCH button. The button will blink when
selected. In this mode every pad represents a marker in the beat grid. Each pad will light up as each slice is played. Press
a pad to repeat the slice and hold the pad down to loop it.

1 4

8765

32

Figure56: Pioneer DDJ-SB3 (performance pads in slicer mode)
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Sampler Mode

Sampler mode is enabled by pressing the SAMPLER button. The button will light up when selected.

1 4

8765

32

Figure57: Pioneer DDJ-SB3 (performance pads in sampler mode)

No. Control Function
1 Pad Play sample 1
1 SHIFT + Pad Stop sample 1
2 Pad Play sample 2
2 SHIFT + Pad Stop sample 2
3 Pad Play sample 3
3 SHIFT + Pad Stop sample 3
4 Pad Play sample 4
4 SHIFT + Pad Stop sample 4
5 Pad Load sample 1
5 SHIFT + Pad Unload sample 1
6 Pad Load sample 2
6 SHIFT + Pad Unload sample 2
7 Pad Load sample 3
7 SHIFT + Pad Unload sample 3
8 Pad Load sample 4
8 SHIFT + Pad Unload sample 4

Trans Mode

Trans mode is enabled by holding SHIFT down and by pressing the SAMPLER button. The button will blink when
selected. Press one of the pads to trigger one of the built in cut effects. This mode is driven entirely by the controller's
firmware, so there is no equivalent in the Mixxx UI. In this mode, pressing and holding a pad triggers a Cut Effect, where
the deck's fader volume is toggle from 0 to max at the rate described in the table below. For example, pressing and holding
pad 5 will cause the volume to toggle from max to min every one beat.
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1/16 beat

1 beat

1/4 beat

1/3 beat

1/8 beat

2 beats

1/2 beat

Manual

Figure58: Pioneer DDJ-SB3 (performance pads in trans mode)

No. Control Function
1 Pad 1/16 beat cut effect
2 Pad 1/8 beat cut effect
3 Pad 1/4 beat cut effect
4 Pad 1/2 beat cut effect
5 Pad 1 beat cut effect
6 Pad 2 beat cut effect
7 Pad 1/3 beat cut effect
8 Pad Manual cut effect

17.1.98 Pioneer DDJ-SX

The Pioneer DDJ-SX is a 4 deck all-in-one controller that provides intuitive control of all of Mixxx’s features. The
DDJ-SX mapping reportedly works with the DDJ-SX2, but it does not use the new features of the DDJ-SX2 hardware.

• Manufacturer’s product page
• Forum thread
• User Manual

Baru pada versi 2.1.

User Options

To change the mapping’s user options, you have to open the script file (.js). At the top of the file under **USER OPTIONS*
the following settings can be made:

• PioneerDDJSX.jogwheelSensivity: Sets the jogwheel sensitivity. 1 = default, 2 is twice as sensitive, 0.5 is half
as sensitive.

• PioneerDDJSX.jogwheelShiftMultiplier: Sets howmuchmore sensitive the jogwheels get when holding SHIFT.
Set it to 1 to disable jogwheel sensitivity increase when holding SHIFT.

• PioneerDDJSX.twinkleVumeterAutodjOn: If true, level-meter twinkles if AutoDJ is enabled.
• PioneerDDJSX.autoDJAddTop: If true, the selected track will be added to AutoDJ queue-top on pressing RO-
TARY SELECTOR, else the selected track will be added to AutoDJ queue-bottom.

• PioneerDDJSX.autoDJTickInterval: Sets the duration of sleeping between AutoDJ actions if AutoDJ is enabled
[ms].
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• PioneerDDJSX.autoDJMaxBpmAdjustment: Sets the maximum adjustment of BPM allowed for beats to sync
if AutoDJ is enabled.

• PioneerDDJSX.autoDJShuffleAfterSkip: If true, AutoDJ queue is being shuffled after skipping a track.
• PioneerDDJSX.jumpPreviewEnabled: If true, by releasing the Rotary Selector, track in preview player jumps
forward to jumpPreviewPosition.

• PioneerDDJSX.jumpPreviewPosition: Sets the preview player absolute position, being set at releasing Rotary
Selector and if jumpPreviewEnabled enabled.

• PioneerDDJSX.samplerCueGotoAndPlay: If true, pad press in SAMPLER PAD MODE repeatedly causes
sampler to play loaded track from cue-point, else it causes to play loaded track from the beginning.

• PioneerDDJSX.autoPFL: If true, PFL / Cue (headphone) is being activated by loading a track into certain deck.
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General Functions

Group Fig-
ure

Control Description

5 -
BROWSER

2, 3,
4, 5

LOAD Loads the selected track into the specific deck

5 -
BROWSER

2 SHIFT + LOAD AutoDJ - Toggle BPM sync

5 -
BROWSER

3 SHIFT + LOAD AutoDJ - Toggle Key sync

5 -
BROWSER

1 Rotary Selector Move UP or DOWN the specified number of locations in Library
(MoveVertical function)

5 -
BROWSER

1 Rotary Selector
(press)

Equivalent to double clicking the currently selected item in Library
(GoToItem function)

5 -
BROWSER

1 SHIFT + Rotary
Selector

Move LEFT or RIGHT the specified number of locations in Library
(MoveHorizontal function)

5 -
BROWSER

1 SHIFT + Rotary
Selector (press)

Add track from Library to AutoDJ queue at top/bottom (see user op-
tions: default = at bottom)

5 -
BROWSER

6 BACK Currently focused pane changes in Library - previously focused pane
will be focused (MoveFocusBackward function)

5 -
BROWSER

6 SHIFT BACK Maximize view of Library

5 -
BROWSER

7 LOAD PREPARE Load selected track into PreviewDeck, jump to position (see user op-
tions) and play, else stop already playing track

3 - MIXER 1 Crossfader Controls Mixxx crossfader, fades between deck 1, 3 and 2, 4
3 - MIXER 2 Channel fader Controls deck volume
3 - MIXER 2 SHIFT Channel

fader
Fader start (starts playing deck when rising deck volume)

3 - MIXER 3 TRIM Controls deck gain
3 - MIXER 4 EQ HIGH Controls deck’s equalizer/filter high frequencies
3 - MIXER 5 EQ MID Controls deck’s equalizer/filter mid frequencies
3 - MIXER 6 EQ LOW Controls deck’s equalizer/filter low frequencies
3 - MIXER 7 CUE Toggles PFL/Cue (headphones) for specific deck
3 - MIXER 7 SHIFT CUE BPM Tab function for specific deck
3 - MIXER 8 MASTER LEVEL Controls the master output volume
3 - MIXER 9 MASTER CUE Toggles master cue
3 - MIXER 9 SHIFT MASTER

CUE
Toggles split cue (headphones)

3 - MIXER 10 Crossfader Assign Crossfader assignment - deck to crossfader (left (A), right (B) or center
(THRU))

3 - MIXER 13 HEADPHONES
MIX

Controls headphone’s audio source (cue, master)

3 - MIXER 14 SAMPLER VOL-
UME

Controls volume of all available Sampler decks

3 - MIXER 15 BOOTH MONI-
TOR LEVEL

Controls the booth output volume

4 - FRONT
PANEL

1 Crossfader curve Controls Mixxx crossfader curve

4 - FRONT
PANEL

2 INPUT SELECT Controls deck source (PC, MIC, CD, PHONO, LINE)

1 - DECK 25 PANEL SELECT Show/hide Sampler decks / Effect rack
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Catatan: The MASTER LEVEL, MASTER CUE, HEADPHONE MIX, BOOTH MONITOR LEVEL and INPUT
SELECT controls directly affect the controller’s sound card, so adjusting these will not change anything on screen in
Mixxx.

Deck Functions

The controls listed here are documented in Section 1 ("Deck") of the owner's manual.

Figure Control Description
1 PLAY/PAUSE Toggles play/pause (hold pressed while playing: starts brake effect -> release: pause track, press while stopped: starts playback)
1 SHIFT + PLAY/PAUSE Toggles play stutter
2 CUE Toggles default cue (sets cue point/ goes to cue point)
2 SHIFT + CUE Jump to the beginning of the track and stop
3 Jog Wheel (platter) Vinyl-Mode enabled: performs scratching when pressed and rotated, Vinyl-Mode disabled: performs pitch bend
3 SHIFT + Jog Wheel (platter) Vinyl-Mode enabled: performs scratching considering user-options multiplier when touched and rotated, Vinyl-Mode disabled: performs pitch bend considering user-options multiplier
3 Jog Wheel (side) Performs pitch bend when rotated
3 SHIFT + Jog Wheel (side) Performs pitch bend when rotated considering user-options multiplier
4 TEMPO Controls pitch/tempo ratio
5 KEYLOCK Toggles keylock
5 SHIFT + KEYLOCK Changes TEMPO slider range: Doubles the rateRange, starting from the value set up in the Mixxx settings, until 100% is reached. On the next press rateRange jumps back to its original value.
5 KEYLOCK (long press) Toggles pitch/tempo reset
6 NEEDLE SEARCH Jumps to equivalent absolute position in track if track is stopped.
6 SHIFT + NEEDLE SEARCH Jumps to equivalent absolute position in track while track is playing.
7 DECK 1 Switches left deck to DECK 1 control and illumination
8 DECK 2 Switches right deck to DECK 2 control and illumination
9 DECK 3 Switches left deck to DECK 3 control and illumination
10 DECK 4 Switches right deck to DECK 4 control and illumination
11 DUAL DECK Toggles left deck to dual deck control and illumination (DECK 1 and 3)
12 DUAL DECK Toggles right deck to dual deck control and illumination (DECK 2 and 4)
13 SYNC Toggles deck sync
13 SHIFT + SYNC Toggles quantize function
14 AUTO LOOP Set and enable beat loop
14 SHIFT AUTO LOOP Activates / Deactivates current loop
15 LOOP 1/2X Halves active loop
15 SHIFT LOOP 1/2X Moves active loop one beat backward (left)
16 LOOP 2X Doubles active loop
15 SHIFT LOOP 2X Moves active loop one beat forward (right)
17 LOOP IN Toggles loop in
17 SHIFT LOOP IN Activates current loop, jumps to its loop in point and stops playback.
18 LOOP OUT Toggles loop out
18 SHIFT LOOP OUT Toggles reloop / exit loop
19 VINYL Toggles vinyl (scratch) mode
20 CENSOR Toggles reverse roll play
20 SHIFT CENSOR Toggles reverse play
21 SLIP Toggles slip mode
22 GRID ADJUST Hold and touch/rotate Jog dial to adjust beats faster/slower
22 SHIFT GRID ADJUST Set/translate beat grid to current track position (adjust position with Jog dial)
23 GRID SLIDE Hold and touch/rotate Jog dial to set/translate beat grid earlier/later
24 SHIFT Switches to shifted controls, no direct function

17.1. Controllers 393



Mixxx User Manual, Rilis 2.3.0

Performance Pads

The performance pads support multiple different modes. The controls listed here are documented in Section 6 ("Perfor-
mance Pads") of the owner's manual.

Fig-
ure

Control Description

9 HOT CUE mode Switches pad control and illumination to HOT CUE mode
10 ROLL mode Switches pad control and illumination to BEATLOOP ROLL mode
10 SHIFT + ROLL

mode
Switches pad control and illumination to GROUP2 (BEATLOOP) mode

11 SLICER mode Switches pad control and illumination to SLICER mode, in SLICER mode switches be-
tween continuous slice mode and loop slice mode

12 SAMPLER mode Switches pad control and illumination to SAMPLER mode
12 SAMPLER mode

(long press)
Toggles sampler pad velocity mode (velocity ~ volume)

HOT CUE Mode

Figure Control Description
1 PAD 1 Set/activate Hot cue 1
1 SHIFT + PAD 1 Clear Hot cue 1
2 PAD 2 Set/activate Hot cue 2
2 SHIFT + PAD 2 Clear Hot cue 2
3 PAD 3 Set/activate Hot cue 3
3 SHIFT + PAD 3 Clear Hot cue 3
4 PAD 4 Set/activate Hot cue 4
4 SHIFT + PAD 4 Clear Hot cue 4
5 PAD 5 Set/activate Hot cue 5
5 SHIFT + PAD 5 Clear Hot cue 5
6 PAD 6 Set/activate Hot cue 6
6 SHIFT + PAD 6 Clear Hot cue 6
7 PAD 7 Set/activate Hot cue 7
7 SHIFT + PAD 7 Clear Hot cue 7
8 PAD 8 Set/activate Hot cue 8
8 SHIFT + PAD 8 Clear Hot cue 8
13 PARAMETER LEFT Jump beatjump_size beats backward
13 SHIFT + PARAMETER LEFT Increase beatjump_size
14 PARAMETER RIGHT Jump beatjump_size beats forward
14 SHIFT + PARAMETER RIGHT Decreate beatjump_size
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BEATLOOP ROLL Mode

By using the PARAMETER LEFT and PARAMETER RIGHT buttons in BEATLOOP ROLL (default parameter set:
2), you can change the pad-assigned loop size. The following table shows the possible assignments (unit: beats).

Set No. Pad 1 Pad 2 Pad 3 Pad 4 Pad 5 Pad 6 Pad 7 Pad 8
0 1/4 1/2 1 2 4 8 16 32
1 1/8 1/4 1/2 1 2 4 8 16
2 1/16 1/8 1/4 1/2 1 2 4 8
3 1/32 1/16 1/8 1/4 1/2 1 2 4

Fig-
ure

Control Description

1 PAD 1 Toggle Beatloop roll length index 1 (according parameter set)
2 PAD 2 Toggle Beatloop roll length index 2 (according parameter set)
3 PAD 3 Toggle Beatloop roll length index 3 (according parameter set)
4 PAD 4 Toggle Beatloop roll length index 4 (according parameter set)
5 PAD 5 Toggle Beatloop roll length index 5 (according parameter set)
6 PAD 6 Toggle Beatloop roll length index 6 (according parameter set)
7 PAD 7 Toggle Beatloop roll length index 7 (according parameter set)
8 PAD 8 Toggle Beatloop roll length index 8 (according parameter set)
13 PARAMETER

LEFT
Decrement active looproll-interval parameter set (0-3), button LED is illuminated at
parameter set 2, 3

14 PARAMETER
RIGHT

Increment active looproll-interval parameter set (0-3), button LED is illuminated at
parameter set 1, 3

SLICER Mode

For a detailed explanation of the slicer mode, take a look at the controller’s manual. A limited slicer functionality is
implemented into the controller mapping as described below.
There are two slicer modes, continuous slice and loop slice, which can be selected by pressing the SLICER mode button.
If none or only one pad (beat) is lit, continuous slice mode is active. If you press SLICER mode button again, loop slice
mode will be activated and all pads, except one for the beat, will light up.
Starting with the first beat marked on a playing track, the track is divided into sections of 8 equal parts (not visible in
waveform). If the first 8 parts are reached, the next section starts. The pads are assigned to one section, each time the
active section changes, the pads will be assigned to the new active section (pad 1..8 = section part 1..8). The section size
is dependent of the selected slicer domain, changeable by pressing SHIFT + PARAMETER LEFT or PARAMETER
RIGHT. The default slicer domain is 8 beats, so each part represents the part between one beat and the following beat.
Possible slicer domains are 8, 16, 32, 64 beats.

17.1. Controllers 395



Mixxx User Manual, Rilis 2.3.0

Fig-
ure

Control Description

1 PAD 1 Press: Jumps to beat position 1 in 8-beat-section and beat loops according quantization index
(default: 1/4 beat), Release (continuous slice only): Jumps to actual play position in the
background (slip).

2 PAD 2 Press: Jumps to beat position 2 in 8-beat-section and beat loops according quantization index
(default: 1/4 beat), Release (continuous slice only): Jumps to actual play position in the
background (slip).

3 PAD 3 Press: Jumps to beat position 3 in 8-beat-section and beat loops according quantization index
(default: 1/4 beat), Release (continuous slice only): Jumps to actual play position in the
background (slip).

4 PAD 4 Press: Jumps to beat position 4 in 8-beat-section and beat loops according quantization index
(default: 1/4 beat), Release (continuous slice only): Jumps to actual play position in the
background (slip).

5 PAD 5 Press: Jumps to beat position 5 in 8-beat-section and beat loops according quantization index
(default: 1/4 beat), Release (continuous slice only): Jumps to actual play position in the
background (slip).

6 PAD 6 Press: Jumps to beat position 6 in 8-beat-section and beat loops according quantization index
(default: 1/4 beat), Release (continuous slice only): Jumps to actual play position in the
background (slip).

7 PAD 7 Press: Jumps to beat position 7 in 8-beat-section and beat loops according quantization index
(default: 1/4 beat), Release (continuous slice only): Jumps to actual play position in the
background (slip).

8 PAD 8 Press: Jumps to beat position 8 in 8-beat-section and beat loops according quantization index
(default: 1/4 beat), Release (continuous slice only): Jumps to actual play position in the
background (slip).

13 PARAME-
TER LEFT

Decrement active slicer quantization (1/8, 1/4, 1/2, 1 beat loop), button LED is illuminated
at quantization 1/2, 1

13 SHIFT + PA-
RAMETER
LEFT

Decrement active slicer domain (8, 16, 32, 64 beats), button LED is illuminated at domain
32, 64

14 PARAME-
TER RIGHT

Increment active slicer quantization (1/8, 1/4, 1/2, 1 beat loop), button LED is illuminated
at quantization 1/4, 1

14 SHIFT + PA-
RAMETER
RIGHT

Increment active slicer domain (8, 16, 32, 64 beats), button LED is illuminated at domain
16, 64

Continuous slice mode

The pad lights show the active part in the active section: The active part pad is lit, all other pad lights are off.
Continuous slice mode moves to the next section if the end of the previous active section is reached.
By pressing pad X, the play position jumps to the beat X of the active section. If you have pressed the pad on-beat and
hold it, the play position is playing in loop. The beat loop length depends on the selected slicer quantization (changeable
by pressing PARAMETER LEFT or PARAMETER RIGHT). If you release the pad, the playback will resume where the
track would have been if the slicer wouldn’t have been activated (slip mode).
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Figure59: Pioneer DDJ SX Slicer (type 1)

Loop slice mode

The pad lights show the active part in the active section: The active part pad light is off, all other pads are lit.
As soon as loop slice mode is activated, the active section is played in loop (not visible in waveform). If the end of the
active section is reached, the play position jumps back to the beginning of the active section.

Figure60: Pioneer DDJ SX Slicer (type 2)

By pressing pad X, the play position jumps to the beat X of the active section. In loop slice mode beat loop is not possible.
As soon as loop slice mode is deactivated (by pressing SLICER mode button again), the playback will resume where the
track would have been if the slicer wouldn’t have been activated (slip mode).
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SAMPLER Mode

Fig-
ure

Control Description

1 PAD 1 Sample deck index 1 (according sampler bank) - empty: Load selected track into sample deck,
track loaded: start play (default, see user options) sample deck

1 SHIFT
+ hwla-
bel:PAD
1

Sample deck index 1 (according sampler bank) - playing: stop deck, stopped: eject track

2 PAD 2 Sample deck index 2 (according sampler bank) - empty: Load selected track into sample deck,
track loaded: start play (default, see user options) sample deck

2 SHIFT
+ hwla-
bel:PAD
2

Sample deck index 2 (according sampler bank) - playing: stop deck, stopped: eject track

3 PAD 3 Sample deck index 3 (according sampler bank) - empty: Load selected track into sample deck,
track loaded: start play (default, see user options) sample deck

3 SHIFT
+ hwla-
bel:PAD
3

Sample deck index 3 (according sampler bank) - playing: stop deck, stopped: eject track

4 PAD 4 Sample deck index 4 (according sampler bank) - empty: Load selected track into sample deck,
track loaded: start play (default, see user options) sample deck

4 SHIFT
+ hwla-
bel:PAD
4

Sample deck index 4 (according sampler bank) - playing: stop deck, stopped: eject track

5 PAD 5 Sample deck index 5 (according sampler bank) - empty: Load selected track into sample deck,
track loaded: start play (default, see user options) sample deck

5 SHIFT
+ hwla-
bel:PAD
5

Sample deck index 5 (according sampler bank) - playing: stop deck, stopped: eject track

6 PAD 6 Sample deck index 6 (according sampler bank) - empty: Load selected track into sample deck,
track loaded: start play (default, see user options) sample deck

6 SHIFT
+ hwla-
bel:PAD
6

Sample deck index 6 (according sampler bank) - playing: stop deck, stopped: eject track

7 PAD 7 Sample deck index 7 (according sampler bank) - empty: Load selected track into sample deck,
track loaded: start play (default, see user options) sample deck

7 SHIFT
+ hwla-
bel:PAD
7

Sample deck index 7 (according sampler bank) - playing: stop deck, stopped: eject track

8 PAD 8 Sample deck index 8 (according sampler bank) - empty: Load selected track into sample deck,
track loaded: start play (default, see user options) sample deck

8 SHIFT
+ hwla-
bel:PAD
8

Sample deck index 8 (according sampler bank) - playing: stop deck, stopped: eject track

13 PARAM-
ETER
LEFT

Decrement active sampler bank (0-3), button LED is illuminated at sampler bank 2, 3. Sampler
bank 0: sampler 1-8, sampler bank 1: sampler 9-16 sampler bank 2: sampler 17-24, sampler
bank 3: sampler 25-32

14 PARAM-
ETER
RIGHT

Increment active sampler bank (0-3), button LED is illuminated at sampler bank 1, 3. Sampler
bank 0: sampler 1-8, sampler bank 1: sampler 9-16, sampler bank 2: sampler 17-24, sampler
bank 3: sampler 25-32
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BEATLOOP Mode (GROUP2)

By using the PARAMETER LEFT and PARAMETER RIGHT buttons in BEATLOOP mode (default parameter set: 0),
you can change the pad-assigned loop size. The following table shows the possible assignments (unit: beats).

Set No. Pad 1 Pad 2 Pad 3 Pad 4 Pad 5 Pad 6 Pad 7 Pad 8
0 1/4 1/2 1 2 4 8 16 32
1 1/8 1/4 1/2 1 2 4 8 16
2 1/16 1/8 1/4 1/2 1 2 4 8
3 1/32 1/16 1/8 1/4 1/2 1 2 4

Fig-
ure

Control Description

1 PAD 1 Toggle Beatloop length index 1 (according parameter set)
2 PAD 2 Toggle Beatloop length index 2 (according parameter set)
3 PAD 3 Toggle Beatloop length index 3 (according parameter set)
4 PAD 4 Toggle Beatloop length index 4 (according parameter set)
5 PAD 5 Toggle Beatloop length index 5 (according parameter set)
6 PAD 6 Toggle Beatloop length index 6 (according parameter set)
7 PAD 7 Toggle Beatloop length index 7 (according parameter set)
8 PAD 8 Toggle Beatloop length index 8 (according parameter set)
13 PARAMETER

LEFT
Decrement active loop-interval parameter set (0-3), button LED is illuminated at pa-
rameter set 2, 3

14 PARAMETER
RIGHT

Increment active loop-interval parameter set (0-3), button LED is illuminated at pa-
rameter set 1, 3

Effect Functions

This controller mapping uses the standard Mixxx mapping for effects sections on controllers. The controls listed here are
documented in Section 2 ("Effects") of the owner's manual.
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Figure Control Description
1 (L) FX1-1 Focused effect none: Controls EffectRack1-EffectUnit1/3-Effect1 meta, Focused effect

1..3: Controls effect parameter 1 of effect in EffectRack1-EffectUnit1/3
1 (L) SHIFT + FX1-

1
Controls effect selection for EffectRack1-EffectUnit1/3 effect 1

1 (R) FX2-1 Focused effect none: Controls EffectRack1-EffectUnit2/4-Effect1 meta, Focused effect
1..3: Controls effect parameter 1 of focused effect in EffectRack1-EffectUnit2/4

1 (R) SHIFT + hwla-
bel:FX2-1

Controls effect selection for EffectRack1-EffectUnit2/4 effect 1

2 (L) FX1-2 Focused effect none: Controls EffectRack1-EffectUnit1/3-Effect2 meta, Focused effect
1..3: Controls effect parameter 2 of focused effect in EffectRack1-EffectUnit1/3

2 (L) SHIFT + hwla-
bel:FX1-2

Controls effect selection for EffectRack1-EffectUnit1/3 effect 2

2 (R) FX2-2 Focused effect none: Controls EffectRack1-EffectUnit2/4-Effect2 meta, Focused effect
1..3: Controls effect parameter 2 of focused effect in EffectRack1-EffectUnit2/4

2 (R) SHIFT + hwla-
bel:FX2-2

Controls effect selection for EffectRack1-EffectUnit2/4 effect 2

3 (L) FX1-3 Focused effect none: Controls EffectRack1-EffectUnit1/3-Effect3 meta, Focused effect
1..3: Controls effect parameter 3 of focused effect in EffectRack1-EffectUnit1/3

3 (L) SHIFT + hwla-
bel:FX1-3

Controls effect selection for EffectRack1-EffectUnit1/3 effect 3

3 (R) FX2-3 Focused effect none: Controls EffectRack1-EffectUnit2/4-Effect3 meta, Focused effect
1..3: Controls effect parameter 3 of focused effect in EffectRack1-EffectUnit2/4

3 (R) SHIFT + hwla-
bel:FX2-3

Controls effect selection for EffectRack1-EffectUnit2/4 effect 3

4 (L) FX1 BEATS Controls EffectRack1-EffectUnit1/3 mix
4 (R) FX2 BEATS Controls EffectRack1-EffectUnit2/4 mix
4 (L) SHIFT + hwla-

bel:FX1 BEATS
Controls EffectRack1-EffectUnit1/3 super1 knob

4 (R) SHIFT + hwla-
bel:FX2 BEATS

Controls EffectRack1-EffectUnit2/4 super1 knob

5 (L) FX1-1 ON EffectFocusButton press and hold: focus EffectRack1-EffectUnit1/3-Effect1, else: Tog-
gles EffectRack1-EffectUnit1/3-Effect1

5 (R) FX2-1 ON EffectFocusButton press and hold: focus EffectRack1-EffectUnit2/4-Effect1, else: Tog-
gles EffectRack1-EffectUnit2/4-Effect1

6 (L) FX1-2 ON EffectFocusButton press and hold: focus EffectRack1-EffectUnit1/3-Effect2, else: Tog-
gles EffectRack1-EffectUnit1/3-Effect2

6 (R) FX2-2 ON EffectFocusButton press and hold: focus EffectRack1-EffectUnit2/4-Effect2, else: Tog-
gles EffectRack1-EffectUnit2/4-Effect2

7 (L) FX1-3 ON EffectFocusButton press and hold: focus EffectRack1-EffectUnit1/3-Effect3, else: Tog-
gles EffectRack1-EffectUnit1/3-Effect3

7 (R) FX2-3 ON EffectFocusButton press and hold: focus EffectRack1-EffectUnit2/4-Effect3, else: Tog-
gles EffectRack1-EffectUnit2/4-Effect3

8 (L) FX1 TAP EffectFocusButton of EffectRack1-EffectUnit1/3
8 (R) FX2 TAP EffectFocusButton of EffectRack1-EffectUnit2/4
8 (L) SHIFT + hwla-

bel:FX1 TAP
Switch EffectUnit 1 <-> 3

8 (R) SHIFT + hwla-
bel:FX2 TAP

Switch EffectUnit 2 <-> 4

9, 10,
11, 12

FX1 ASSIGN Assign EffectRack1-EffectUnit1/3 to specific deck

13, 14,
15, 16

FX2 ASSIGN Assign EffectRack1-EffectUnit2/4 to specific deck

17, 18,
19, 20

FILTER Control QuickEffectRack1 super1 knob (e.g. moog filter)
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Troubleshooting

If you experience any strange behavior of a button or a LED (e.g. wheel LEDs not working), make sure your controller
is set up correctly to work with Mixxx. The DDJ-SX provides several settings, which can be changed in a special Utility-
Mode.

Utility-Mode

• Disconnect USB-cable.
• Switch off STANDBY/ON the unit.
• Hold SHIFT button and PLAY/PAUSE button at the left deck while switching on the unit STANDBY/ON.
• Now Utility-Mode is activated.
• For saving and exiting Utility-Mode, switch off the unit again STANDBY/ON.

Setting for usage of Serato DJ

To use the DDJ-SX with Mixxx, the controller must be configured for the usage of Serato DJ. You can check/change this
setting by pressing the KEY LOCK button at the left deck.

• KEY LOCK button off: Controller is configured for using Serato DJ (default).
• KEY LOCK button on (lit): Controller is configured for using different DJ-software.

17.1.99 Reloop Beatmix 2

The Reloop Beatmix 2 is a performance-oriented 2-channel pad controller with integrated soundcard. Beatmix 2 offers
an ergonomically designed 2-channel mixer layout, optimized for the club allowing you to work intuitively: Dedicated
equalizer and gain dials, high-quality line-faders, an extremely smooth-running crossfader, 16 multi-colour drum pads, as
well as two extensive FX units are the foundation for your creativity.
This controller is a midi and audio class compliant device so it is compatible as-is with Linux, MacOS and Windows.
However, onWindows, the manufacturer ship an ASIO low-latency driver that can be found on the manufacturer’s product
page.
The mapping for the Reloop Beatmix 4 should be compatible with this controller, but hasn’t been tested. See the Reloop
Beatmix 4 page for the complete mapping description.

• Manufacturer’s product page
• Forum thread

Baru pada versi 2.1.
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17.1.100 Reloop Beatmix 4

The Reloop Beatmix 4 is a performance-oriented 4-channel pad controller with integrated soundcard. It offers an er-
gonomically designed 4-channel mixer layout, optimized for the club allowing you to work intuitively: Dedicated equal-
izer and gain dials, high-quality line-faders, an extremely smooth-running crossfader, 16 multi-colour drum pads, as well
as two extensive FX units are the foundation for your creativity.

• Manufacturer’s product page
• Forum thread

Baru pada versi 2.1.

Audio

This controller is a MIDI and audio class compliant device so it is compatible as-is with Linux, MacOS and Windows.
On windows, the manufacturer ships an ASIO low-latency driver that can be found on the Manufacturer’s product page.
The MIC input is hardware-mixed and is not digitized so Mixxx can not have any control on the mic and you can not
use ducking in Mixxx. The MASTER volume and PHONES volume knobs directly control hardware and don’t change
Mixxx controls.

Mixer Section

Control Description
MASTER Controls the master volume to your main sound system. This controls the built in sound card

and has no effect on the master gain knob in Mixxx.
PHONES Controls your headphones volume. This controls the built in sound card and has no effect on

the headphone gain knob in Mixxx.
CUE MIX Mixes the headphones CUE signal between your selected channel and the master output.
TRAX SELECT Use the Trax selector to navigate through your song library.
TRACK LOAD
(short press)

Load tracks on either channel. These buttons are lit when a track is loaded into the associated
deck.

TRACK LOAD
(long press)

Eject the selected deck.

SHIFTTRACK
LOAD

Enable and launch a track using your linefader (FADER-START, hardware function)

CUE Pre-listen the selected channel in your headphones. This buttons lights-up when activated
BACK Switch Trax action between playlists (sidebar), tracks and Preview Deck.
SAMPLER VOL-
UME

Controls the volume of all samplers.

LINE FADERS Controls your channel volume.
CROSSFADER Enables you to fade between your decks.
GAIN Adjust the gain for each deck.
EQ Tweak the high, mid or low frequencies when mixing your track.
DECK Press the deck button to swap between decks 1 & 3 on the left and 2 & 4 on the right.

Petunjuk: You can replace the fader cap of the SAMPLER VOLUME fader with a custom colored fader cap to make
it visually stand out from the channel volume faders.
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Trax selector and Back button

The trax selector let you navigate through your library (playlist and tracks) as well as preview tracks.
The trax selector has three modes:
Track mode (default) Turning the trax selector will select tracks (one by one), turning with shift will select tracks faster

(10 by 10). Pressing the Back button will switch to Playlist mode and pushing the trax selector will load the selected
track into the preview deck, start playing and switch to Preview mode.

Playlist mode Turning the trax selector will select sidebar item (one by one), turning with shift will select sidebar item
faster (10 by 10). Pressing the trax selector will expand/collapse the selected sidebar item and pressing the Back
button will return to Track mode.

Preview mode Turning the trax selector let you navigate through the track loaded in the PreviewDeck (faster with shift),
pushing the trax selector will play/pause the preview deck and pushing the back button return to Track mode.

Transport Section

Control Description
PLAY/PAUSE Press to launch and pause your track.
SHIFT +
PLAY/PAUSE

Reverses the direction of the track playing.

CUE Sets a temporary cue point. It is set by pausing the track and pressing the CUE button. While the
track is playing, press the button to return to that point, where it will pause.

SHIFT +
CUE

Takes you back to the start of your track.

CUP Takes you directly to your cue point and starts playback instantly. If no cue point is set, it will jump
to the beginning of the track.

SHIFT +
CUP

Changes the pitch range, cycling through 8%, 10%, 12% and 16%

SYNC Syncs the BPM and phase to that of the other track (if BPM is detected on both).
SHIFT +
SYNC

Turn on master sync, keeping sync enabled

Jog wheel and pitch slider

Touch and move the jog wheel to scratch (either deck playing or not).
When playing, use the side of the wheel, without touching the metallic platter, to temporarily bend the pitch (speed
up/slow down playback). When the deck is not playing, using the side of the wheel let you quick search through your
track.
Hold SHIFT and turn the jog wheel to quick search through your track. SHIFT ignores touch sensitive platter so holding
it and turning jogwheel is the same as using the side of the jog wheel.
When a deck is playing, jog led will turn around at 33.3 RPM. When track time left is below 30 seconds, jog leds will
blink slowly, and when track time remaining is below 15 seconds, jog leds will blink quickly. These delays can be changed
by editing the two variables at the beginning of the JavaScript file and eventually set to -1 to disable jog led blink.
The pitch slider let you adjust pitch.
PITCH +/- buttons let you temporarily adjust the the speed one step higher/lower. These buttons, when used with shift,
let you control effects.
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Effects Section

The effect section let you control the first two EffectUnits. There are two different effect modes mapped:
• Multi Effect mode (the default), where you can load up to three effects in each EffectUnit and control then with the
super knob

• Single Effect mode, where you can load a single effect in the Effect Unit and control the first 6 parameters

Control Multi Effect mode Single Effect mode
FX1 Turn left to disable effect 1 Effect parameter 1
FX2 Turn left to disable effect 2 Effect parameter 2
FX3 Turn left to disable effect 3 Effect parameter 3
SHIFT + FX1 select effect 1 Effect parameter 4
SHIFT + FX2 select effect 2 Effect parameter 5
SHIFT + FX3 select effect 3 Effect parameter 6
BEATS (turn) SuperKnob dry/wet knob
BEATS (push) Toggle Effect Unit
SHIFT + Beats (turn) Dry/Wet knob Select Effect Chain
SHIFT + Beats (push) Eject Effect Chain

You can choose which deck you want to apply EffectUnit 1 and 2 by pressing SHIFT + PITCHBEND - / SHIFT +
PITCHBEND + on that deck (short press).
To switch from Single Effect mode to Multi Effect mode, hold down SHIFT and press PITCHBEND - for more than a
second to switch to “Single Effect mode” or PITCHBEND + for more than a second to switch to “Multi Effect mode”.
The corresponding led will blink three times, indicating which mode you switched to.

Pad Section

Mode A - Cue points and Loops

Control Description
Pads 1-4 (top row) Press an unlit pad to set a new cue point. If it is already set, jump to this cue point.
SHIFT + Pads 1-4 (top row) Deletes cue points.
Pads 5-8 (bottom row) Press the pad to activate a loop. Loop length (in beats) is respectively 1, 2, 4 and 8

beats.
SHIFT + Pads 5 (bottom
row)

Sets a loop length. Push to define loop start, release to define loop end.

SHIFT + Pads 6 (bottom
row)

Shortens (half) the loop.

SHIFT + Pads 7 (bottom
row)

Lengthens (double) the loop.

SHIFT + Pads 8 (bottom
row)

Replays the loop.
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Mode B - Samplers

Mode B let you control 8 samplers. Top row is for sampler 1-4 and bottom row is for sampler 5-8, each sampler controlled
by a pad button.
Press an unlit pad to load the track selected in the library to that sampler. Pads are red when the sampler is loaded but
not playing and purple when playing.
Press a red pad to play the sample from its cue point. Press a purple pad to jump back to the sample’s cue point.
Press a purple pad with shift to stop a playing sample. Press a red pad with shift to eject a sample.

Split mode

Split mode is activated by pressing mode A and mode B buttons simultaneously. The two leds A and B are lit together.
In this mode, to top row is configured in mode A, and the bottom row if configured as the top row of mode B.
So in this mode, you can control 4 cue points and 4 samplers.

17.1.101 Reloop Beatpad

The Reloop Beatpad is a conventional 2 channel controller that is primarily designed to work with algoriddim‘s djay on
the iOS platform and more recently on the Android platform, but can also be used with Mixxx by sending MIDI signals
to a computer with a USB cable.

• Manufacturer’s product page
• Forum thread

Baru pada versi 2.0.

Mixer Section

Crossfader

Blends audio between left and right mixer channels.

Volume Faders

Adjust the Volume of each channel. If Fader Start <reloop-beatpad-trackselect> is enabled the deck will stop at the
previously used Cue if the Volume Fader reaches the minimum position and will start playing if the Volume fader moves
from the minimum position.
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1 and 2 (Track select buttons)

• Load a track: Press these buttons to load the selected track from the Browser to left or right deck. The LED of
the button will be on if the deck is loaded.

• Eject: Hold the same button for more than half of a second to unload the same deck.
• Fader Start: Hold SHIFT down and then press one of these buttons to enable the Fader Start on a deck. The
LED of the button will blink if Fader Start is enabled. If Fader Start is enabled the deck will stop at the previously
used Cue if the Volume Fader reaches the minimum position and will start playing if the Volume fader moves from
the minimum position.

PFL (symbolized by a headphone)

• **PFL: **Press these buttons to send each channel to the Headphones Output channel for pre-listening.
• **Slip mode: **Hold SHIFT down and then press these buttons to activate/deactivate Slip Mode. When active, the
playback continues muted in the background during a loop, scratch etc. Once disabled, the audible playback will
resume where the track would have been.

• Quantize mode: Hold SHIFT down and then press these buttons to activate/deactivate the Quantize mode. When
active, it aligns Hot-cues and Loops to the next beat from the current position.

Equalizer

• LOW: Adjust the Low (Bass) frequencies for each mixer channel.
• MID: Adjust the Mid frequencies for each mixer channel.
• HIGH: Adjust the High (Treble) frequencies for each mixer channel.
• GAIN: Adjust the Gain of each mixer channel.
• MASTER: Adjust the level of the Master Output.
• Cue Mix (Hadphones mixing): Adjust how the Channels and the Master Output blend at the Headphones Chan-
nel.

• Phones (Hadphones level): Adjust the Volume Output of the Headphones Channel.
• AUX: Adjust the Volume of the AUX Input.

The MASTER, Phones, and AUX knobs adjust the levels of the Beatpad’s sound card; they do not control the software
gains in Mixxx so the changes are not visible on screen.

REC

• Record: Use this button to start/stop recording your mixing session.
• End track warning: Hold SHIFT down and then press this button in order to toggle on or off the red flashing of
the jog wheels when the playback reaches the end of the track.
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Browse Knob

Scroll through your library.
• Turn to select a track in the song list.
• Push to load the selected track into first stop deck.
• SHIFT+Turn to select a folder or subfolder in the left item list sidebar.
• SHIFT+Push to open/close folders and subfolders in the left item list sidebar.

Deck Controls Section

SHIFT

Press and hold one of those buttons to access secondary functions of other controls on the Beatpad. The secondary
functions can be accessed while the SHIFT button is held down. If the SHIFT LOCK switch on the back side of the
Reloop Beatpad is on, the secondary functions can be accessed after the button SHIFT button is released and until the
SHIFT is pressed again.

PLAY/PAUSE

• Play/pause: Press to play/pause the track. If there was no track loaded into the deck and a track is selected in the
library, it is loaded and starts playing.

• Censor: Hold SHIFT down and then press this button to play the track in reverse. When released the track will
continue to play from the position it would have been if the button was never pressed. In other words, it enables
reverse and slip mode while held.

JUMP

• While playing, or stopped: If the Cue point is set, seeks the player to it and starts playback.
• Brake: Hold SHIFT down and then press this button to stop the track with a gradual brake. If the JUMP button
is released before the track has completely stopped, the track is then played back to its regular speed.

• Spinback: see the Instant FX usage.

SET

• While playing: Seeks the track to the cue-point and stops.
• While stopped: Sets the cue point (Pioneer/Mixxx mode) OR preview from it (Denon mode). If the Cue point is
already set at the current position of the track, hold this button to play the track and release it to return to the Cue
point and pause it. To continue playback without returning to the Cue Point, press and hold the SET Button, then
press and hold the Play/Pause Button and then release both buttons.

• Key lock: Hold SHIFT down and then press this button to enable/disable the Key-lock.

Petunjuk: Change the default cue mode in Preferences -> Interface. The Pioneer mode is the more consistent with the
Reloop Beatpad.
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SYNC

• Press once to synchronize the tempo (BPM) and phase to that of the other track.
• Press twice quickly to play the track immediately, synchronized to the tempo (BPM) and to the phase of the other
track, if the track was paused.

• Sync Lock: Hold for at least half of a second to enable sync lock for this deck. Decks with sync locked will all
play at the same tempo, and decks that also have quantize enabled (which is enabled by default by the mapping)
will always have their beats lined up. Note : the quantize mode is not mapped on the controller but can be
enabled/desabled from Mixxx.

Jogwheel

Touch sensitive platters for scratching (Scratch mode/iCut mode), bending (Scratch mode/CD mode) or Seek mode.
The jogwheel offers multi-color leds, which will show the playing marker (Scratch mode), the song progress bar (in
Seek mode), and other colored combinations depending on the applied effect, loop, loop roll or Filter. If no track is
loaded, the jogwheel displays a red cross. At the end of a track, the jogwheel is flashing red faster and faster until it
reaches the end of the track (full steady red).
You can toggle on/off this behavior with SHIFT + REC.

Scratch mode

Toggle with the JOG SCRATCH button.
Use the jogwheel to scratch and the outer ring to bend (like in CD mode).

• iCut mode: Hold SHIFT down and scratch to scratch in “automagic” scratch mode. When the jog wheel is
turned back, the crossfader is closed. When the jog wheel is turned forward, the crossfader opens. (Note that the
Algoriddim djay mapping actually closes/opens the crossfader quickly without taking into account the direction of
the wheel, contrary to what the Beatpad’s Quick Start guide says.)

Seek mode

Toggle with the JOG SEEK button.
Use the jogwheel to navigate through the track.

CD mode

Deactivate both the Scratch mode and the Seek mode to enable this mode.
Use the jogwheel to temporarily bend the pitch of the track (which only affects the tempo with keylock on).

17.1. Controllers 409



Mixxx User Manual, Rilis 2.3.0

PITCH BEND

• Pitch bend: Use these buttons temporary slow-down/speed up the tempo of the track. Once the buttons are
released the track will continue to play at the tempo designated by the pitch fader.

• Beat Jump: Hold SHIFT down and then use these buttons to jump 1 beat backwards or forward.

PITCH

Controls the track’s pitch. With keylock on, this only changes the tempo. The red LED indicates that the pitch fader of
the unit is on zero (center) position.

Loops Section

• Loop size: Turn the encoder to select the number of beats for a loop. Turn it counterclockwise to half the size of
the loop and clockwise to double it.

• Loop move: Hold SHIFT down and then use the encoder to move the triggered loop forward or backwards by 1
beat.

• Activate/deactivate: (Acts exactly like the LOOP Button)
• Regular loop mode: Push (and release) the encoder to trigger a loop of the selected size
• Roll loop mode: Press (and hold down) to trigger a momentary rolling loop of the selected size. While the encoder
is held down, the track will keep moving forward as if it was not looping, so when the encoder is released, it will
jump forward to where the track would have been if the rolling loop was never enabled. In other words, this is a
regular loop in slip mode.

• Toggle loop mode: Hold SHIFT down and then push the encoder to toggle between Regular and Roll Loop mode.
Lihat juga:
Rolling loops can be set using the Bounce Loop (Roll) mode.

Effects Section

FX ON

Push (and release) this button to trigger the selected effect chain for the corresponding deck (toggle function).

FX SELECT

• Select: Use this encoder to select an effect for the current selected rack.
• Temporary effect: Push and hold the encoder to temporarily apply the effect of the current selected rack for the
corresponding deck (while pressed).

• Quick Effect: Hold SHIFT down and then push the encoder Activate or Kill the Quick Effect. You can change
the Quick effect assigned in Mixxx, via Options -> Settings-> Equalizers -> Quick Effect.
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FX PARAM

• SUPER: Use this knob to control the SUPER parameter of the effect for the current selected rack.
• MIX: Hold SHIFT down and then use this knob to control theMIX parameter of the effect for the current selected
rack.

FILTER

• Quick Effect: Use this knob to apply the Quick effect (by default, this is Filter, but you can change it) to the deck.
In middle position no effect is applied for filter.

• Key: Hold SHIFT down and use this knob to adjust the key (pitch) of the track without changing the tempo. In
middle position the track will have its original key.

Pads Section

The 4 Performance Pads offer 4 different modes, depending on the 4 PAD MODE buttons just above.

HotCues mode

CUE

Press the CUE mode button to set the PADs to HOT CUE mode.

Pads

• Press each one of the 4 pads to assign a Hot Cue Point (1 to 4) or returns the track to that Hot Cue Point. When a
Hot Cue Button is unlit, you can assign a Hot Cue Point by pressing it at the desired point in your track. Once it is
assigned, the Hot Cue Button will light up blue.

• ** SHIFT + Press** to delete its assigned Hot Cue Point.

Bounce Loop (Roll) mode

BOUNCE LOOP

Press the BOUNCE LOOP mode button to set the PADs to Loop Roll mode.

Pads

Press (and keep down) any of the 4 pads to trigger a momentary Loop Roll of a different size (in beats) as per the table.
===================+++++===================== === === === === Pads 1 2 3 4 Press 1/8 1/4 1/2 1
SHIFT + Press 2 4 8 16 ===========++================================ === === === ===
Once the PAD is released the track will continue to play from the position it would have been if the Loop Roll was never
triggered. The size of the applied Loop Roll can be adjusted with the LOOP SIZE encoder as well. Pads change the
“selected loop size” introduced in LOOP SIZE and LOOP sections.
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Instant FX mode

Instant FX

• Press this button to set the PADs to Effects mode.
• Spinback: Hold SHIFT down and then press this button down in order to stop the track with a backward brake
effect. If the Instant FX button is released before the track has completely stopped, the track is then played back
to its regular speed, in the forward direction.

• Brake : see JUMP button usage

Pads

• Instant FX: Press (and keep down) any of the 4 pads to apply momentarily the effect of the corresponding effect
rack. The parameters of these effects can be adjusted from the FX PARAM knob.

• Current effect rack selection: Hold SHIFT <reloop-beatpad-shift> down and then press any of the 4 pads to
select the current effect rack for this deck that will be used for effect selection or for the corresponding effect to be
triggered later on (see Effects Section). this can also be done with a visual feedback in Sampler mode.

Sampler mode

Note: On account of the Reloop Beatpad limitations (bug ?), lights will not show on in Sampler mode when the controller
is in SHIFT mode.
Press the SAMPLER mode button to set the PADs to cycle between 4 sub modes:

• Sampler mode (orange LEDs): each pad triggers a sample from the selected Sampler bank. The PADs wgich are
lit indicate which samples are loaded and ready to use. While a sample is playing, the corresponding PAD changes
its color to pink.

• Sampler bank selectionmode (pink LED): each pad selects 1 of the 4 sampler banks. The PAD that is lit indicates
which bank is active.

• Loop mode status and selection (magenta LEDs): press any pad to toggle between regular loop mode and roll loop
mode. Regular loop mode is symbolized by the left PAD lit, representing the loop), and all the others switched
off. Roll loop mode is symbolized by both the left (representing the loop) and the right PADs lit (symbolizing the
position after the loop where the track will continue to play when the loop will be triggered off).

• Effect rack selectionmode (purple LED): each pads selects 1 of the 4 effect racks. The PAD which is lit indicates
which effect rack is active (see Effect Section).

Troubleshooting

Grounding problem

If your controller randomly freezes or your iPad or Android tablet acts weirdly (screen flashing, bad sound), make a home
made, grounded power cable.
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Controller not detected by Windows

If you see a yellow exclamation point (!) in the Windows Device Manager indicating that the drivers did not start, unplug
the power cable from your laptop then unplug/replug the USB cable from your controller. If that does not work, restart
your laptop without the power cable plugged in.

17.1.102 Reloop Digital Jockey 2 Controller Edition

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.8.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.103 Reloop Digital Jockey 2 Master Edition

• Manufacturer’s product page
• Forum thread

Baru pada versi 1.8.

Peringatan: This device is not USB MIDI class compliant. Its signals are translated to MIDI by special drivers on
Windows and macOS. There is no driver available for Linux.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.104 Reloop Jockey 3 Master Edition

The Reloop Jockey 3 Master Edition is a 2 Channel Controller with the option to control 4 Channels. It has a built-in
sound card with 6 channels in and 4 channels out. It features both balanced 1/4" and unbalanced RCA master outputs
plus RCA booth outputs with an independent volume control. It can also be used as a stand-alone mixer, or used to mix
an analog source with music files in Mixxx. This device requires a power adapter in addition to the USB cable.

• Mixxx Forum Thread
• Manufacturer’s product page
• Manufacturer’s manual

Baru pada versi 2.1.

Peringatan: This device is not USB MIDI class compliant. Its signals are translated to MIDI by special drivers on
Windows and macOS. There is no driver available for Linux.
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Setup

The Mixxx mapping uses the same settings as Reloop’s Traktor mapping. Leave the MIDI channels as the default 1-4. If
you have problems with the jogwheels, set the jogwheel resolution to 2048. (Please read the manual of this Controller
section 5.1 and 5.1.2)
Set the Input 1 and Input 2 switches on the front side of the Jockey 3 ME to SW.

Mixxx Sound Hardware Preferences

• Master output: channels 1-2
• Headphone output: channels 3-4
• Auxiliary or vinyl input 1: channels 1-2
• Auxiliary or vinyl input 2: channels 3-4
• Microphone input: channels 5-6

Mapping Description

Mixer Section

• Trax encoder: scroll through library. With shift, scroll through sections on the left side of the library. Push to
toggle big library.

• Load button: load selected track into active deck
• Deck switches: select between controlling deck 1/3 or analog input 1 on the left; select between controlling deck
2/4 or analog input 2 on the right. Note that the analog inputs are only affected by the mixer controls but not the
other deck controls.

• Gain: set deck gain
• High/mid/low: adjust EQ for high/mid/low frequencies
• Master/booth/phones: control the Jockey 3 ME’s sound card. These knobs do not send MIDI messages or adjust
values in Mixxx, so turning them will not change anything on screen. Use these but don't change the software knobs
on screen in Mixxx.

• Headphones: play deck on headphone output
• Cuemix: Fade between PFL and master output on headphones
• Vertical faders: deck volume
• Level meter LEDs: show the level of the deck
• Crossfader: fade between decks
• Crossfader curve (front side of controller): Adjust crossfader curve between fade and cut.

17.1. Controllers 414



Mixxx User Manual, Rilis 2.3.0

Transport Section

• Play/pause: play/pause or, with shift, toggle keylock
• Cue: behavior depends on cue mode set in Mixxx preferences. With shift, it does not work as labeled; it toggles
quantize.

• Cup: Like Cue, but it plays only after releasing the button.
• Sync: toggle master sync. With shift, it does not work as labeled; it toggles microphone talkover.

Jogwheels

Set the jog wheel mode by pressing one of the 4 buttons beside the jog wheel, below the trash and 5-8 buttons.
• Off: By default, all mode buttons are off. In this default mode, moving the jogwheel temporarily bends the pitch,
regardless of whether it is moved from the top or the side.

• Scratch: Move the wheel from the top to scratch. Touch the outside rubber ring to temporarily bend the pitch.
• Pitch bend: Move the wheel to control the SuperKnob on EffectUnit of this Deck. FIXME (Maybe a Touch
Control?)

• Search: Search position in file quickly. Touch stops the Deck.
• Trax: Not Mapped. FIXME (No Plans)

Hotcue Section

Press an unlit hotcue button to set that hotcue at the current position. Press a lit hotcue button to jump to that hotcue.
To delete a hotcue, hold the Trash button while pressing a hotcue. To toggle between hotcues 1-4 and 5-8, press the 5-8
button.

Loop Section

• Length encoder: Press to activate a 4 beat loop. Double or half the beats of the loop by turning
• Move encoder: Move a track 4 Beats forward or backward. Push, hold and Turn it to halve or double the value of
4 Beats.

• Loop button: Turn on/off a Loop that is set from Length encoder. With shift, sets the start position of a loop.
• Reloop button: Repeat the entire file. With shift, sets the end position of a loop.

Other controls

• Filter: turn to apply a highpass or lowpass filter. On Deck A, press Shift and turn Filter to adjust the Gain of the
Microphone

• Pan: On Deck A, turn to fade between the left and right speakers on the master output. (Balance)
• < Beat: Beatjump by one beat back. With shift, moves the beatgrid lines further from each other (lower BPM by
0.01)

• Beat >: Beatjump by one beat forward. With shift, moves beatgrid lines closer to each other (raise BPM by 0.01)
• Pitch fader: adjust playback rate of deck (with keylock, only adjusts tempo and not pitch)
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• +/-: Pitch temporarily faster or slower.
• FX 1: Shift - (Minus) does not function as labeled. It aligns the beatgrid with the current play position.

Effect Section

The effect section controls the effect chain with the same number as the deck selected by the deck switch, although any
effect chain can be applied to any deck.

• Dry/wet: adjust how much the effect is applied. With shift, turn to select different effect chain presets
• FX Param: adjust effect parameters 1-3 for the first effect in the chain.
• Press FX Param 1-3 + Shift: edit how effect parameters are linked to the superknob. The effect selected corre-
sponds to the number of the FX Param encoder pressed. For example, pressing FX Param 2 with shift on deck 3
edits Effect2 of the EffectRack3. Each encoder press with shift changes what is being edited:

– Select which effect parameter to edit
– Select a [[effects framework#linking values|superknob link type between 0 and 4]] for the parameter selected
on the first press

– Select whether the [[effects framework#linking values|superknob link is inverted]] for the parameter selected
on the first press

– Close superknob link editing mode
• FX on: enable/disable effect chain
• FX B1/2/3: enable/disable effect 1/2/3 on this chain
• Preset 1-4 (shift+effect buttons): apply effect chain to that deck number

17.1.105 Reloop Terminal Mix 2/4

• Terminal Mix 2 product page
• Terminal Mix 4 product page

The Reloop Terminal Mix 2 and Terminal Mix 4 use the same mapping in Mixxx.
Baru pada versi 1.11.

Sound hardware

The Reloop Terminal Mix 2 and Terminal Mix 4 have integrated multichannel sound cards. Usually, the TerminalMix
runs very well with USB power only. If you experience issues especially when powering both Master and Booth outputs
at high levels you should use the additional power supply (6v/1.5A). The official manual from Reloop states not to operate
the unit at temperatures below 5°C/41°F as it might damage A/D converters and other components. However, the audio
output may already start crackling if the temperature drops below 10°C.

17.1. Controllers 416

http://web.archive.org/web/20190916160609/http://www.reloop.com/reloop-terminal-mix-2
https://web.archive.org/web/20190916134709/http://www.reloop.com/reloop-terminal-mix-4


Mixxx User Manual, Rilis 2.3.0

Inputs

Both TerminalMix 2 and 4 have a microphone and a switchable line/phono input that can be routed into Mixxx. The
Microphone jack is at the front side of the controller, the RCA line jacks are at the back next to the line/phono switch.
For both inputs there is a gain knob and a switch on the controller’s front side that toggles between routing the signal to
the computer (SW) or mixing it directly with the master output (MST). MST allows to play music from external sources
without any software, for example while setting up Mixxx software. Switch to SW if you want to use the line signal for
vinyl control or AUX input, or if you want to record the microphone input with Mixxx, broadcast it, or put on effects.

Outputs

At the front, there are two headphone jacks (1/8" and 1/4“), both affected by the hard-wired TONE knob. At the back,
there are unbalanced outputs for booth and master (RCA), as well as a balanced master output (1/4”). The output level of
both master outputs, booth and headphone outputs are all controlled by respective hard-wired knobs in the center column
which can’t be mapped to software.

Controller hardware / Maintenance

The jog wheels’ touch sensitivity can be adjusted separately. Refer to the official manual for instructions.
When used in dusty environment for a while you might find the MIDI LED flickering although you didn’t touch any of
the controls. This is mostly due to dust/fuzz particles in the ‘comb’ at the jog wheels’ underside that is distracting the IR
light barriers that detect platter movement. Remove the particles with a vacuum cleaner, or blow into the gap between
wheel and housing.
After a few years of heavy usage the buttons and sliders may start to wear out. Then, buttons need to be pressed harder
or in a different manner than what was working before, and sliders may send false values when they are actually in the
‘off zone’. Luckily, the buttons are standard parts and relatively easy to replace, and the sliders’ conductive surface can be
cleaned with Q-tips and alcohol.

Mapping options

The mapping the following customization variable at the top of the script you can set to your liking:
• pitchRanges: Set the pitch slider range each time you toggle it.

Just open the Reloop Terminal Mix 2-4.js file in your favorite text editor and you’ll see these variables right
near the top. Edit and save and Mixxx will automatically reload the mapping.

Deck controls

The controls are the same on both sides of the controller. The left side controls Deck 1 or 3 and the right side controls Deck
2 or 4.

• RANGE button - Toggles the pitch slider range. See Mapping Options.
• KEYLOCK* button - Toggles key lock.
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FX Controls

This mapping uses the Standard Effects Mapping to control the FX units.

Catatan: These knobs and buttons don’t switch to decks 3 and 4.

• FX1/2/3 knobs
– control the Meta knob of each effect
– focused effect: control the first three knob parameters of the focused effect

• ON buttons
– Press: toggle the effects
– Press + hold: temporarily toggle an effect
– focused effect: control the first three button parameters of the focused effect

• BEATS encoder
– Turn: adjust the Wet/Dry knob of the effect unit
– Press repeatedly: adjust the BPM (not the pitch/speed!) of the loaded track
– SHIFT + Press: move the nearest beat marker to the current play position

• TAP button
– LED flashes on each beat
– Press + hold, then press any ON button to focus the respective effect
– SHIFT + Press: switch between FX units 1/3 (left FX section) and 2/4 (right FX section)

Loop Controls

• LENGTH knob
– Turn: double or halve the current loop size (beats) visible in loop size spinbox in each skin.
– Press: set and activate a loop of loop size

• SHIFT + Press: re-activate the previous loop
– play position behind loop-out: jump to loop-in point and play loop from there
– play position before loop: activate loop, keep playing and enter loop when play position crosses loop-in marker

• IN / 1/2x button
– Press: set the loop in point, flashes when a loop is active
– Press + hold: drags the loop in point of an active loop

• OUT / 2x button
– Press: set the loop out point, flashes when a loop is active
– Press + hold: drags the loop out point of an active loop

• MOVE knob
– Press + turn: adjust the //beatjump size// visible in beatjump spinbox in each skin
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– Turn with no active loop: jump back or forth in the track by beatjump size
– Turn with active loop + Quantize OFF: move the loop position by 1/8 beat per detent (helpful to correct the
loop in point in case it's set slightly too early or too late)

– Turn with active loop + Quantize ON: move the loop position by one beat per detent (helpful to correct the
loop in point in case it snapped to the wrong beat marker)

– SHIFT + turn with active loop: shift the loop back or forth by beatjump size

Hot cues / Sampler buttons

• Hot cue buttons 1-4
– LED: lit if a hot cue is set
– Press: set or recall a hot cue
– Press + hold when deck is stopped: play from hot cue as long as button is pressed. Press Play to continue
playing after releasing hot cue button

– Press + hold when deck is playing: jump to hot cue and play from there
– SHIFT + press: delete the hot cue

• ▶ 1-4 Sampler buttons
• LED: lit when a sample is loaded to the corresponding sampler, flashes when that sampler is playing.
• Press: play the sample from the beginning
• SHIFT + Press: stop the sample
• ✂ (scissors) button - Switches hot cues 5-8 and samplers 5-8

Wheel & Vinyl button

• Vinyl/Search button
• Press + release: toggle scratching with the wheel (LED On)
• Hold down + turn the wheel: seek through the track
• Wheel
• Vinyl mode ON

– Touch the top black area + turn: scratch the current track like a vinyl record
– Touch gray rim only + turn: perform a temporary pitch bend

• Vinyl mode OFF
– Touch wheel anywhere + turn: perform a temporary pitch bend
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Transport buttons

• ▶◀ (Sync) - Synchronizes the tempo and beat phase of this deck to that of the other.
• CUP (Cue-Play) Start playback from the cue point (also known as stutter play)
• Q (Cue)

– LED: lit or flashes when play position is at cue point, depending on the cue mode.
– Press: Set or recall the main cue point on the track
– Press + hold: play from Cue point. Release stops playback

• ▶|| (Play/Pause) Toggle playback of the track
• SHIFT + ▶◀ (left deck) / SHIFT + ▶|| (right deck)

– initiate the brake effect for the respective deck: track slows down to full stop.
• Touch wheel, Vinyl mode ON: track speed jumps back to normal (considering the pitch slider) and playback
continues as soon as the wheel is released. Open the controllers/Reloop Terminal Mix 2-4.js file
and look for TerminalMix.brake to adjust parameters.

• 3 / 4 button - When lit all deck buttons (except FX controls) control deck 3 (deck 4 respectively).

Mixer controls

Channel strips

The below controls adjust the specified parameter of the respective virtual deck.

• GAIN knob - Adjusts the pre-fader gain
• HIGH/MID/LOW EQ knobs - Adjust the volume of the respective frequency range
• FILTER knob - Adjust the QuickEffect Meta knob (default: filter)
• Headphone button - Toggles hearing the deck in the headphone output
• 1 / 2 / 3 / 4

– Press: load the currently highlighted song into that deck.
– SHIFT + press: toggle fader-start (on the channel fader and cross-fader when applicable.) The button flashes
when fader-start is enabled on that deck.

• Channel slider - Adjust the output volume
The below controls are not deck-specific.

• MASTER knob - Adjust the master output volume of the internal sound card. (Hard-wired knob, does not send
MIDI messages)

• BOOTH knob - Adjust the booth output volume of the internal sound card. (Hard-wired knob, does not send MIDI
messages)

• PHONES knob - Adjust the headphone output volume of the internal sound card. (Hard-wired knob, does not send
MIDI messages)

• CUE MIX knob - Adjust how much of the headphone bus vs the master output you hear in the headphones.
• SAMPLER VOLUME knob - Adjusts the volume of all of the samplers at once.
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• CRATES button - Does nothing at the moment. (Mixxx’s library doesn’t yet support direct panel selection.) Use
the MIDI Learning Wizard to assign an action.*

• VIEW button - Does nothing at the moment. Use the MIDI Learning Wizard to assign an action.* - PREP button
- Does nothing at the moment. Use the MIDI Learning Wizard to assign an action.

• BACK button
– Press: move the highlight in the active library panel to the right
– SHIFT + Press: move the highlight to the left

• TRAX knob
– Turn: move the highlight up/down by one line
– SHIFT + turn: move the highlight one page up/down
– Press while Tree panel has focus: expand an item if possible. If item can’t be expanded further, it is selected
and and highight is shifted rightwarde to the respective tracks table.

– Press while tracks table has focus: perform the Track Load Action specified in Preferences ‣ Library (default:
load track to next empty deck)

• Volume Level Meter
– LEDs display the hardware (!) volume of the Master output (2 blue LEDs at the top indicate clipping)
– Attention: the Master volume might already clip in Mixxx before the hardware LEDs light up. You can adjust
the hardware Master volume knob and target loudness in Preferences ‣ Normalization ‣ ReplayGain to keep
enough headroom for the Master volume in Mixxx and make the lower blue LEDs light up when the Master
volume clips in Mixxx

• POWER LED (red)
• MIDI LED (blue)

– Flashes when a MIDI messages was sent
– When it flashes although no control is touched, it’s probably due to dust in the jogwheels (See Controler
Hardware / Maintenance)

• Shift Lock switch at the back side
– ON: press SHIFT buttons once to switch to secondary button/knob actions
– OFF: press & hold SHIFT buttons to switch to secondary button/knob actions

Cross-fader section

Move the cross-fader to smoothly fade between the decks assigned to either side.
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Deck assign switches (Terminal Mix 4 only)

Use the four switches on the front of the unit to choose on which side of the cross fader that deck will be heard. (Note
that the fader-start functionality correctly follows this assignment.) If “thru” is selected, the cross-fader will not affect the
audio from that deck and it will always be heard.

Curve adjust

Use the knob to adjust the curve from a smooth fade to a fast cut.
The remaining controls on the front of the unit adjust hardware parameters and are not MIDI-mappable.

17.1.106 Roland DJ-505

Figure61: Roland DJ-505 (schematic view)

The Roland DJ-505 is an all-in-one USB MIDI controller with an integrated audio interface. It has controls for 2 decks
that can be toggled between decks to play with 4 decks. It also features a TR-S step sequencer with sounds from the
TR-808 and the TR-909 drum machines (TR-606 and TR-707 are available via firmware update).

• Manufacturer’s product page
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• Serato DJ Hardware Page
• Owner’s Manual
• Driver/Firmware/TR-S Samples Download Page
• Mapping Forum Thread

Baru pada versi 2.3.0.

Drivers

You can download the latest Windows &MacOS drivers and firmware from the manufacturer’s website. Since the DJ-505
is a USB class compliant MIDI and audio device, the device is plug-and-play on Linux.

Audio Setup

The mapping relies on the following channel assignments (for line/phono input support, applying effects to the TR-S
output, etc.):

Output Channels Assigned to
1-2 Master
3-4 Headphones

Input Channels Assigned to
1-2 (CH 1 Line/Phono) Vinyl Control 1
3-4 (CH 2 Line/Phono) Vinyl Control 2
5-6 (Mix) Record/Broadcast
7-8 (TR-S output) Auxiliary 1

The microphone, TR-S drum machine, and external inputs are mixed together in input channels 5-6, so Mixxx can record
and broadcast them.
The knobs for MASTER LEVEL, BOOTH LEVEL, PHONES VOLUME, MIC LEVEL, TR/SAMPLER LEVEL and
CUE/MASTER MIXING are controlling the hardware mixer of the built-in audio interface. Hence, turning the knobs
will not change values in the Mixxx GUI and you’ll need to set the Mixxx knobs to their default values when using the
controller:

• Set the master/booth/headphones/microphone/aux channel levels to 100% (knob center position)
• Set cue/master mixing to cue-only (leftmost position)

Catatan: You should assign the Vinyl Control input channels even if you do not intend to use timecode vinyl. These
channel assignments are also needed to make the CH 1/2 PC/LINE/PHONO switches work (i. e. passing through line or
phono input to the left/right deck).
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Controller Mapping

The control numbering in the schematic drawings matches the those found on the specified page in the Owner’s Manual.

Browser Section (p. 4)

Figure62: Roland DJ-505 (browser section)

No. Control Function
1 LOAD buttons Load song into deck.
1 SHIFT + LOAD

button (left)
Sort library by BPM (press repeatedly to toggle ascending/descending order).

1 SHIFT + LOAD
button (right)

Sort library by key (press repeatedly to toggle ascending/descending order).

2 Rotary Selector Turn to move tracklist cursor up/down. Press to load and play/pause currently selected
track on preview deck. Hold and turn to seek in track on preview deck.

2 SHIFT + Rotary
Selector

Turn to move sidebar cursor up/down. Hold and turn to change track color of currently
selected track.

3 BACK button Not yet mapped.
3 SHIFT + BACK

button
Sort library by title (press repeatedly to toggle ascending/descending order).

4 ADD PREPARE
button

(Un-)Maximizes the library view.

4 SHIFT + ADD
PREPARE button

Sort library by artist (press repeatedly to toggle ascending/descending order).
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Figure63: Roland DJ-505 (deck section)
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Deck Section (p. 5-6)

No. Control Function
1 Jog Wheel (top surface) Perform scratch operation.
1 Jog Wheel (outer edge) Rotate to lower/raise playback speed and pitch if key lock is off).
1 SHIFT + Jog Wheel (top surface) Search fast through the track location.
2 SLIP button Hold to turn on slip mode temporarily or double press to turn it on per-

manently.
2 SHIFT + SLIP button Toggle vinyl control mode.
3 SHIFT button Hold down to access other functions.
4 SYNC button Short press to match tempo and phase of other deck once. Long press to

enable Sync Lock.
4 SHIFT + SYNC button Short press to disable Sync Lock. Long press to toggle quantization.
5 CUE button Specifies, plays or recalls temporary cue point.
5 SHIFT + CUE button Returns to the beginning of the song.
6 PLAY/PAUSE button Plays or pause the song.
6 SHIFT + PLAY/PAUSE button Hold to play backwards.
7 Pad Mode Select See Performance Pads.
8 Performance Pads See Performance Pads.
9 PARAMETER area See Performance Pads.
10 LOOP area: AUTO LOOP button Set a beatloop at the current play position.
10 LOOP area: SHIFT + AUTO

LOOP button
Toggle looping.

10 LOOP area: 1/2X/2X buttons Set the loop playback length to half/double.
10 LOOP area: SHIFT + 1/2X button Move the loop by it’s length toward the left.
10 LOOP area: SHIFT + 2X button Move the loop by it’s length toward theright.
10 LOOP area: IN/OUT button Specify loop-in/loop-out points.
10 LOOP area: SHIFT + IN button Toggle beats quantization.
10 LOOP area: SHIFT + OUT button Toggle looping, go to loop-in point and resume playback.
11 DECK 3/DECK 4 buttons Switches the deck (left: decks 1 and 3, right: decks 2 and 4)
12 KEY LOCK Toggle key lock.
12 SHIFT + KEY LOCK Cycles through tempo slider range (8%, 16%, 50%).
13 Tempo slider Adjust song playback speed (and pitch if key lock if off).
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Figure64: Roland DJ-505 (mixer section)
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Mixer Section (p. 7)

No. Control Function
1 TRIM knobs Adjust the deck gain (prefader)
2 HI/MID/LOW knobs Adjust the high/mid/low-frequency regions of the song.
3 FILTER knobs QuickEffect superknob (filter by default, can be changed to a different effect

in Mixxx preferences)
4 Channel CUE buttons Toggle PFL for each channel.
4 SHIFT + CUE buttons (short

press)
Adjust beatgrid so that the closest beat is set to the current cursor position.

4 SHIFT + CUE buttons (long
press)

Adjust beatgrid to match another playing deck.

4 SHIFT + CUE buttons (tap re-
peatedly)

Set tempo by tapping on each beat.

5 Channel faders Adjust the output level for each channel.
6 Cross fader Fades between left and right deck.
7 MASTER LEVEL knob Adjusts the master output level.
8 BOOTH LEVEL knob Adjusts the output level of the BOOTH OUT jacks.
9 MIXING knob Fades between PFL and master output in headphones
10 TR/SAMPLER LEVEL knob Adjusts output of the TR-S (Aux 3) and Samplers 1-16.
11 TR/SAMPLER CUE button Toggle PFL of the TR-S (Aux 3) and Samplers 1-16.
12 Level indicator Indicate the output level of each channel and master.

Effects Section (p. 7)

Figure65: Roland DJ-505 (effects section)

No. Control Function
1 CH ASSIGN

area
Toggle effect units 1/2 for decks 1/2 (3/4 if SHIFT is pressed) or the TR-S (Aux 3) and
Samplers 1-16.

2-5 Various See Standard Effects Mapping.
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TR-S Section (p. 8)

Figure66: Roland DJ-505 (TR-S section)

No. Control Function
1 VALUE knob See Owner’s Manual.
2 SHIFT button Hold down to access other functions.
3 Display See Owner’s Manual.
4 SYNC button Match tempo of playing deck (phase matching is not implemented yet, use the NUDGE

button instead).
4 SHIFT + SYNC

button
Currently not mapped.

5-
17

Various See Owner’s Manual.

Front Panel (p. 8)

No. Control Function
1 PHONES jacks Connect headphones here.
2 VOLUME knob Adjust the volume of the headphones.
3 CROSS FADER switch Switch the cross fader response curve.
4 REVERSE switch Switch cross fader reverse (hamster) mode on/off.
5 CH1/CH 2 switches: PC Selects Mixxx deck as input source (Unmute the Mixxx deck and mute Aux 1/2).
5 CH1/CH 2

LINE/PHONO
Selects Line/Phono input source (Mute the Mixxx deck and unmute Aux 1/2).

6 MIC LEVEL knob Adjust the microphone volume.

Performance Pads

You can use the Pad Mode Select buttons to select a mode for the performance pads.

Control Mode LED Color
HOT CUE button Hot Cue Mode White
SHIFT + HOT CUE button Cue Loop Mode Blue
SHIFT + HOT CUE button (press twice) Prepare Mode Red
ROLL button Roll Mode Light blue
ROLL button (press twice) Loop Mode Green
TR button TR Mode Red
SHIFT + TR button Pattern Mode Green
TR button (press twice) TR Velocity Mode Orange
SAMPLER button Sampler Mode Magenta
SHIFT + SAMPLER button Velocity Sampler Mode Purple
SAMPLER button (press twice) Pitch Play Mode Green
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Most pad modes are similar to those found when used with Serato. A notable exception is the LoopMode, which replaces
the Serato’s Saved LoopMode. In this mapping, the LoopMode is similar to the Roll mode, but sets a non-rolling beatloop
instead.
Modes that are described in the owner’s manual (Slicer, Slicer Loop, Saved Loop, Flip) but not listed below are currently
not mapped.

Hot Cue Mode

Figure67: Roland DJ-505 (performance pads)

Bookmark positions in the track and jump to them.

No. Control Function
1-8 Pad (unlit) Save current position as hot cue.
1-8 Pad (lit) Jump to hot cue. If the track is stopped, holding the pad will preview the hot cue

until the pad is released.
1-8 SHIFT + Pad (lit) Clear hot cue.
9 PARAMETER - button Change color of last used hotcue to the previous color in the palette.
10 PARAMETER + button Change color of last used hotcue to the next color in the palette.
9 SHIFT + PARAMETER -

button
Move beatgrid left.

10 SHIFT + PARAMETER
+ button

Move beatgrid right.

Cue Loop Mode

Set beatloop from a hot cue point.

No. Control Function
1-8 Pad (lit) Set a beatloop at the position of the hotcue and jump to it.
1-8 Pad (unlit) Save the current position as hot cue and set a beatloop.
9 PARAMETER - button Halve the size of the current loop.
10 PARAMETER + button Double the size of the current loop.
9-10 SHIFT + PARAMETER -/+ buttons Currently not mapped.
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Figure68: Roland DJ-505 (performance pads)

Prepare Mode

Figure69: Roland DJ-505 (performance pads)

This mode allow you to prepare tracks by setting intro/outro cues.

No. Control Function
1 Pad (unlit) Set current position as intro start.
1 Pad (lit) Jump to intro start position.
2 Pad (unlit) Set current position as intro end.
2 Pad (lit) Jump to intro end position.
3 Pad (unlit) Set current position as outro start.
3 Pad (lit) Jump to outro start position.
4 Pad (unlit) Set current position as outro end.
4 Pad (lit) Jump to outro end position.
5-8 Pad Currently not mapped.
9-10 SHIFT + PARAMETER -/+ buttons Currently not mapped.

Catatan: This mode has been added by the Mixxx developers and is not available in Serato.
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Roll Mode

Figure70: Roland DJ-505 (performance pads)

The Roll Mode provides quick access to rolling loops and beatjumps.

No. Control Function
1-4 Pad (hold) Play a rolling loop with the beatlength that is assigned to the pad.
5 Pad (press) Beatjump left.
6 Pad (press) Decrease beatjump size.
7 Pad (press) Increase beatjump size.
8 Pad (press) Beatjump right.
9 PARAMETER - button Halve the size of the current loop.
10 PARAMETER + button Double the size of the current loop.
9-10 SHIFT + PARAMETER -/+ buttons Currently not mapped.

TR/Pattern/TR Velocity Modes

These modes are hardcoded in the device firmware, so they work exactly as described in the Owner’s Manual.

Sampler/Velocity Sampler Play Modes

The sampler modes allow you to load, play and stop samples in the first 8 sample slots.

No. Control Function
1-8 Pad (unlit) Load currently selected track into the sample slot associated with the pad.
1-8 SHIFT + Pad

(lit)
If the sample is playing, stop the playback. If the sample is not playing, eject the sample
from the sample slot.

1-8 Pad (lit) Play the sample in the sample slot associated with the pad. Velocity Sampler Mode: The
playback volume of the sample depends on the pressure (velocity).

9-
10

PARAMETER
-/+ buttons

Currently not mapped.
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Figure71: Roland DJ-505 (performance pads)

Pitch Play Mode

Figure72: Roland DJ-505 (performance pads)

Play the track from a hot cue position and change the pitch in semitone steps. Pads right of the white lit pad raise the
pitch, pads left of it lower it.

No. Control Function
1-8 Pad Play currently selected hotcue with modified pitch.
1-8 SHIFT + Pad (dimly lit) Select hot cue for pitch play. The pad of the currently selected hotcue pad is lit.
9-10 PARAMETER -/+ buttons Cycles through semitone ranges (Up, Mid, Down).
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Known Issues

• TR-S Syncing currently works at the BPM level, but phase syncing is not implemented yet. As a workaround, the
NUDGE button can be used to adjust the phase. This depends on MIDI clock I/O (Launchpad Bug #682221).

• Some performance pad modes are missing (Slicer [Launchpad Bug #1828886], Slicer Loop, Saved Loop [Launch-
pad Bug #1367159, PR #2194 ], Flip [Launchpad Bug #1768113])

• Some buttons are not mapped yet (e.g. BACK)
• LEDs on BACK/ADD PREPARE do not work (this seems to be a hardware/firmware bug and does not work in
Serato either)

• Controller does not send current cross fader value on Serato SysEx Message (this seems to be a hardware/firmware
bug and does not work in Serato either)

17.1.107 Sony Sixxaxis

The Sony Sixaxis is a motion-sensitive wireless game console controller.
• Forum thread

Baru pada versi 1.11.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.108 Soundless Studio joyMIDI

The joyMIDI is a portable 4-in-1 MIDI controller with 4 operating modes: Keyboard (MIDI), DrumPad (MIDI), DJ
(MIDI) and GamePad (HID joystick). The case is 3D printed and the design files are open source on Onshape.

• User Manual (See the chapter 7.3 , DJ controller mode)
• Forum thread

Baru pada versi 2.2.4.

Mapping Description

After powering on the device, press the right button to enter the DJ controller mode.

Bank 1

Bank 2

Bank 3
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Figure73: Soundless Studio joyMIDI (top view)

Figure74: Entering the DJ controller mode on the joyMIDI.
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Figure75: Soundless Studio joyMIDI (bank 1)
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Figure76: Soundless Studio joyMIDI (bank 2)
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Figure77: Soundless Studio joyMIDI (bank 3)
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Figure78: Soundless Studio joyMIDI (bank 4)

17.1. Controllers 439



Mixxx User Manual, Rilis 2.3.0

Bank 4

17.1.109 Stanton DJC.4

• Manufacturer’s product page
• Manual / Midi commands
• Forum thread

Baru pada versi 2.2.4.

Compatibility

This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on
GNU/Linux, Mac OS X, and Windows. However, if you wish to use the ASIO sound API under Windows, please install
the latest driver package available from the Product page.

Sound card setup

This controller has a built-in 4 channel sound card, with MASTER output (RCA and balanced 6.3 mm TRS) and HEAD-
PHONE output (6.3 and 3.5mm jack).

Output Channels Assign to
1-2 Master
3-4 Headphones

Input Channels Assign to
1-2 (Input 1) Vinyl Control 1 or Aux 1
3-4 (Input 2) Vinyl Control 2 or Aux 2

Above the Gain knobs are switches to select which input should be sent to the PC. For input 1 this can be Aux (3.5
mm TRS) or Line/Phono 1/2 (RCA) and for input 2 this can be microphone (6.3 mm TRS on front) or Line/Phono 3/4
(RCA).

Input 1 routing

On the rear side is a small switch to select if Input 1 is routed to the PC or directly to the master output (through). It is
therefore possible to include the microphone into a recording/stream or to exclude it.
Lihat juga:
The example setups section provides more details about the audio configuration in Mixxx.
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Hardware controls

TheMaster andMic Level are hardware controls and interact directly with the integrated sound card and are not mapped
to Mixxx.
Lihat juga:
The gain staging documentation explains how to set your levels properly when using Mixxx.

Mapping description

The knobs for MASTER LEVEL, MIC LEVEL and the MIC ON/OFF switch are controlling the hardware mixer of the
built-in audio interface. Hence, turning the knobs will not change values in the Mixxx GUI and you’ll need to set the
Mixxx knobs to their default values when using the controller.

Controls

Center section

No. Control Function
1 SAMPLER VOLUME

knob
Change the volume of all eight samplers at the same time. If the SAMPLER
VOLUME is at zero hide the sampler bank.

2 BROWSER Rotary en-
coder

Turn to move tracklist/sidebar cursor up/down. Press to toggle between sidebar
and tracklist.

2 SHIFT + BROWSER
Rotary encoder

Turn to move tracklist/sidebar cursor page wise up/down. Press to (Un-
)Maximizes the library view.

3 LOAD buttons Load song into active deck (Depending on Deck select).
3 SHIFT + LOAD buttons Open/close a tree view. Equivalent to pressing the LEFT/RIGHT key on the key-

board

Mixer section

No. Control Function
1 GAIN knobs Adjust the deck gain (prefader)
2 HI, MID, LOW knobs Adjust the high/mid/low-frequency regions of the song. Press to kill

this frequency region.
3 SHIFT + LOW knob QuickEffect superknob (filter by default). Press to (de-)activate

QuickEffect.
4 Channel CUE buttons Toggle PFL for each channel.
5 Channel faders Adjust the output level for each channel.
6 Cross fader Fades between left and right deck.
7 Level indicator Indicate the output level of master.
8 CROSSFADER CURVE (front side

of controller)
Adjust crossfader curve between fade and cut.

9 HEADPHONES MIX (front side of
controller)

Adjusts the cue/main mix in the headphone output.

10 HEADPHONES LEVEL (front side
of controller)

Adjusts the headphone output gain.
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Deck section

No. Control Function
1 Jog dial (top surface) Perform scratch operation if Scratch is enabled.
1 Jog dial (outer edge) Rotate to lower/raise playback speed if Scratch is enabled (and pitch if key

lock is off).
1 SHIFT + Jog dial (top sur-

face)
Search fast through the playback location.

2 SCRATCH button En-/Disable scratch function
3 SHIFT button Hold down to access other functions.
4 SYNC button Match tempo and phase of other deck.
4 SHIFT + SYNC button Plays the track reverse as long as pressed.
4 TAP button (tap repeat-

edly)
Set tempo by tapping on each beat.

5 CUE button Specifies, plays or recalls temporary cue point.
5 SHIFT + CUE button Jumps to the cue point and stops.
6 PLAY/PAUSE button Plays or pause the song.
11 DECK select buttons Switches the deck (left: decks 1 and 3, right: decks 2 and 4)
12 KEY LOCK Toggle key lock.
12 SHIFT + KEY LOCK Toggle beats quantization.
13 Tempo slider Adjust song playback speed (and pitch if key lock if off).
14 PITCH BEND + Holds the speed one step (4 % default) higher while pushed.
15 PITCH BEND - Holds the speed one step (4 % default) lower while pushed.
14,
15

SHIFT + PITCH BEND Not mapped.

16 HOT CUE Set (if empty) or Play Hot Cue Point.
16 SHIFT + HOT CUE Unset/Delete Hot Cue Point

Loop section

No. Control Function
1 IN If loop is disabled, sets the player loop in position to the current play position. If loop

is enabled, press and hold to move loop in position to the current play position.
1 SHIFT + IN Seek to the loop in point.
2 OUT If loop is disabled, sets the player loop out position to the current play position. If loop

is enabled, press and hold to move loop out position to the current play position.
2 SHIFT + OUT Seek to the loop out point.
3 ON Toggles the current loop on or off. If the loop is ahead of the current play position, the

track will keep playing normally until it reaches the loop.
3 SHIFT + ON Activate current loop, jump to its loop in point, and stop playback.
4 DELETE Not mapped.
5 LOOP LENGTH / Halves beatloop size.
6 LOOP LENGTH X Doubles beatloop size.
7 BEAT MULTI-

PLIER encoder
Turn to move the loop left or right by 1 beat per click.

7 BEAT MULTI-
PLIER button

Sets a loop using the current beatloop size long and enable the loop.

7 SHIFT + BEAT
MULTIPLIER
button

Activates a rolling loop using the current beatloop size.
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Sampler section

No. Control Function
1 SAMPLER 1-4 (left deck) Controls Samplers 1-4 (independent of deck selection)
2 SAMPLER 1-4 (right deck) Controls Samplers 5-8 (independent of deck selection)

Effect section

No. Control Function
1 ON Toggle FX 1 for decks 1/3 (both on the left) and FX 2 for decks 2/4 (both on the right).
2-5 Various See Standard effects mapping.

Tweakables

At the top of the file file:Stanton-DJC-4-scripts.js there are a few customizable options to change the default mapping.

Variable Function De-
fault

autoShowFour-
Decks

If a track gets loaded into deck 3 or 4, automatically show four decks in Mixxx false

showMasterVu If set to false, show channel VU meter instead of Master L/R true
dryWetAdjust-
Value

Amount the dryWetKnob changes the value for each increment 0.05

Known Issues

The following controls are currently not mapped:
• Loop Delete button (no matching function in Mixxx)
• X-Fader Link button
• Smart Fade button
• Smart button (Shift + Scratch)
• Video button (Shift + Smart Fade)
• FX Ctrl 1/2 fader (Shift + Channel fader)
• TX/FX Select rotary encoder
• TX/FX Action rotary encoder button
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17.1.110 Stanton SCS.1d

• Manufacturer’s product page
Baru pada versi 1.9.1.

Mapping description

Easy customization: We have provided the following customization variables at the top of the script you can set to your
liking:

• pitchRanges - The pitch ranges selectable with the Range button. You can add more as you like but they must be
in ascending order.

• fastDeckChange - If set to true, changes decks instantly by skipping the flashing lights. Useful for beat juggling
on one unit.

• globalMode - If true, the unit will stay in the current section modes on virtual deck changes (instead of switching
to the modes you were in the last time you controlled that virtual deck.) The trigger pad section always stays in the
current mode regardless of this setting.

• platterSpeed - The speed of the platter at 0% pitch: 0=33 RPM, 1=45 RPM
• deckChangeWait - Time in milliseconds to hold the Deck Select button down to avoid changing decks
• padVelocity - If set to true, uses the velocity values when recalling cues on the trigger pads (this is toggle-able with
a button on the unit as well.)

• crossFader - If true, uses the pitch slider to adjust the cross-fader while the Pitch Range button is held down
• browseDamp - Number of platter ticks to move the highlight one item when browsing the library. Set higher for
slower movement. (Defaults to 3.)

• looseLoops - If true (default,) causes the loop buttons to set new loop points each time you press them (good for
loop rolls.) If set to false, you must explicitly delete one before you can set another.

Just open the midi/Stanton-SCS1d-scripts.js file in your favorite text editor (Wordpad works too) and you’ll
see these variables right near the top. Edit & save, then restart Mixxx and enjoy.
Now let’s take a look at how the controls operate, starting in the upper left and moving counter-clockwise:

Mode switch buttons

• Setup: unused by Mixxx but will enter the deck’s internal setup menu
• Control: unused
• Browse: Allows browsing the library with the platter. Press additional times to change the category (Library,
Playlists, Crates, etc.) To go backwards, press another mode button (Vinyl or Control) then Browse again.

• Vinyl: Take a guess! :-)
• ⇒/Enter: Loads the currently selected track into the currently selected virtual deck
• Deck Select: Switches to the other virtual deck
• ⇐/Cancel: unused
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Transport section

• circle button: Toggles headphone cue
• «: Fast rewind
• »: Fast forward
• |«: unused
• »|: unused
• Cue, Sync, Play/Pause: as labeled
• BPM: BPM tap

Trigger Pad section

The trigger pads are used to set and recall hot cues. You can use them as you would a sampler if the target deck is stopped
(where it will only play as long as you are pressing the pad) or as hot cues (if the target deck is playing.) You set a cue
simply by pressing an unlit pad at the desired point. It lights green when there’s a cue set and the corresponding display
shows the cue point in minutes:seconds.centiseconds format.

• circle buttonsabove the displays: unused
• circle button at the top right of the section:
• Velocity toggle: When lit red, the target deck’s volume will be adjusted by how hard you strike the pads. Press this
button to toggle the feature.

• Delete cues: Hold this button down and press a pad to delete the cue stored there
• circle buttons at the bottom right of the section: These select the cue bank for each deck. The top button chooses
the bank for deck one and the bottom for deck two. There are three banks for each deck denoted by the button
color: green (1), red (2), and amber (3). In this way you can recall cues/play samples on either deck at any time
regardless of what the rest of the controller is doing.

Pitch slider section

• Pitch slider:
• Pitch adjust: directly corresponds to the slider on screen for the currently selected virtual deck. Since the slider is
motorized, it will move on its own if you change decks or adjust the slider on the screen.

• Cross-fader adjust: will move to and allow adjustment of the on-screen cross-fader while the Range button is held
down.

• Range button:
• Toggles between the pitch range values specified in the pitchRanges global variable mentioned at the top of this
page

• When held, allows the pitch slider to be used to adjust the cross-fader (if the crossFader variable is set to true.) If
you do this, the pitch range will not be changed when you release the button.

• Reset button: Resets the slider to the center position when adjusting pitch or the cross-fader.
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Preset section

This section has three banks, selected by the three circle buttons at the bottom of the section.

Loop mode

Press the top circle button (Bank 1) at the bottom of the section to get into this mode. The 12 preset buttons are grouped
in pairs with the left one adjusting the loop in point and the right one adjusting the loop out point.
There are two modes of operation selectable by the looseLoops global variable described at the top of this page:

1. Loose Loops mode - Works just like a CDJ and the on-screen loop controls. Use this for loop rolls.
• Left loop button - Sets loop in point any time you press it
• Right loop button - Sets loop out point any time you press it
• Reloop/Exit: Hold the Bank 1 button and press either Left or Right loop buttons to toggle the loop on and
off

2. Protected Loops mode - Works like the hot cue section in that you must first delete a loop point before you can
set another. Use this when you want to return to a pre-set loop and not worry about accidentally losing it.

• Left loop button - Sets loop in point only when none is already set
• Right loop button - Sets loop out point only when none is already set
• Reloop/Exit: Both loop buttons together - Toggles the loop on and off
• Delete: Hold the Bank 1 button and press a Left or Right loop button to delete that loop point.

Instant pitch changes

The bottom two banks are used for instant pitch changes for the current virtual deck. These are useful when using the
pads as samplers to further vary the sounds.
They offer the following arrangements, increasing from left to right, top to bottom:

• circle buttons at the bottom:
• Middle: Key change - Center row buttons are one semitone away from their vertical neighbors and the outside
ones are three semitones away (for harmonic key changes.)

• Bottom: Notes - Buttons correspond to major scale notes (ala Vestax Controller One.) This is most useful with a
constant-pitch sound or chord. (You can generate one in Audacity, or use the time code sound. :-) )

Remember you can return to the original pitch (tonic) by pressing Reset just above the pitch slider.
Note that when you use one of these buttons, the pitch range is automatically set to 100% in order for the values to be set
correctly.
Key change and Note modes were tuned with respect to 440Hz A (above middle C.)
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Encoder section

Pressing any of the encoders returns the parameter to the default value.
• circle button to the left of the section: changes the parameter bank the encoders adjust:
• Green:

– 1st encoder (from the left): adjusts low frequency equalizer
– 2nd encoder: adjusts mid frequency equalizer
– 3rd encoder: adjusts high frequency equalizer
– 4th encoder: adjusts deck volume
– circle buttons under each display: momentary kill buttons for the corresponding parameter

• Red:
– 1st encoder (from the left): adjusts flanger depth
– 2nd encoder: adjusts flanger delay
– 3rd encoder: adjusts flanger period (Low Frequency Oscillator)
– 4th encoder: adjusts pre-fader track gain
– circle button under the 1st display: toggles the flange effect for the current deck.
– //circle button under the 2nd display: unused//
– //circle button under the 3rd display: unused//
– circle button under the 4th display: toggles key lock for the current deck.

• When holding down the Deck Select button:
– 1st encoder (from the left): adjusts the cue/main headphone mix
– 2nd encoder: adjusts the headphone volume
– 3rd encoder: adjusts the master balance (pan)
– 4th encoder: adjusts the master volume

17.1.111 Stanton SCS.1m

• Manufacturer’s product page
Baru pada versi 1.7.
Easy customization: We have provided the following customization variables at the top of the script you can set to your
liking:

1. faderStart: If set to true, it allows decks to start when their channel or the cross-fader is opened. (This is also
toggleable with the topmost button on the controller. See below.)

2. scratchFactor: Adjusts the speed of scratching with the select knob. (Defaults to 2.)
Just open the controllers/Stanton-SCS1m-scripts.js file in your favorite text editor (Wordpad works too)
and you’ll see these variables right near the top. Edit & save.
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Figure79: Stanton SCS.1m (top/schematic view). Image courtesy of Stanton Magnetics, Inc., overlay (c) 2009 Sean M.
Pappalardo.
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Deck controls

Refer to the image above, top to bottom

• a buttons: Sync function: change the pitch of the deck so that its BPM matches that of the other deck (assuming
the pitch range is sufficient)

• b buttons: Toggle headphone cue
• Gain, High, Mid, Low knobs: as labeled
• Panknob: unused
• c encoders
• Rotate to increase or decrease the pitch range in 1% steps
• Press to toggle the flange effect
• c displays: Show the current pitch adjustment percentage. The back light color changes with the pitch range:
• Green = 1%-25%
• Orange = 25%-50%
• Red = 50% and above
• c A buttons: Permanently lower the pitch by 1%
• c B buttons: Permanently raise the pitch by 1%
• e sliders: Pitch adjust
• e buttons: Temporarily raise the pitch by 4% for as long as held (pitch bend up.)
• g buttons: Temporarily lower the pitch by 4% for as long as held (pitch bend down.)
• d encoders
• Rotate to nudge the track either direction (akin to twisting a record spindle)
• Press to toggle reverse playback
• LEDs show current track position
• d displays: Show the current track time remaining. They will flash slowly when less than 30 seconds remain, quickly
when less than 15 seconds remain.

• d A buttons: Rewind
• d B buttons: Fast-forward
• f sliders: Volume adjust
• f buttons: Play/pause
• h buttons: Cue
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Global controls

Refer to the image above, top to bottom

• z button: Toggle fader start/cue
• Master, Headphones, Cue Mix knobs: as labeled
• Zoneknob: unused
• Gainknob: unused
• i knob: Adjust flange effect depth
• j knob: Adjust flange effect delay
• k knob: Adjust flange effect period (Low Frequency Oscillator)
• l knob: Adjust master pan (balance)
• pbutton: unused
• m button: BPM tap for Deck 1
• nbutton: unused
• o button: BPM tap for Deck 2
• Preset buttons: Hot cue points for the selected deck (q button)
• Bank Down button: select backward between Library, Playlist, and Browse views
• Bank Up button: select forward between Library, Playlist, and Browse views
• q button: Change which deck’s hot cues are active (Preset buttons.) Off is Deck 1, On (red) is Deck 2.
• r jog wheel:
• Browse mode:

– Rotate to move the track select highlight
– Press to load the selected track into the first stopped deck, if any. //(This is [[https://bugs.launchpad.net/
mixxx/+bug/734713|not working]] in 1.9.x for some reason.)//

• Control mode:
– Rotate to scratch the song on the selected deck
– //Pressing does nothing//

• Cancel button:
• Browse mode: Press to load the highlighted song onto deck 1, if it’s not currently playing.
• Control mode: hold down to enable scratching on deck 1
• Enter button:
• Browse mode: Press to load the highlighted song onto deck 2, if it’s not currently playing.
• Control mode: hold down to enable scratching on deck 2
• //Setup button: unused by Mixxx but will enter the mixer’s internal setup menu//
• Control button: Selects scratching mode for the jog wheel
• Browse button: Selects track browse mode for the jog wheel

(Any unlabeled controls are not currently used.)
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17.1.112 Stanton SCS.3d “DaScratch”

• Manufacturer’s product page
• Walk-through video!

Baru pada versi 1.7.
Baru pada versi 2.0: Alternate mapping with many more visual effects (flashing lights) and different behavior.

Default Mapping

Figure80: Stanton SCS.3d (layout). Images courtesy of Stanton Magnetics, Inc.
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Easy customization: We have provided the following customization variables at the top of the script you can set to your
liking:

• pitchRanges - Set the pitch slider range when the Pitch LED is off, blue, purple and red (in decimal values. E.g.
0.08 = 8%, 0.5 = 50%)

• fastDeckChange - If set to true, changes decks instantly by skipping the flashing lights. Useful for beat juggling
on one unit.

• spinningPlatter - If set to true, uses the circle LEDs to accurately (no sticker drift!) show the track position in
record revolutions, also useful for juggling.

• spinningPlatterOnlyVinyl - If set to true, only shows the spinning platter LED in vinyl modes. Otherwise shows
in all modes except Loop, Instant Pitch Change and TRIG (because they’re used for other things in those modes.)

• spinningLights - The number of lights used for the spinning platter effect, 1 or 2. (1 is best for juggling.)
• VUMeters - If set to true, shows a VU meter in the circular area for the currently selected deck when in vinyl
mode. (Left for deck 1, right for deck 2.)

• markHotCues - Set to "blue" or "red" (with quotes) to choose which LEDs mark the stored positions in
TRIG & LOOP modes

• jogOnLoad - If true, the unit will automatically change to Vinyl (jog) mode after loading a track (from Track
Select mode)

• globalMode - If true, the unit will stay in the current mode on deck changes (instead of switching to the mode you
were in the last time you controlled that deck.)

• singleDeck - If you’ve got more than one MIDI controller, set this to true to have the SCS.3d stay on one deck and
make Deck mode non-temporary. More on this here.

• deckChangeWait - Time in milliseconds to hold the DECK button down to avoid changing decks
• pitchAdjustment - Adjusts the coarseness of the pitch slider (1=coarse, 3=normal, 5=fine)
• finePitchAdjustment - Adjusts the coarseness of the pitch slider in fine mode (1=coarser, 3=normal, 5=finer)
• finePitchDefault - If true, swaps normal and fine pitch modes so you can use fine pitch mode unshifted

Just open the controllers/Stanton-SCS3d-scripts.js file in your favorite text editor and you’ll see these
variables right near the top. Edit & save.

Mode buttons

• FX - Adjust & toggle Flanger effect, toggle reverse effect
• EQ - Adjust channel EQ parameters
• Loop - Loop controls and Instant pitch changes
• Trig - Hot cues
• Vinyl - Toggle between pitch bend, vinyl manipulation & scratching, and track selection
• Deck - Adjust global controls and switch to another virtual deck
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Figure81: Stanton SCS.3d (mode buttons)

Common to all modes:

(except where noted)
• Gain slider (S1) adjusts deck volume
• Pitch slider (S2) adjusts deck pitch control
• B11 toggles headphone cue
• B12 toggles pitch range (black=8%, blue=12%, purple=50%, red=100%)
• B13 Rewind (REW)
• B14 Fast Forward (FFWD)
• PLAY starts or pauses track playback.
• CUE will jump to the cue point or set it, depending on your settings and whether the track is playing.
• SYNC synchronizes the tempo of the current deck to another. Holding SYNC for more than 1/3 of a second will
enable Master SYNC lock. (Press SYNC again to disable it.)

• Pressing TAP repeatedly will change the speed of the current deck to match your tap tempo (useful for synchro-
nizing with an external music source.)

While holding down the current mode button:
• Gain slider (S1) adjusts pre-fader gain
• Pitch slider (S2) finely adjusts pitch control
• B11 resets pre-fader gain to center
• B12 resets pitch to center 0%
• SYNC toggles the Quantize function (where Cue and Loop points snap to the nearest beat and triggering them
happens in time with the beat.)
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FX Modes

These modes let you adjust the effect unit parameters. The FX button will be red when adjusting effect unit 1, purple for
unit 2, and black for unit 3. (In Mixxx versions below 2.0.1, there is only one mode that adjusts the Flanger effect.)

Figure82: Stanton SCS.3d (slider mode)

• Left slider (S3) adjusts the first effect parameter
• Center slider (S4) adjusts the second effect parameter
• Right slider (S5) adjusts the third effect parameter
• B11 performs a reverse-roll (censor) while held down
• B12 toggles this effect on the current deck
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Hold the FX button down and touch any slider to reset it to center.

EQ Mode

Figure83: Stanton SCS.3d (slider mode)

• Left slider (S3) adjusts low frequency equalizer
• Center slider (S4) adjusts mid frequency equalizer
• Right slider (S5) adjusts high frequency equalizer

Hold the EQ button down and touch any slider to reset it to center.
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Loop mode (red)

The surface is configured as 11 buttons:

Left Middle Right
1/8-beat loop Loop In 2-beat loop
1/4-beat loop Reloop/Exit 4-beat loop
1/2-beat loop Reloop/Exit 8-beat loop
1-beat loop Loop Out 16-beat loop

Mixxx v2.0.1 and above have the left column flipped so you can adjust the loop size sequentially when moving along the
circle:

Left Middle Right
1-beat loop Loop In 2-beat loop
1/2-beat loop Reloop/Exit 4-beat loop
1/4-beat loop Reloop/Exit 8-beat loop
1/8-beat loop Loop Out 16-beat loop

The Reloop/Exit button lights up when a loop is active. If it happens to be an exact number of beats, the corresponding
beat loop button will light up as well.
Also:

• B11 (under the Gain slider) halves the length of the current loop
• B12 (under the Pitch slider) doubles the length of the current loop

You can exit any loop by pressing Reloop/Exit (or a lit beat loop button.)

Instant-pitch change modes (Loop button)

This offers instant pitch change buttons in the following arrangements:
Key change (purple) - Center buttons are one semitone away from their vertical neighbors and the outside ones are three
semitones away (for harmonic key changes.)
Notes (black) - Buttons correspond to major scale notes (ala Vestax Controller One.) This is most useful with a constant-
pitch sound or chord. (You can generate one in Audacity.)
Remember you can return to the original pitch (tonic) by pressing B12 (under the pitch slider.)
Note that when you use one of these buttons, the pitch range is automatically set to 100% in order for the values to be set
correctly.
Key change and Note modes were tuned with respect to 440Hz A (above middle C.)

1.7 also offered the following since looping was not available:
Fixed increment (red) - Each button sets the pitch 3.33% above or below its vertical neighbors.
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Trig Modes

These modes configure the surface as three separate banks of 12 buttons (lit up dim red for visibility) giving you a total of
THIRTY-SIX hot cues! (Mixxx 1.8.0-1.9.0 internally supports just 32, so the center 4 buttons and the lower right one in
the third bank (black) are inoperative. Mixxx 1.9.1+ supports 36 again.) The TRIG button will be red in bank 1, purple
in bank 2, and black in bank 3.
The red LEDs flash when you press the corresponding button. The outer blue LEDs light when a cue point is set on that
button. (Changeable with themarkHotCues option mentioned at the top of this page.)

• To set a cue, just press a free button at the desired time.
• To recall a cue, just press a button that has a cue point set
• To erase a cue, hold TRIG while pressing the button(s) you want to erase

Vinyl Modes

Vinyl mode (red)
• Outer circle (C1) and Center slider (S4) allow you to bend the song’s pitch, akin to dragging your finger on the
record

Vinyl2 Mode (purple)
• Outer circle (C1) allows you to “scratch” the song and perform juggles
• Center slider (S4) allows you to “scratch” the song
• Scratch & cue toggle: Hold the VINYL button and press CUE when in Vinyl2 mode to toggle recalling the cue
point when you touch either C1 or S4. This makes juggling really easy since you don’t have to back-cue.

Track Select Mode (black)
• Outer circle (C1) allows you to scroll through your Library
• Center button (anywhere on S4) loads the currently highlighted song into the current deck, as long as it’s not live
(playing to the master output.)

• B11 selects backward between Library, Playlist, Browse, etc. views
• B12 selects forward between Library, Playlist, Browse, etc. views
• B13 moves the highlight up one item
• B14 moves the highlight down one item

Deck Mode

You are in this mode only while holding down the Deck button, unless the controller is in single-deck mode:
• Gain slider (S1) adjusts master volume
• Pitch slider (S2) adjusts master balance (pan)
• B11 resets master volume knob to the middle
• B12 resets master balance to center
• Left slider (S3) adjusts the cue/main headphone mix
• Center slider (S4) adjusts the cross-fader
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Figure84: Stanton SCS.3d (circle mode)

17.1. Controllers 458



Mixxx User Manual, Rilis 2.3.0

Figure85: Stanton SCS.3d (slider mode)
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• Right slider (S5) adjusts the headphone volume
• TAP resets cross-fader to center position (only in multi-deck mode)
• Press Deck + Sync together to toggle between multi- and single-deck modes
• In single-deck mode:
• Hold the Deck button down and touch any slider to reset it to its default value
• Press Deck + Play together to change the active deck

General controls

Figure86: Stanton SCS.3d (slider mode)
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Unless otherwise noted, the following controls have the same function in all modes.
• S1 controls volume of currently active deck.
• S2 changes rate or pitch depending on current mode, see VINYL-mode for discussion.
• PLAY starts or pauses the track. When a track is ready to play the button blinks.
• CUE will jump to the cue point or set it, depending on your settings and whether the track is playing.
• SYNC syncs the active deck to another deck. Holding SYNC for more than one second will enable SYNC lock.
• Pressing TAP repeatedly will adjust track BPM.

The currently active deck/channel is shown by lighting one of B11 through B14 red (except for FX-mode where the
selected FX chain is shown). B11 lights red for deck 1, B12 for deck 2, B13 for deck 3 and B14 for deck 4. See DECK
and FX modes on how to control this.
A light spinning around the circle shows the track is playing. When the track nears its end (at -30 seconds), a blinking
light will detach and run slower. When the spinning light reaches the blinking light, the track ends.
By touching one of the six mode buttons, you switch to that mode. Some modes have alternate overlays, you can switch
to those by touching the mode again. The first overlay is red, the second blue, the third is purple. The following mode-
overlays are available:

Figure87: Stanton SCS.3d (mode buttons)

• FX: (red) Control effect device; (blue) Control deck superknob
• EQ: (red) Control deck EQ
• LOOP: (red) Set/release beat-loops; (blue) Rolling-loops
• TRIG: (red) cue points 1 through 5; (blue) cue points 6 through 10; (pink) cue points 11 through 15;
• VINYL: (red) jog wheel; (blue) scratch
• DECK: (red) library scan & load

Modes are remembered per-deck. When you switch the deck, the mode last active for that deck will be selected.
By holding a mode button, a mode is enabled temporarily in hold-mode. When the button is released again, the device
switches back to the previously selected mode. Some hold-modes enable alternative, often disruptive functionality. Most
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of the time you won’t want to use the hold-modes on live decks (e.g. needledrop in VINYL) or you must be very cautious
(assigning effect chains with FX).
Each mode will be explained in detail below.

FX mode

Figure88: Stanton SCS.3d (slider mode)

FX mode allows you to control effects. Slider S2 controls the wet/dry mix of the current effect. Sliders S3, S4, and
S5 control the first three effect knobs on the effect unit. (Specifically, the first effect of one of the four effect chains is
controlled.)
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The device remembers the selected effect per deck, so if you switch decks you also switch to the previously selected effect
on that deck. Initially, effect slot 1 is selected for deck 1, slot 2 for deck 2 and so on.
To control another effect, buttons B11 through B14 allow you to switch. The currently active effect is shown in red where
button B11 lights red when the first effect chain is selected, B12 for the second chain, B13 for chain 3, and B14 for chain
4. The buttons turn blue when the active deck is assigned to this effect chain. If the active effect is assigned to the current
deck, the corresponding button will appear purple. If you don’t see purple it means that the effect you’re controlling is
not assigned to the current deck.
For example, if the controller is on deck 2, has effect slot 2 selected, and effects 2 and 3 assigned, the four buttons would
be lit as follows:

• B11: black
• B12: purple
• B13: blue
• B14: black

Holding FX

By holding FX, you can toggle assignment of the current deck to effect chains with buttons B11 through B14. B11 assigns
effect chain 1, B12 assigns effect chain 2, B13 assigns chain 3, and B14 assigns chain 4 to the active deck. The effects that
have the current deck assigned are shown in blue. While FX is held, S2 can be used to scroll through different effects. To
load the next effect, touch top half of the slider and touch the bottom half to load the previous effect into the currently
active effect slot.
When FX is held, the button for the active deck is shown in red. So if you want to assign the active effect to the active
deck, press the button that is red. If the button is purple, pressing it would deactivate the active effect on the active deck.
Example on how to load an echo effect into chain 3 and assign it to channel 2:

1. Press DECK-B12 to switch to deck 2
2. Press FX to switch to FX mode
3. Press B13 to select effect chain 3
4. Slide S2 to the bottom to bypass chain 3 (precautionary measure)
5. Hold FX and touch S2 above the middle to select the next effect (will select echo if no effect was selected previously)
6. Hold FX and press B13 to assign effect chain 3 to deck 2
7. Adjust echo parameters with sliders S3, S4, S5
8. Slide S2 upwards to bring the effect in

EQ mode

In EQ mode, the central sliders S3, S4, S5 control low/mid/high EQs. Hold EQ to control pre-gain on S1 instead of
volume. The other controls (low/mid/high/pitch) are reset to center when the control is touched while EQ is held.
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LOOP mode

Figure89: Stanton SCS.3d (circle mode)

By touching the circle you activate a loop over a certain number of beats. Touching on the right side will activate a beat-
loop over 1, 2, 4, 8 etc beats, starting from the top. On the left side you get fractions 1/2, 1/4, 1/8 etc loops starting from
the top. To leave the loop, touch center.
By touching the LOOP mode button again, the ‘rolling’ overlay comes on and the LOOP button turns blue. In rolling
mode, the loop will be released as soon as you take your finger off the circle and the track will resume where it would
have been without looping.
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TRIG mode

You can set hotcues and jump to hotcues in this mode. The circle is split into five fields (1: top left, 2: bottom left, 3: top
right, 4: bottom right, 5: center) where touching the area will either set the hotcue if it was unset, or trigger the hotcue if
it was set. When a hotcue is set, the blue lights next to it will light.
To clear a hotcue, hold TRIG and touch the corresponding field.
The first TRIG overlay (red light) controls hotcues 1 to 5, touching TRIG will switch to overlay two, controlling hotcues
6 to 10 (blue light), then overlay three, for cue points 11 to 15 (purple light).

VINYL mode

The circle C1 functions as a jog-wheel, slide clockwise to speed-up the track. The center slider S4 can be used to raise
and lower speed by holding it above or below center, respectively.
B11 jumps back one beat, B12 jumps forward. B13 and B14 control fast-reverse, fast-forward.
While VINYL is held, B11 through B14 set the pitch slider mode. The currently active mode lights blue. The different
pitch slider modes are:

• B11 Absolute rate: The pitch slider directly sets the rate in a wide range
• B12 Discrete Pitch: Change pitch up or down by touching upper or lower part of slider
• B13 Rate: Change the rate up or down by holding the slider off-center. The further from the center you hold the
slider, the faster the rate changes.

• B14 Relative pitch: slide to change pitch up or down
When VINYL is held, the SYNC button adjusts the beatgrid. When the track is not playing, the beatgrid is moved to the
current track position. When the track is playing, the beatgrid is aligned with the other track’s beatgrid.
A second overlay to VINYL (blue) enables scratching on the pad. Both the circle and the center slider (S4) can be used
to scratch.

DECK mode

This mode is used to load tracks. When the current deck is not playing, an arrow pattern indicates that the currently
selected track can be loaded into the deck by pressing the central field S4. Sliding on the circle C1 will scroll through the
library.
B11 and B13 allow you to switch up and down between the library categories, while B12, B14 allow stepping through the
library list one-by-one (the slider allows only coarse control).
When holding DECK, you can switch channels.

• B11: deck 1; B12: deck 2
• B13: deck 3; B14: deck 4

The corresponding button turns red. The active deck is shown on the buttons in all modes except FX.
The controller keeps its mode per deck. So when changing deck, the mode will switch to the mode previously used on
that deck.
Note that the active deck is synced with the Stanton SCS.3m, so when switching between decks 1 and 3, or 2 and 4 the
other device changes as well.
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Figure90: Stanton SCS.3d (circle mode)
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17.1.113 Stanton SCS.3m “DaMix”

• Manufacturer’s product page
Baru pada versi 1.7.

Mapping Description

Figure91: Stanton SCS.3m "DaMix" (top view). Images courtesy of Stanton Magnetics, Inc.

The left side of the controller controls deck 1. The right side is for deck 2. This l’ll walk through the controller from top
to bottom and explain the features.

Deck select buttons

These are used only as modifier buttons in Mixxx for now. Hold them down to access different functions for that side of
the controller (Deck A/C for the left side virtual deck 1, Deck B/D for the right side, deck 2,) detailed for each control
below.
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Top horizontal sliders

These adjust the pitch control.
• Touching near the edges will do a temporary pitch bend in that direction.
• Hold the current mode button down (EQ/FX) and touch the slider on that side to reset it to 0%.
• Hold the applicable Deck select button down when using these sliders to perform fine-grained pitch adjustment.

When the Master button is held down:
• The left slider adjusts the Pre/Main headphone mix
• The right slider adjusts Master Balance
• Also hold the current mode button and touch the slider on that side to reset it to center

FX/EQ sliders

From left to right, for each side:
• in EQ mode these adjust Low, Mid, and High frequency filters
• in FX mode these adjust Depth, Delay, and LFO for the flanging effect

Hold down the current mode button (FX/EQ) and touch one of these sliders to reset it to center.

FX/EQ mode buttons

Press these to choose what the sliders above them control. (See above.)
• Hold Deck and press FX to toggle the flange effect for that deck
• Hold Deck and press EQ to auto-adjust the pitch to sync the BPM on this deck with the other one (assuming it was
detected correctly on both)

Volume sliders

These adjust the channel volume as on a traditional mixer.
• Holding Deck causes these to adjust the pre-fader gain for the deck

When the Master button is held down:
• The left slider adjusts the Headphone volume
• The right slider adjusts Master volume
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Soft buttons

From top to bottom on both sides:
• Rewind
• Fast forward
• Cue
• Play

Headphone buttons toggle that deck in the headphone mix.

Cross-fader

Adjusts the cross-fade between the virtual decks
• Needle drop function: Hold a Deck button to use the cross-fader strip to search through the track loaded on that
deck

Level Meters

These normally show the pre-fader signal for the respective deck. When holding down the Master button, they show the
stereo master output meters: left side for the left channel, right side for the right channel.
NOTE: The LEDs are calibrated to the VU meters on-screen. If you see a red LED flicker, you are clipping and need to
reduce the volume or gain to avoid distorted sound and/or speaker damage.

Deck switching buttons

When touching the “A C” or “B D” buttons, the mixer switches between decks. On the left side, touching “A C” will
switch between decks 1 and 3. On the right side, touching “B D” will switch between decks 2 and 4. All controls except
for the crossfader then control the selected deck.
Connected SCS.3d modules will follow deck changes. For example if you switch from deck 1 to deck 3 on a SCS.3m, all
connected SCS.3d modules who are on deck 1 will also switch to deck 3.

EQ mode

This is the standard mixing mode where the three EQ sliders control low/mid/high. The top slider controls the filter knob.
Touching EQ will return to EQ mode from the FX modes. Holding EQ and touching a slider will reset it to its preset
position. (Unfortunately this doesn’t work for FX and MASTER modes.)
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FX modes

Touch one of the four buttons to the side of the gain slider to control one of the effect chains. Top button selects first
effect chain and so forth. In this mode, the vertical sliders control the first three knobs of the first effect in the selected
effect chain. The top slider controls dry/wet mix.
You can assign FX chains to the deck by holding FX and pressing one of the four buttons next to the gain slider. So to
assign FX chain 1 to the current deck, hold FX and press the top button (right below EQ).
When holding FX, the volume slider can be used to adjust channel gain. Hold FX and slide up to make the channel louder.
Hold FX-EQ and touch the gain slider to reset gain.

MASTER mode

When holding the central MASTER button, the left side controls the headphone channel, while the right side controls the
master channel.

• Left top slider: Pre/main mix on headphone
• Right top slider: main balance
• Left slider: head gain
• Right slider: master gain
• Buttons: The buttons assign effects to head and master

17.1.114 Tascam US-428

This product has been discontinued.
• Manufacturer’s product page

Baru pada versi 1.6.2.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.115 TrakProDJ

Baru pada versi 1.10.0.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.116 Vestax Spin

This controller has been discontinued as Vestax went out of business in 2014.
• Forum thread

Baru pada versi 1.9.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.117 Vestax Typhoon

This controller has been discontinued as Vestax went out of business in 2014.
• Manfacturer’s product page
• Forum thread

Baru pada versi 1.9.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.118 Vestax VCI-1000 (MixVibes 3DEX Edition)

This controller has been discontinued as Vestax went out of business in 2014.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.

17.1.119 Vestax VCI-100 MKI

This controller has been discontinued as Vestax went out of business in 2014.
Baru pada versi 1.6.

Catatan: Only Firmware version 1.2 is supported by Mixxx.

Catatan: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller,
please consider contributing one.
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17.1.120 Vestax VCI-100 MKII

This controller has been discontinued as Vestax went out of business in 2014.
• Product page in archive.org
• ASIO driver for Windows in serato.com
• Forum thread

Baru pada versi 2.0.

Mapping Description

[Functions] in brackets are executed if a shift button of the deck is pressed. {Functions} in braces are executed if a
shift button of the other deck is pressed. Changes after the previous version are in bold.

1. Unfocus EffectSlot of the EffectUnit [Select EffectUnit1/2]
2. Focus next EffectSlot of the EffectUnit [Select EffectUnit3/4]
3. Meta knob of the EffectSlot1, or if EffectSlotN is focused Parameter1 of it [Set the link to meta knob][1]
4. Meta knob of the EffectSlot2, or if EffectSlotN is focused Parameter2 of it [Set the link to meta knob]
5. Meta knob of the EffectSlot3, or if EffectSlotN is focused Parameter3 of it [Set the link to meta knob]
6. Super knob, or if EffectSlotN is focused Parameter4 of it [Set the link to meta knob], or if enabled by #33

Wet/dry mix of the EffectUnit
7. EQ high
8. EQ mid
9. EQ low
10. Pitch (up and down to 3 semitones continuously, or in keylock mode discretely)
11. Filter (super knob of Quick Effect)
12. Gain
13. Rate [Rate by quantized BPM]
14. Channel fader
15. Cross fader
16. Headphone volume
17. Headphone mix
18. Master volume
19. Scratch [Brake (if released before full stop, playback resumes)]
20. Jog (locked in slip mode)
21. Play [Reverse]
22. Cue [Cue and Play]
23. Activate [Clear] hotcue1
24. Activate [Clear] hotcue2
25. Sync mode [Adjust beatgrid to the current playposition]
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26. Keylock mode [Quantize mode]
27. Loop by default loop size[2] [Reloop], or in loop Exit the loop [Set loop out position]
28. Halve default loop size [Jump backward], or in loop Halve the loop[Jump it backward] {Halve jump size[3] of

the other deck}
29. Double default loop size [Jump forward], or in loop Double the loop[Jump it forward] {Double jump size of

the other deck}
30. Enable [Set next effect to] EffectSlot1 of the EffectUnit
31. Enable [Set next effect to] EffectSlot2 of the EffectUnit
32. Enable [Set next effect to] EffectSlot3 of the EffectUnit
33. Enable #6 to control wet/dry mix of [Set next effect chain to] the EffectUnit
34. Slip mode (affect scratch, brake, pause, reverse, loop and hotcue)
35. PFL [PFL solo] (if headphone mix is cue or master only then switch it)
36. Enable EffectUnit1 [EffectUnit3] for the channel
37. Enable EffectUnit2 [EffectUnit4] for the channel
38. Up: previous item and scroll, Down: next item and scroll, Left: previous pane [load to left], Right: next pane

[load to right], Push: choose item
39. Channel select

Mapping for Mixxx 2.0

[Functions] in brackets are executed if a shift button of the deck is pressed.
1. Set previous effect chain to the EffectUnit [Select EffectUnit1/2]
2. Set next effect chain to the EffectUnit [Select EffectUnit3/4]
3. Parameter1 of Effect1 of the EffectUnit
4. Parameter2 of Effect1 of the EffectUnit
5. Parameter3 of Effect1 of the EffectUnit
6. Wet/dry mix of the EffectUnit
7. EQ high
8. EQ mid
9. EQ low
10. Gain
11. Filter (high pass only)[4]
12. Pitch (semitones only)
13. Rate [Rate by quantized BPM]
14. Channel fader
15. Cross fader
16. Headphone volume
17. Headphone mix
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18. Master volume
19. Scratch
20. Jog (locked in slip mode)
21. Play [Adjust beatgrid to the current playposition]
22. Cue [Adjust beatgrid to match another playing deck]
23. Cue and Play [Move beatgrid earlier]
24. Sync mode [Move beatgrid later]
25. Quantize mode [Zoom in waveform]
26. Keylock mode [Zoom out waveform]
27. Loop by default loop size[5] [Reloop], or in loop Exit the loop [Set loop out position]
28. Halve default loop size, or in loop Halve the loop [Move the loop backward by 1/2 beat]
29. Double default loop size, or in loop Double the loop [Move the loop forward by 1/2 beat]
30. Activate [Clear] hotcue1
31. Activate [Clear] hotcue2
32. Activate [Clear] hotcue3
33. Activate [Clear] hotcue4
34. Slip mode (affect scratch, loop and hotcue)
35. PFL [PFL solo] (if headphone mix is cue or master only then switch it)
36. Enable EffectUnit1 [EffectUnit3] for the channel
37. Enable EffectUnit2 [EffectUnit4] for the channel
38. Up: previous track and scroll, Down: next track and scroll, Left: load to left, Right: load to right, Push: load to

first stopped
39. Channel select

1. left-right inverse -> right inverse -> left inverse -> full inverse -> none -> full -> left -> right -> left-right
2. size < 1/4: LED28 & 29; 1/4 ≤ size < 4: LED28; 4 < size ≤ 64: LED29; 64 < size: LED28 & 29
3. size < 1/4: LED28 & 29; 1/4 ≤ size < 4: LED28; 4 < size ≤ 64: LED29; 64 < size: LED28 & 29
4. see the article or use Controller Wizard (choose “Quick Effect Super Knob”) for low-high pass
5. size < 1/4: LED28 & 29; 1/4 ≤ size < 4: LED28; 4 < size ≤ 64: LED29; 64 < size: LED28 & 29

17.1.121 Vestax VCI-300

The VCI-300 is a dedicated USB MIDI controller. It also comes with a built in audio interface with standard 4-in/4-out
and headphone connection, which means all you need for DJing is the VCI-300, a laptop and a set of headphones.
This controller has been discontinued as Vestax went out of business in 2014.

• Forum thread
Baru pada versi 1.11.
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Differences between VCI-300 and VCI-300 MKII

In 2010 Vestax made changes to the original VCI-300 that improved the controller. There were no changes in the MIDI
mapping.

Volume Boost (Gain Boost)

• Higher output gain level and headphone volume level when supplying power with the optional power adaptor.
• Important Note: Optional power supply DC-7 must be used in order to get the boost on the headphones and Master
output. Without the power supply the MKII will perform just like the original VCI-300. Also, using the DC-7 on
the original VCI-300 will do nothing.

Optional Vestax Digital Fader (not included)

The VCI-300MKII Cross fader can be upgraded to Vestax’s new magnetic sensor system digital fader CF-X2.

New Direct Audio Thru

Audio fed to the MIC/AUX input can now be directly sent to the Master outputs with the THRU switch turned ON,
minimizing latency of when fed through ITCH.

New adjust knobs for the JOG sensor control

New JOG sensor adjust knobs for speedy and accurate adjustments.the VCI-300MKII’s JOG wheels have excellent track-
ing ability,and flexibility for various play styles.You can control songs with analog precision.

New Mini Head-Phone Jack

The MKII features a 1/8 inch headphone connection along with standard 1/4 inch connection.

Mapping description

Mixxx supports the VCI-300 out of the box. The mapping for Mixxx closely resemble the original to make the transition
easy.

# KEY FUNCTION
01 Pitch Slider Adjusts playback speed.
02 Auto Tempo Toggle quantize (1.11.0: Trigger beatsync)

Shift + Auto Tempo Trigger beatsync (1.11.0: Toggle quantize)
Scroll + Auto Tempo Tap BPM. When taped repeatedly, adjust the tracks BPM to the tapped BPM.

03 Keylock Trigger beatsync
Shift + Keylock Reset pitch to 0.00% (quartz)

04 Pitch Shift Pitch bend
Shift + Pitch Shift Fine tune playback speed +/-0.01

05 Cue [1-3]/In Set/Activate Hotcue
Shift + Cue [1-3]/In Delete Hotcue

berlanjut ke halaman berikutnya
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Table 15 – lanjutan dari halaman sebelumnya
06 Scratch Toggle scratching on jogwheel
07 Out 1/Loop Set manual loop in point

Shift + Out 1/Loop Clear loop point
Out 2/Loop Set manual loop out point
Shift + Out 2/Loop Clear loop point
Out 3/Loop Enable/disable loop

08 Shift Holding shift engages shift functions of many of the buttons, secondary functions are printed inside a grey box.
09 Trim This controls the volume of the track before it goes to the EQ and fader.
10 Censor Temporary play backwards while pressed, resumes from where the playhead would have been if the button was not pressed

Shift + Censor 1.11: Toggle reverse playback. Pressing Censor again during reverse playback, will return to normal playback.
1.12 (work in progress): Enable/disable effect unit with preselected Filter effect. The filter parameter is controlled with the Mid EQ knob next to the button.

11 Auto Loop Enable beatloop of the current beatloop value (default: 4 beats) for tracks that have BPM calculated
Shift + Auto Loop Enter/Exit beatloop roll
Scroll + Auto Loop Reset number of beats to 4 if beatloop not active

12 Equalizers Adjust the gain of the high/mid/low EQ filter.
13 Half Halve loop length

Shift + Half Jump to start of track (while paused)
Scroll + Half Seek backward (while paused)
Double Double loop length
Shift + Double Jump to end of track (while paused)
Scroll + Double Seek forward (while paused)

14 Master Level This knob controls the overall output of the VCI-300, ensure this is right down before running the software.
15 Monitor Select Controls the balance in the headphones between the mix output and the PFL headphone cue
16 Monitor Volume Controls the volume of the headphones.
17 Cue If a cue point is set, jumps to the cue point when pressed.

Shift + Cue Set the cue point (while playing), clear the cue point (while paused), jump to beginning of track (if no cue point is set)
18 Play Start/Pause playback

Shift + Play Stutter Play
19 Crossfader Fades between the left and right channels.
20 Input faders Control the volume of their respective tracks.
21/23 PFL A/B Sends the left/right deck to the headphone mix.

Shift + PFL A/B Load selected track into the deck (while paused) and switch PFL to this deck
22 Scroll + Jogwheel Scroll playlist (while paused)
24 Cursor Up/Down Scrolls to the next/previous track in the track table.

Cursor Left/Right Switches to the next view (Library, Queue, etc.)
Tab Toggles (expands/collapses) the currently selected sidebar item.

25 Jog (platter touched) Track search (while paused when scratching is disabled)
Pitch bend / nudge (while playing when scratching is disabled)
Scratch (when scratching is enabled)

Jog (outer rim) Pitch bend / nudge
Shift + Jog Fast track search (while paused)
Scroll + Jog Scroll playlist (while paused)
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Figure92: Vestax VCI-300 (schematic view) Image (c) Vestax
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17.1.122 Vestax VCI-400

The Vestax VCI-400 is a 4 deck controller. It has an integrated audio interface with balanced outputs (XLR and 1/4"
TRS), two pairs of RCA inputs, and two XLR / 1/4" combination microphone inputs. The microphone inputs can be sent
to the computer for recording and broadcasting. The RCA inputs do not have phono preamps and do not work for vinyl
control. The VCI-400 requires its own power supply; it does not run on USB bus power.
This controller has been discontinued as Vestax went out of business in 2014.
Baru pada versi 1.10.1.

Compatibility

The original VCI-400 firmware has a bug that prevents the sound card from working with Linux. Now that Vestax is out
of business, drivers and firmware for Vestax devices are hosted on Serato’s website. If your VCI-400’s sound card does
not appear as an available device using Linux, use the firmware updater on a computer running Windows or Mac OS X.
This will only need to be done once and then the controller will continue to work with Linux.
Note that the VCI-400 and VCI-400 Ean Golden Edition are incompatible. Their firmwares use different MIDI messages
to communicate with the computer. Unfortunately, it is not possible to switch between the VCI-400 and VCI-400 Ean
Golden Edition firmware.

Mapping

The VCI-400 mapping for Mixxx is based on the Serato Limited Edition overlay.
For regular use, make sure the “mixer select” switches are all the way to the left. If you move them to the right, the
Play / Cue buttons will be used to select vinyl control modes instead.
Most of the functions are exactly as they appear on the overlay, and the overlay is very nicely labeled so that’s the best
place to start.
The four small buttons below the grouping of 8 buttons selects which mode the 8 buttons are in, either Hot Cues, Loops,
Rolls, or Samples. Mixxx remembers which mode is selected on a per-deck basis, so when you toggle the deck-selection
switches the mode may change. The button corresponding to the current mode will be lit so you know what mode you’re
in.
Button Modes:

• In Hot Cue mode, the 8 buttons will move Mixxx to the designated hotcue. If you hold the shift button, the hotcue
will be cleared.

• In Loop mode, the 8 buttons will create a new loop at the current position from size 32nd note to 16 beats.
• In Roll mode, holding any of the buttons will temporarily create a loop anywhere from 32nd note to 16 beats.
• In Sampler mode, both sides of the controller launch the same set of 8 samplers. Holding shift will eject a sample.

Some of the buttons have special functions in Mixxx:
1. The Vinyl / Slip button. While pushed, the jog wheel is in scratching mode (similar to if you push down on the

platter). If you hold this button while spinning the jog wheel, you can let go of the wheel and Mixxx will still be in
scratch mode. Great for backspins.

2. The Param knob can be used to adjust the musical key of the current track. Twist to make the tone higher or lower.
If you hold the shift button (3), use this knob to scroll quickly through the track. Pushing this knob will reset the
key.

3. Shift button
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Figure93: Vestax VCI-400 (top view with annotations)
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4. Auto Loop knob. Twisting this will change the size of the current loop, either doubling or halving the size. If you
hold shift (3), twisting this knob will move the loop left or right by 1 beat per click. Pushing this knob will enable
or disable looping.

5. The Master FX button enables the 1st FX bank to be applied to the master output.
6. The FX Mode button toggles which effect is in the first FX bank.
7. Controls FX1 Parameter 1
8. Controls FX1 Parameter 2
9. Controls FX1 Parameter 3
10. Controls FX1 Dry / Wet
11. Enable/Disable Quantize Mode.
12. Enable/Disable Keylock

The four small buttons in the center, Area, Panel, Back, and Prepare, don’t do anything. Neither does the sampler volume
slider.
Some additional functions are accessible with the shift button:

• Shift + Load to eject a track.
• Shift + Play while the deck is playing does a breaking stop.
• Shift + Censor does a spinback stop.

Vinyl Control Mode

If you want to use vinyl control instead of the jog wheels, you can move the mixer selection switches all the way to the
right. In this mode, the Play button becomes a Vinyl Control Enable/Disable button, and the Cue button selects which
Vinyl Control mode is active – Absolute, Relative, or Constant. The cue button lights up when Absolute is selected.

Note about VU Meters

There’s a bug in the way that the VCI400 firmware works – although Mixxx can control the VU meters, the VCI’s internal
soundcard always also controls the VU Meters. This can result in an odd flickering effect that looks strange. For this
reason, the Master VU meters are disabled by default. If you’ve installed the firmware that allows decks C and D to act
as pass-through mixer channels, you may see flickering there too.
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Glossary of Terms

AAC
Advanced Audio Coding A patented audio compression algorithm which uses a form of lossy data compression. De-

signed to be the successor toMP3, AAC generally achieves better sound quality at similar bit rates. While the .aac
extension is sometimes used for AAC-encoded files, they are typically saved with an .m4a file extension.

AcoustID An acoustic fingerprint system built entirely on open-source technology. It aims to create a free database of
user-submitted audio fingerprints with mapping to the MusicBrainz metadata database and provide a web service
for audio file identification using this database. For more information, see`<https://acoustid.org/>`_.

AIFF
Audio Interchange File Format High-quality digital audio file format, similar to .wav files. Contains CD quality audio

stored in a non-compressed, lossless format. AIFF files generally end with a .aiff or .aif extension.
ALAC
Apple Lossless Audio Codec A lossless audio file format used by iTunes and other Apple products. ALAC files use

the same MP4 container format as AAC and use the same file extensions (m4a, mp4). Mixxx and many other
programs are not compatible with ALAC. It is recommended to convert ALAC files to FLAC for use in Mixxx.

API
Application Program Interface An API is a specification and set of rules for how software programs interact with each

other. In Mixxx, an example of this is the Sound API that Mixxx uses to communicate with the operating system
to make use of the soundcards connected to the computer.

ASIO
Audio Stream Input/Output ASIO is a low-latency audio interface API on Microsoft Windows.
audio interface An audio interface is a device that facilitates the input and output of audio signals to and from a computer,

typically connected by USB. Almost all computers come with a basic audio interface built in, but a higher quality
audio interface with at least 4 output channels is recommended for Mixxx.

balance A balance control on a mixer allows you to adjust the balance between the left and right channel. The balance
refers to the relative volume of the corresponding channel in a stereo audio signal.
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bar In musical notation, a bar (or measure) is a segment of time defined by a given number of beats. Typically, a piece
consists of several bars of the same length.

beatgrid A series of markers that point to the location of beats within the track. Beatgrids are used for advanced mixing
functions such as track sync, precise effects synchronization, looping and accurate BPM representation.

beatmatching A mixing technique used to establish a similar tempo with two or more tracks, making them sound like
just one track.

binaries Files that contain compiled computer code, which was compiled from source code. Source code, which is
usually a bunch of text files, is processed with a program called a compiler. The compiler then generates a binary,
which is something like an an .exe or a .dll file. By using binaries you are relieved of the task of having to compile
the code by yourself.

bitrate Describe the quality of an audio or video file. For audio data the bitrate is commonly measured in kbps. For
example, an MP3 audio file that is compressed at 192 Kbps will have a greater dynamic range and may sound
slightly more clear than the same audio file compressed at 128 Kbps.

BPM
Beats per minute BPM is used as a measure of tempo in music. If you tap your foot to music you are following the

“beat”. If you count how many taps you do in a minute you have calculated the BPM.
bug report Every software has bugs. When you come across a bug in this software, you should submit a report about it

to the developers. They can use this to identify, replicate and fix the issue.
CDJ CDJ is a term originally used to describe a line of CD players from Pioneer Electronics. Today CDJ generally refers

to DJ CD players that work like a record player. They allow analog control of music using CDs, usually using a
touch sensitive emulated vinyl control surface.

codec Short for compressor/decompressor, a codec is any technology for compressing and decompressing audio and
video data. Some popular codecs for computer audio include MP3 and Ogg Vorbis.

controller An external hardware device that generates and transmits signals to a computer, usually via USB, to control
software with physical controls other than a mouse and keyboard. Controllers have many uses for music such
as controlling DJ programs like Mixxx. They typically send MIDI signals but some controllers use HID signals.
Many DJs prefer to control DJ software using physical knobs, faders, and wheels on controllers instead of using a
computer keyboard and mouse.

crossfader The crossfader is a slider that determines how much each deck of audio contributes to the master output.
cue
cue point A reference point in the track usually placed on the position the DJ wants the track to start at by default. This

is useful to instantly jump to that point without seeking through the track.
cue sheet A cue sheet (or CUE file, CUE sheet, etc.) is a formatted plain text file which is used to provide index

information for a large audio file. For example, it can be used to tell software extra details about the layout of a CD
to burn.

cueing Headphone cueing, or just cueing, is listening to the next track you would like to mix in your headphones. The
audience will not hear what you are cueing in your headphones. Being able to cue is a crucial aspect to DJing.

DAW
Digital Audio Workstation An electronic device or application software used for recording, editing and producing audio

files.
db
decibel A Decibel is a logarithmic measurement of sound level. Whispering is around 25 dB while unbearable sound

such as a jet engine is around 160 db. Rule of thumb: A volume increase of 10 dB is perceived as twice as loud.
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deck A deck is like a virtual vinyl turntable. You can load a track into it and play the track, just like you would put a
record on turntable and play it.

direct monitoring A feature of many soundcards that allows microphones and other input signals to be heard through
the soundcard outputs with no perceivable latency. With direct monitoring, the audio interface mixes the input
signal in hardware with the output signal from Mixxx. This bypasses the latency of sending the signal into the
computer for Mixxx to process and sending it back out to the soundcard.

DRM Digital Rights Management (DRM) technologies attempt to control what you can and can't do with the media
and hardware you've purchased. Typically, a DRM system either encrypts the data so that it can only be accessed
in a way authorized by copyright holders or marks content with a digital watermark or similar method so that the
content can not be freely distributed. For information about how you can get involved in activism against DRM,
see Defective by Design.

EQ
Equalizer An equalizer allows the sound in specified frequency bands to be amplified or reduced, in order to adjust the

quality and character of the sound.
A simple graphic equalizer consists of multiple controls for boosting or cutting bands or frequencies of sound.
A parametric equalizer controls more parameters of the sound than a graphic equalizer. It can control three aspects
of each frequency: level (boost or cut), the center or primary frequency, and the bandwidth or range of each
frequency.

fast-forward To cause something to advance at quicker than normal speed. In terms of audio software that means if
you press the fast-forward button the audio will play with increased speed as long as the button is pressed. This is
useful to seek through a track.

fast-rewind The opposite of fast-forward. If you press the fast-rewind button the audio will play in reverse with increased
speed as long as the button is pressed.

file manager A computer program that organizes data files into groups and shows you where they are when you need to
find them again. Popular file managers for the operating systemsMixxx supports are Explorer on Windows, Finder
on macOS and Nautilus on GNU/Linux.

FLAC
Free Lossless Audio Compression A patent-free audio compression similar toMP3 but lossless (i.e. there is no loss in

audio quality when used). FLAC files generally end with a .flac extension.
flanger A flanger is an effect that mixes the input signal with a delayed copy of itself which leads to interferences in the

signal and creates a comb-filter effect. By routing the output of the effect back into the input (feedback), the effect
is enhanced.

GUI
Graphical User Interface It's pronounced "gooey" and it refers to a user interface based on graphics (icons, pictures

and menus) instead of text. In Mixxx, it uses a mouse, keyboard, or MIDI / HID controllers as input devices.
head/mix button The head/mix button is used to control how much you mix the master output into your headphone

output. This can be very useful when cueing a track, because you can test out how it sounds when mixed with the
main mix in your headphones, before letting the audience hear the track.

headphone button The headphone button is used to indicate whether or not you are pre-listening to a deck or sampler
in your headphones.

headphone output The headphone output is what you hear in your headphones.
HID
Human Interface Device A part of the USB specification. It specifies a device class (a type of computer hardware) for

human interface devices such as keyboards, mice, game controllers, and some DJ controllers.
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hotcue Similar to the main cue point, a hotcue is a reference point in the track. DJs usually place hotcues at distinctive
positions within a track such as drops, breaks or kicks and snares. Mixxx supports up to 36 hotcues.

HSV HSV stands for hue, saturation, and value, and is also often called HSB (B for brightness). The HSV Color Model
represents color in a way more suited to the human perception of color. For example, the relationships “stronger
than”, “darker than”, and “the opposite of” are easily expressed in HSV. In contrast, the representation of the
hardware-oriented RGB model is close to what most monitors show.

icecast Icecast is free and open-source software that allows digital audio content to be broadcast to and from media
player software, enabling the creation of Internet radio stations. Unlike Shoutcast, the software provides the ability
to stream in free file formats like Ogg Vorbis and run your own directory server.

IRC
Internet Relay Chat IRC is an online chat network. The Mixxx IRC channel was on the FreeNode IRC Network in the

#mixxx channel. The channel was replaced in 2018 by the Mixxx Zulip Chat.
kbps Short for kilobits per second. Here used to measure the quality of audio data. See bitrate
key Short for "musical key" (i.e. C major).
key lock With key lock enabled, the tempo of the track will change but the pitch remains consistent. When unlocked,

the pitch slider will speed up (or slow down) the track and the pitch will increase (or decrease) along with it.
kill switch A button to turn on and off individual frequency ranges within a channel, i.e. treble, mid and bass. Useful

for effects where the DJ drops a track out for a period or creates room for a transition.
LADSPA
Linux Audio Developer's Simple Plugin The LADSPA API is a standard for handling audio filters and audio signal

processing effects.
LAME LAME is a free software codec used to encode/compress audio into the lossy MP3 file format.
latency Latency refers to a short period of delay (usually measured in milliseconds) between when an audio signal enters

and when it emerges from a system. Being able to lower the latency as much as possible makes a huge difference
in responsiveness.

level meter The level meter is used to show the average levels of audio signals. The level should average around the top
of the green region, with the loudest parts of the music (the transients) briefly going into the yellow region. If the
level meter is in the red, the signal is clipping and the gain should be turned down.

lossless Used when describing audio compression algorithms, a lossless algorithm is one which results in no loss in audio
quality when used.

lossy Used when describing audio compression algorithms, a lossy algorithm is one which results in a loss in audio quality
when used.

macOS macOS (originally named "Mac OS X" until 2012 and then "OS X" until 2016) is the current Mac operating
system that officially succeeded the classic Mac OS in 2001.

master output The master output is the main audio output. It is what your audience hears.
metadata In general, any piece of information about a music file that Mixxx uses (e.g. title, artist, album, hotcue

locations, loops, etc.). Various file metadata formats allow information such as the title, artist, album, and track
number to be stored in the audio file itself, see https://en.wikipedia.org/wiki/ID3 . Mixxx stores additional metadata
about music files in its database, like beatgrid, waveform data, hotcues, playlists, crates, number of plays, etc.

MIDI
Musical Instrument Digital Interface A digital communications language and hardware specification enabling com-

patible electronic instruments, sequencers, computers, etc., to communicate with each other in a network. Most
DJ controllers use MIDI to communicate with computers.

484

https://freenode.net
https://en.wikipedia.org/wiki/ID3


Mixxx User Manual, Rilis 2.3.0

MP3 A patented audio compression algorithm which uses a form of lossy data compression. It is de-facto standard of
digital audio compression for music. MP3 files generally end with a .mp3 extension.

MusicBrainz A open-source music encyclopedia that collects music metadata and makes it available to the public. For
more information, see https://musicbrainz.org/.

Ogg Vorbis A patent-free audio compression algorithm which uses a form of lossy data compression. It is designed to
provide for efficient streaming and manipulation of high quality digital audio. Ogg Vorbis files generally end with
a .ogg or .oga extension.

open-source Generically, open-source refers to a program for which the source code is available to the public for use
and/or modification from its original design free of charge. Open source code is typically created as a collaborative
effort in which programmers improve upon the code and share the changes within the community. Open source
sprouted in the technological community as a response to proprietary software owned by corporations. For more
information, see Wikipedia.

OpenGL An operating system feature used to draw hardware-accelerated graphics. Mixxx uses OpenGL to draw the
waveform displays and spinning vinyl widgets.

operating system Your operating system (OS) is the computing environment on your computer. For example, Windows,
macOS, or GNU/Linux are the three operating systems that Mixxx supports.

Opus Opus is a totally open, royalty-free, highly versatile lossy audio codec. The .opus filename extension is recom-
mended.

PFL PFL or “pre-fader listen” is the headphone signal that is not affected by the deck volume faders. This allows for
pre-listening tracks in headphones by lowering the volume fader so the deck plays only to headphones but not to
the audience. See also: headphone button.

phase The phase of a track is its position relative to another track. If two tracks are sync'd to the same tempo and
in-phase then they should be playing so that their beats are aligned.

pitch bend A technique used by DJs that temporarily bends the rate of a track up or down, usually while a button is held.
This technique is usually used to make micro-adjustments to the synchronization of tracks while beatmatching.
Before digital DJing, this was accomplished by dragging one's finger alongside the turntable to slow it down or by
twisting the record spindle to speed it up.

podcast A podcast is a feed of audio or video files made available for free or for purchase over the Internet. Podcast
clients such as iTunes allow listeners to subscribe to the feed and automatically download content to their portable
audio players as it becomes available.

quantization Quantization is the process of aligning notes and other events like loops or cuepoints so that they start or
finish exactly on beats or fractions of beats.

ramping pitch bend Basically identical to the regular pitch bend with the difference that the pitch changes gradually,
instead of all at once. Often uses for temporary pitch changes. It simulates the effect of touching a turntable to
temporarily slow down or speed up a record.

rate The speed at which a track is played back, usually expressed in terms of a percentage of the speed relative to the
tracks normal rate. Often while mixing, DJs adjust the rates of tracks so that they can play at the same tempo as
other tracks. This allows DJs to beatmix, and is an essential part of DJing.

ReplayGain ReplayGain normalizes audio data in a non-destructive way, so the tracks in your music library don't all
play at different volumes. Audio files are scanned by a psychoacoustic algorithm to determine the loudness of the
audio data. ReplayGain information is stored asmetadata in a digital audio file in order for the sound to be correctly
played at the right level of loudness.

reverse Reverse plays a track backwards.
RGB The RGB color model is an additive color model in which red, green, and blue light are added together in various

ways to reproduce a broad array of colors. The name of the model comes from the initials of the three additive
primary colors, red, green, and blue.
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shortcut Shortcuts let you work more efficiently. This manual shows some shortcuts for accessing Mixxx functions with
an English keyboard layout. Depending on your language settings the defaults may be different.

shoutcast Shoutcast is proprietary software that allows digital audio content to be broadcast to and from media player
software, enabling the creation of Internet radio stations.

soundcard Another name for an audio interface, although few audio interfaces are shaped like cards anymore.
sync Sync allows you to automatically adjust a track's tempo and phase to be in sync with another deck that is playing.
sync lock
master sync Sync lock mode persistently adjusts a track's tempo and phase (if quantization is enabled) in order to stay

in sync with other decks that are in sync lock mode.
tempo The speed of a track measured in BPM.
timecode Used here in conjunction with vinyl control. A special audio signal on a control vinyl or control CD (timecode

media) that a computer can listen to in order to determine speed, direction and position of the playback.
track A track is another word for a song.
URL
Uniform Resource Locator The address that defines the route to a file on an Internet server. URLs are typed into a

Web browser to access Web pages and files, and URLs are embedded within the pages themselves as hypertext
links. One example of a URL is https://mixxx.org .

USB
Universal Serial Bus USB is an industry standard for cables, connectors and protocols and used for lots of consumer

hardware. If an audio interface is "USB class compliant", this means it can be used on all major operating systems
without special drivers (on Windows, special drivers might still be necessary to use the ASIO sound API though).

vinyl control Amethod of controlling DJ applications which simulates the traditional DJing paradigm of two turntables.
Using special timecode media, the DJ application analyzes the timecode signal and simulates the sound and feel of
having your music collection on vinyl.

volume A term that refers to the degree of sound intensity or audibility; loudness. Volume is determined by people's
perception and does not directly correspond to any physical property of sound.

WAV Standard digital audio file format used for storing waveform data; allows audio recordings to be saved with different
sampling rates and bitrates; often saved in a 44.1 KHz, 16-bit, stereo format, which is the standard format used
for CD audio. Wave files are not compressed, and are therefore lossless. Wave files generally end with a .wav
extension.

waveform overview The waveform overview shows the waveform envelope of the entire track, and is useful because
they allow DJs to see breakdowns far in advance.

waveform summary The waveform summary shows the waveform envelope of the track near the current playback po-
sition.

Zulip Zulip is a powerful, open source group chat application that combines the immediacy of real-time chat with the
productivity benefits of threaded conversations. The Mixxx Zulip Chat at can be found at https://mixxx.
zulipchat.com .
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[PreviewDeckN],PeakIndicator (chap-
ters/appendix/mixxx_controls), 148

[PreviewDeckN],PeakIndicatorL (chap-
ters/appendix/mixxx_controls), 148

[PreviewDeckN],PeakIndicatorR (chap-
ters/appendix/mixxx_controls), 148

[PreviewDeckN],pfl (chap-
ters/appendix/mixxx_controls), 148

[PreviewDeckN],pitch (chap-
ters/appendix/mixxx_controls), 148

[PreviewDeckN],pitch_adjust (chap-
ters/appendix/mixxx_controls), 149

[PreviewDeckN],pitch_down (chap-
ters/appendix/mixxx_controls), 149

[PreviewDeckN],pitch_up (chap-
ters/appendix/mixxx_controls), 148

[PreviewDeckN],play (chap-
ters/appendix/mixxx_controls), 149

[PreviewDeckN],play_indicator (chap-
ters/appendix/mixxx_controls), 149

[PreviewDeckN],play_latched (chap-
ters/appendix/mixxx_controls), 149
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[PreviewDeckN],play_stutter (chap-
ters/appendix/mixxx_controls), 150

[PreviewDeckN],playposition (chap-
ters/appendix/mixxx_controls), 150

[PreviewDeckN],pregain (chap-
ters/appendix/mixxx_controls), 150

[PreviewDeckN],quantize (chap-
ters/appendix/mixxx_controls), 150

[PreviewDeckN],rate (chap-
ters/appendix/mixxx_controls), 150

[PreviewDeckN],rate_dir (chap-
ters/appendix/mixxx_controls), 150

[PreviewDeckN],rate_perm_down (chap-
ters/appendix/mixxx_controls), 150

[PreviewDeckN],rate_perm_down_small
(chapters/appendix/mixxx_controls), 151

[PreviewDeckN],rate_perm_up (chap-
ters/appendix/mixxx_controls), 151

[PreviewDeckN],rate_perm_up_small (chap-
ters/appendix/mixxx_controls), 151

[PreviewDeckN],rate_temp_down (chap-
ters/appendix/mixxx_controls), 151

[PreviewDeckN],rate_temp_down_small
(chapters/appendix/mixxx_controls), 151

[PreviewDeckN],rate_temp_up (chap-
ters/appendix/mixxx_controls), 151

[PreviewDeckN],rate_temp_up_small (chap-
ters/appendix/mixxx_controls), 151

[PreviewDeckN],rateEngine (chap-
ters/appendix/mixxx_controls), 152

[PreviewDeckN],rateRange (chap-
ters/appendix/mixxx_controls), 152

[PreviewDeckN],rateSearch (chap-
ters/appendix/mixxx_controls), 152

[PreviewDeckN],reloop_andstop (chap-
ters/appendix/mixxx_controls), 152

[PreviewDeckN],reloop_exit (chap-
ters/appendix/mixxx_controls), 159

[PreviewDeckN],reloop_toggle (chap-
ters/appendix/mixxx_controls), 152

[PreviewDeckN],repeat (chap-
ters/appendix/mixxx_controls), 152

[PreviewDeckN],reset_key (chap-
ters/appendix/mixxx_controls), 153

[PreviewDeckN],reverse (chap-
ters/appendix/mixxx_controls), 153

[PreviewDeckN],reverseroll (chap-
ters/appendix/mixxx_controls), 153

[PreviewDeckN],scratch (chap-
ters/appendix/mixxx_controls), 160

[PreviewDeckN],scratch2 (chap-
ters/appendix/mixxx_controls), 153

[PreviewDeckN],scratch2_enabled (chap-
ters/appendix/mixxx_controls), 153

[PreviewDeckN],slip_enabled (chap-
ters/appendix/mixxx_controls), 153

[PreviewDeckN],stars_down (chap-
ters/appendix/mixxx_controls), 154

[PreviewDeckN],stars_up (chap-
ters/appendix/mixxx_controls), 154

[PreviewDeckN],start (chap-
ters/appendix/mixxx_controls), 154

[PreviewDeckN],start_play (chap-
ters/appendix/mixxx_controls), 154

[PreviewDeckN],start_stop (chap-
ters/appendix/mixxx_controls), 154

[PreviewDeckN],stop (chap-
ters/appendix/mixxx_controls), 154

[PreviewDeckN],sync_enabled (chap-
ters/appendix/mixxx_controls), 155

[PreviewDeckN],sync_key (chap-
ters/appendix/mixxx_controls), 155

[PreviewDeckN],sync_master (chap-
ters/appendix/mixxx_controls), 155

[PreviewDeckN],sync_mode (chap-
ters/appendix/mixxx_controls), 155

[PreviewDeckN],track_color (chap-
ters/appendix/mixxx_controls), 155

[PreviewDeckN],track_loaded (chap-
ters/appendix/mixxx_controls), 155

[PreviewDeckN],track_samplerate (chap-
ters/appendix/mixxx_controls), 156

[PreviewDeckN],track_samples (chap-
ters/appendix/mixxx_controls), 156

[PreviewDeckN],vinylcontrol_cueing
(chapters/appendix/mixxx_controls), 156

[PreviewDeckN],vinylcontrol_enabled
(chapters/appendix/mixxx_controls), 156

[PreviewDeckN],vinylcontrol_mode (chap-
ters/appendix/mixxx_controls), 157

[PreviewDeckN],vinylcontrol_status
(chapters/appendix/mixxx_controls), 157

[PreviewDeckN],visual_bpm (chap-
ters/appendix/mixxx_controls), 157

[PreviewDeckN],visual_key (chap-
ters/appendix/mixxx_controls), 157

[PreviewDeckN],visual_key_distance
(chapters/appendix/mixxx_controls), 158

[PreviewDeckN],volume (chap-
ters/appendix/mixxx_controls), 156

[PreviewDeckN],VuMeter (chap-
ters/appendix/mixxx_controls), 158

[PreviewDeckN],VuMeterL (chap-
ters/appendix/mixxx_controls), 158

[PreviewDeckN],VuMeterR (chap-
ters/appendix/mixxx_controls), 158

[PreviewDeckN],waveform_zoom (chap-
ters/appendix/mixxx_controls), 158
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[PreviewDeckN],waveform_zoom_down (chap-
ters/appendix/mixxx_controls), 159

[PreviewDeckN],waveform_zoom_set_default
(chapters/appendix/mixxx_controls), 159

[PreviewDeckN],waveform_zoom_up (chap-
ters/appendix/mixxx_controls), 158

[PreviewDeckN],wheel (chap-
ters/appendix/mixxx_controls), 159

[QuickEffectRack1]
[QuickEffectRack1],clear (chap-

ters/appendix/mixxx_controls), 173
[QuickEffectRack1],num_effectunits

(chapters/appendix/mixxx_controls), 173

[QuickEffectRack1_[ChannelI]]
[QuickEffectRack1_[ChannelI]],chain_selector

(chapters/appendix/mixxx_controls), 173
[QuickEffectRack1_[ChannelI]],clear

(chapters/appendix/mixxx_controls), 174
[QuickEffectRack1_[ChannelI]],enabled

(chapters/appendix/mixxx_controls), 174
[QuickEffectRack1_[ChannelI]],focused_effect

(chapters/appendix/mixxx_controls), 174
[QuickEffectRack1_[ChannelI]],group_[ChannelI]_enable

(chapters/appendix/mixxx_controls), 174
[QuickEffectRack1_[ChannelI]],loaded

(chapters/appendix/mixxx_controls), 174
[QuickEffectRack1_[ChannelI]],mix (chap-

ters/appendix/mixxx_controls), 174
[QuickEffectRack1_[ChannelI]],next_chain

(chapters/appendix/mixxx_controls), 175
[QuickEffectRack1_[ChannelI]],num_effects

(chapters/appendix/mixxx_controls), 175
[QuickEffectRack1_[ChannelI]],num_effectslots

(chapters/appendix/mixxx_controls), 175
[QuickEffectRack1_[ChannelI]],prev_chain

(chapters/appendix/mixxx_controls), 175
[QuickEffectRack1_[ChannelI]],show_focus

(chapters/appendix/mixxx_controls), 175
[QuickEffectRack1_[ChannelI]],show_parameters

(chapters/appendix/mixxx_controls), 175
[QuickEffectRack1_[ChannelI]],super1

(chapters/appendix/mixxx_controls), 175

[QuickEffectRack1_[ChannelI]_Effect1]
[QuickEffectRack1_[ChannelI]_Effect1],button_parameterK

(chapters/appendix/mixxx_controls), 177
[QuickEffectRack1_[ChannelI]_Effect1],button_parameterK_loaded

(chapters/appendix/mixxx_controls), 177
[QuickEffectRack1_[ChannelI]_Effect1],button_parameterK_type

(chapters/appendix/mixxx_controls), 177
[QuickEffectRack1_[ChannelI]_Effect1],clear

(chapters/appendix/mixxx_controls), 175

[QuickEffectRack1_[ChannelI]_Effect1],effect_selector
(chapters/appendix/mixxx_controls), 176

[QuickEffectRack1_[ChannelI]_Effect1],enabled
(chapters/appendix/mixxx_controls), 176

[QuickEffectRack1_[ChannelI]_Effect1],loaded
(chapters/appendix/mixxx_controls), 176

[QuickEffectRack1_[ChannelI]_Effect1],meta
(chapters/appendix/mixxx_controls), 176

[QuickEffectRack1_[ChannelI]_Effect1],next_effect
(chapters/appendix/mixxx_controls), 176

[QuickEffectRack1_[ChannelI]_Effect1],num_button_parameters
(chapters/appendix/mixxx_controls), 176

[QuickEffectRack1_[ChannelI]_Effect1],num_button_parameterslots
(chapters/appendix/mixxx_controls), 176

[QuickEffectRack1_[ChannelI]_Effect1],num_parameters
(chapters/appendix/mixxx_controls), 176

[QuickEffectRack1_[ChannelI]_Effect1],num_parameterslots
(chapters/appendix/mixxx_controls), 176

[QuickEffectRack1_[ChannelI]_Effect1],parameterK
(chapters/appendix/mixxx_controls), 177

[QuickEffectRack1_[ChannelI]_Effect1],parameterK_link_inverse
(chapters/appendix/mixxx_controls), 177

[QuickEffectRack1_[ChannelI]_Effect1],parameterK_link_type
(chapters/appendix/mixxx_controls), 177

[QuickEffectRack1_[ChannelI]_Effect1],parameterK_loaded
(chapters/appendix/mixxx_controls), 177

[QuickEffectRack1_[ChannelI]_Effect1],parameterK_type
(chapters/appendix/mixxx_controls), 177

[QuickEffectRack1_[ChannelI]_Effect1],prev_effect
(chapters/appendix/mixxx_controls), 177

[Recording]
[Recording],status (chap-

ters/appendix/mixxx_controls), 165
[Recording],toggle_recording (chap-

ters/appendix/mixxx_controls), 165

[SamplerN]
[SamplerN],back (chap-

ters/appendix/mixxx_controls), 129
[SamplerN],beat_active (chap-

ters/appendix/mixxx_controls), 129
[SamplerN],beat_closest (chap-

ters/appendix/mixxx_controls), 129
[SamplerN],beat_distance (chap-

ters/appendix/mixxx_controls), 130
[SamplerN],beatjump (chap-

ters/appendix/mixxx_controls), 130
[SamplerN],beatjump_backward (chap-

ters/appendix/mixxx_controls), 130
[SamplerN],beatjump_forward (chap-

ters/appendix/mixxx_controls), 130
[SamplerN],beatjump_size (chap-

ters/appendix/mixxx_controls), 130
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[SamplerN],beatjump_X_backward (chap-
ters/appendix/mixxx_controls), 130

[SamplerN],beatjump_X_forward (chap-
ters/appendix/mixxx_controls), 130

[SamplerN],beatloop (chap-
ters/appendix/mixxx_controls), 159

[SamplerN],beatloop_activate (chap-
ters/appendix/mixxx_controls), 131

[SamplerN],beatloop_size (chap-
ters/appendix/mixxx_controls), 131

[SamplerN],beatloop_X (chap-
ters/appendix/mixxx_controls), 161

[SamplerN],beatloop_X_activate (chap-
ters/appendix/mixxx_controls), 131

[SamplerN],beatloop_X_enabled (chap-
ters/appendix/mixxx_controls), 131

[SamplerN],beatloop_X_toggle (chap-
ters/appendix/mixxx_controls), 131

[SamplerN],beatlooproll_activate (chap-
ters/appendix/mixxx_controls), 132

[SamplerN],beatlooproll_X_activate
(chapters/appendix/mixxx_controls), 132

[SamplerN],beats_adjust_faster (chap-
ters/appendix/mixxx_controls), 132

[SamplerN],beats_adjust_slower (chap-
ters/appendix/mixxx_controls), 132

[SamplerN],beats_translate_curpos (chap-
ters/appendix/mixxx_controls), 132

[SamplerN],beats_translate_earlier
(chapters/appendix/mixxx_controls), 133

[SamplerN],beats_translate_later (chap-
ters/appendix/mixxx_controls), 133

[SamplerN],beats_translate_match_alignment
(chapters/appendix/mixxx_controls), 132

[SamplerN],beatsync (chap-
ters/appendix/mixxx_controls), 133

[SamplerN],beatsync_phase (chap-
ters/appendix/mixxx_controls), 133

[SamplerN],beatsync_tempo (chap-
ters/appendix/mixxx_controls), 133

[SamplerN],bpm (chapters/appendix/mixxx_controls),
133

[SamplerN],bpm_tap (chap-
ters/appendix/mixxx_controls), 134

[SamplerN],CloneFromDeck (chap-
ters/appendix/mixxx_controls), 134

[SamplerN],CloneFromSampler (chap-
ters/appendix/mixxx_controls), 134

[SamplerN],cue_cdj (chap-
ters/appendix/mixxx_controls), 134

[SamplerN],cue_clear (chap-
ters/appendix/mixxx_controls), 134

[SamplerN],cue_default (chap-
ters/appendix/mixxx_controls), 135

[SamplerN],cue_goto (chap-
ters/appendix/mixxx_controls), 135

[SamplerN],cue_gotoandplay (chap-
ters/appendix/mixxx_controls), 135

[SamplerN],cue_gotoandstop (chap-
ters/appendix/mixxx_controls), 135

[SamplerN],cue_indicator (chap-
ters/appendix/mixxx_controls), 135

[SamplerN],cue_mode (chap-
ters/appendix/mixxx_controls), 135

[SamplerN],cue_play (chap-
ters/appendix/mixxx_controls), 136

[SamplerN],cue_point (chap-
ters/appendix/mixxx_controls), 136

[SamplerN],cue_preview (chap-
ters/appendix/mixxx_controls), 136

[SamplerN],cue_set (chap-
ters/appendix/mixxx_controls), 136

[SamplerN],cue_simple (chap-
ters/appendix/mixxx_controls), 136

[SamplerN],duration (chap-
ters/appendix/mixxx_controls), 136

[SamplerN],eject (chap-
ters/appendix/mixxx_controls), 137

[SamplerN],end (chapters/appendix/mixxx_controls),
137

[SamplerN],end_of_track (chap-
ters/appendix/mixxx_controls), 137

[SamplerN],file_bpm (chap-
ters/appendix/mixxx_controls), 137

[SamplerN],file_key (chap-
ters/appendix/mixxx_controls), 137

[SamplerN],filter (chap-
ters/appendix/mixxx_controls), 160

[SamplerN],filterDepth (chap-
ters/appendix/mixxx_controls), 160

[SamplerN],filterHigh (chap-
ters/appendix/mixxx_controls), 161

[SamplerN],filterHighKill (chap-
ters/appendix/mixxx_controls), 161

[SamplerN],filterLow (chap-
ters/appendix/mixxx_controls), 160

[SamplerN],filterLowKill (chap-
ters/appendix/mixxx_controls), 160

[SamplerN],filterMid (chap-
ters/appendix/mixxx_controls), 161

[SamplerN],filterMidKill (chap-
ters/appendix/mixxx_controls), 161

[SamplerN],fwd (chapters/appendix/mixxx_controls),
137

[SamplerN],hotcue_focus (chap-
ters/appendix/mixxx_controls), 139

[SamplerN],hotcue_focus_color_next
(chapters/appendix/mixxx_controls), 139
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[SamplerN],hotcue_focus_color_prev
(chapters/appendix/mixxx_controls), 139

[SamplerN],hotcue_X_activate (chap-
ters/appendix/mixxx_controls), 137

[SamplerN],hotcue_X_clear (chap-
ters/appendix/mixxx_controls), 138

[SamplerN],hotcue_X_color (chap-
ters/appendix/mixxx_controls), 138

[SamplerN],hotcue_X_enabled (chap-
ters/appendix/mixxx_controls), 138

[SamplerN],hotcue_X_goto (chap-
ters/appendix/mixxx_controls), 138

[SamplerN],hotcue_X_gotoandplay (chap-
ters/appendix/mixxx_controls), 138

[SamplerN],hotcue_X_gotoandstop (chap-
ters/appendix/mixxx_controls), 139

[SamplerN],hotcue_X_position (chap-
ters/appendix/mixxx_controls), 139

[SamplerN],hotcue_X_set (chap-
ters/appendix/mixxx_controls), 139

[SamplerN],intro_end_activate (chap-
ters/appendix/mixxx_controls), 140

[SamplerN],intro_end_clear (chap-
ters/appendix/mixxx_controls), 140

[SamplerN],intro_end_enabled (chap-
ters/appendix/mixxx_controls), 140

[SamplerN],intro_end_position (chap-
ters/appendix/mixxx_controls), 140

[SamplerN],intro_end_set (chap-
ters/appendix/mixxx_controls), 140

[SamplerN],intro_start_activate (chap-
ters/appendix/mixxx_controls), 140

[SamplerN],intro_start_clear (chap-
ters/appendix/mixxx_controls), 141

[SamplerN],intro_start_enabled (chap-
ters/appendix/mixxx_controls), 141

[SamplerN],intro_start_position (chap-
ters/appendix/mixxx_controls), 141

[SamplerN],intro_start_set (chap-
ters/appendix/mixxx_controls), 141

[SamplerN],jog (chapters/appendix/mixxx_controls),
160

[SamplerN],key (chapters/appendix/mixxx_controls),
141

[SamplerN],keylock (chap-
ters/appendix/mixxx_controls), 142

[SamplerN],LoadSelectedTrack (chap-
ters/appendix/mixxx_controls), 142

[SamplerN],LoadSelectedTrackAndPlay
(chapters/appendix/mixxx_controls), 142

[SamplerN],local_bpm (chap-
ters/appendix/mixxx_controls), 143

[SamplerN],loop_double (chap-
ters/appendix/mixxx_controls), 143

[SamplerN],loop_enabled (chap-
ters/appendix/mixxx_controls), 143

[SamplerN],loop_end_position (chap-
ters/appendix/mixxx_controls), 143

[SamplerN],loop_halve (chap-
ters/appendix/mixxx_controls), 143

[SamplerN],loop_in (chap-
ters/appendix/mixxx_controls), 143

[SamplerN],loop_in_goto (chap-
ters/appendix/mixxx_controls), 144

[SamplerN],loop_move (chap-
ters/appendix/mixxx_controls), 144

[SamplerN],loop_move_X_backward (chap-
ters/appendix/mixxx_controls), 145

[SamplerN],loop_move_X_forward (chap-
ters/appendix/mixxx_controls), 144

[SamplerN],loop_out (chap-
ters/appendix/mixxx_controls), 144

[SamplerN],loop_out_goto (chap-
ters/appendix/mixxx_controls), 144

[SamplerN],loop_scale (chap-
ters/appendix/mixxx_controls), 145

[SamplerN],loop_start_position (chap-
ters/appendix/mixxx_controls), 145

[SamplerN],mute (chap-
ters/appendix/mixxx_controls), 156

[SamplerN],orientation (chap-
ters/appendix/mixxx_controls), 145

[SamplerN],orientation_center (chap-
ters/appendix/mixxx_controls), 145

[SamplerN],orientation_left (chap-
ters/appendix/mixxx_controls), 145

[SamplerN],orientation_right (chap-
ters/appendix/mixxx_controls), 146

[SamplerN],outro_end_activate (chap-
ters/appendix/mixxx_controls), 146

[SamplerN],outro_end_clear (chap-
ters/appendix/mixxx_controls), 146

[SamplerN],outro_end_enabled (chap-
ters/appendix/mixxx_controls), 146

[SamplerN],outro_end_position (chap-
ters/appendix/mixxx_controls), 146

[SamplerN],outro_end_set (chap-
ters/appendix/mixxx_controls), 146

[SamplerN],outro_start_activate (chap-
ters/appendix/mixxx_controls), 146

[SamplerN],outro_start_clear (chap-
ters/appendix/mixxx_controls), 147

[SamplerN],outro_start_enabled (chap-
ters/appendix/mixxx_controls), 147

[SamplerN],outro_start_position (chap-
ters/appendix/mixxx_controls), 147

[SamplerN],outro_start_set (chap-
ters/appendix/mixxx_controls), 147
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[SamplerN],passthrough (chap-
ters/appendix/mixxx_controls), 147

[SamplerN],PeakIndicator (chap-
ters/appendix/mixxx_controls), 148

[SamplerN],PeakIndicatorL (chap-
ters/appendix/mixxx_controls), 148

[SamplerN],PeakIndicatorR (chap-
ters/appendix/mixxx_controls), 148

[SamplerN],pfl (chapters/appendix/mixxx_controls),
148

[SamplerN],pitch (chap-
ters/appendix/mixxx_controls), 148

[SamplerN],pitch_adjust (chap-
ters/appendix/mixxx_controls), 149

[SamplerN],pitch_down (chap-
ters/appendix/mixxx_controls), 149

[SamplerN],pitch_up (chap-
ters/appendix/mixxx_controls), 149

[SamplerN],play (chap-
ters/appendix/mixxx_controls), 149

[SamplerN],play_indicator (chap-
ters/appendix/mixxx_controls), 149

[SamplerN],play_latched (chap-
ters/appendix/mixxx_controls), 149

[SamplerN],play_stutter (chap-
ters/appendix/mixxx_controls), 150

[SamplerN],playposition (chap-
ters/appendix/mixxx_controls), 150

[SamplerN],pregain (chap-
ters/appendix/mixxx_controls), 150

[SamplerN],quantize (chap-
ters/appendix/mixxx_controls), 150

[SamplerN],rate (chap-
ters/appendix/mixxx_controls), 150

[SamplerN],rate_dir (chap-
ters/appendix/mixxx_controls), 150

[SamplerN],rate_perm_down (chap-
ters/appendix/mixxx_controls), 151

[SamplerN],rate_perm_down_small (chap-
ters/appendix/mixxx_controls), 151

[SamplerN],rate_perm_up (chap-
ters/appendix/mixxx_controls), 151

[SamplerN],rate_perm_up_small (chap-
ters/appendix/mixxx_controls), 151

[SamplerN],rate_temp_down (chap-
ters/appendix/mixxx_controls), 151

[SamplerN],rate_temp_down_small (chap-
ters/appendix/mixxx_controls), 151

[SamplerN],rate_temp_up (chap-
ters/appendix/mixxx_controls), 151

[SamplerN],rate_temp_up_small (chap-
ters/appendix/mixxx_controls), 151

[SamplerN],rateEngine (chap-
ters/appendix/mixxx_controls), 152

[SamplerN],rateRange (chap-
ters/appendix/mixxx_controls), 152

[SamplerN],rateSearch (chap-
ters/appendix/mixxx_controls), 152

[SamplerN],reloop_andstop (chap-
ters/appendix/mixxx_controls), 152

[SamplerN],reloop_exit (chap-
ters/appendix/mixxx_controls), 159

[SamplerN],reloop_toggle (chap-
ters/appendix/mixxx_controls), 152

[SamplerN],repeat (chap-
ters/appendix/mixxx_controls), 152

[SamplerN],reset_key (chap-
ters/appendix/mixxx_controls), 153

[SamplerN],reverse (chap-
ters/appendix/mixxx_controls), 153

[SamplerN],reverseroll (chap-
ters/appendix/mixxx_controls), 153

[SamplerN],scratch (chap-
ters/appendix/mixxx_controls), 160

[SamplerN],scratch2 (chap-
ters/appendix/mixxx_controls), 153

[SamplerN],scratch2_enabled (chap-
ters/appendix/mixxx_controls), 153

[SamplerN],slip_enabled (chap-
ters/appendix/mixxx_controls), 153

[SamplerN],stars_down (chap-
ters/appendix/mixxx_controls), 154

[SamplerN],stars_up (chap-
ters/appendix/mixxx_controls), 154

[SamplerN],start (chap-
ters/appendix/mixxx_controls), 154

[SamplerN],start_play (chap-
ters/appendix/mixxx_controls), 154

[SamplerN],start_stop (chap-
ters/appendix/mixxx_controls), 154

[SamplerN],stop (chap-
ters/appendix/mixxx_controls), 154

[SamplerN],sync_enabled (chap-
ters/appendix/mixxx_controls), 155

[SamplerN],sync_key (chap-
ters/appendix/mixxx_controls), 155

[SamplerN],sync_master (chap-
ters/appendix/mixxx_controls), 155

[SamplerN],sync_mode (chap-
ters/appendix/mixxx_controls), 155

[SamplerN],track_color (chap-
ters/appendix/mixxx_controls), 155

[SamplerN],track_loaded (chap-
ters/appendix/mixxx_controls), 156

[SamplerN],track_samplerate (chap-
ters/appendix/mixxx_controls), 156

[SamplerN],track_samples (chap-
ters/appendix/mixxx_controls), 156
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[SamplerN],vinylcontrol_cueing (chap-
ters/appendix/mixxx_controls), 156

[SamplerN],vinylcontrol_enabled (chap-
ters/appendix/mixxx_controls), 156

[SamplerN],vinylcontrol_mode (chap-
ters/appendix/mixxx_controls), 157

[SamplerN],vinylcontrol_status (chap-
ters/appendix/mixxx_controls), 157

[SamplerN],visual_bpm (chap-
ters/appendix/mixxx_controls), 157

[SamplerN],visual_key (chap-
ters/appendix/mixxx_controls), 157

[SamplerN],visual_key_distance (chap-
ters/appendix/mixxx_controls), 158

[SamplerN],volume (chap-
ters/appendix/mixxx_controls), 156

[SamplerN],VuMeter (chap-
ters/appendix/mixxx_controls), 158

[SamplerN],VuMeterL (chap-
ters/appendix/mixxx_controls), 158

[SamplerN],VuMeterR (chap-
ters/appendix/mixxx_controls), 158

[SamplerN],waveform_zoom (chap-
ters/appendix/mixxx_controls), 158

[SamplerN],waveform_zoom_down (chap-
ters/appendix/mixxx_controls), 159

[SamplerN],waveform_zoom_set_default
(chapters/appendix/mixxx_controls), 159

[SamplerN],waveform_zoom_up (chap-
ters/appendix/mixxx_controls), 158

[SamplerN],wheel (chap-
ters/appendix/mixxx_controls), 159

[Sampler]
[Sampler],LoadSamplerBank (chap-

ters/appendix/mixxx_controls), 162
[Sampler],SaveSamplerBank (chap-

ters/appendix/mixxx_controls), 162

[Samplers]
[Samplers],show_samplers (chap-

ters/appendix/mixxx_controls), 162

[Shoutcast]
[Shoutcast],enabled (chap-

ters/appendix/mixxx_controls), 171
[Shoutcast],status (chap-

ters/appendix/mixxx_controls), 171

[VinylControl]
[VinylControl],gain (chap-

ters/appendix/mixxx_controls), 165
[VinylControl],show_vinylcontrol (chap-

ters/appendix/mixxx_controls), 165

[VinylControl],Toggle (chap-
ters/appendix/mixxx_controls), 165

Control Index 502



Indeks

A
AAC, 481
AcoustID, 481
Advanced Audio Coding, 481
AIFF, 481
ALAC, 481
API, 481
Apple Lossless Audio Codec, 481
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